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Chapter 1: Topology Query Language
This chapter includes:

Topology Query Language (TQL) Overview 15

Creating TQLQueries in the UCMDB Managers 16

Viewing TQLQuery Results 17
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Query Node Conditions 19
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Shortcut MenuOptions 33

Attribute Operator Definitions 38

TQL Logs 40

Topology Query Language User Interface 43

Troubleshooting and Limitations 93

Topology Query Language (TQL) Overview
Topology Query Language (TQL) is a language and tool for discovering, organizing, andmanaging
IT infrastructure data. It enables you to create TQL queries that retrieve business service data from
the CMDB. TQL queries also help you display the data in a visual representation that facilitates
datamonitoring andmanaging.

This section includes the following topics:
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l "Topology Query Language" below

l "The Roles of TQL" below

Topology Query Language
TQL extends the standard SQL language by adding two important capabilities:

l TQL enables you to draw conceptual relationships between configuration items (CIs), which
represent their actual interdependencies. Using predefined operators, the different types of
interconnections (relationships) that exist between CIs can be established, and consequently
the infrastructure design and performance aremore accurately represented. This representation
serves as a basis and amodel for the discovery, arrangement, query, andmanagement of
complex infrastructures.

l TQL includes a graphical aspect, consisting of visual symbols and syntax, that represents the
resources and their interconnections. This visualization of an IT infrastructure simplifies the
understanding, monitoring, andmanaging of the IT business operations.

The Roles of TQL
TQL plays several roles:

l Builds a business servicemodel that defines and delineates the interconnection between IT
assets that function together as business services. The business servicemodel guides the
discovery and identification of these business services, from the ever-increasing number and
complexity of infrastructure resources. After the resources that comprise the business services
are discovered, the business servicemodel structures the way they are organized andmanaged
in the CMDB.

l Constantly searches the CMDB for changes that occur in the state of managed resources.
When such changes are detected, the relevant subsystems are informed and updated.

l Creates queries that retrieve business service data from the CMDB, and displays the data in a
visual representation that facilitates datamonitoring andmanaging.

Creating TQL Queries in the UCMDB Managers
The followingmanagers enable you to create TQL queries that retrieve specific data from the
CMDB and to display that data:

l Impact Analysis Manager. An Impact rule simulates how infrastructure changes can impact
your system and enables you to determine the true origin of a problem and its business impact.
During rule creation, you define the base TQL query type, which can be a new query or an
existing query. For details, see "Impact Analysis Manager" on page 430.

l Enrichment Manager. An Enrichment rule enables enlarging the CMDB, deleting CI instances
from the CMDB, or updating the attributes of a CI that already exists in the CMDB. During rule
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creation, you define the base TQL query type, which can be a new query or an existing query.
For details, see "Enrichment Manager" on page 489.

l Modeling Studio. You can build a new TQL query using the TQLQuery Editor or you can build a
new query while defining a new view, template, or perspective using the Pattern View Editor.
You can also define the topology report settings for any view in the Pattern View Editor. For
details, see "Modeling Studio" on page 241.

Viewing TQL Query Results
You view the resulting data in a visual representation in IT UniverseManager. The queries define
the structure of the resulting topology map. The view displays only those CIs and relationships that

meet the query definition. You can also view the results of a query by clicking thePreview
button in the toolbar to open a preview display identical to IT UniverseManager. For more details
about IT UniverseManager, see "IT UniverseManager" on page 180.

TQL Query Types and Priorities
When you define a TQL query, you define the type of the TQL query in the Type field of the Query
Definition Properties dialog box. The following query types are available:

l View. TQL queries used as the basis for pattern views.

l Integration. TQL queries used for integrations.

l Discovery. TQL queries used as the basis for DFM patterns.

l Template. TQL queries used as the basis for templates.

l Perspective. TQL queries used as the basis for perspectives.

l Impact Analysis. TQL queries used as the basis for Impact rules. This is the default type for
queries created in Impact Analysis Manager.

l Enrichment. TQL queries used as the basis for Enrichment rules. This is the default type for
queries created in Enrichment Manager.

You cannot change the type of an existing TQL query if it has dependencies (such as views,
templates, and so on).

If a query imported though an integration is not assigned a type, it is considered a hidden query and
does not appear in the query list in theModeling Studio. To display hidden queries in the query list,
change the setting for hidden queries under General in the User Preferences dialog box. For details,
see "User Preferences Dialog Box" on page 92.

You can also set the priority level of a TQL query, which determines how often the query is rerun
automatically to include updated information. The following priorities are available:

Modeling Guide
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l Low. The TQL query is refreshed every 2minutes.

l Medium. The TQL query is refreshed every 30 seconds.

l High. The TQL query is refreshed every 10 seconds.

l Express. The TQL query is refreshed continuously.

l Not Active. The TQL query is inactive.

Note: The above refresh times are average values.

If you set the priority of a TQL query toNot Active, the query becomes inactive and is not run
automatically, however it can be used for manually building a view.

Base Queries
You can select a base query for a TQL query in the Query Definition Properties dialog box. In this
case, the base query is first applied to the entire IT Universe, generating results. The new query is
then applied to that subset of the universe, further refining the results. Selecting a base query
enables you to filter the query results more finely and generate results more quickly in certain
cases.

The base query you select must be both active and persistent for your new query to be active. If the
base query is not active and persistent, the new query is automatically assigned a priority of Not
Active.

TQL Query Thread Pool
Each TQL query is calculated in a separate thread, taken from a thread pool. If there aremany TQL
queries being calculated, you can increase the thread pool size to improve performance. Edit the
TQL Threads Pool Size setting in the Infrastructure Settings Manager. The pool size can be any
integer value between 1 and 64. If no value is entered, the pool size is automatically set to be the
number of CPU cores divided by the number of customers (if this number is smaller than 4, it is set
to aminimum of 4 threads).

Compound Relationship
A compound relationship represents a path in the topological graph. You use a compound
relationship to define the allowed steps in the path between the source and the target CIs.

Each row represents one of the allowed steps in the path leading from the source CI to the target CI
in the topology map.
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For an example of a compound definition, see "How to Define a Compound Relationship –
Scenario" on page 26. For details on defining compound relationships, see "Add/Edit Compound
Relationship Dialog Box" on page 46.

Join Relationship
A join relationship is a logical connection that represents the relationship between two CIs (and
which appears only in the topology map containing the TQL query results). It does not exist in the
CMDB. A join relationship is created by defining an attribute for each query node, whose values are
used for comparison.

The TQL results retrieve all CIs whose attribute values meet the conditions defined in the join
definition.

For example, you can create a join definition that links all nodeCIs connected to IP AddressCIs
whoseCreated By attribute values are equal (see the example below).

Each join definition represents one condition defined for the join relationship.

Note: You can definemultiple conditions.

For an example of a join definition, see "How to Define a Join Relationship – Scenario" on page 29.
For details on defining join relationships, see "Add/Edit Join Relationship Dialog Box" on page 49.

Query Node Conditions
You can add conditions to the query nodes and relationships of a TQL query in the Query Node
Properties dialog box. The conditions filter the query results by retrieving only CIs and relationships
that match the conditions defined in the query. There are several types of conditions you can define:

l Attributes. Conditions based on CI property values.

l Cardinality. Conditions based on the number of related query nodes.

l Qualifiers. Conditions based on CI type qualifiers.

l Element type. Conditions based on CI subtypes. See below for details.

l Identity. Conditions based on CI element IDs.

Each one has a separate tab in the dialog box. For details, see "Query Node/Relationship
Properties Dialog Box" on page 72.

When you define an attribute condition using the attribute nameCI Type, the condition is converted
to a complex type condition when you save the query. The condition disappears from the Attribute
tab and appears in the Element Type tab. For Enrichment and Impact type queries, the condition
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disappears from the Attribute tab in Enrichment Manager or Impact Analysis Manager, and you
need to open the query in Modeling Studio to edit it in the Element Type tab.

Note: If you define an attribute condition that is not supported for the selected data, the
condition is ignored during the TQL query calculation.

Element Type Conditions
The Element type conditions enable you to specify the subtypes of a query node that should appear
in the query results. There are two options for defining this condition:

l Simple Type Condition. The simple type condition enables you to either include all subtypes
of the selected query node in the query results, or to exclude all of them.

l Complex Type Condition. The complex type condition enables you to select the specific
subtypes of the query node to be included in the query results. For details, see "Complex Type
Condition" on the next page.

Element Layout
You can specify the attributes to include in the query results for each query node or relationship in a
TQL query in the Element Layout tab of the Query Node Properties dialog box. Select theSelect
attributes for layout radio button and then select a CIT or relationship in the CIT pane. If you
select Specific Attributes for the Attributes condition, only the attributes youmove to the Specific
Attributes pane are included in the query results for that element. If you select All for the Attributes
condition, all of the available attributes are included in the query results for that element. In this
case, you can select Exclude specific attributes andmove selected attributes to the Excluded
Attributes pane.

There is also an option to select attributes by qualifiers. If you select qualifiers in theAttributes
with the following qualifiers field, all attributes that have the selected qualifiers are included in
the query results for that element, in addition to the attributes selected in the Specific Attributes
pane. In this case too, you can exclude selected attributes by moving them to the Excluded
Attributes pane.

By default, the attribute settings you select for a CIT are automatically applied to its descendant
CITs in the query results, however the settings are not visible in the Element Layout tab of the
dialog box. For example, if you select specific attributes to be included for theDatabaseCIT, the
same attributes are included for theOracleCIT (a child CIT of Database), but if you select Oracle
in the CIT pane, the Attributes condition displayed is None (the default condition).

You can thenmake an attributes condition selection for the child CITs themselves. If the parent CIT
has All selected as the attributes condition, then theSpecific Attributes option is disabled for the
child CITs. If the parent CIT has Specific Attributes selected as the attributes condition, you can
select All orSpecific Attributes for the child CIT. If you select Specific Attributes, you can add
more attributes by moving them to the Specific Attributes pane. These are included in the query
results along with the attributes inherited from the parent CIT's setting. Similarly, you can select
attributes from the parent CIT's setting to exclude for the child CIT, by moving them to the
Excluded Attributes pane. If the parent CIT has qualifiers selected to determine the attribute
selection, these are also inherited by the child CIT. If you select additional qualifiers to filter the
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child CIT's attribute selection, the combined set of selected qualifiers is used to filter the attribute
selection for the child CIT.

When you change the type of a query node or relationship using the ChangeQuery
Node/Relationship Type dialog box, the attributes selection for that element is lost.

If you import a package with a query that includes an attributes selection that is invalid for the
selected query node, or if youmake an invalid attributes selection using the JMX console, the query
can be saved successfully and a warning appears in the log.

Note: The layout selection is not visible in the query results in the user interface. To view the
query results with the selected attributes, access the JMX console, select TQL services, and
invoke the calculateTqlAdHocmethod.

For details on the Element Layout tab, see "Element Layout Tab" on page 82.

Complex Type Condition
The complex type condition enables you to select the specific subtypes of the query node to be
included in the query results. A CI type tree appears with all the subtypes of the selected query
node. By default, instances of all the displayed subtypes are included in the query results. For each
subtype, you can select Exclude <subtype> from the querywhich excludes instances of that
subtype from the query results. If you select theApply this condition recursively on all
subtypes check box, instances of the subtype and all of its descendants are excluded from the
results.

If you select a subtype from the tree and you select Include <subtype> in the querywithout
selecting theApply this condition recursively on all subtypes check box, only instances of the
specified subtype are included, but not instances of its descendants.

For both the Include and Exclude options, there is a further selection in the Conditions pane. If you
select By CI type, all instances of the specified subtype are then included or excluded from the
results. If you select By qualifiers and then select qualifiers from the pop-up list, only the
instances of the selected subtype with the selected qualifiers are included or excluded from the
query results.

For example, suppose CIT_B and CIT_C are subtypes of CIT_A, and CIT_A and CIT_B have
qualifier Q1. The following are some of the possible configurations of options:

l Select Exclude for CIT_A and all of its descendants. NoCITs are included.

l Select Exclude for CIT_A without its descendants. Only CIT_B and CIT_C are included.

l Select Exclude for CIT_A and all of its descendants with qualifier Q1. Only CIT_C is
included.

Note:
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n It is possible to apply the Exclude option to the root of the tree (that is, the CI type of the
original query node). If theApply this condition recursively on all subtypes check box
is selected, no CIs are included in the results. If the check box is not selected, instances
of the root CI type are excluded, but instances of its descendants are included.

n The Element Type Conditions feature is only available in theModeling Studio. If you define
a complex type condition in theModeling Studio, and thenmodify the TQL query in
Enrichment Manager or Impact Analysis Manager, the conditionmay be overwritten and
will no longer be in effect. If the complex condition is equivalent to a simple condition, you
can edit the TQL query from theQualifier tab of Enrichment Manager or Impact Analysis
Manager.

n If you want to define a qualifier condition on a query node as using the functionality of
previous UCMDB versions, select Customize subtypes and select the root query node in
the CI types tree. Then select the Include option, select By qualifiers, and select the
required qualifiers. Similarly, when accessing a TQL query with qualifier conditions defined
in a previous UCMDB version or in Enrichment Manager or Impact Analysis Manager, the
condition appears in theCustomize subtypes section of the Element Type tab, using the
Include andBy qualifiers options.

n It is sometimes possible to define an attribute condition (using the CI Type attribute) that
generates the same results as a complex type condition. However, the complex type
condition ensures better performance. In such cases, UCMDB automatically optimizes
the query calculation by substituting an equivalent complex type condition for the simple
one. If the query is active, you will see the complex conditions in the TQL definition the
next time you open it.

For details on defining a complex type condition, see "How to Define a Complex Type Condition -
Scenario" on page 31.

Subgraph Definition
A subgraph definition enables you to create a graph that represents additional TQL query data
related to a specific CI. The DFM job searches for the results from both the TQL query and the
subgraph definitions. The query recursively retrieves all related CIs for a defined depthmatching the
definition of the subgraph. For details on defining subgraph definitions, see "Subgraph Definition
Dialog Box" on page 90.

In the graph, you can define the relationship that is connected to a specific query node. For
example, if one of the query nodes is of type node, you can specify different relationships for
Windows, router, and IP Address. You can also define attribute conditions for query nodes. For
details, see "Subgraph Condition Definition Dialog Box" on page 88.

DFM jobs retrieve data that meets the criteria defined in the subgraph.

For an example of a subgraph definition, see "How to Create a Subgraph Definition – Scenario" on
page 31.
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The Use Update Value Policy Qualifier
This qualifier is used tomark attributes that enableminor deviations to their value. For example,
there is probably no need to report a small disk size change (from 8.00008 to 8.00009GB).

When updating an attribute that is marked with this qualifier, HP Universal CMDB checks the new
value against the old value. This check is performed on the server as part of the record update. If
the difference between the two values is smaller than the allowed deviation, an update is not
performed (the action is considered a false update).

When the qualifier is selected, the Insensitive Value Deviation parameter applies. Enter a value in
the box and select Percent orAbsolute Value from the drop-down list.

WhenPercent is selected, the Insensitive Value Deviationmust be between 0 and 100. Deviations
of a smaller percentage than this value are considered false updates.

WhenAbsolute Value is selected, the following rules apply:

l For numeric attributes, the Insensitive Value Deviationmust be of the same type as the attribute

l For date attributes, the Insensitive Value Deviationmust be an integer, and denotes the
deviation in milliseconds

Deviations smaller than this value are considered false updates.

By default, Use Update Value Policy is enabled for the following numeric or date attributes only:

l CIT: Node

n MemorySize

n SwapMemorySize

These attributes also include comparable and static qualifiers.

l CIT: CPU

n CpuClockSpeed

l CIT: Filesystem

n Disk_size

To deactivate the qualifier:

Access the Infrastructure Settings Manager (Managers > Administration > Infrastructure
Settings Manager). Locate theAllow Volatility option. Change the value to False.

How to Define a TQL Query
This task describes how to create a TQL query in theModeling Studio.
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Note: You can also create a TQL query during the procedure for creating Impact rules,
Enrichment rules, Views, Templates, and Perspectives.

This task includes the following steps:

l "Create a TQLQuery" below

l "AddQuery Nodes and Relationships to the Query" below

l "Set the Query Properties" below

1. Create a TQL Query
In theModeling Studio, select New > Query to open the TQLQuery Editor. For details, see
"TQLQuery Editor" on page 326.

2. Add Query Nodes and Relationships to the Query
Add the TQL query nodes and relationships that define the query. The TQL query nodes
represent the CITs, as defined in the CI TypeManager, and the relationships represent the
connections between them. Relationships are defined one at a time for each pair of TQL query
nodes in the query. For details, see "How to AddQuery Nodes and Relationships to a TQL
Query" on the next page.

Note: You can also define a self-relationship from a query node to itself.

3. Set the Query Properties

Click theQuery Definition Properties button to open theQuery Definition Properties
dialog box. Set the query type, scope, priority, and other properties. For details, see
"Query/View Definition Properties Dialog Box" on page 313.

Example of a TQL Query Definition:

The direction of the relationship indicates which query node is dependent on the other. The
following example displays two nodes, an IP Service Endpoint, and a Client Port, which
are linked to one another via a client/server connection. The TQL query results must
comply with the direction of the arrows.

Modeling Guide
Chapter 1: Topology Query Language

HP Universal CMDB (10.10) Page 24 of 534



Note: A TQL query is subject to certain validation restrictions. For details, see
"Troubleshooting and Limitations" on page 93.

How to Add Query Nodes and Relationships to a TQL
Query

This section explains how to add query nodes and relationships to a TQL query. It is relevant for
Impact Analysis Manager, Enrichment Manager, and theModeling Studio.

Note: For TQL queries to be valid, they must comply with certain restrictions. For details, see
"Troubleshooting and Limitations" on page 93.

To add query nodes and relationships to a TQL query:

1. In Impact Analysis Manager or Enrichment Manager, select the required query from the tree in

the left pane or click theNew button to create one.

In theModeling Studio, select the Resources tab in the left pane, select Queries as the
Resource type, and select the required query from the tree or click New > Query to create a new
one.

2. In Impact Analysis Manager or Enrichment Manager, click and drag one or more required TQL
query nodes from the tree displayed in the CI Type Selector, onto the editing pane. In the
Modeling Studio, select the CI Types tab in the left pane and drag the required TQL query
nodes from the tree onto the editing pane. These are the TQL query nodes that are included in
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the query.

If you want the query to run over federated CIs also, right-click a query node and select Set
Integration Points. In the Select Integration Points dialog box, select the integration points for
the external data sources to use. For details, see "Select Integration Points Dialog Box" on
page 319.

3. To add a relationship between two query nodes, do one of the following:

n Select the required TQL query nodes by holding theCTRL key and clicking the TQL query
nodes, right-click and select Add Relationship. The Add Relationship dialog box opens.
Select the required relationship. For details, see "Add/Edit Relationship Dialog Box" on page
52.

n Click theCreate Relationship icon and draw a line between the required query nodes.
The Select Relationship Type dialog box opens. Select the required relationship type. For
details, see "Select Relationship Type Dialog Box" on page 87.

4. Click OK. The selected query nodes are linked by the relationship you have selected.

How to Define a Compound Relationship – Scenario
This section describes how to define the allowed steps that form a compound relationship between
an IP SubnetCI and an IP AddressCI.

Note: To reach the required result, youmust implement each one of the following steps.

To define a compound relationship between an IP Subnet CI and an IP Address CI:

1. Create a TQL query of type view and drag the following query nodes onto the editing pane:

n IP Subnet

n IP Address

2. Right-click the IP Subnet and IP Address query nodes and select Add Compound
Relationship to open the Add Compound Relationship dialog box.

3. Click theAdd button. In Enrichment Manager and Impact Analysis Manager, the Add
Triplet dialog box opens. In theModeling Studio, a row is added to the table. Make the following
selections:

n From theSource list, select IP Subnet.

n From the Target list, select Node.
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n From theRelationship list, selectMembership.

n Select the requiredRelationship direction.

In Enrichment Manager and Impact Analysis Manager, click OK to save your changes.

4. Click theAdd button again andmake the following selections:

n From theSource list, select Node.

n From the Target list, select IP Address.

n From theRelationship list, select Containment.

n Select the requiredRelationship direction.

In Enrichment Manager and Impact Analysis Manager, click OK to save your changes.

The following shows an example of compound definitions following the changes:

5. Click OK to save your changes.

The TQL query in the editing pane now looks like this:

6. Create a view based on your TQL query and save it.

7. Go to the required view in IT UniverseManager to view the results. If you did not select the
Show full path between source and target CIs option, then the results display the names of
the relationships that link the CIs as Virtual-Compound rather than the actual names of the
relationships. See the illustration below:
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You can double-click theVirtual - Compound relationship in IT UniverseManager to open the
Link Map, which displays the CIs and relationships that comprise the allowed steps used to link
the IP Subnet and IP AddressCIs.

In the example above, the 192.168.168.0 (IP Subnet) CI is linked to the 192.168.0.1 (IP
Address) CI through the labm1ccm15 (Node) CI.

If you selected theShow full path between source and target CIs option, then the results in
IT UniverseManager display the actual names of the relationships that link the CIs and the full
path between the source and target CIs. See the illustration below:
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How to Define a Join Relationship – Scenario
This section explains how to define a join relationship that links NodeCIs to IP AddressCIs
whoseCreated by attribute values are equal.

Note: To reach the required result, youmust implement each one of the following steps.

To define a join relationship that links all IP Address and Node CIs whose Created by
attribute values are equal:

1. Create a TQL query and drag the following query nodes from the CI Type Selector onto the
editing pane:

n Node

n IP Address

2. Select theNode and IP Address query nodes and right-click to open the Add Join
Relationship dialog box.

3. Click theAdd button to add a row to the table and do the following:

n In theNode Attribute box, select Created by.

n In theOperator box, select Equal.
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n In the IP Address Attribute box, select Created by.

In Enrichment Manager and Impact Analysis Manager, youmake these selections in the Join
Relationship Condition dialog box.

The Join Definition area now looks like this:

4. Click OK to save your changes.

The TQL query in the editing pane now looks like this:

How to Define an Attribute Condition – Scenario
This task describes how to define an attribute condition to select theNodeCIs that were created or
updated over the past week.

1. In theModeling Studio, Enrichment Manager, or Impact Analysis Manager, open a TQL query,
view, Enrichment rule, or Impact Analysis rule containing a Node CI.

2. Right-click the Node CI and select Query Node Properties.

3. In the Query Node Properties dialog box in the Attributes tab, click theAdd button to add a
condition.

4. For theAttribute name, select Create Time from the drop-down list.

5. For theOperator, select Changed During [Hour(s)] from the drop-down list.

6. For theValue, enter 7.

7. Click OK to save the attribute condition.
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How to Define a Complex Type Condition - Scenario
This section describes how to define a complex type condition in the Query Node Properties dialog
box. In this example, you add subtype conditions to a Node query node in a TQL query.

To define a complex type condition:

1. Create a TQL query and drag a query node of type Node onto the editing pane.

2. Right-click the query node and select Query Node Properties. TheQuery Node Properties
dialog box opens.

3. Select theElement Type tab and select Customize subtypes.

4. In the CI Types pane, select Computer, and in the Conditions pane, select Exclude
<Computer> from the query. Select theApply this condition recursively on all subtypes
of <Computer> check box. This excludes all CIs of type Computer and its descendants in the
query results.

5. In the CI Types pane, select Unix, and in the Conditions pane, select Include <Unix> in the
query. This includes all Unix CIs in the query results.

6. In the CI Types pane, select IBM Frame, and in the Conditions pane, select Include <IBM
Frame> in the query. Then select By qualifiers and select theCONTAINER qualifier. This
includes all IBM FrameCIs with the CONTAINER qualifier in the query results.

7. In the CI Types pane, select Firewall, and in the Conditions pane, select Exclude <Firewall>
from the query. Select By qualifiers and select the HIDDEN_CLASS andMAJOR_APP
qualifiers. This excludes all Firewall CIs with the HIDDEN_CLASS andMAJOR_APP
qualifiers from the query results.

8. Click OK to save your conditions and exit the dialog box.

How to Create a Subgraph Definition – Scenario
This section describes how to create a subgraph definition. In this example, the TQL query results
retrieve all CIs that are connected to a Business Service CI by aContainment relationship up to a
depth of 3.

Note: To reach the required result, youmust implement each one of the following steps.

To create this sample subgraph definition:

1. Create a TQL query and drag a query node of typeBusiness Service onto the editing pane.

2. Right-click the Business Service query node and select Subgraph Definition to open the
Subgraph Definition dialog box.
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3. Click theAdd button. In Enrichment Manager and Impact Analysis Manager, the Add
Triplet dialog box opens. In theModeling Studio, a row is added to the table. Make the following
selections:

n From theSource drop-down list, selectManaged Object.

n From the Target drop-down list, selectManaged Object.

n From theRelationship drop-down list, select Containment.

n Set the direction of the relationship as left to right.

In Enrichment Manager and Impact Analysis Manager, click OK to save your changes.

The Subgraph Definition dialog box now looks like this:

4. Set theDepth setting to 3.

5. Click OK in the Subgraph Definition dialog box.

Go to the required view in IT UniverseManager to view the results.
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The results show the Business Service CI aaa and all of the CIs linked to it in succession by
Containment relationships down to three levels.

Shortcut Menu Options
This section includes a list of TQL query shortcut menu options:

UI Element (A-Z) Description

Add Calculated
Relationship

Enables you to create a calculated relationship.

l For details on how to create a calculated relationship, see "Triplets
Page" on page 474.

l For details about Impact Modeling, see "Using Calculated
Relationships" on page 98.
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UI Element (A-Z) Description

Add Compound
Relationship

Enables you to define the connection between two query nodes using a
compound relationship.

For details, see "Add/Edit Compound Relationship Dialog Box" on page
46.

Add Join
Relationship

Enables you to define join relationships. You create them by defining an
attribute for each query node. These query node values are used for
comparison during federation.

For details, see "Add/Edit Join Relationship Dialog Box" on page 49.

Add Related Query
Node Wizard

Displays the Add Related Query NodeWizard which enables you to build
a TQL query. For details, see "Add Related Query NodeWizard" on page
54.

Add Relationship Enables you to create a relationship for your query nodes by selecting it
from a predefined list. Displays the Add Relationship dialog box.

For details, see "Add/Edit Relationship Dialog Box" on page 52.

Note: In Enrichment Manager, this option adds an Enrichment
relationship to the rule when working inEnrichmentmode.
Applicable for regular and Enrichment query nodes. For details, see
"Enrichment Manager" on page 489. Added relationships are denoted

by an added indicator.

Add to Hierarchy Adds the selected query node to the hierarchy as a separate query node.

Note: Only relevant for theModeling Studio.

Add to Model
Output

Designates the selected query node as output for the pattern-based
model.

Note: Only relevant for pattern-basedmodels in theModeling Studio.

Change Query
Node/Relationship
Type

Displays the ChangeQuery Node Type dialog box. Enables you to
change the CI type of the query node after you have created it. For
details, see "ChangeQuery Node/Relationship Type Dialog Box" on page
270.

Note: Only relevant for theModeling Studio.
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UI Element (A-Z) Description

Clear Available by right-clicking a query node or relationship when working in
Enrichmentmode in the Enrichment Manager. Clears the query
node/relationship's Enrichment rule definition. For details, see
"Enrichment Manager" on page 489.

Appears only if you have updated or deleted a query node/relationship
using an Enrichment rule.

Note: Only relevant for Enrichment Manager.

Copy/Paste Copy/paste an existing TQL query node/relationship in the same query or
into another TQL query.

The copied TQL query node/relationship includes all TQL definitions.

You can copy and paste relationships provided that the TQL query nodes
to which the relationships are connected are also selected. A relationship
on its own cannot be copied without its connecting TQL query nodes.

You can select multiple TQL query nodes/relationships as well.

Note: TheCopy andPaste options are only available in theModeling
Studio. ThePaste option is available only after using theCopy
option to copy an existing TQL query node/relationship.

Define Impacted Define which query node in the TQL query is the trigger Impact Analysis
query node and which query nodes are impacted by the changes that
occur in the system. For details, see "Impacted Query Nodes Dialog
Box" on page 441.

Note: Only relevant for Impact Analysis Manager.

Delete Deletes the selected query node/relationship/CI.

Note: This option is not available for calculated relationships.

Modeling Guide
Chapter 1: Topology Query Language

HP Universal CMDB (10.10) Page 35 of 534



UI Element (A-Z) Description

Delete
Relationship/Query
Node

Available by right-clicking a query node or relationship when working in
Enrichmentmode.

Creates a specific Enrichment rule that is designed to delete
CIs/relationships from the CMDB. Applicable to regular query nodes and
relationships only. You can use this option, for example, for removing
unnecessary data from the CMDB. For details, see "Enrichment
Manager" on page 489.

Deleted query nodes and relationships are denoted by a removed
indicator.

Note: Only relevant for Enrichment Manager.

Edit Relationship Displays the Refine Relationship Type dialog box. For details, see
"Refine Query Node Type Dialog Box" on page 86.

Note:

l Not relevant in theModeling Studio.

l This option appears only when the selected relationship has
descendants.

Hide Element in
Query Results

When this option is selected, aHidden in Query Results indicator
appears to the right of the selected TQL query node in the editing pane.

Any query results pertaining to that TQL query node are not displayed in
the topology map. This can be useful when certain relationships or TQL
query nodes are required to build the query but are not needed in the
results. At least one query nodemust be visible for the view to be valid.

Note: Only relevant for theModeling Studio.

Query
Node/Relationship
Properties

Displays the Query Node/Relationship Properties dialog box, enabling
you to define the attribute conditions for the selected TQL query
node/relationship. For details, see "Query Node/Relationship Properties
Dialog Box" on page 72.

Note: This option is not available for calculated relationships.
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UI Element (A-Z) Description

Refine Query Node
Type

Displays the Refine Query Node Type dialog box. Enables you to change
the CI type of the query node after you have created it. For details, see
"Refine Query Node Type Dialog Box" on page 86.

Note: This option only appears if a child of the CI type exists. Only
relevant for Impact Analysis Manager and Enrichment Manager.

Remove Subgraph Only appears if you have defined a subgraph definition. For details, see
"Subgraph Definition Dialog Box" on page 90.

Reset Impacted Removes the Define Impacted definition applied to that query node. For
details on the Define Impacted definition, see "Impacted Query Nodes
Dialog Box" on page 441.

Note: Only relevant for Impact Analysis Manager.

Reset Inner
Relationship

Redraws a self-referential relationship in the Topology map as a square
for ease of viewing.

Note: Only relevant for self-referential relationships that are not
square.

Select All Selects all query nodes and relationships in the TQL query.

Note: Only relevant for theModeling Studio.

Set As Contact
Query Node

Designates the selected query node as a contact query node for the
perspective.

Note: Only relevant for perspectives in theModeling Studio.

Set Integration
Points

Opens the Select Integration Points dialog box which enables you to
select the required data sources for a TQL query node.

Note: Only relevant for theModeling Studio.

Show Element in
Query Results

When this option is selected, the results pertaining to the TQL query node
are displayed in the topology map.

Note: Only relevant for theModeling Studio.
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UI Element (A-Z) Description

Show Element
instances

Displays the CI Instances dialog box which displays all the instances
found for each query node in a table. For details, see "CI Instances Dialog
Box" on page 64.

Show Node
Parameters

Opens the Template Parameter Values dialog box, which enables you to
set the values of the query node's parameters.

Note: Only relevant for template-based views in theModeling
Studio.

Subgraph
Definition

Displays the Subgraph Definition dialog box, where you can create a
graph that represents additional TQL query data related to a specific
query node. For details, see "Subgraph Definition Dialog Box" on page
90.

Update
Relationship/Query
Node

Use an Enrichment rule to update the value of CI attributes in the CMDB,
or to add data to attributes that currently do not have values. Opens the
Query Node Definition - Attributes dialog box. For details, see "Query
Node/Relationship Definition Dialog Box" on page 514. This is applicable
for both regular and Enrichment query nodes.

Updated query nodes are denoted by an updated indicator.

Note: Only relevant for Enrichment Manager.

Attribute Operator Definitions
This section contains a list of operators used to define attribute conditions in various dialog boxes,
such as the Subgraph Condition dialog box, Impact Rules Definition dialog box, or the Query
Node/Relationship Properties dialog box.

Operator Description

Changed
during

(Displayed only when you select an attribute of type Date.) Displays only the
instances that changed during the period specified in theValue box.

Equal Checks whether the attribute value is equal to the value specified in theValue
box.

Equal
ignore
case

Checks whether the attribute value is equal to the value specified in theValue box
regardless of the case.

Note:Whenworking with Microsoft SQL Server, this option is identical to
Equal.
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Operator Description

Greater Checks whether the attribute value is greater than the value specified in theValue
box.

Note:When comparing attributes of type string, the comparison is based on
the ASCII values of the string characters.

Greater
than or
equal

Checks whether the attribute value is greater than or equal to the value specified
in theValue box.

In Displays only the instances where this attribute value equals one of the selected
values. For example, for CIs that have a Change state that equals Plan and New,
select the operator In from theOperator list and select bothPlan andNew from
theValue box.

In ignore
case

Displays only the instances where this attribute value equals one of the selected
values, regardless of the case.

Note:Whenworking with Microsoft SQL Server, this option is identical to In.

Is null Checks whether the attribute value is null.

Less Checks whether the attribute value is less than the value specified in theValue
box.

Note:When comparing attributes of type string, the comparison is based on
the ASCII values of the string characters.

Less than
or equal

Checks whether the attribute value is less than or equal to the value specified in
theValue box.

Like Uses a wildcard (%). Use Likewhen you are not sure of the complete name for
which you are searching.

Like ignore
case

Uses a wildcard (%). Use Like ignore case when you are not sure of the
complete name for which you are searching. The case of the string is ignored.

Note:Whenworking with Microsoft SQL Server, this option is identical to
Like.

Not equal Checks whether the attribute value is not equal to the value specified in theValue
box.

Unchanged
during

(Displayed when you select a date type attribute.) Displays only the instances
that did not change during the period specified in theValue box.
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Note:

l For theNot equal operator, query results do not include data from the CI instances that are
not assigned a value. For example, a system contains three nodes: Node1 is assigned the
value A, Node2 is assigned the value B, and Node3 is not assigned a value. If you create a
query to retrieve all nodes that areNot equal to A, the results of your query include Node2
only, because Node3 is not assigned a value.

l HP Universal CMDB supports bothMicrosoft SQL Server andOracle Server databases.
Microsoft SQL Server is not case sensitive by default (unlike Oracle database which is
case sensitive). Consequently, if you are usingMicrosoft SQL Server, theEqual operator
retrieves the same query results as theEqual ignore case operator. For example, if you
select the attributeCity, the operatorEqual, and typeNEW YORK in theValue
comparison box, case differences are ignored and query results includeNEW YORK,
New York and new york.

TQL Logs
This section contains definitions for TQL parameter log files.

This section includes the following topics:

l "Pattern Statistics Log" below

l "Audit Short/Detailed Log (TQL Perspective)" on the next page

l "Incremental Statistics Log" on page 42

l "Incremental Splitter Log" on page 42

l "Incremental Detailed Log" on page 43

Pattern Statistics Log
The log name is cmdb.pattern.statistics.log.

Log File Description

Purpose General calculation data for each TQL query, updated at predefined
intervals.
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Log File Description

Information Level The following information is given for each TQL query:

l name

l average, minimum, andmaximum calculation times

l number of calculations

l last calculation time

l result size

Error Level Not available.

Debug Level Not available.

Basic
Troubleshooting

l Verify that a specific TQL query was updated.

l Evaluate a TQL query's calculation time.

l Evaluate a TQL query's result size.

Audit Short/Detailed Log (TQL Perspective)
The log name is cmdb.audit.short.log.

Log File Description

Purpose CMDB state changes, CI Type changes, and TQL query results.

You can use this log to follow the results of TQL queries.

Information Level Not available.

Error Level Not available.

Debug Level l Final calculation for TQL queries is logged.

l If the final TQL query calculation is unchanged from the previous
calculation, this is noted.

l If the final TQL query calculation is changed from the previous
calculation, results of the CIs and relationships are recorded in the
detailed log. The number of CIs and relationships are recorded in the
short log.
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Log File Description

Basic Troubleshooting l Use this log to verify which notifications are published by the TQL
query subsystem.

l Check the section at the end of each result. This section includes
added, removed, and updated CIs and relationships.

l Track the CIT changes and see if the query results also change. You
can thus correlate the CIT changes to the results of the query
calculations.

Incremental Statistics Log
The log name is cmdb.incremental.statistics.log.

Log File Description

Purpose Traces the calculation procedure, full or incremental, of every query.

Information
Level

Not available.

Error Level Not available.

Debug Level l Gives the date, time, query name, and whether an incremental statistic
calculation was performed (yes/no).

l If an incremental statistic calculation was not performed, states the reason,
the number of subcalculations (relevant for incremental calculations only),
and the complete calculation time.

Basic
Troubleshooting

Monitors the calculation process.

If a specific query calculation takes a long time, check if it is a full or
incremental calculation:

l If full, check whether a full calculation is necessary.

l If incremental, check how many subcalculations have been performed.

Incremental Splitter Log
The log name is cmdb.incremental.splitter.log.

Log File Description

Purpose Monitors the incremental splitter result made during an incremental
calculation.
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Log File Description

Information
Level

Not available.

Error Level Not available.

Debug Level Gives the set of query node numbers of each query graph created by the
incremental splitter.

Basic
Troubleshooting

If the TQL result calculated by the incremental calculator is wrong, verify that
the splitter result is correct.

Incremental Detailed Log
The log name is cmdb.incremental.detailed.log.

Log File Description

Purpose Monitors the incremental calculation process.

Information
Level

Not available.

Error Level Not available.

Debug Level Each incremental subcalculation entry includes the following:

l the trigger query node

l the number of elements classified to the trigger query node

l whether the subcalculation step is driven by new elements added to the
model or by existing elements

l the calculated query graph

Basic
Troubleshooting

Follows the basic steps of an incremental calculation.

Topology Query Language User Interface
This section includes (in alphabetical order):

Add/Edit Calculated Relationship Dialog Box 44

Add/Edit Compound Relationship Dialog Box 46

Add/Edit Join Relationship Dialog Box 49

Add/Edit Relationship Dialog Box 52

Add Related Query NodeWizard 54

Add Triplet Dialog Box 61
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CI Instances Dialog Box 64

Conditions Preview Dialog Box 68

Element Layout Preview Dialog Box 68

Filter CI Instances Dialog Box 69

Join Relationship Condition Dialog Box 70

Layout Settings Dialog Box 71

Query Node/Relationship Properties Dialog Box 72

Refine Query Node Type Dialog Box 86

Select Relationship Type Dialog Box 87

Subgraph Condition Definition Dialog Box 88

Subgraph Definition Dialog Box 90

User Preferences Dialog Box 92

Add/Edit Calculated Relationship Dialog Box
This dialog box enables you to define the connection between two query nodes using a calculated
relationship from the CI Typemodel.

To
access

To access in Enrichment Manager, Impact Analysis Manager, and theModeling
Studio:

Right-click the required query node in the editing pane in Enrichment Manager,
Impact Analysis Manager, or theModeling Studio and select Add Calculated
Relationship.

Note: If you are using Enrichment Manager, select Querymode at the top of the
editing pane to display theAdd Calculated Relationship option.

To access in Adapter Management in Data Flow Management (DFM):

1. Select an adapter in the Resources pane.

2. In theAdapter Definition tab, click theEdit Input Query button to the right
of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Calculated Relationship.
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Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

See also l "Using Calculated Relationships" on page 98

l "CI Type Relationships" on page 450

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

Expand All. Expands all the folders in the tree.

Collapse All. Collapses all the folders in the tree.

Tree View Tree View. Enables you to select the display format of the calculated
relationship tree. The following options are available:

l by Display label

l by Class name

l by Legacy class name

<Calculated
relationship
tree>

Select the calculated relationship that defines the connection between two query
nodes.

Relationship
Direction

The direction of the relationship that indicates which query node is dependent on
the other.

Relationship
Name

The name of the calculated relationship.
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UI Element
(A-Z) Description

Relationship
Restrictions

Select an option to define how to handle relationships between identical query
nodes or self relationships in the query results. A self relationship is a
relationship that leads from a query node to itself.

Note: This list appears only when you select one query node or two identical
query nodes.

l Allow All Relationships. All relationships appear in the query results.

l Allow Self Relationships Only. Only self-relationships (a relationship that
leads to itself) appear in the query results.

l Allow Non Self Relationships Only. Self-relationships do not appear in the
query results.

Add/Edit Compound Relationship Dialog Box
This dialog box enables you to define the connection between two query nodes using a compound
relationship.

To access To access in Enrichment Manager, Impact Analysis Manager, and the
Modeling Studio:

Right-click the required query nodes in the editing pane in Enrichment
Manager, Impact Analysis Manager, or theModeling Studio and select
Add Compound Relationship.

Note: If you are using Enrichment Manager, select Querymode at
the top of the editing pane to display theAdd Compound
Relationship option.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. In theAdapter Definition tab, click the Edit Input Query
button to the right of the Input Query box to open the Input Query
Editor.

3. Right-click the required query node and select Add Compound
Relationship.

Important
information

You can create as many compound definitions as necessary.
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Relevant tasks l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB
Developer ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

See also l "Compound Relationship" on page 18

l "How to Define a Compound Relationship – Scenario" on page 26

User interface elements are described below:

UI Element
(A-Z) Description

Add. Adds a compound definition.

In Impact Analysis Manager, Enrichment Manager, and the Input Query Editor in
DFM, it opens the Add Triplet dialog box. In theModeling Studio, it enters a
default compound definition in the table. Click theEdit buttons to edit the
definition components.

Delete. Deletes the selected compound definition.

Condition. Enables you to edit the selected compound definition.

In Impact Analysis Manager, Enrichment Manager, and the Input Query Editor in
DFM, it opens the Edit Triplet dialog box. In theModeling Studio, it opens the
Compound Relationship Condition Definition dialog box.

Max steps The longest path allowed between the two CIs in the CMDB to be included in the
discovery process.

Default: 5

Min steps The shortest path allowed between the two CIs in the CMDB to be included in
the discovery process.

Default: 1

Relationship The relationship connecting the two query nodes.
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UI Element
(A-Z) Description

Relationship
Direction

The direction of the relationship that indicates which query node is dependent on
the other.

Relationship
Name

The name of the compound relationship.

Relationship
Restrictions

Select an option to define how to handle relationships between identical query
nodes or self relationships in the query results. A self relationship is a
relationship that leads from a query node to itself.

Note: This list appears only when you select one query node or two
identical query nodes.

l Allow All Relationships. All relationships appear in the query results.

l Allow Self Relationships only. Only self-relationships (a relationship that
leads to itself) appear in the query results.

l Allow Non Self Relationships only. Self-relationships do not appear in the
query results.

Show
element in
query
results

Select Show element in query results to include query results relating to a join
or compound relationship. By default, this option is selected. When the check
box is cleared, aHidden in Query Results indicator appears to the left of the
relationship's name in the editing pane, denoting that any query results pertaining
to the relationship are not displayed in the topology map.

Show full
path
between
source and
target CIs

If you select this option, then the query results display the actual names of the
relationships that link the CIs and the full path between the source and target
CIs.
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UI Element
(A-Z) Description

Source The required source query node.

Stop at first
compound
level

Select this option if you want the system to stop looking for TQL query results
once it reaches the first target in the path.

In the following sample compound link definition, Depth is defined as 10 and
Stop at first compound level is selected.

The TQL query results include the Target 1, Target 3, and Target 4 because
they are all at level 1 (the first CI found in the path). Target 2 is not included in
the TQL results because it is at level 2 (the second CI found in the path).

Target The required target query node.

Add/Edit Join Relationship Dialog Box
This dialog box enables you to define join relationships.
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To access To access in Enrichment Manager, Impact Analysis Manager, and theModeling
Studio:

Right-click the required query nodes in the editing pane in Enrichment Manager,
Impact Analysis Manager, or theModeling Studio and select Add Join
Relationship.

Note: If you are using Enrichment Manager, select Querymode at the top of
the editing pane to display theAdd Join Relationship option.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. In theAdapter Definition tab, click theEdit Input Query button to the
right of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Join Relationship.

Important
information

When you access the dialog box from theModeling Studio, you select the
attributes and operator within the dialog box itself. When you access the dialog
box from Impact Analysis Manager or Enrichment Manager, you select the
attributes and operator from the Join Relationship Condition dialog box.

Note: You cannot select attributes of type list for a join relationship condition.

Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

See also l "Join Relationship" on page 19

l "How to Define a Join Relationship – Scenario" on page 29

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element
(A-Z) Description

Add. Enables you to define a join definition. In Impact Analysis Manager,
Enrichment Manager and the Input Query Editor in DFM, it opens the Join
Relationship Condition dialog box. In theModeling Studio, it adds the selected
attributes and operator to the list.

Delete. Deletes the selected join definition.

Edit. Enables you to edit the join definition. Opens the Join Relationship
Condition dialog box.

Note: This option is not relevant in theModeling Studio.

<Query
node1
Attribute>
box

Select an attribute for the <end_1> query node.

Note: This option is only available in theModeling Studio.

<Query
node2
Attribute>
box

Select an attribute for the <end_2> query node.

Note: This option is only available in theModeling Studio.

<Selected
query
node1>
column

A selected query node. The first attribute applies to <end_1>.

<Selected
query
node2>
column

A selected query node. The second attribute applies to <end_2>.

And All join definitions are linked by theAnd operator.

Note: This is not relevant in theModeling Studio.

Operator
box

Select an operator. For details on the available operators, see "Join Relationship
Condition Dialog Box" on page 70.

Note: This option is only available in theModeling Studio.

Operator
column

The operator selected in the Join Relationship Condition dialog box. For details
about operator definitions, see "Attribute Operator Definitions" on page 38.
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UI Element
(A-Z) Description

Relationship
Direction

The direction of the relationship that indicates which query node is dependent on
the other.

Relationship
Name

The name of the join relationship.

Relationship
Restrictions

Select an option to define how to handle relationships between identical query
nodes or self relationships in the query results. A self relationship is a
relationship that leads from a query node to itself.

Note: This list appears only when you select one query node or two identical
query nodes.

l Allow All Relationships. All relationships appear in the query results.

l Allow Self Relationships only. Only self-relationships (a relationship that
leads to itself) appear in the query results.

l Allow Non Self Relationships only. Self-relationships do not appear in the
query results.

Show
relationship
in query
results

Select Show relationship in query results to include query results relating to a
join or compound relationship. By default, this option is selected. When the
check box is cleared, aHidden in Query Results indicator appears to the left
of the relationship's name in the editing pane. Any query results pertaining to the
relationship are not displayed in the topology map.

Add/Edit Relationship Dialog Box
This dialog box enables you to define the connection between two query nodes in a TQL query.
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To access To access in Enrichment Manager, Impact Analysis Manager, and theModeling
Studio, do one of the following:

l Right-click the required query node in the editing pane in Enrichment Manager,
Impact Analysis Manager, or theModeling Studio and select Add
Relationship.

l Click theCreate Relationship button and draw a line between the
required query nodes. The Select Relationship Type dialog box opens. Select
Regular Relationship.

Note: If you are using Enrichment Manager, select Querymode at the top of
the editing pane to display theAdd Relationship option.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. In theAdapter Definition tab, click the Edit Input Query button to the
right of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Relationship.

Important
information

This option does not appear when two selected query nodes (or a single selected
query node) do not have a valid relationship between them.

Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

See also l "How to AddQuery Nodes and Relationships to a TQLQuery" on page 25

l "CI Type Relationships" on page 450

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element
(A-Z) Description

Expand All. Expands all the folders in the relationship tree.

Collapse All. Collapses all the folders in the relationship tree.

Tree View Tree View. Enables you to select the display format of the relationship tree.
The following options are available:

l by Display label

l by Class name

l by Legacy class name

<Relationship
tree>

Select the relationship that defines the connection between two query nodes.

Relationship
Direction

The direction of the relationship that indicates which query node is dependent
on the other.

Relationship
Name

The name of the relationship.

Relationship
Restrictions

Select an option to define how to handle relationships between identical query
nodes or self relationships in the query results. A self relationship is a
relationship that leads from a query node to itself.

Note: This list appears only when you select one query node or two
identical query nodes.

l Allow All Relationships. All relationships appear in the query results.

l Allow Self Relationships only. Only self-relationships (a relationship that
leads to itself) appear in the query results.

l Allow Non Self Relationships only. Self-relationships do not appear in
the query results.

Add Related Query Node Wizard
This wizard enables you to build a TQL query.
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To access To access in Enrichment Manager, Impact Analysis Manager, and theModeling
Studio:

In the editing pane, right-click the required query node and select Add Related
Query Node.

Note: If you are using Enrichment Manager, select Querymode at the top of
the editing pane to display the Add Related Query Node option.

To access in Universal Discovery in DFM:

1. Select a job in the Discovery Modules pane.

2. Select a Trigger Query in the Properties tab. Click theOpen the Query

Editor button to open the Trigger Query Editor.

3. Right-click the required query node and select Add Related Query Node
Wizard.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. In theAdapter Definition tab, click theEdit Input Query button to the
right of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Related Query Node
Wizard.

Important
information

If the TQL query is empty, drag the required TQL query nodes on to the editing
pane from the tree displayed in the CI Type Selector or the CI Types tab of the left
pane.

Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257
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Wizard
map

The AddRelated Query NodeWizard contains:

"Related Query Node Type Page" > "Relationship Type Page" > "Related Query
Node Properties Page" > "Related Query Node Instances Page"

See also "Topology Query Language (TQL) Overview" on page 15

Related Query Node Type Page

This wizard page enables you to add a query node to the TQL query.

Important
information

If the TQL query is empty, drag the required TQL query node on to the editing pane
from the tree displayed in the Configuration Item Types pane.

For general information on the Add Related Query NodeWizard, see "Add Related
Query NodeWizard" on page 54.

Wizard
map

The "Add Related Query NodeWizard" contains:

"Related Query Node Type Page" > "Relationship Type Page" > "Related
Query Node Properties Page" > "Related Query Node Instances Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A-Z) Description

Expand All. Expands all the folders in the tree.

Collapse All. Collapses all the folders in the tree.

Tree View Tree View.Enables you to select the display format of the CI type tree. The
following options are available:

l by Display label

l by Class name

l by Legacy class name

Note: This feature is only available in theModeling Studio.

Modeling Guide
Chapter 1: Topology Query Language

HP Universal CMDB (10.10) Page 56 of 534



UI
Element
(A-Z) Description

<query
node> is
required

Define the relationship cardinality. For details, see "Query Node/Relationship
Properties Dialog Box" on page 72.

l Select the <query node> is required check box for each query node to include
aminimum of one instance of the query node at the other end of the relationship
in the query results. Selecting the check box gives the relationship a cardinality
value of 1..*.

l Clear the <query node> is required check box to give the relationship a
cardinality value of 0..*.

<TQL
Query
Node
hierarchy
tree>

Select the required query node. The query node you select appears in theElement
name box.

This list only includes the query nodes of the CI type that have valid relationships to
the selected (source) query node.

To the right of each query node, the number of CI instances that exist in the CMDB
for that CI type is displayed. The number of instances is only updated after you
close the Add Related Query NodeWizard and open it again.

Note: The first query node in the hierarchy tree is selected by default.

Element
name

(Optional) Contains the name of the selected query node. By default, the CI type is
assigned as the element's name.

You can rename a TQL query node in theElement name box giving it a unique
label. This can be helpful when there is more than one query node of the sameCI
type in the TQL query.

Show
only CITs
with
instances

Select this check box to display only the CITs of which there are instances in the
CMDB. If this box is not selected, the tree includes all CITs with a valid link to the
source query node.

Note: TheShow only CITs with instances check box is selected by default.

Relationship Type Page

This wizard page enables you to add a relationship to a TQL query.

Wizard
map

The "Add Related Query NodeWizard" contains:

"Related Query Node Type Page" > "Relationship Type Page" > "Related Query
Node Properties Page" > "Related Query Node Instances Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element (A-
Z) Description

Tree View Tree View. Enables you to select the display format of the Relationship tree.
The following options are available:

l by Display label

l by Class name

l by Legacy class name

Note: This feature is only available in theModeling Studio.

<TQL Query
Relationship
hierarchy tree>

Select the required relationship.

Relationship
Direction

Select the required relationship direction. The direction indicates which query
node is dependent on the other.

Relationship
Name

The name of the relationship.

Note: This feature is only available in theModeling Studio.

Relationship
Restrictions

Select an option to define how to handle relationships between identical query
nodes or self relationships in the query results. A self relationship is a
relationship that leads from a query node to itself.

Note: This feature is only available in theModeling Studio.

Relationship
Type

A valid relationship that defines the connection between the selected query
nodes. The box displays the relationship you selected in the relationship
hierarchy tree.

Note: This feature is only available in Enrichment Manager and Impact
Analysis Manager.

Show only
relationships
with instances

Display only the relationships of which there are instances in the CMDB. If
this box is not selected, the tree includes all valid relationships between the
selected query nodes.

Related Query Node Properties Page

This wizard page enables you to create an expression that restricts the number of query nodes that
appear in the query by adding an attribute condition to a query node or relationship.
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Important
information

Each row represents an attribute condition that you specify. Use the And/Or
column and the Brackets columns to link multiple conditions. In this way, you can
construct amore precise logical statement to generate the required results.

When you access the wizard from theModeling Studio, this wizard page has three
tabs: Attribute, Element Type, andElement Layout. TheAttribute tab includes
the elements described below. For details on theElement Type tab, see
"Element Type Tab" on page 80. For details on theElement Layout tab, see
"Element Layout Tab" on page 82.

Wizard
map

The "Add Related Query NodeWizard" contains:

"Related Query Node Type Page" > "Relationship Type Page" > "Related Query
Node Properties Page" > "Related Query Node Instances Page"

User interface elements are described below:

UI
Element
(A-Z) Description

Add. Adds an attribute condition row. Select the attribute name, operator, and value
to define the attribute condition.

Delete. Deletes the selected attribute condition.

Up.Moves a selected row up.

Down.Moves a selected row down.

Show Criteria. Displays the criteria of the selected condition in a pop-up dialog box.

And/Or Click inside theAnd/Or field and select eitherAnd orOr to link multiple conditions.

Attribute
name

Choose an attribute from the list.

Brackets Click inside theBrackets box to display a list of brackets you can use to build more
complex, logical statements.

Criteria Contains the attribute condition definition as defined in the CI Instances Dialog Box.

Include
subtypes

Display both the selected CI and its children in the topology map.

Note: This check box is only available in the Enrichment Manager and Impact
Analysis Manager.
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UI
Element
(A-Z) Description

NOT Select NOT if you want the condition statement to do the opposite of what is defined.

Note: If you select NOT, query results do not include data from the CI instances
that were not assigned a value. For example, your system contains three nodes:
Node1 is assigned the value A, Node2 is assigned the value B and Node3 is not
assigned a value. You create a query to retrieve all nodes that are equal to A and
select NOT; the results of your query only include Node2 because Node3 is not
assigned a value.

Operator Select the required operator. For details, see "Attribute Operator Definitions" on page
38.

Show
element
in query
results

Select Show element in query results to display the selected TQL query node in
the editing pane. When the check box is cleared, aHidden in Query Results
indicator appears to the right of the selected TQL query node in the editing pane.

Any query results pertaining to that TQL query node are not displayed in the topology
map. This can be useful when certain relationships or TQL query nodes are required
to build the query but are not needed in the results. For example, Windows are
connected to the network by defining specific IP Addresses, but in any query results
youmay want to view the IP Address elements only and not theWindows elements.

Value Enter or select the value of the attribute. TheValue options vary according to the
attribute type you select.

Related Query Node Instances Page

This wizard page displays all the instances found for the selected TQL query node in a table.
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Important
information

The columns displayed in the report vary according to the CI type selected.

By default, only columns corresponding to attributes that have been defined with
theAsset Data, Managed, andComparable attribute qualifiers in the CI Type
Manager are displayed as columns in the dialog box. For details, see "Attributes
Page" on page 469.

If required, you can click theDisplay Hidden Columns button to display the
attributes that are defined as Visible but not Static. For details on Static attributes,
see "Attributes Page" on page 469.

Note: For information on the elements included in the Related Query Node
Instances page, see "CI Instances Dialog Box" on page 64.

Wizard
map

The "Add Related Query NodeWizard" contains:

"Related Query Node Type Page" > "Relationship Type Page" > "Related Query
Node Properties Page" > "Related Query Node Instances Page"

Add Triplet Dialog Box
This dialog box enables you to define the allowed steps in a path in the topology graph leading from
the source CI to the target CI when creating a subgraph definition, a compound relationship, or a
calculated relationship.

To access In Enrichment Manager, Impact Analysis Manager, or the Input Query Editor in
DFM:

l In the Add Compound Relationship dialog box, click theAdd button. For
details, see "Add/Edit Compound Relationship Dialog Box" on page 46.

l In the Subgraph Definition dialog box, click Add . For details, see
"Subgraph Definition Dialog Box" on page 90.

In CI TypeManager, select Calculated Relationships from the drop-down list in
the CI Types pane. In the editing pane, select the Triplets page and then click

Add .

Important
information

Select the query nodes and relationships to be included in the topology graph.

Note: The Condition fields are displayed only when you access the Add
Triplet dialog box from the Subgraph Definition dialog box.
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Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

See also l "Compound Relationship" on page 18

l "How to Define a Compound Relationship – Scenario" on page 26

l "Subgraph Definition" on page 22

User interface elements are described below:

UI Element
(A-Z) Description

Condition. Enables you to define attribute conditions for the source and target
query nodes you selected. When the Add Triplet dialog box is opened from the
Subgraph Definition dialog box, it opens the Subgraph Condition Definition dialog
box. When the Add Triplet dialog box is opened from the Add Compound
Relationship dialog box, it opens the Compound Relationship Condition
Definition dialog box.

TheCondition button is enabled only after you select a query node from the
Source or Target lists.

Note: You cannot define attribute conditions for the source and target query
nodes in the CI TypeManager.

Relationship Select an available relationship connecting the two query nodes. The list of
available relationships appears only after defining both query nodes.

Relationship
Direction

Select the required direction. Setting different relationship directions can achieve
different query results. For an example, see "Setting Different Relationship
Directions for Compound Definitions" on the next page.

Note: The Relationship list remains empty until you have selected a source
and target.
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UI Element
(A-Z) Description

Source Select the required source query node.

Target Select the required target query node.

Setting Different Relationship Directions for Compound Definitions
You can achieve different TQL results by setting different relationship directions. For example, in
your business world, as illustrated below, you want to create a compound relationship that
connects between a query node of the CIT a and a query node of the CIT b. Depth is defined at 5
(for details, see "Depth" on page 91).

In the Add Triplet dialog box, you can create compound definitions to link query nodes a and b using
different relationship directions.

Compound
Definition Source Target Relationship

Relationship
Direction

#1 query node
a

query node c <relationship> source --> target

#2 query node
c

query node
b

<relationship> source --> target

#3 query node
c

query node
b

<relationship> source <-- target
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l Compound definitions 1 and 2 result in the following query:

l Compound definitions 1 and 3 result in the following query:

l Compound definitions 1, 2, and 3 result in the following query:

CI Instances Dialog Box
This dialog box displays all of the CI instances found for the selected TQL query node.
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To access To access in Enrichment Manager, Impact Analysis Manager, and the
Modeling Studio:

In the editing pane, right-click the required query node and select Show Element
Instances.

Note: If you are using Enrichment Manager, select Querymode at the top of
the editing pane to display the Show Element Instances option.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. In theAdapter Definition tab, click theEdit Input Query button to the
right of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Show Element’s Instances.

To access in Integration Studio:

Create an integration point based on a Jython integration adapter. In the Trigger CI
Instancemenu, chooseSelect Existing CI.

Important
information

The columns in the table display the attributes of the selected CI type. The
attributes displayed vary according to the CI type selected.

By default, only columns corresponding to attributes that have been defined with
theAsset Data,Managed, andComparable attribute qualifiers in the CIT
Manager are displayed as columns in the dialog box. For details, see "Attributes
Page" on page 469.

Relevant
tasks

"How to Define an Impact Rule –Workflow" on page 430

"How to Define an Enrichment Rule – Scenario" on page 491

"How to Define a TQLQuery" on page 23

"How to Create a Pattern View" on page 255

"How to Create a Template" on page 256

"How to Create a Perspective" on page 257

"Work with Population Jobs" in theHP Universal CMDB Data Flow Management
Guide

"Work with Data Push Jobs" in theHP Universal CMDB Data Flow Management
Guide

See also l "Topology Query Language (TQL) Overview" on page 15

l "Topology Query Language User Interface" on page 43

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element (A-Z) Description

. Specify the CIT you want displayed in the table. The table
also includes the children of the selected CIT.

Delete from CMDB. Deletes the selected CI.

Properties. Opens the Configuration Item Properties dialog
box for the selected CI.

Refresh. Refreshes the list of CI instances.

Set Filter. Filters the CI instances you want to display for the
selected query node. Opens the Filter CI Instances dialog
box.

Clear Filter. Clears the filter definitions you created in the
Filter CI Instances dialog box.

Select Columns. Enables you to select the columns to be
displayed. For details, see "Select Columns Dialog Box" on
page 530.

Sort Column Content. Enables you to set the sort order of
the CI instances. For details, see "Sort ColumnContent
Dialog Box" on page 531.

Find. Displays the Find toolbar.

Send Mail. Enables you to send the table data in an email.
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UI Element (A-Z) Description

Export Data To File. Enables you to select the format for
previewing and exporting the table data. The available options
are:

l Excel. The table data is formatted as an .xls (Excel) file
that can be displayed in a spreadsheet.

l PDF. The table data is exported in PDF format.

Note:When exporting to PDF, select a reasonable
number of columns to display to ensure that the report
is legible.

l CSV. The table data is formatted as a comma-separated
values (CSV) text file that can be displayed in a
spreadsheet.

Note: For the CSV formatted table data to display
correctly, the comma (,) must be defined as the list
separator. InWindows, to verify or modify the list
separator value, open Regional Options from the
Control Panel, and on the Numbers tab ensure that
the comma is defined as the List Separator value. In
Linux, you can specify the list separator in the
application that opens the CSV file.

l XML. The table data is formatted as an XML file that can
be opened in a text or XML editor.

Tip: To extract HTML code from the report:

l Open the file in an HTML editor

l Copy the relevant table into the target file

Rows per page Select the number of rows to be displayed on each page. You
can alsomanually enter value for the number of rows per
page.

Click to navigate through the results page by page or to jump
to the first or last page.
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UI Element (A-Z) Description

<CI Instances> The CI instances found for the selected TQL query node. You
can double-click an instance to open the Configuration Item
Properties dialog box for that CI.

<CI instances shortcut menu> For details, see "IT UniverseManager Shortcut Menu" on
page 222.

Display Label The name of the CI instance as it appears in the topology
map.

Conditions Preview Dialog Box
This dialog box displays the conditions selected when selecting a complex type condition in the
Element Type tab of the Query Node Properties dialog box.

To access Click thePreview button from the Element Type tab of the Query Node
Properties dialog box.

See also "Query Node Conditions" on page 19

User interface elements are described below:

UI Element (A-Z) Description

CI Type Displays the subtypes for which you defined conditions.

Condition Displays the icon of the selected condition, as defined in the Legend.

Filter by Specifies the selected condition (i.e., by CI type or by qualifier, and for
qualifier, specifies the qualifiers).

Element Layout Preview Dialog Box
This dialog box displays the attributes selected in the Element Layout tab of the Query Node
Properties dialog box to be included in the query results for the selected element.

To access Click thePreview button from the Element Layout tab of the Query Node
Properties dialog box.

See also "Query Node Conditions" on page 19

User interface elements are described below:
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UI Element (A-Z) Description

Attributes Mode Displays the Attributes condition selected in the Element Layout tab of
the Query Node Properties dialog box.

CI Type Displays the CIT of the selected query node or relationship.

Excluded Attributes Displays the attributes appearing in the Excluded Attributes pane in
the Element Layout tab of the Query Node Properties dialog box.

Qualifier Marked
Attributes

Displays the qualifiers selected in the Element Layout tab of the Query
Node Properties dialog box.

Specific Attributes Displays the attributes appearing in the Specific Attributes pane in the
Element Layout tab of the Query Node Properties dialog box.

Filter CI Instances Dialog Box
This dialog box enables you to reduce the number of CI instances to be displayed in a list by
selecting a condition and a value for a specific CI.

To access Click the Filter button in the CI Instances dialog box.

Important
information

A description of the filter condition you defined appears above the table columns in
the CI Instances dialog box. For example, the following illustration shows that a
filter condition was created to display only CI instances whose CI type is
Windows.

Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

User interface elements are described below:
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UI Element (A-
Z) Description

Attribute Displays all the attributes of the CI type to which the CI belongs.

Condition Select the required operator. For details, see "Attribute Operator Definitions"
on page 38.

NOT Select to filter the results by the negation of a condition and value.

Value Select or enter the required value.

Join Relationship Condition Dialog Box
This dialog box enables you to define the connection between two query nodes using a join
relationship.

To access In Enrichment Manager or Impact Analysis Manager, click theAdd button
in the Add Join Relationship dialog box.

Important
information

You cannot select attributes of type list for a join relationship condition.

Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A-Z) Description

<Selected
query
node1>

A selected query node. The first attribute applies to <end_1>.

<Selected
query
node2>

A selected query node. The second attribute applies to <end_2>.
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UI
Element
(A-Z) Description

Operator Select one of the following operators:

l Equal. The system checks whether two selected attributes are equal.

l Not equal. The system checks whether two selected attributes are not equal.

l Sub string. The system checks whether the value of the first attribute is a
substring of the value of the second attribute.

l Sub string ignore case. The system checks whether the value of the first
attribute is a substring of the value of the second attribute regardless of the
string's case.

Note:When using the operatorNot equal, ensure that both sides of the join
relationship have a limited result size. It is recommended to definemore
specific conditions so as not to overload the system with large results.

Layout Settings Dialog Box
This dialog box enables you to determine which attributes are used in the calculation of the TQL
query when using the UCMDB API. For details, see HP Universal CMDBWeb Service API in the
HP Universal CMDB Developer ReferenceGuide.

To access Click Advanced layout settings in the Query Node/Relationship Properties
dialog box in Enrichment Manager or Impact Analysis Manager.

Important
information

Since this option is only relevant when querying the CMDB API, the query results
in the user interface are not impacted by the attributes you select in this dialog
box.

Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l Implement a Discovery Adapter in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257
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User interface elements are described below:

UI Element (A-Z) Description

Attribute name The name of the attribute.

Calculate Select this check box to include the attribute in the query's calculation.

Query Node/Relationship Properties Dialog Box
This dialog box enables you to define the attribute conditions for the selected TQL query
node/relationship.

To
access

To access in Enrichment Manager, Impact Analysis Manager, and theModeling
Studio:

In the editing pane, right-click the required query node and select Query
Node/Relationship Properties or double-click the required query node or
relationship.

Note: If you are using Enrichment Manager, select Querymode at the top of the
editing pane to display theQuery Node Properties option.

To access in DFM:

1. To access from the Adapter Definition tab, select an adapter. Click theEdit

Input Query button to the right of the Input Query box to open the Input
Query Editor.

2. Right-click the required query node/relationship and select Query Node
Properties orRelationship Properties or double-click the required query node
or relationship.

Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

User interface elements are described below:
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UI
Element
(A-Z) Description

Element
name

(Optional) TheElement name box contains the name of the selected query
node/relationship. By default, the CI type is assigned as the element's name. You
can rename a TQL query node in theElement name box giving it a unique label. This
can be helpful when there is more than one query node of the sameCI type in the
TQL query.

Element
type

Displays the CI type of the selected query node. If you want to change the query
node type to a child of the original type, select a subtype from the drop-down list.

Note:

l If you have already defined a complex type condition for the query node, the
condition is lost when you change the query node type.

l This feature is only available in theModeling Studio.

Include
subtypes

Select to display both the selected CI and its children in the topology map.

Note: This feature is only available in Enrichment Manager and Impact Analysis
Manager.

Query
Result

Click Query Result to display a topology map of the TQL query showing the number
of instances of each query node/relationship.

Note: This feature is only available in theModeling Studio.
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UI
Element
(A-Z) Description

Show
element
in query
results

Select Show element in query results to display the selected TQL query node in
the editing pane. When this option is cleared, aHidden in Query Results indicator
appears to the right of the selected TQL query node in the editing pane.

Any query results pertaining to that TQL query node are not displayed in the topology
map. This can be useful when certain relationships or TQL query nodes are required
to build the query but are not needed in the results. For example, Windows are
connected to the IP Subnet by defining specific IP Addresses, but in any query
results youmay want to view the IP Address elements only and not theWindows
elements.

Attribute Tab
This tab enables you to create an expression defining conditions that restrict the number of query
nodes that appear in the query. You can add an attribute condition to a query node or relationship
and filter the query results.

To access Click theAttribute tab in the Query Node/Relationship Properties dialog box.

Important
information

Each row represents an attribute condition that you specify. Use the And/Or
column and the Brackets columns to link multiple conditions. In this way, you can
construct amore precise logical statement to generate the required results.

Note:

l This tab is not available for calculated relationships.

l When you access the Query Node/Relationship Properties dialog box in
Modeling Studio, this tab is read-only for Enrichment and Impact type
queries for which an Enrichment rule or Impact rule is defined.
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Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

User interface elements are described below:

UI Element
(A-Z) Description

Add. Adds an attribute condition row. Select the attribute name, operator, and
value to define the attribute condition.

Delete. Deletes the selected attribute condition.

Up.Moves the selected row up.

Down.Moves the selected row down.

Show Criteria. Displays the criteria of the selected condition in a pop-up
dialog box.

Advanced
layout
settings

Opens the Layout Settings dialog box which enables you to determine which
attributes are used in the calculation of the TQL query when querying the
CMDB using third-party or custom tools.

Note: This feature appears only in Enrichment Manager and Impact
Analysis Manager.

And/Or Click inside theAnd/Or field and select eitherAnd orOr to link multiple
conditions.

Attribute
name

Select an attribute from the drop-down list.

Note:When you select one of the following attribute types: float, double,
or long, the In operator is not available.
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UI Element
(A-Z) Description

Brackets Click inside theBrackets box to display a list of brackets you can use to build
more complex, logical statements.

Criteria Contains the attribute condition definition as defined in the CI Instances dialog
box.

Default Value For parameterized attributes, enter a default value for the parameter.

Not Select NOT if you want the condition statement to do the opposite of what is
defined.

Note: If you select NOT, query results do not include data from the CI
instances that were not assigned a value. For example, your system
contains three nodes: Node1 is assigned the value A, Node2 is assigned
the value B and Node3 is not assigned a value. You create a query to
retrieve all nodes that are equal to A and select NOT; the results of your
query only include Node2 because Node3 is not assigned a value.

Operator Select the required operator. For details, see "Attribute Operator Definitions" on
page 38.

Note:When you select one of the following attribute types: float, double,
or long, the In operator is not available.

Parameterized Select Yes to define a parameterized value for the attribute. Select No to
define a fixed value for the attribute.

Note: This feature is only available in theModeling Studio.

Parameter
Name

If you are defining a parameterized value for the attribute, youmust enter the
parameter name.

Note: This feature is only available in theModeling Studio.

Value Enter or select the value of the attribute. TheValue options vary according to
the attribute type you select.

Note: You can paste a copied value into the window by pressingCTRL+v
on the keyboard.

Cardinality Tab
In this area, you can define a relationship cardinality, which enables you to define how many CI
instances you expect to have at the end of a relationship in your query result.
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To access Click theCardinality tab in the Query Node Properties dialog box.

Important
information

Select the required relationship to which the selected query node is attached.
Then define the lower and upper limits for including the query node at the other end
of the relationship in the query results.

Each row represents a cardinality condition that you specify. Use the And/Or
column and the Brackets columns to link multiple conditions.

You can define relationship conditions that enable the relationship's connecting
query node to be included in the TQL query results by creating an expression
defining that condition. For an example, see "Example of a Relationship
Condition" on page 79.

Note:

l This tab only appears when a query node is selected.

l When you access the Query Node/Relationship Properties dialog box in
Modeling Studio, this tab is read-only for Enrichment and Impact type
queries for which an Enrichment rule or Impact rule is defined.

Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

User interface elements are described below:

UI Element (A-Z) Description

Add. Adds a cardinality condition row. Select the query node andmax
andmin values to define the cardinality condition.

Delete. Deletes a cardinality condition from the Cardinality area.

Up.Moves a selected row up.
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UI Element (A-Z) Description

Down.Moves a selected row down.

Show Criteria. Displays the criteria in a pop-up dialog box.

Inserts 1 in theMin box and * in theMax box.

Note: Only relevant for theModeling Studio.

Inserts 0 in theMin box and * in theMax box.

Note: Only relevant for theModeling Studio.

And/Or Click inside theAnd/Or field and select eitherAnd orOr to link multiple
conditions.

Brackets Click inside theBrackets box to display a list of brackets you can use to
build more complex, logical statements.

Criteria Contains the cardinality condition definition as defined in the CI
Instances Dialog Box.

Max Enter the value that defines the upper limits for including the query node
at the other end of the relationship in the query results.

Note: You can use an asterisk (*) in theMax box to represent an
infinite value.

Min Enter the value that defines the lower limits for including the query node
at the other end of the relationship in the query results.

For example, if <end_1> is IpAddress and <end_2> isWindows,
entering 1 in theMin box and asterisk (*) in theMax box instructs the
system to retrieve only those IP Addresses that are connected to at
least oneWindows operating system. (The asterisk indicates an infinite
value.) Entering 3 in theMin box and asterisk (*) in theMax box
instructs the system to retrieve only thoseWindows operating systems
that are connected to at least three IP Addresses.

Query Node Select the required relationship to which the selected query node is
attached. The list contains all the relationships that are linked to the
selected query node.
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UI Element (A-Z) Description

Not Select NOT if you want the condition statement to do the opposite of
what is defined.

Note: If you select NOT, query results do not include data from the
CI instances that were not assigned a value. For example, your
system contains three nodes: Node1 is assigned the value A,
Node2 is assigned the value B and Node3 is not assigned a value.
You create a query to retrieve all nodes that are equal to A and
select NOT; the results of your query only include Node2 because
Node3 is not assigned a value.

Example of a Relationship Condition

The example of relationship conditions is based on the following TQL query:

In the Relationship Cardinality dialog box, the following relationship conditions are defined for the
query:

l Containment –Min: 2, Max: 4

l Membership –Min: 1, Max: *

Using theOR operator, the definitions appear in theCardinality section, as follows:

l [Containment (Node, IP Address)] OR [Membership (IP Subnet, Node)] means that
the nodemust either have between two and four IP Addresses OR be amember of the IP
Subnet.

Using the AND operator, the definitions appear in theCardinality section, as follows:
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l [Containment (Node, IP Address)] AND [Membership (IP Subnet, Node)] means that
the nodemust have between two and four IP Addresses AND also be amember of the IP
Subnet.

Note: A cardinality of (0..0) is only valid when both ends of a relationship are defined with that
cardinality. If one end is defined with cardinality (0..0) and the other end is defined with a
different cardinality, the condition is invalid. However, the TQL query is saved (the cardinality
has no effect on the query results).

Element Type Tab
This area enables you to specify subtype conditions for the selected query node or relationship.

To access Click theElement Type tab in the Query Node/Relationship Properties
dialog box.

Important
information

This tab is only available in theModeling Studio.

This tab is not available for calculated relationships.

Relevant tasks l "How to Define a TQLQuery" on page 23

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

l "How to Define a Complex Type Condition - Scenario" on page 31

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

<Legend> Indicates the icons displayed next to the subtypes based on the
selected conditions:

l Include the subtype without its descendants.

l Include the subtype with its descendants.

l Exclude the subtype without its descendants.

l Exclude the subtype with its descendants.
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UI Element (A-Z) Description

CI
Types/Relationships
pane

WhenCustomize subtypes is selected, the CI Types pane displays a
tree with all subtypes of the selected CI type (for relationships, the
Relationships pane displays a tree with all subtypes of the selected
relationship). After selecting conditions in Conditions pane, click the

Preview button to open the Conditions Preview dialog box.

Conditions pane For details, see "Conditions Pane" below.

Customize subtypes Select Customize subtypes to set a complex type condition. Select the
required subtypes from the tree in the CI Types/Relationships pane and
select conditions for them in the Conditions pane, as described below.

Element type Select Element type to set a simple type condition. If you want to
include all subtypes of the selected CI type, select the Include
subtypes check box. If you do not want to include all subtypes, clear
the check box.

Conditions Pane

UI Element (A-Z) Description

Apply this condition
recursively on all
subtypes of
<selected CI type>

Select this check box to apply the specified condition for the selected CI
type to all of that CI type's descendants, recursively.

By CI types Select By CI types to include or exclude all instances of the selected
CI type in the query results.

By qualifiers Select By qualifiers to include or exclude instances of the selected CI
type with specific qualifiers in the query results. A pop-up window
appears with a list of qualifiers. Select the required qualifiers for the
selected subtype. For details on the qualifiers, see "Qualifier Tab" on
page 84.
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UI Element (A-Z) Description

Condition Select a condition for the selected CI type. The following options are
available:

l None. No condition is selected for this CI type. Instances of this CI
type and all its descendants are included in the query results, unless
a parent CI type of this CI type was selected for exclusion and the
Apply recursively check box was selected.

l Include <selected subtype> in the query. Includes instances of
the selected CI type in the query results (according to the condition
selected). An example of a situation where this option is relevant is
where a parent of the CI type was selected to be excluded and the
Apply recursively check box was selected. You can select certain
subtypes to be included, so the query results exclude all subtypes of
the parent CI type except for the specified ones.

l Exclude <selected subtype> from the query. Excludes instances
of the selected CI type from the query results (according to the
condition selected).

Element Layout Tab
This area enables you to select the attribute values returned in the query results for the selected
query node or relationship.

To access Click theElement Layout tab in the Query Node/Relationship Properties dialog
box.

Important
information

When youmake a selection of the attributes to include in the query results for a
particular CIT, the selection also applies to all of its descendant CITs. You can
manually exclude specific attributes for descendant CITs in the Conditions pane.

This option is only relevant when querying the CMDB API. The query results in
the user interface are not impacted by the attributes you select in this dialog box.

This tab is only available in theModeling Studio.

This tab is not available for calculated relationships.

Relevant
tasks

l "How to Define a TQLQuery" on page 23

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

l "How to Define a Complex Type Condition - Scenario" on page 31
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

<Legend> Indicates the icons displayed next to the subtypes based on the
selected attributes condition:

l Include all attributes for this subtype.

l Include only the selected attributes for this subtype.

CI
Types/Relationships
pane

WhenSelect attributes for layout is selected, the CI Types pane
displays a tree with all subtypes of the selected CI type (for
relationships, the Relationships pane displays a tree with all subtypes of
the selected relationship). After selecting conditions in Conditions pane,

click thePreview button to open the Element Layout Preview dialog
box.

Conditions pane For details, see "Conditions Pane" below.

No attributes If you select No attributes, no attribute values are returned in the query
results for the selected query node or relationship.

Select attributes for
layout

If you select Select attributes for layout, you can select the attributes
to be included in the query results for the selected query node or
relationship.

Conditions Pane

UI Element (A-Z) Description

Attributes condition Select one of the following options:

l None. No attributes are included in the query results for the selected
element.

l All. All attributes defined for the selected element are included in the
query results.

l Specific Attributes. Only the selected attributes are included in the
query results for the selected element.

Attributes with the
following qualifiers

You can include attributes with specific qualifiers. Click the ellipsis
button to open a dialog box with the available qualifiers and select the
required qualifiers.

Note: This feature only appears when you select Specific
Attributes for the Attributes condition.
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UI Element (A-Z) Description

Available Attributes Displays all of the available attributes for the selected element.

Excluded Attributes WhenAll is selected as the Attributes condition, you can exclude
selected attributes by moving them into the Excluded Attributes pane.

WhenSpecific Attributes is selected as the Attributes condition for a
CIT that has inherited an attribute selection from its parent CIT, you can
exclude specific attributes from the selection by moving them to the
Excluded Attributes pane.

Alternatively, if you select attributes with selected qualifiers for a CIT,
you can exclude some attributes from that selection by moving then to
the Excluded Attributes pane.

You canmove attributes into and out of the pane using the arrow
buttons.

Exclude Specific
Attributes

Select this check box to enable the Available Attributes and Excluded
Attributes panes and the arrow buttons.

Note: This feature only appears when you select All for the
Attributes condition.

Specific Attributes Displays the attributes to be included in the query results for the
selected element. Move attributes into and out of the pane using the
arrow buttons.

Note: This feature only appears when you select Specific
Attributes for the Attributes condition.

Qualifier Tab
This area enables you to define qualifier conditions for the selected query node or relationship. For
example, you can use a qualifier to define a CIT as abstract, meaning you cannot create instances
from it.

To access Click theQualifier tab in the Query Node/Relationship Properties dialog box.

Important
information

By default, multiple selection links the conditions with the OR operator.

Note: This tab is only available in Enrichment Manager, Impact Analysis
Manager, and the Input Query Editor in DFM.
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Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

User interface elements are described below:

UI Element
(A-Z) Description

<Qualifiers> For a list of the available qualifier options, see "Qualifiers Page" on page 472.

Negate
Qualifiers

If this check box is selected, then the element is included in the query results
only if it has no qualifier in the list of selected qualifiers.

Identity Tab
This area enables you to filter the TQL query results according to the element ID of the instances
found for the selected TQL query node.

To access Click the Identity tab in the Query Node Properties dialog box.

Important
information

Move the required element from theOptional identities pane on the left to the
Selected identities pane on the right to define what you want included in the TQL
query results using the left and right arrows.

Note: This tab only appears when a query node is selected.

Modeling Guide
Chapter 1: Topology Query Language

HP Universal CMDB (10.10) Page 85 of 534



Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

The following elements are included (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

<Toolbar> For descriptions of the toolbar buttons, see "CI Instances Dialog Box" on
page 64.

Optional identities
pane

Displays all the instances found for the selected TQL query node.

Selected identities
pane

Displays the elements that are used to define what should be included in
the TQL query results.

Refine Query Node Type Dialog Box
This dialog box enables you to change the CI type of a TQL query node after you have created a
TQL query.

To access In Impact Analysis Manager or Enrichment Manager, right-click the required query
node and select Refine Query Node Type.

Note: If you are using Enrichment Manager, select Querymode at the top of the
editing pane to display theRefine Query Node Type option.

Important
information

You can change the CI type to a type from one of the CI type's children, if one
exists. If no such CI type exists, this option does not appear.
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Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

See also l "Topology Query Language (TQL) Overview" on page 15

l "CI TypeManager" on page 448

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

<List of CI types from which to choose> Select the required CI type.

Select Relationship Type Dialog Box
This dialog box enables you to select the type of TQL relationship to be created.

To access In the editing pane of Impact Analysis Manager, Enrichment Manager, and the

Modeling Studio, click theCreate Relationship button in the toolbar and
draw a line between two query nodes. The Select Relationship Type dialog box
opens automatically.

Important
information

Select one of the following relationship types:

l Regular Relationship. For details, see "Add/Edit Relationship Dialog Box"
on page 52.

l Join Relationship. For details, see "Add/Edit Join Relationship Dialog Box"
on page 49.

l Compound Relationship. For details, see "Add/Edit Compound Relationship
Dialog Box" on page 46.

l Calculated Relationship. For details, see "Add/Edit Calculated Relationship
Dialog Box" on page 44.

Modeling Guide
Chapter 1: Topology Query Language

HP Universal CMDB (10.10) Page 87 of 534



Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

See also l "How to AddQuery Nodes and Relationships to a TQLQuery" on page 25

l "CI Type Relationships" on page 450

Subgraph Condition Definition Dialog Box
This dialog box enables you to create conditions that restrict the number of query nodes that appear
in the query.

To access In Impact Analysis Manager, Enrichment Manager and the Input Query Editor in

DFM, click Condition in the Add Triplet dialog box.

In theModeling Studio, click Condition in the Subgraph Definition dialog box.

Important
information

Contains the following tabs:

l Attribute. Enables you to define attribute conditions for query nodes and
relationships. See a description of the elements in theAttribute tab in the table
below. Each row represents an attribute condition that you specify. Use the
And/Or column and the Brackets columns to link multiple conditions. In this
way, you can construct amore precise logical statement to generate the
required results.

l Qualifiers (for Enrichment Manager, Impact Analysis Manager, and the Input
Query Editor in DFM). Enables you to define qualifier conditions for the
selected query node or relationship. For details, see "Qualifier Tab" on page 84.

l Element Type (for theModeling Studio). Enables you to define subtype
conditions for the selected query node or relationship. For details, see
"Element Type Tab" on page 80.
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Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "Microsoft Internet Information Services (IIS) Discovery" in theHP UCMDB
Discovery and Integrations Content Guide

l "How to Create a Perspective" on page 257

User interface elements are described below:

UI
Element
(A-Z) Description

Add. Adds the subgraph condition definition.

Delete. Deletes the subgraph condition definition.

Up.Moves a selected row up.

Down.Moves a selected row down.

Show Criteria. Displays the subgraph condition definition in a pop-up dialog box.

And/Or Click inside theAnd/Or field and select eitherAnd orOr to link multiple conditions.

Attribute
name

Choose an attribute from the list.

Brackets Click inside theBrackets box to display a list of brackets you can use to build more
complex, logical statements.

CIT Contains the CIT selected from theSource and Target lists.

Note: This option is not relevant when accessing the dialog box from the
Modeling Studio.

Criteria Contains the attribute condition definition as defined in the CI Instances Dialog Box.
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UI
Element
(A-Z) Description

Not Select NOT if you want the condition statement to do the opposite of what is defined.

Note: If you select NOT, query results do not include data from the CI instances
that were not assigned a value. For example, let us assume that your system
contains three nodes. Node1 is assigned the value A, Node2 is assigned the
value B and Node3 is not assigned a value. If you create a query in which you
want to retrieve all nodes that are equal to A and you select NOT, the results of
your query only include Node2 because Node3 is not assigned a value.

Operator Select the required operator. For details, see "Attribute Operator Definitions" on page
38.

Value Enter or select the value of the attribute. TheValue options vary according to the
attribute type you select.

Subgraph Definition Dialog Box
This dialog box enables you to create a graph that represents additional TQL query data related to a
specific CI.

To access To access in Enrichment Manager, Impact Analysis Manager, and theModeling
Studio:

In the editing pane, right-click the required query node and select Subgraph
Definition.

Note: If you are using Enrichment Manager, select Querymode at the top of
the editing pane to display theSubgraph Definition option.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. In theAdapter Definition tab, click theEdit Input Query button to the
right of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Subgraph Definition.

Important
information

The following icon is displayed next to the query node for which you define a
subgraph:
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Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

See also l "Subgraph Definition" on page 22

l "How to Create a Subgraph Definition – Scenario" on page 31

User interface elements are described below:

UI Element
(A-Z) Description

Add. Adds a subgraph definition. In Enrichment Manager, Impact Analysis
Manager, and the Input Query Editor in DFM, click to open the Add Triplet dialog
box. In theModeling Studio, click to add a row to the table.

Delete. Deletes the selected subgraph definition.

Condition. Enables you to edit a subgraph definition. In Impact Analysis
Manager, Enrichment Manager, and the Input Query Editor in DFM, it opens the
Edit Triplet dialog box. In theModeling Studio, it opens the Subgraph Condition
Definition dialog box.

Depth A number that represents the longest path (that is, themaximum number of
connecting query nodes) allowed between two CIs in the CMDB that should be
included in the DFM process.

Default: 5

Element
condition
exists

A green asterisk appears next to either the source, relationship, or target in the
subgraph definition if an attribute condition has been defined for one of them in
the Subgraph Condition Definition dialog box. For details, see "Subgraph
Condition Definition Dialog Box" on page 88.

Relationship The relationship selected connecting the source to the target query node.

Relationship
Direction

The direction of the relationship selected, indicating which query node is
dependent on the other.

Source The required source query node selected.

Modeling Guide
Chapter 1: Topology Query Language

HP Universal CMDB (10.10) Page 91 of 534



UI Element
(A-Z) Description

Target The required target query node selected.

User Preferences Dialog Box
This dialog box enables you to reset system preferences.

To access Select Tools > User Preferences, or click theConfigure User Preferences
button in the Status Bar.

Important
information

All the preferences you select (such as whether to display certain wizard pages or
warningmessage preferences) are stored in the system. This dialog box enables
you to reset those preferences.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

<Left pane> Select the preferences page to edit. The following options are available:

l Wizard Preferences. Enables you to define whether to hide or display
certain wizard pages.

l Optional Messages Preferences. Enables you to define whether to hide or
display certain messages.

l Discovery Preferences. Enables you to define:

n Whether to hide or display certain Discovery warningmessages

n The required default external editor (such as Notepad)

n Whether to use Basic or Advanced Discovery mode

l General. Enables you to define general application preferences.

l Reports. Enables you to set the category of Custom Reports selected by
default.

<Preferences
list>

The list of warningmessages and their user-selected preferences.

Filter by Enter a search word to filter the list of options.

Reset All Click to reset all the preferences to their default values.

Reset Page Click to reset the selected preference to its default value.
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Troubleshooting and Limitations
This section describes troubleshooting and limitations for Topology Query Language.

l When creating resources, such as TQL queries, views, and Impact rules, make sure that there
are no spaces at the end of the resource name.

l In amulti-tenancy environment, TQL query names cannot contain an@ character.

l If an error occurs while working with views in theModelingmanagers, when adding CIs to the
CMDB, or when updating existing CIs, and the error log indicates that objects aremissing in the
database, access the JMX console and run the followingmethods under service = DAL
services:

n rebuildModelViews

n rebuildModelDBSchemaAndViews

l If the login takes a long time when navigating to theModelingmodules, go to Infrastructure
Settings Manager and set the value of themam.gui.automation.flow.mapping.enabled
setting to false. This disables the Automation Flow functionality but improves the login time for
theModelingmodules.

l For TQL queries to be valid, they must comply with certain restrictions.

This section includes the following topics:

n "Understanding Validation Restrictions" below

n "Impact Analysis TQLQuery Validation" on page 95

n "Enrichment TQLQuery Validation" on page 96

Understanding Validation Restrictions
For Impact Analysis, Discovery, and Enrichment TQL query types to be valid, they must comply
with the following restrictions:

n Unique Names. TQL query elements must have unique names.

n Self Relationships. A TQL query must not contain self relationships, that is, a relationship
must not lead from a query node to itself, as the following example illustrates:
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n Cyclic Graph. The TQL query structure cannot be a closed circle, as shown in the following
example:

n Separate Query Nodes and Groups. All the TQL query nodes must be linked to one
another, that is, the TQL query cannot contain separate query nodes or groups, as the
following example illustrates:
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Impact Analysis TQL Query Validation
Impact Analysis TQL queries must also comply with the following restrictions:

n Number of query nodes. An Impact Analysis TQL query must consist of at least two query
nodes.

n Trigger and affected query nodes must be connected. Theremust be a path of
relationships from the triggered query node to the affected query nodes.

n Selecting query nodes to function as Impact Analysis triggers. When selecting query
nodes to function as Impact Analysis triggers, the query nodes must comply with the
following restrictions:

o You can select more than one query node as a trigger. However, you cannot define a query
node both as affected and as a trigger.

o If a query node has a relationship whoseminimum limit is 0 (meaning that one of its ends
does not necessarily have a query node linked to it), the query node that is linked to its
other end cannot be a root cause query node (because it may or may not exist in the TQL
query). For details about minimum limits, see "Cardinality Tab" on page 76. For example,
Configuration Item cannot be either a root cause or affected query node because it is
connected to the query node with aMin limit of 0.
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Note: A query node that is hidden cannot be a root cause or an affected query node.

n The connection between trigger and affected query nodes. The trigger query node and
affected query nodes you definemust be connected by a path of relationships from the
triggered query node to the affected query nodes.

Enrichment TQL Query Validation
Enrichment TQL queries must comply with the following restriction:

n Required elements. You cannot perform Enrichment on a non-required query node, that is, a
query node that does not necessarily appear in the TQL query results.

Example 1. In this example, the TQL query results can be eitherA andB orA andC.
Therefore, you cannot add an Enrichment query node to query nodes B orC because they are
not required elements. You can add an Enrichment query node to query nodeA because it
always appears in the TQL query results. For details on how to add Enrichment query nodes
and relationships, see "How to Add Enrichment Query Nodes and Relationships to an
Enrichment TQLQuery" on page 495.
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Example 2. In this example, bothA andB are required elements that always appear in the
TQL query results. Only C is not a required element because it has a cardinality of 0.
Therefore, you cannot add an Enrichment query node to it.
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Chapter 2: Using Calculated Relationships
This chapter includes:

Calculated Relationships Overview 98

Calculated Relationships 98

Calculated Relationship Types 99

How to Set Folding Rules for Composite CIs 99

Calculated Relationships Overview
A calculated relationship represents the connection between two CIs, whose pathmeets the
conditions defined for the triplets on which it is based in the CI TypeManager. For details on how to
define triplets, see "Triplets Page" on page 474.

You can use calculated relationships to create TQL queries just like any other relationship in the CI
Typemodel. This enables you to base Enrichment rules, Impact rules, and views on calculated
relationships.

The direction of the calculated relationship is not always the same direction as the physical
relationship taken from the CI Typemodel. There can be one or more relationships between two
CIs, depending on the way the triplets, on which the calculated relationship is based, are defined.

Calculated Relationships
Calculated relationships are defined by one or more triplets. Each triplet is defined by the following
components:

l One source CI type

l One target CI type

l A physical relationship type (for example, Containment) that links the two CI types

l The required direction. The direction can be identical to or opposite from the direction of the
physical relationship between the source and target CIs.

Since calculated relationships are defined by physical relationships from within the class model,
their lifetime is determined by the lifetime of the physical relationships. When the physical
relationship in the class model is removed, the corresponding calculated relationship is removed
from all view results as well.

Note: If you create a new CI type or relationship in the CI TypeManager, you need to define
the required triplets.

Example of a Triplet Definition:
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Calculated Relationship Types
There is one out-of-the-box calculated relationship called Impacted By. Impacted By contains two
subtypes, each one representing a different type of dependency relationship (complete dependency
vs. potential dependency.)

l Impacted by (Directly)

l Impacted By (Potentially)

How to Set Folding Rules for Composite CIs
This task describes how to configure the folding rules which define the composite CIs used in
ConfigurationManager. Composite CIs form the content of themanaged views.

Note: This task is only relevant for users of HP Universal CMDB ConfigurationManager.

This task includes the following steps:

l "Prerequisites" below

l "Define a folding rule with no conditions" below

l "Define a folding rule with conditions" on page 101

1. Prerequisites
Consider how you want to display the data in composite CIs in ConfigurationManager and then
decide on the rules for the scope of the composite CIs.

2. Define a folding rule with no conditions
a. SelectModeling > CI Type Manager.

b. Select Calculated Relationships from the list box in the CI Types pane. Under
Calculated Links, select Folding Rules (Configuration Manager).

c. In the right pane, click the Triplets tab.

d. In the Triplets tab, click to open the Add Triplet dialog box. Define the triplet as follows:
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UI Element Description

Source Select the required source CI type.

Target Select the required target CI type.

Relationship Select the required relationship connecting the source and target CI
types.

Note: The list of available relationships appears only after
defining the source and target CI types.

Relationship
Direction

Select the required direction.

o The direction is from source to target.

o The direction is from target to source.

The direction of the relationship determines which is the composite
CI and which is the component CI.

o When the relationship's arrow is pointing to the target, the
source query node is the composite CI and the target query
node is the component CI:

o When the relationship's arrow is pointing to the source, the
target query node is the composite CI and the source query
node is the component CI:
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e. Click OK to save your changes.

After saving the changes, ConfigurationManager receives notification of the change and
recalculates the relevant views.

3. Define a folding rule with conditions
Select this option if you want to specify attribute conditions for a specific node. Only CIs that
match those conditions will be folded under the rule in ConfigurationManager. For example,
you can specify that only installed software with a specific name is a component CI of the
node.

a. SelectModeling > Modeling Studio.

b. On theResources tab, select Queries from the Resource Type list box.

c. In theConfiguration Manager node of the tree, click and add a folder called Filtered
Folding Rules, if one does not already exist.

d. Select New > Query to open the TQLQuery Editor. Define a TQL query that has the
following structure:

source > relation > target

For details about the source and target nodes, see the table in "Define a folding rule with no
conditions" on page 99. For general information about creating TQL queries, see Define a
TQLQuery.

e. Click theEdit properties button and select Perspective in the Type drop-down list.

f. Click OK.

g. Right-click the source query node icon and select Set As Contact Query Node.

h. Right-click the target query node icon and select Query Node Properties. Click to
specify the required conditions for the folding rule.

i. Click OK to save your changes. The following picture shows an example of a TQL query
that was defined for a folding rule. In this example, Node is the source of the TQL query
and InstalledSoftware is the target:
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j. Execute the following JMX command:

i. Access the JMX console by launching yourWeb browser and entering the following
address: http://<server_name>:<port_number>/cnc/jmx-console, where
<server_name> is the name of themachine on which ConfigurationManager is
installed.

ii. Enter the JMX console authentication credentials.

iii. Click Configuration Manager > View Service. Select updateFoldingRules and
click Invoke.

k. Restart the ConfigurationManager server.
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Chapter 3: Create a URL for a Direct Link
This chapter includes:

Generate a Direct Link – Overview 103

How to Generate a Direct Link – Scenario 104

How to Create a Direct Link to a Template with Parameter Values 104

How to Encrypt the Password of a Direct Link Using the JMX Console 105

Generate a Direct Link User Interface 105

Generate a Direct Link – Overview
Direct Links enables you to create a URL that guides another user to a specific target view or CI in
HP Universal CMDB.

You can create a URL that:

l Opens a specific HP Universal CMDB view or CI directly in HP Universal CMDB. This enables
users to retrieve information from HP Universal CMDB without being located in the HP
Universal CMDB context.

Note: To open a specific view or CI directly in HP Universal CMDB, use theOpen in
context links option. For details, see "Select Command Page" on page 107.

l Enables integration with HP Universal CMDB:

n If you create a URL using the Embedded links option, the URL takes you first to the HP
Universal CMDB login page. After you enter your login name and password, the target page
opens in your browser.

Note: To open the target page in your browser, use theEmbedded links option. For
details, see "Select Command Page" on page 107.

When you create a URL, you can:

l Send the URL to an email recipient

l Copy the URL to the clipboard

l Test the URL to ensure that the target application page can be found

The user to whom you are sending the URLmust have an account with sufficient privileges to open
the target page. Youmust apply the appropriate viewing and editing permissions to the users and
user groups that want to access the target view. You set permissions inManagers > Security >
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Roles Manager. For details, see "Roles Manager Page" in theHP Universal CMDB Administration
Guide.

How to Generate a Direct Link – Scenario
This scenario describes how to generate a direct link to email the URL of a specific CI to another
person.

Jane Harrison is a senior engineer in the ABC Software company. She has encountered a
problematic CI in a view she has created. She wants to inform Henry Jones, who is working with
the same view through HP ServiceCenter, about the problematic CI. Since the view Jane has
created contains many hundreds of CIs, she decides to email Henry the URL of the CI so that he
does not have to spend a lot of time searching for that specific CI.

In IT UniverseManager, Jane selects Generate Direct Link from theEditmenu. In the Select
Command page, she selects Open in context links and then theShow view option, and clicks
Next.

In theDirect Link Parameters — Show View page, she selects the view she created, the
problematic CI, andView topology as themode in which Henry should open the CI. When the
URL is created, she emails Henry the link to the problematic CI.

For details, see "Generate Direct Link Wizard" on page 106.

How to Create a Direct Link to a Template with
Parameter Values

This task describes how to create a direct link to a template by including the parameter values in the
URL.

This task includes the following steps:

l "Create a Direct Link to a Template" below

l "Edit the URL" below

l "Paste the URL into a Browser" on the next page

1. Create a Direct Link to a Template
In IT UniverseManager, select Edit > Generate Direct Link to run the Generate Direct Link
wizard. On the Select Command page, select Embedded links. Select Show view topology
from the list of options. On the Direct Link Parameters page, select the required template from
the drop-down list.

2. Edit the URL
When the wizard finishes, click Copy URL and paste the URL into a text editor such as
Notepad.
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Append the following text to the end of the URL:

&params=[parameter1=value1,parameter2=value2]

where parameter1 and parameter2 are the parameter names for the selected template and
value1 and value2 are the values you want to enter for the parameters.

Note: Any special characters must be entered using the URL encoding. In the above
example, the URL encoding for the [ character is %5B, the URL encoding for the ]
character is %5D, and the URL encoding for the comma is %2C. Thus, the actual text to
enter is:

&params=%5Bparameter1=value1%2Cparameter2=value2%5D

3. Paste the URL into a Browser
Paste the URL into a browser. HP Universal CMDB opens to the selected template with the
parameters assigned the specified values.

How to Encrypt the Password of a Direct Link Using
the JMX Console

This task describes how to encrypt the password contained within a direct link using the JMX
console.

To encrypt the password of a direct link using the JMX console:

1. Launch yourWeb browser and enter the following address: http://<server_name>:<port
number>/jmx-console, where <server_name> is the name of themachine on which HP
Universal CMDB is installed.

2. UnderUCMDB-UI, locateUCMDB Integration.

3. Under getEncryptedPasswordForURL, enter your user name and the password to encrypt.

4. Click Invoke to view the encrypted string.

Generate a Direct Link User Interface
This section includes (in alphabetical order):

l "Generate Direct Link Dialog Box" on the next page

l "Generate Direct Link Wizard" on the next page
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Generate Direct Link Dialog Box
This dialog box enables you to create a URL to send to users so that they can access HP Universal
CMDB.

To
access

From the Modeling mainmenu, select Edit > Generate Direct Link. After you
configure the Direct Link parameters in the "Generate Direct Link Wizard" below,
click Finish in the Finish page to open theGenerate Direct Link dialog box.

In IT UniverseManager, click theGenerate Direct Link to View button in the CI
Selector toolbar inBrowse Viewsmode.

In the Reports module, click theGenerate Direct Link button in the toolbar or
select Operations > Generate Direct Link > Direct link to application in the
Modeling mainmenu.

Relevant
tasks

"How to Generate a Direct Link – Scenario" on page 104

See also "Generate a Direct Link – Overview" on page 103

User interface elements are described below:

UI Element
(A-Z) Description

Copy URL Copies the URL to the clipboard.

Description Describes the parameters that are included in the URL. For details on selecting
the parameters, see "Select Command Page" on the next page.

Link URL The created URL that accesses the specified HP Universal CMDB function.

Mail URL Opens an email containing the URL of the link.

Test URL Checks the URL to ensure that the specified application page can be found.

Note: This button is not available when using Linux.

Generate Direct Link Wizard
This wizard enables you to create a URL that guides another user to a specific target view or CI in
HP Universal CMDB.

To access From the Modeling mainmenu, select Edit > Generate Direct Link.
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Important
information

By default, this wizard is set to display aWelcome page. You can choose not to
display theWelcome page by selecting theDo not show this page again check
box.

Relevant
tasks

"How to Generate a Direct Link – Scenario" on page 104

Wizard
map

TheGenerate Direct Link wizard contains:

"Select Command Page" (<Open in context links options> and <Embedded links
options>) > "Finish Page"

See also "Generate a Direct Link – Overview" on page 103

Select Command Page

This wizard page enables you to select the required parameters that must be added to the URL.

You can create two types of links:

l Open in context links. Creates a URL that opens a specific view or CI directly in HP Universal
CMDB without having to be in the HP Universal CMDB context:

l Embedded links. Creates a URL that enables you to embed an HP Universal CMDB applet
into external applications.

Important
information

By default, this wizard is set to display aWelcome page. You can choose not to
display theWelcome page by selecting theDo not show this page again check
box.

Wizard
map

TheGenerate Direct Link wizard contains:

"Select Command Page" (<Open in context links options> and <Embedded
links options>) > "Finish Page"

See also "Generate Direct Link Wizard" on the previous page

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

<Left
pane>

A graphic illustration of the selected command.
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UI Element
(A-Z) Description

CII Grid Creates a URL that displays all the CI instances found in the CMDB for a
selected CI type and its children. For details, see "Direct Link Parameters – CII
Grid Page" on page 112.

Note: Available when you select theEmbedded links option.

CI Selector Creates a URL that embeds the CI Selector displaying the CIs of a selected view,
into external applications. For details, see "Direct Link Parameters – CI Selector
Page" on page 110.

Note: Available when you select theEmbedded links option.

CI Type
Selector

Creates a URL that embeds the CI type selector into external applications. For
details, see "Direct Link Parameters – CI Type Selector Page" on page 110.

Note: Available when you select theEmbedded links option.

Description A description of the selected command.

Impact Map Creates a URL that embeds an impact map into an external application. For
details, see "Direct Link Parameters – Impact Map Page" on page 112.

Note: Available when you select theEmbedded links option.

Model
Editor

Creates a URL that embeds theModel Editor into an external application,
highlighting the selected CIs in the CI Selector in theModel Editor. For details,
see "Direct Link Parameters –Model Editor" on page 113.

Note: Available when you select theEmbedded links option.

Query
Editor

Creates a URL that embeds theModel Editor into an external application,
displaying the selected TQL query. For details, see "Direct Link Parameters –
Query Editor" on page 114.

Note: Available when you select theEmbedded links option.

Related CIs Creates a URL that opens a topology map displaying the selected CI and its
immediate neighbors within the selected view. For details, see "Direct Link
Parameters – Related CIs Page" on page 115.

Note: Available when you select theEmbedded links option.
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UI Element
(A-Z) Description

Report
Viewer

Creates a URL that opens a specific report. For details, see "Direct Link
Parameters – Report Viewer Page" on page 115.

Note: Available when you select theEmbedded links option.

Report
Viewer -
Saved
Report

Creates a URL that opens a saved topology or custom report. For details, see
"Direct Link Parameters – Report Viewer – Saved Report Page" on page 116.

Note: Available when you select theEmbedded links option.

Show CI
properties

Creates a URL that displays a CI's properties. For details, see "Direct Link
Parameters – Show CI Properties Page" on page 116.

Note: Available when you select theEmbedded links option.

Show view Creates a URL that displays the selected view and optionally preselects a query
node in it. For details, see "Direct Link Parameters – Show View Page" on page
118.

Note: Available when you select theOpen in context links option.

Show view
topology

Creates a URL that displays the topology map of the selected view and embeds it
in an external application. For details, see "Direct Link Parameters – Show View
Topology Page" on page 117.

Note: Available when you select theEmbedded links option.

Start in
mode

Creates a URL that opens HP Universal CMDB at the selected page. For details,
see "Direct Link Parameters – Start in Mode Page" on page 120.

Note: Available when you select theOpen in context links option.

Steps The current step in the procedure.

View Editor Creates a URL that opens a specific view in the Pattern View Editor in Modeling
Studio. For details, see "Direct Link Parameters – View Editor Page" on page 118.

Note: Available when you select theEmbedded links option.
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UI Element
(A-Z) Description

Views
Selector

Creates a URL that embeds the View Selector in an external application, enabling
you to select and display a view in that application. For details, see "Direct Link
Parameters – Views Selector Page" on page 118.

Note: Available when you select theEmbedded links option.

Direct Link Parameters – CI Selector Page

This wizard page enables you to create a URL that embeds the CI Selector displaying the CIs of a
selected view, into external applications.

Wizard map "Select Command Page" (Embedded links > CI Selector) > "Finish Page"

Important
information

l For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 106.

l Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 106.

User interface elements are described below:

UI Element (A-
Z) Description

Allow multi
selection

Allow single or multiple selection of CIs.

Selected view Select the required view from which you want to select the required CIs.

l Click to open the View Selector dialog box. Select the view you want
to appear in the CI Selector.

l Click to delete the selected view.

Direct Link Parameters – CI Type Selector Page

This wizard page enables you to create a URL to a hierarchical tree or list of selected CI types,
which can be embedded into an external application.
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Important
information

l For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 106.

l Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > CI Type selector) > "Finish Page"

User interface elements are described below:

UI Element (A-Z) Description

CI type selector
mode

View the selected CI types in either a hierarchical tree or list.

Invisible CITs
(tree only)

Select the CI types you do not want to appear in the tree.

l Click to open the CI Type Selector dialog box. Select the CI types
you want to appear in the tree.

l Click to delete the selected CI types.

Root CI Type (tree
only)

Select the CI type you want to use as the root CI type in a hierarchical tree.

l Click to open the CI Type Selector dialog box. Select the CI type
you want to use as the root CI type in the tree.

l Click to delete the selected CI type. The default is Configuration
Item.

Selection mode Allow single or multiple selection of CI types.

Unselectable CITs
(tree only)

Select the CI types which cannot be selected in the tree.

l Click to open the CI Type Selector dialog box. Select the CI types
which cannot be selected in the tree.

l Click to delete the selected CI types.

Visible CITs (list
only)

Select the CI types which you want to appear in the CI type list.

l Click to open the CI Type Selector dialog box. Select the CI types
which you want to appear in the CI type list.

l Click to delete the selected CI types.

Note: If you choose to view the CITs in a list, then you are required to
select at least one CI type.
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Direct Link Parameters – CII Grid Page

This wizard page enables you to display all of the CI instances found in the CMDB for the selected
CI type and for its children.

Important
information

l For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 106.

l Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > CII Grid) > "Finish Page"

See also "CI Instances Dialog Box" on page 64

User interface elements are described below:

UI Element (A-Z) Description

Class type Select the required CI type.

l Click to select the required CI type.

l Click to clear the box.

Direct Link Parameters – Impact Map Page

This wizard page enables you to run an Impact Analysis rule defined in Impact Analysis Manager.
The URL you create enables you to embed a topology map showing a simulation of all the CIs that
are affected by the selected trigger CI for the selected severity and state. For details, see "Run
Impact Analysis Dialog Box" on page 235.

Important
information

l For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 106.

l Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Impact map) > "Finish Page"

See also "IT UniverseManager" on page 180

User interface elements are described below:
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UI
Element
(A-Z) Description

Filter by
CI types

Select the CI types you do not want to appear in the impact analysis results.

l Click to select the required CI types.

l Click to delete the selected CI types.

Rule
bundle

Enables you to define where you can run Impact Analysis rules.

Severity Select the required severity from the drop-down list.

Note: The severity list was defined for the state in the System TypeManager.
For details, see "System TypeManager" on page 451.

For example, you can create an Impact rule in the Impact Analysis Manager (see the
"Impact Rules Definition Dialog Box" on page 442, that defines the severity of the
trigger query node as other thanNo Change. If you select a severity other thanNo
Change, for example, Plan, the condition is met and the simulated changes in the
system are triggered.

For details, see "Run Impact Analysis Dialog Box" on page 235.

Trigger
CIs

l Click to select the CIs that are used as the triggers in an impact map. These
CIs represent the simulated changes to bemade to the system. Opens the CI
Selector dialog box. For details on how to use the CI Selector pane, see "CI
Selector" on page 133.

l Click to delete the selected CIs.

Direct Link Parameters – Model Editor

This wizard page enables you to embed theModel Editor into an external application, highlighting
the selected CIs in the CI Selector in theModel Editor.

Important
information

l For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 106.

l Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Model Editor) > "Finish Page"

See also "Business CI Models" on page 247

User interface elements are described below:
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UI Element (A-
Z) Description

Model name Select themodel you want to display in theModel Editor.

l Click to open the Select Model dialog box. Select themodel you want
to appear in theModel Editor.

l Click to delete the selectedmodel.

Selected CI in
search

Select the CIs you want to appear highlighted in the CI Selector in theModel
Editor.

l Click to open the CI Selector.

l Click to delete the selected CIs.

Direct Link Parameters – Query Editor

This wizard page enables you to embed theModel Editor into an external application, displaying the
selected TQL query.

Important
information

l For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 106.

l Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Query Editor) > "Finish Page"

See also "Business CI Models" on page 247

User interface elements are described below:

UI Element (A-
Z) Description

Query name Select themodel you want to display in theModel Editor.

l Click to open the Select Query dialog box. Select the query you want
to appear in theModel Editor.

l Click to delete the selected query.
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Direct Link Parameters – Related CIs Page

This wizard page enables you to embed a topology map into an external application. Themap
displays a specific CI, and all the CIs that are linked to it by a distance of nomore than one
relationship.

Important
information

l For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 106.

l Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Related CIs) > "Finish Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

CIs Select the CI type you want to appear in the topology map.

l Click to select the required CI types. Opens the CI Selector dialog
box.

l Click to delete the value in theCIs box.

Filter by CI
types

Restrict the results of the topology map to related CIs of one or more CI
types.

l Click to select the required CI types.

l Click to delete the value in the Filter by CI types box.

Restrict to view Restrict the results of the topology map to related CIs from a specific view.

l Click to select the required view. Opens the View Selector dialog
box.

l Click to delete the selected view in theRestrict results to view box.

Direct Link Parameters – Report Viewer Page

This wizard page enables you to create a URL that opens a specific report.
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Important
information

l For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 106.

l Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Report Viewer) > "Finish Page"

User interface elements are described below:

UI Element
(A-Z) Description

Report type Select the required report type. For information about the different report types,
see "Reports" on page 334.

Direct Link Parameters – Report Viewer – Saved Report Page

This wizard page enables you to create a URL that opens a saved topology or custom report.

Important
information

l For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 106.

l Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Report Viewer - Saved Report) >
"Finish Page"

User interface elements are described below:

UI Element (A-Z) Description

Report Select the required saved report.

l Click to open the Select Report dialog box. Select the required
topology or custom report.

l Click to delete the selected report.

For information about saved reports, see "Reports" on page 334.

Direct Link Parameters – Show CI Properties Page

This wizard page enables you to view basic information for an existing CI.
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Important
information

l For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 106.

l Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Show CI properties) > "Finish
Page"

See also "Configuration Item Properties Dialog Box" on page 207

User interface elements are described below:

UI Element (A-Z) Description

Source CI object ID Select the required CI.

l Click to select the source CI and retrieve its object ID. Opens
the Select Source CI dialog box. For details, see "CI Selector" on
page 133.

l Click to delete the value in theSource CI object ID box.

Direct Link Parameters – Show View Topology Page

This wizard page enables you to display the topology map of the selected view and embed it in an
external application.

Important
information

l For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 106.

l Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Show view topology) > "Finish
Page"

User interface elements are described below:

UI Element (A-Z) Description

Show topology of
view

l Click to select the required view to be opened by the URL.
Opens the View Selector dialog box.

l Click to delete the selected view in the Show topology of view
box.
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Direct Link Parameters – View Editor Page

This wizard page enables you to create a URL that opens a specific view in the Pattern View Editor
in Modeling Studio.

Important
information

l For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 106.

l Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > View Editor) > "Finish Page"

See also "Building a Business View" on page 242

User interface elements are described below:

UI Element (A-Z) Description

View name
l Click to select the required view to be opened by the URL.

Opens the View Selector dialog box.

l Click to delete the selected view in the View name box.

Direct Link Parameters – Views Selector Page

This wizard page enables you to embed into an external application, the View Selector, that enables
you to select, and display a view in that application.

Important
information

l For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 106.

l Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Views Selector) > "Finish Page"

See also "Building a Business View" on page 242

Direct Link Parameters – Show View Page

This wizard page enables you to create a URL to a specific view and optionally select a specific
query node in that view. When the view opens, the CI you chose is selected in the view. The view
opens in IT UniverseManager.
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Important
information

l For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 106.

l Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Open in context links > Show view) > "Finish Page"

User interface elements are described below:

UI Element
(A-Z) Description

<Left pane> A graphic illustration of the selected option.

Advanced
pane
(visibility)

Hide or display the Advanced pane in IT UniverseManager.

Select CI
from view
result

(Optional) Click to select a CI and retrieve its object ID. When the view opens,
the CI you chose is selected in the view.

l Click to choose the CI you want selected in the target view and retrieve its
object ID. Opens the Select CI dialog box. For details, see "CI Selector" on
page 133.

l Click to delete the object ID for the selected CI in theSelect CI from
view result box.

Selected
View

The target view to be opened by the URL.

l Click to select the target view to be opened by the URL. Opens the Select
View dialog box.

l Click to delete the selected view in theSelected view box.

View mode The view options are:

l View Topology. Displays an entire layer within a view.

l Related in View. Displays the selected CI and its immediate neighbors within
the current view.

l Related in CMDB. Displays the selected CI and its immediate neighbors in
the CMDB.
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Direct Link Parameters – Start in Mode Page

This wizard page enables you to start the UCMDB application at the selected page, for example, in
theModeling Studio page.

Important
information

l For general information about the Generate Direct Link wizard, see
"Generate Direct Link Wizard" on page 106.

l Click Finish to close the wizard and create a URL. For details, see
"Generate Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Open in context links > Start in mode page) >
"Finish Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

<Left pane> A graphic illustration of the selectedmode.

Initial mode Starts the UCMDB application in the selectedmode.

Finish Page

This is the final page of the Generate Direct Link wizard. Click Finish to close the wizard and
create a URL. Opens theGenerate Direct Link dialog box.

Important
information

For general information about the Generate Direct Link wizard, see "Generate
Direct Link Wizard" on page 106.

Wizard map "Select Command Page" (<Open in context links options> and <Embedded
links options>) > "Finish Page"
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Chapter 4: Embedding UCMDB Applets Using
Direct Links

This chapter includes:

Using the Direct Link Functionality to Embed UCMDB Applets 121

UCMDB Applet Tag –Overview 121

Direct Link Operation Flow 123

Note: This chapter is relevant to integration developers only.

Using the Direct Link Functionality to Embed UCMDB
Applets

You can directly embed UCMDB applets into external applications using a direct link. A direct link
is a URL that you create using the Direct Links wizard. For details, see "Generate Direct Link
Wizard" on page 106.

You can embed UCMDB applets in the following ways:

l Using the URL itself to display CMDB content in an external application. For example, you can
create a URL in the Direct Links wizard to display the properties of a certain CI. The login page
opens if you are not already logged into HP Universal CMDB.

Note: Using the URL to enable the integration requires opening the link in an IFrame or a
new window. This does not allow you tomanage the resulting UCMDB applet using
Javascript due to cross-site scripting issues. For example, if you use a URL that displays
the properties of a specific CI using the object ID, you cannot use the sameURL to display
the properties of another CI.

l Using the UCMDB applet tag to embed the UCMDB applet in an external application. This
enables integration developers to display a part of the HP Universal CMDB user interface as
part of their own application. In addition, this enables interaction with the embedded HP
Universal CMDB user interface using Javascript.

UCMDB Applet Tag – Overview
The UCMDB Applet tag creates the environment needed for the UCMDB applet to run (HTML,
Javascript, and server session parameters). The code behind the tag can log into the HP Universal
CMDB server in one of the following cases:
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l The login parameters are specified and the user is not already logged in.

l The clear session parameter is true.

Once a user session is established, the tag continues to write the required applet environment
(HTML and Javascript code) to the result of the JSP processor. The resulting HTML page includes
the required Javascript code to load the UCMDB applet from the specified server. On error, the
specified error string is printed to the page. This string can be customized using the
userErrorMessage parameter andmay include HTML elements and HTMLwrapped Javascript
code to initiate error handling scenarios.

Example of the Usage of a UCMDB Applet Tag

<ucmdb:ucmdb_applet
serverConnectionString="http://server_name.server_domain:server_port"
serverType="UCMDB"
directLinkParameters="initViewName=NetworkTopology"
userName="user-name"
userPassword="password"
customerId="1"
encoded="false"
printDebugLogs="true"
userErrorMessage="This is your general error"
navigation="false"
clearSessionCookies="false"
command="ShowCISelector"/>

Caution: You retrieve the directLinkParameters from the URL created in the Direct
Links wizard. Insert the values for each parameter in the tag as displayed. If the URL
contains values for parameters not displayed above, copy them into the
directLinkParameters line of the tag. For details on how to create a direct link, see
"Generate Direct Link Wizard" on page 106.

The UCMDB applet tag is located at <HP Universal CMDB root folder>\deploy\ucmdb-
ui\WEB-INF\tags\ucmdb_applet.tag.

You can copy the UCMDB applet tag to an external application server. The UCMDB applet tag
requests the login data from the HP Universal CMDB server provided that:

l The external application server can communicate with JSP tags.

l The HP Universal CMDB server is accessible to the external application server and to the
browser.
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Direct Link Operation Flow
This section describes different scenarios in which direct links are used to embed UCMDB applets
into external machines.

This section includes the flow descriptions:

l "Regular Login" below

l "An Embedded UCMDB Applet Using a Direct Link URL" on the next page

l "An Embedded UCMDB Applet Using a UCMDB Applet Tag" on page 125

Regular Login
This flow describes a regular login to the HP Universal CMDB server. It serves as a base reference
for the direct link flows.
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1. The user enters the direct link URL (into the browser) to log into the HP Universal CMDB
server.

2. The browser sends the login request to the HP Universal CMDB server.

3. The server checks the user credentials and creates a user session if required.

4. The server returns the requested first page of HP Universal CMDB.

5. The browser loads the Java virtual machine (JVM) with the code base location parameter
(which instructs the JVM from where to load the UCMDB applet files) as the HP Universal
CMDB server.

6. UCMDB applet files (jars) and data are transferred between the HP Universal CMDB server
and the JVM loaded in the browser.

At this point, the UCMDB applet is loaded and regards HP Universal CMDB as the server with
which it should communicate.

An Embedded UCMDB Applet Using a Direct Link URL
This flow shows how to use the direct link to open a UCMDB applet (opened to a specified context)
in a new browser frame.
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1. The external application has a page that needs to show the UCMDB applet.

2. The returned page includes a directive to open the direct link in an IFrame or new browser
window.

3. The browser opens a new frame (IFrame or new window) with the direct link as the frameURL.

4. The new frame sends the direct link to the HP Universal CMDB server.

5. If the user is not already logged into HP Universal CMDB, HP Universal CMDB displays the
login page and waits for the user to enter credentials and click the login button.

6. The user session is created, if required.

7. The HP Universal CMDB server returns a page that includes the directive to load the UCMDB
applet.

8. The browser processes the page. When the browser encounters the directive to load the
UCMDB applet, it starts the JVM. The browser then passes the needed parameters to the
JVM, including the HP Universal CMDB server location as "code base."

9. UCMDB applet files (jars) and data are transferred between the HP Universal CMDB server
and the JVM loaded in the browser.

Caution: The HP Universal CMDB server must be accessible from the browser machine.

An Embedded UCMDB Applet Using a UCMDB Applet Tag
This flow shows how to use the UCMDB applet tag in conjunction with direct links to embed the
UCMDB applet (opened to a specified context) in an external application page.
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1. The UCMDB applet tag is included in the processed JSP in the external application.

2. The UCMDB applet tag uses the parameters given to it to create an HTTP/HTTPS connection
to the HP Universal CMDB server and requests the applet HTML snippet code.

3. If the user is not already logged in, the parameters from the UCMDB applet tag are used (see
the tag itself for reference information regarding this step). If login fails, the UCMDB applet tag
returns an error message, either the preset one or the one specified in the UCMDB applet tag
parameters.

4. The HP Universal CMDB server returns the HTML snippet code (with embedded Javascript)
that loads the UCMDB applet. The external application can now incorporate this snippet code
into the page, and send the page to the browser.

5. The external application sends the complete page that includes the HTML snippet code to the
browser.

6. The browser processes the page. When the browser encounters the HTML snippet code that
loads the UCMDB applet, the JVM is started. The browser then passes the needed parameters
to the JVM, including the HP Universal CMDB server location as "code base".

7. UCMDB applet files (jars) and data are transferred between the HP Universal CMDB server
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and the JVM loaded in the browser.

Caution: The HP Universal CMDB server must be accessible from both the browser
machine as well as the external applicationmachine.
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Chapter 5: Working with the CI Selector
This chapter includes:

CI Selector Overview 128

How to Display a View in BrowseMode 128

How to Search for CIs in SearchMode 129

How toModify CI Selector Display Options 130

CI Selector User Interface 131

Troubleshooting and Limitations 144

CI Selector Overview

Note: The CI Selector was known as View Explorer in earlier versions of HP Universal CMDB.

The CI Selector presents the elements of the IT universemodel in HP Universal CMDB through the
medium of views. HP Universal CMDB displays the CI Selector in the left pane of IT Universe
Manager and theModeling Studio.

When you select a view in the CI Selector, the configuration items (CIs) contained in the view are
displayed in a hierarchical tree format according to the relationships defined between the CIs. A
view may be empty if no CIs were foundmatching the TQL query. For details on views, see "View
Formats" on page 242.

You can use the CI Selector to select views and to locate CIs. You can select a view and browse
through the list of CIs, or you can search for a specific CI by name or by CI type. You can also save
the search criteria for future use.

For information on the components of the CI Selector, see "CI Selector User Interface" on page
131.

How to Display a View in Browse Mode
When the CI Selector is set toBrowse mode, you can display the contents of a selected view. For
details on the CI Selector user interface in Browsemode, see "CI Selector" on page 133.

This task includes the following steps:

l "Prerequisites" below

l "Select a View to Display" on the next page

1. Prerequisites
In the CI Selector pane, select Browse Views mode.
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2. Select a View to Display

Click the ellipsis button to open the View Selector dialog box and select the view you want
to display. The name of the selected view is shown in theView box. The CIs in the view
appear in the CI tree in the lower part of the CI Selector pane. The view remains selected when
youmove to other applications in HP Universal CMDB.

How to Search for CIs in Search Mode
The CI Selector search tool enables you to locate a specific CI. The search is executed on the
entire CMDB. For details on the CI Selector search tool user interface, see "CI Selector" on page
133.

This task includes the following steps:

l "Prerequisites" below

l "Search by CI Name or Global ID" below

l "Search by Configuration Item Type" below

l "Run the Search and Sort the Results" on the next page

l "Run an Advanced Search" on the next page

Prerequisites
In the CI Selector pane, select Search CIsmode and select theSimple tab.

Search by CI Name or Global ID
To search for CIs by name, enter a string in theCI Name box, representing the name of the CI, or
part of the name. The search returns all CIs that contain the entered string somewhere in their
names (within the boundaries of the other search criteria that you define).

Alternatively, enter the global ID of a CI in the CI Name box. You need to enter the full global ID.

Note: The search by CI name option is not case sensitive.

Search by Configuration Item Type
You can search for CIs using theCI Type box. This search returns CIs of the type specified in the
CI Type box.

Click the ellipsis button and select the required CI type. You cannot manually enter a CIT in the
CI Type box.

After defining a CI in theCI Type box, HP Universal CMDB remembers your selection until you
move to a different application, or until you define a different value.
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Run the Search and Sort the Results
Run the search. The results appear in the lower part of the CI Selector pane, showing the CI name
and type for each entry. You can sort the search results by clicking the appropriate heading.

When you select a CI in the search results, the CI appears in the topology mapwith its related CIs
in the CMDB.

Optionally, save the search criteria by clicking theSave button and entering a name for the
search. For details, see "Save Search Criteria Dialog Box" on page 144.

Run an Advanced Search
You can select the Advanced tab for other search options. For details on the CI Conditional
search, see "CI Conditional Search Dialog Box" on the next page. For details on the Running
Software search, see "Running Software Search Dialog Box" on page 143.

How to Modify CI Selector Display Options
You canmodify the display options for the CI Selector. These options are configured in the
Infrastructure Settings Manager.

Caution: Modifying certain settings in the Infrastructure Settings Manager can adversely
affect the performance of HP Universal CMDB. Do not modify settings without first consulting
HP Software Support or your HP Professional Services representative.

This task includes the following steps:

l "Prerequisites" below

l "Modify Selected Settings" below

1. Prerequisites
Access the Infrastructure Settings Manager by selectingManagers > Administration >
Infrastructure Settings Manager.

2. Modify Selected Settings
The following settings can bemodified:

n Immediate Children Count. Number of children immediately displayed when expanding
their parent's query node in the CI Selector.

n Maximal Children Count.Maximum number of children displayed under their parent's
query node in the CI Selector.

n Maximal search results size.Maximum number of CMDB instances that can be returned
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in one search operation.

n Recently Used Views List size.Maximal number of recently used views to store per user.

CI Selector User Interface
This section includes (in alphabetical order):

CI Conditional Search Dialog Box 131

CI Selector 133

Organize Searches Dialog Box 143

Running Software Search Dialog Box 143

Save Search Criteria Dialog Box 144

CI Conditional Search Dialog Box
This dialog box enables you to search for CIs by attribute conditions, by related CIs, and by
attribute conditions of related CIs.

To
access

In the CI Selector, select theAdvanced tab in Searchmode and click the ellipsis
button next to CI Conditional Search.

See
also

"CI Selector Overview" on page 128

User interface elements are described below:

UI Element
(A-Z) Description

Attribute
name

Select an attribute from the drop-down list.

Note: If you select Display Label from theAttribute name list, the
operator Like ignore case does not appear in theOperator list since a
Display Label Like ignore case condition can be added using the CI
name/Related CI Name.

CI Name Enter a CI name for which to search.

CI Type Click the ellipsis button to select a CI type from the tree.
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UI Element
(A-Z) Description

Integration
Points

If you want to run your search over federated CIs also, click the ellipsis
button to select the target integration points for the CIs.

Note: If you select a disconnected integration point for your search, an error
message appears when the search is run, asking if you want to see local
search results.

Operator Select an operator from the drop-down list.

Related CI
Name

Enter the name of a related CI for the search.

Related CI
Type

Click the ellipsis button to select a CI type from the tree for a search by
related CI.

Relationship
Type

Click the ellipsis button to select a relationship from the tree for a search by
related CI.

Search by
CI
conditions

Select the check box to run a search for CIs with the specified conditions.

Each row represents an attribute condition that you specify. Use the And/Or
column and the Brackets columns to link multiple conditions. Select NOT if you
want the condition statement to do the opposite of what is defined. In this way,
you can construct amore precise logical statement to generate the required
results.

Add attribute condition. Adds an attribute condition row. Select the
attribute name, operator, and value to define the attribute condition.

Delete selected row. Deletes the selected attribute condition.

Move selected row up.Moves the selected row up.

Move selected row down.Moves the selected row down.

. Show Criteria. Displays the criteria of the selected condition in a pop-up
dialog box.

Search by
related CI
conditions

Select to run a search for CIs related to CIs with the specified conditions.

Note: If you select Display Label from theAttribute name list, the
operator Like ignore case does not appear in theOperator list since a
Display Label Like ignore case condition can be added using the CI
name/Related CI Name.
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UI Element
(A-Z) Description

Search by
related CI
criteria

Select to run a search for CIs related to the specified CIs or CI types.

Value Enter a value for the attribute condition.

CI Selector
This feature enables you to select views and to locate CIs.

To access Appears in the left pane of the IT UniverseManager page and theModeling
Studio.

Important
information

The CI Selector consists of two functional formats: Browse Views mode and
Search CIs mode.

l In Browse Views mode, you can search for and display a view, and browse
through the view to locate a particular CI. You can also perform operations on
the CI from a shortcut menu.

l In Search CIs mode you can search for one or more CIs in the CMDB by name
or by CI type.

Relevant
tasks

"How to Display a View in BrowseMode" on page 128

"How to Search for CIs in SearchMode" on page 129

See also "CI Selector Overview" on page 128

Browse Views Mode
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

Refresh CIs Tree. Refreshes the data content of the hierarchical
tree structure that may have beenmodified by other users.

Show Template Parameters. Opens the Template Parameter
Values dialog box, which enables you to edit the parameters of
the selected template.

Note: This button is only active when a template is
selected.
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UI Element (A-Z) Description

Add selected CIs to model/view. Adds the selected CIs to the
current model or view.

Note: This button only appears in theModeling Studio.

Add to model as related CIs. Adds the selected CI to the
model as a related CI.

Note: This button is only active in theModel Editor of the
Modeling Studio.

Open selected model in a new tab. Opens the selectedmodel
in theModel Editor.

Note: This button is only active when amodel is selected in
theModeling Studio.

Show models containing selected CI. Displays a list of
models containing the selected CI.

Note: This button only appears in theModeling Studio.

In IT UniverseManager, this represents Show View Definition,
which takes you directly to the view definition in theModeling
Studio for the current view.

In theModeling Studio, this represents Open selected view,
which opens the selected view in the Editor pane.

Show views containing selected CI/model. Displays a list of
views containing the selected CI or model.

Note: This button only appears in theModeling Studio.

Generate view for selected model. Opens the Creating New
View dialog box which enables you to build a view based on the
selectedmodel.

Note: This button is only active when amodel is selected in
theModeling Studio.
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UI Element (A-Z) Description

Show Discovery and Changes Summary. Enables you to
rediscover all the CIs in a selected view by manually starting the
DFM jobs that originally discovered them. For details, see "Show
Discovery Status and Changes Dialog Box" on page 238.

Note: This button only appears in IT UniverseManager.

Generate Direct Link to View. Enables you to create a direct
link to the view using the Direct Links wizard.

Note: This button only appears in IT UniverseManager.
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UI Element (A-Z) Description

Export Browse Results to File. Enables you to export the
browse results. Choose the export format from the following
options:

l Excel. The table data is formatted as an .xls (Excel) file that
can be displayed in a spreadsheet.

l PDF. The table data is exported in PDF format.

Note:When exporting CIs to PDF format, themaximum
number of CIs that can be exported is approximately
20,000, depending on the amount of text associated with
the exported CIs. It is also important to select a
reasonable number of columns to display to ensure that
the report is legible.

l RTF. The table data is exported in Rich Text Format.

l CSV. The table data is formatted as a comma-separated
values (CSV) text file that can be displayed in a spreadsheet.

Note: For the CSV formatted table data to display
correctly, the comma (,) must be defined as the list
separator. InWindows, to verify or modify the list
separator value, open Regional Options from the Control
Panel, and on the Numbers tab ensure that the comma is
defined as the List Separator value. In Linux, you can
specify the list separator in the application that opens
the CSV file

l XML. The table data is formatted as an XML file which can be
opened in a text or XML editor.

Tip: To extract HTML code from the report:

l Open the file in an HTML editor

l Copy the relevant table into the target file
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UI Element (A-Z) Description

Snapshots. Enables you to work with snapshots. The following
options are available:

l Save Snapshot. Select to open the Save Snapshot dialog
box, which enables you to save a snapshot of the view. For
details, see "Save Snapshot Dialog Box" on page 237.

l Compare Snapshots. Select to run the Compare Snapshots
Report. For details, see "Compare Snapshots Report" on
page 366.

l Schedule Snapshot. Select to open the Schedule Job dialog
box. For details, see "Schedule Report/Snapshot Dialog Box"
on page 409.

l Show Scheduled Snapshot Jobs. Select to open the Job
List dialog box. For details, see "Job List Dialog Box" on page
386.

Note: This button only appears in IT UniverseManager.

View Based Report. Displays the topology report for the
selected view.

Note: This button only appears in IT UniverseManager.

Asset Report. Opens the Asset report for the selected view. For
details, see "Asset Report" on page 346.

Note: This button only appears in IT UniverseManager.

Click the ellipsis button to the right of the View box, to open the
View Selector dialog box. You can browse through the folder tree
to locate the view you want to display.

Enables you tomove to the next or previous result of the search
for the string entered in the Find box.

<CIs> The CIs contained in the currently selected view.

<Tooltip> Hold the cursor over a CI to display a tooltip with the relevant CI
type.

Find Enter a CI name or a portion of a CI name in the Find box to
locate a CI in the CI tree.
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UI Element (A-Z) Description

View TheView box displays the currently selected view. To select a
view to display, click the down arrow on the right side of the View
box; this displays an abridged list of views, containing themost
recently accessed views. Click the arrow at the bottom of the list
to scroll through the entire list. The recently accessed views
appear at the top of the drop-down, above the dividing line. The
complete list of views appears below the line.

Alternatively, place the cursor in the list and begin typing the
view name. If the first few letters that you typematch an existing
entry, HP Universal CMDB completes the view name. If the
names of several views begin with those letters, all matching
views are displayed in the list.

Note: If the selected view in the View box fails to load, the
value in the View box is set to the default (empty) selection.

Search CIs Mode
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

Show Search Results in Table. Opens a separate pane with a
table of the CIs in the search results.

Note: This button only appears in IT UniverseManager.

Add selected CIs to model/view. Adds the selected CIs to
the current model or view.

Note: This button only appears in theModeling Studio.

Add to model as related CIs. Adds the selected CI to the
model as a related CI.

Note: This button is only active in theModel Editor of the
Modeling Studio.
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UI Element (A-Z) Description

Open selected model in a new tab. Opens the selected
model in theModel Editor.

Note: This button is only active when amodel is selected
in theModeling Studio.

Show models containing selected CI. Displays a list of the
models containing the selected CI.

Note: This button only appears in theModeling Studio.

Show views containing selected CI/model. Displays a list of
the views containing the selected CI or model.

Note: This button only appears in theModeling Studio.

Generate view for selected model. Opens the Creating New
View dialog box which enables you to build a view based on the
selectedmodel.

Note: This button is only active when amodel is selected
in theModeling Studio.
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UI Element (A-Z) Description

Export Search Results to File. Enables you to export the
search results. Choose the export format from the following
options:

l Excel. The table data is formatted as an .xls (Excel) file that
can be displayed in a spreadsheet.

l PDF. The table data is exported in PDF format.

Note:When exporting CIs to PDF format, themaximum
number of CIs that can be exported is approximately
20,000, depending on the amount of text associated
with the exported CIs. It is also important to select a
reasonable number of columns to display to ensure that
the report is legible.

l RTF. The table data is exported in Rich Text Format.

l CSV. The table data is formatted as a comma-separated
values (CSV) text file that can be displayed in a
spreadsheet.

Note: For the CSV formatted table data to display
correctly, the comma (,) must be defined as the list
separator. InWindows, to verify or modify the list
separator value, open Regional Options from the Control
Panel, and on the Numbers tab ensure that the comma
is defined as the List Separator value. In Linux, you can
specify the list separator in the application that opens
the CSV file.

l XML. The table data is formatted as an XML file that can be
opened in a text or XML editor.

Tip: To extract HTML code from the report:

n Open the file in an HTML editor

n Copy the relevant table into the target file

Manage the list of saved searches. Opens theOrganize
Searches dialog box, where you can edit or delete searches
from the list of saved searches.
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UI Element (A-Z) Description

Collapse/Expand Search Criteria Panel. Collapses or
expands the search criteria area.

Start the Search. Runs the search. The search results are
displayed in the lower part of the CI Selector pane.

Save the Last Search Pattern. Saves the current search
criteria for future use.

Enables you tomove to the next or previous result of the search
for the string entered in the Find field.

<Search results> After you run the search, the results are listed in the lower part
of the CI Selector pane. The results are shown in two columns:

l Name. Contains the name of the CI.

l CI Type. Contains the CI type of the CI.

If the CI or view name is abbreviated, hold the pointer over the
entry to see the full name. You can sort the search results by
clicking the appropriate heading.

Advanced tab The following detailed search options are available:

l CI Conditional Search. Enables you to search for CIs by
attribute conditions, by related CIs, and by attribute
conditions of related CIs.

l Running Software Search. Enables you to search for hosts
by the applications running on them and for applications by
the host on which they are running.

For each of the searches, click the ellipsis button to open

the search dialog box. After running a search, click Save to
save the search for future use.

CI Name To search for a CI by name, enter the name or global ID of the
CI for which to search.

CI Type To search for CIs by CI type, click the ellipsis button to select a
CI from the Select Configuration Item Type dialog box.

Find Enter a CI name or a portion of a CI name in the Find box to
locate a CI in the search results.

Searches Select a search from the drop-down list of saved searches.
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UI Element (A-Z) Description

Search results count The Search results count below the Find box displays the total
number of CIs found in the search.

Simple tab The Simple tab includes the standard search functionality. Click
the Advanced tab for more detailed search options.

Shortcut Menu Options

Menu Item Description

<IT Universe
Manager shortcut
menu options>

The regular shortcut menu for the topology map in IT UniverseManager is
also available from the CI Selector. For details on themenu options, see
"IT UniverseManager Page" on page 217.

Add Adds the selected CI to the current model or view.

Note: This feature only appears in theModeling Studio.

Add to model as
related CIs

Adds the selected CI as a related CI to the current model.

Note: This feature only appears in theModeling Studio.

Generate view for
selected model

Select to create a view based on the current model. The Creating New
View dialog box opens which enables you to select a perspective to apply.

Note: This feature only appears in theModeling Studio.

Open selected
model in a new
tab

Opens the selectedmodel in a new tab in theModel Editor.

Note: This feature only appears in theModeling Studio.

Show containing
models

Select Show models containing selected CI to display a list of the
models containing the selected CI.

Note: This option only appears in theModeling Studio.

Show containing
views

Select Show views containing selected CI/model to display a list of the
views containing the selected CI or model.

Note: This option only appears in theModeling Studio.
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Organize Searches Dialog Box
This dialog box enables you to edit or delete searches from the list of saved searches.

To access Click theManage the list of saved searches button in the CI Selector.

See also "CI Selector Overview" on page 128

User interface elements are described below:

UI
Element
(A-Z) Description

Click to edit the selected search. For simple searches, the CI Simple Search dialog
box opens, which enables you to edit the name and type of the CI. For CI
Conditional searches, the CI Conditional Search dialog box opens.

Click to delete the selected search.

Click to expand the search tree.

Click to collapse the search tree.

<Searches
tree>

Displays all the saved searches in tree format.

Find Enter a search name or a portion of a search name in the Find box to locate it in the
list.

Find Next Click to go to the next occurrence of the selected search phrase in the list.

Find
Previous

Click to go to the previous occurrence of the selected search phrase in the list.

Running Software Search Dialog Box
This dialog box enables you to search for hosts by the applications running on them and to search
for applications by the host on which they are running.

To
access

In the CI Selector, select theAdvanced tab in Searchmode and click the ellipsis
button next to Running Software Search.

See
also

"CI Selector Overview" on page 128

User interface elements are described below:
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UI
Element
(A-Z) Description

Host
name

Enter the name of the node for which you are searching.

Running
Software

Select a running software CI from the drop-down list.

Note: The drop-down list may not display an accurate list of available running
software CI types (only the optionAny appears). In this event, perform the Host
name search only.

Search
for

Select Running Software orNode.

Note: To search for a running software CI running on a specific node, enter a
node name, select the required running software CI and click Search to search
for it.

Save Search Criteria Dialog Box
This dialog box enables you to save the current search criteria for future use.

To access Click Save from Searchmode in the CI Selector.

See also "CI Selector Overview" on page 128

User interface elements are described below:

UI Element (A-
Z) Description

Existing
Queries

Displays a list of existing searches in tree format.

Name Enter a name for the current search.

Find Enter a search name or a portion of a search name in the Find box to locate it
in the list.

Find Next Click to go to the next occurrence of the selected search phrase in the list.

Find Previous Click to go to the previous occurrence of the selected search phrase in the list.

Troubleshooting and Limitations
This section describes troubleshooting and limitations for the CI Selector.
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Unavailable Views and CIs
The View list in the CI Selector may not display all views in the CMDB, or it may not display the
contents of a view, for any of the following reasons:

l The View list includes only the views for which you have the necessary permissions. Similarly,
Searchmode is only available if you have theAllow Search general action permission. To set
permissions, selectManagers > Administration > Roles Manager. For more information, see
Roles Manager in theHP Universal CMDB Administration Guide.

l Views that are currently inactive appear in red in the View list, but they cannot be selected. In IT
UniverseManager, inactive views appear in faded text.

l Out-of-the-box views for which you do not have a licensemay appear in the View list, but these
views do not contain CIs. For information on the out-of-the-box views, see "Predefined Folders
and Views" on page 246.

Note: After deleting one or more query nodes from a TQL query, it can take time for changes
to be updated to the view; meanwhile, the removed CIs appear in the view. If you select one
of these CIs before it is updated, an error message is displayed. Click theRefresh button to
update the view.
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Chapter 6: Working with Topology Map
This chapter includes:

Topology MapOverview 146

Handling Large Views 146

Topology MapUser Interface 147

Topology Map Overview
The Topology Map provides a graphical display of a view. All the CIs in a given layer of the view are
represented by icons and the connecting lines represent relationships. You can select a CI in the
Topology Map or in the CI Selector in the left pane. You can also drill down in the CI Selector to
display different layers of the view in the Topology Map.

The label of a CI appears under the icon. You can set themaximum number of characters per line
and themaximum number of lines in a CI label in the User Preferences dialog box underGeneral.
For details, see "User Preferences Dialog Box" on page 92.

A CI that has an additional CI layer beneath it, created by the hierarchy set for the view, appears
with a downward arrow icon in the Topology Map, as well as a count indicator displaying the total
number of CIs in all of the sublayers under it. You can click the arrow to display the CIs contained in
the sublayer.

When you hold the pointer over the CI icon, a tooltip displays the CI's details. When you hold the
pointer of the count indicator, a tooltip displays a breakdown of the CIs beneath that CI by CI type.

The topology map is automatically updated dynamically with changes in the IT Universe data, such
as new CIs discovered by the Data Flow Management process.

The toolbar andMainMenu above the Topology Map enable you to zoom in, change the layout of
the Topology Map, and print the Topology Map. Additional functionality is available from the
shortcut menu by right-clicking a CI in the Topology Map or in the CI Selector.

Handling Large Views
The Topology Map cannot display a view with more than 900 CIs in a single layer. When you select
a view which contains a layer with more than this number of CIs, the Topology Map appears empty.
A layer with more than 900 CIs can be displayed in a table in Text mode.

To display large views in the Topology Map, use one of the followingmethods:

l Reduce the TQL query results by redefining the view in theModeling Studio. For details, see
"ChangeQuery Node/Relationship Type Dialog Box" on page 270.
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l Define a different hierarchy for the view to redistribute the CIs among the view's layers. For
details on defining hierarchy, see "Setting the View Hierarchy" on page 243.

l Reset themaximum number of CIs allowed in the configuration parameters. Select theMax
Object Count GUI for TS parameter underVisualization Settings in the Infrastructure
Settings Manager. However, be aware that increasing themaximum number of CIs per layer
may significantly slow down the redrawing of the Topology Map.

For details regarding Infrastructure Settings Manager, see "Infrastructure Settings Manager User
Interface" in theHP Universal CMDB Administration Guide.

Topology Map User Interface
This section includes (in alphabetical order):

Export Map to Image Dialog Box 147

Layout Properties Dialog Box 148

MainMenu 163

Print Dialog Box 164

Print Preview Dialog Box 165

Print Setup Dialog Box 165

Toolbar Options 167

Topology Map Sidebar 176

Export Map to Image Dialog Box
This dialog box enables you to save a topology map to a file.

To access From a topology map, select Operations > Export Map to Image.

Relevant tasks "How to Print and Save a Topology Map to File" on page 201

See also l "Topology MapOverview" on the previous page

l "Topology MapUser Interface" above

User interface elements are described below:

UI Element (A-Z) Description

Actual Size Save the view so that the graph node sizes are at
maximum.
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UI Element (A-Z) Description

Current Zoom Level Save the view as you see it on the topology map. For
example, if you have used the Interactive Zoommode
to decrease the view magnification, the graph nodes
also appear smaller in the saved view. For details, see
"Interactive Zoom" on page 171.

Custom Specify the size of the view you want to save in the
Width andHeight boxes.

File Name Specify the required file name and location (or click
Browse to search for the file and location).

Fit in Canvas Expand or shrink the view so that it fits in the pane.

Image Quality The quality of the printedmap. Select High,Medium,
or Low.

Selected Objects Only Saves only the graph nodes/CIs and their relationships
that you selected in themap.

Type Select the required file format.

Visible Window Only Saves only the part of the graph that appears in the
pane.

Layout Properties Dialog Box
This dialog box enables you to customize the layout of a specific layer in a view, to achieve the
clearest presentation possible and to better understand andmonitor themanaged data.

To access Select Layout > Layout Properties.

Important
information

You define the layout of a view's layers by assigning logical positions for the
graph's nodes and relationships that appear in a layer. You customize the layer
layouts by modifying the default values.

You set layout definitions for a specific layer only. The definitions cannot be saved
for a different layer or a different view.

Parameter values are in pixels.

See also l "Topology MapOverview" on page 146

l "Topology MapUser Interface" on the previous page

Global Tab
This area enables you to define global layout parameters.
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To access Click theGlobal tab in the Layout Properties dialog box.

Important information TheGlobal tab enables you to define global settings for the layout.

User interface elements are described below:

UI
Element
(A-Z) Description

Drawing
Fitting

Select one of the following options for fitting the layout:

l Fit to Canvas. Fit the layout to the canvas on the screen.

l Fit for Printing. Fit the layout to a page for printing.

l No Fitting. Do not change the layout.

Labeling Select Perform Labeling to ensure that the labels appear when the layout is
redrawn. If this field is not selected, labels do not appear in the redrawn layout.

Style Select Apply Style Deeply to apply the layout selected to all nested layers of the
topology map.

All Styles Tab

To access Click theAll Styles tab in the Layout Properties dialog box.
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Important
information

The All Styles tab enables you to define general layout parameters for
disconnected graph nodes and connected components.

l A disconnected graph node is a node that is not connected to any other graph
node.

l A disconnected component is a component that is not connected to any other
component. It contains a set of graph nodes that can be connected to each
other.

This illustrates a connected component with five graph nodes:

This illustrates a connected component with two graph nodes:

This illustrates four disconnected components, eachmade up of a single,
disconnected graph node:

User interface elements are described below:
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UI Element
(A-Z) Description

Components The spacing between the components in a disconnected graph consists of both
a constant value and a proportional value based on the sizes of the
components.

Select Detect Components to view the disconnected components. You can
specify that all components be laid out together or individually, regardless of the
other components. If the grouping for components is selected, each component
is laid out, and the resulting components are packed together.

When Detect Components is selected, enter values for the following settings:

l Constant Spacing. Set constant spacing (horizontal and vertical) around
each disconnected component.
Default value: 20

l Proportional Spacing. Set spacing (horizontal and vertical) that is
proportional to the size of the component around each disconnected
component.
Default value: 0.05

Disconnected
Graph Nodes

The spacing between the graph nodes in a disconnected graph consists of both
a constant value and a proportional value based on the sizes of the graph
nodes.

Select Detect Disconnected Graph Nodes to view the disconnected graph
nodes. You can specify that disconnected graph nodes be grouped into one
component or laid out individually.

When Detect Disconnected Graph Nodes is selected, enter values for the
following settings:

l Constant Spacing. Set constant spacing (horizontal and vertical) around
each disconnected graph node.
Default value: 20

l Proportional Spacing. Set spacing (horizontal and vertical) that is
proportional to the size of the component around each disconnected graph
node.
Default value: 0.05

Margin
Spacing

Enter values for the right, left, top, and bottommargin spacing for the layout.

Circular Tab

To access To access:Click theCircular tab in the Layout Properties dialog box.
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Important
information

The Circular tab enables you to group a graph's nodes into groups or clusters
based on the grouping options you select. It is particularly suited for visualizing
ring and star network topologies, and for link analysis.

User interface elements are described below:

UI
Element
(A-Z) Description

Clustering Set the values for the following settings:

l Cluster Size Factor. Specifies the ratio between the average cluster size and
the number of clusters. The size of a cluster is defined as the sum of the
weights of all graph nodes in the cluster. You can assign a weight value to each
graph node.

l Min Number of Clusters. Theminimum number of clusters in a layer.

l Max Number of Clusters. Themaximum number of clusters in a layer.

Cluster
Layout
Style

Displays clusters either in a symmetric or circular layout style.

Select one of the following options:

l Symmetric. Displays clusters in a symmetric layout style.

l Circular. Displays clusters in a circular layout style.
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UI
Element
(A-Z) Description

Layout
Quality

Adjusts the quality of the layout produced to fit your application's needs. The
quality reflects the number of steps or themethod used to produce the layout. For
example, high quality is sharper but takes more time to set the layout.

Select one of the following options:

l Draft. Produces faster results (faster thanMedium and Proof).

l Medium. Produces a result that is a combination of Draft and Proof, that is, it
produces amore accurate graph layout than Draft, but not as accurate as Proof.

l Proof. Produces amore refined result but takes more time.

Note: The differences between the speed and resulting layout of each quality
setting varies depending on the nature of the graph being laid out. You can try
each option to determine which works best for you.
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UI
Element
(A-Z) Description

Spacing Sets the spacing around each graph node within the same cluster and between
clusters.

Enter values for the following settings:

l Between Graph Nodes. Sets the spacing around each graph node within the
same cluster. The larger the spacing, themore graph nodes there are on the
cluster boundary.

Default value: 50

This illustration shows smaller graph node spacing:

This illustration shows larger graph node spacing:

l Between Clusters. Sets the spacing between clusters.

Default value: 50

This illustration shows smaller cluster spacing:

This illustration shows larger cluster spacing:

Hierarchical Tab

To access Click theHierarchical tab in the Layout Properties dialog box.
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Important
information

The Hierarchical tab shows the precedence relationships that can represent
organizational or informationmanagement system dependencies, as well as
process models, software call graphs, and work flows. The hierarchical layout
emphasizes dependencies by placing the graph nodes at different levels.

User interface elements are described below:

UI Element
(A-Z) Description

Backward
Edges

Specifies how backward relationships are displayed in the hierarchical layout.

Select one of the following options:

l Minimize Backward Edges. Sets the number of backward relationships
displayed in a layer to aminimum.

l Optimize for Feedback Flow. Sets the number of backward relationships
displayed in a layer to amaximum. This mode is more appropriate for flow
charts.

Horizontal
Spacing

Enables you to set theminimum horizontal distance between two neighboring
graph nodes at each level.

Enter values for the following settings:

l Between Graph Nodes. Sets a horizontal space around each graph node in
the layer.
Default value: 28

l Between Edges. This setting is available only when you select Routing >
Orthogonal. It sets a horizontal space between edges in the graph.
Default value: 12
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UI Element
(A-Z) Description

Layout
Quality

Adjusts the quality of the layout produced to fit your application's needs. The
quality reflects the number of steps or themethod used to produce the layout. For
example, high quality is sharper but takes more time to set the layout.

Select one of the following options:

l Draft. Produces faster results (faster thanMedium and Proof).

l Medium. Produces a result that is a combination of Draft and Proof, that is, it
produces amore accurate graph layout than Draft, but not as accurate as
Proof.

l Proof. Produces amore refined result but takes more time.

Note: The differences between the speed and resulting layout of each quality
setting varies depending on the nature of the graph being laid out. You can try
each option to determine which works best for you.
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UI Element
(A-Z) Description

Level
Alignment

Enables you to set the way graph nodes are vertically aligned.

Select one of the following options:

l Top. This illustration shows that the top of the graph nodes at the same level of
the hierarchy are aligned:

l Center. This illustration shows that the center of the graph nodes at the same
level of the hierarchy are aligned:

l Bottom. This illustration shows that the bottom of the graph nodes at the same
level of the hierarchy are aligned:
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UI Element
(A-Z) Description

Orientation Enables you to set the orientation of the hierarchy.

Select one of the following options:

l Top to Bottom. The children are located above the parent.

l Left to Right. The children are located to the left of the parent.

l Bottom to Top. The children are located below the parent.

l Right to Left. The children are located to the right of the parent.

Orthogonal
Routing -
Fix Node
Sizes

This setting is available only when you select Routing > Orthogonal. Maintain
the size of a graph node. Clear this option if you want the layout to increase the
size of a graph node, if it is necessary tomaintain the specified relationship
spacing, whenmore than one relationship is attached to the same side of the
graph node.

Polyline
Routing -
Spacing
Between
Bends

This setting is available only when you select Routing > Polyline. Polyline
routing routes edges (connecting lines) as one or more straight line segments with
arbitrary angles. Path nodes are added automatically to prevent the edges
(connecting lines) from overlapping.

Default Value: 12

Routing Select the type of routing for the layout. The available options are:

l Orthogonal

l Polyline

Undirected
Layout

Edge direction is not used to build the levels of the hierarchical drawing.
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UI Element
(A-Z) Description

Variable
Level
Spacing

Variable level spacing adjusts the spacing between pairs of neighboring levels
according to the density of edges between the levels.

If the drawing's edges are orthogonally routed, this ensures the desired vertical
spacing between horizontal edges (in a top-to-bottom or bottom-to-top layout)
routed between levels.

If the routing is polyline, variable level spacingmakes it easier to distinguish
among edges in very dense drawings.

Vertical
Spacing

Enables you to set theminimum vertical distance between two neighboring graph
nodes on different levels.

Enter values for the following settings:

l Between Graph Nodes. Sets a vertical space around each graph node in the
level.
Default value: 28

l Between Edges. This setting is available only when you select Routing >
Orthogonal. It sets a vertical space between edges in the graph.
Default value: 12

Orthogonal Tab

To access Click theOrthogonal tab in the Layout Properties dialog box.

Important
information

TheOrthogonal tab enables you to set orthogonal layout route relationships
horizontally and vertically. This results in relationships bending at 90-degree
angles only.

User interface elements are described below:

UI
Element
(A-Z) Description

Fix Node
Sizes

Maintain the size of a graph node. Clear this option if you want the layout to
increase the size of a graph node if it is necessary tomaintain the specified
relationship spacing whenmore than one relationship is attached to the same side
of the graph node.

Modeling Guide
Chapter 6: Working with Topology Map

HP Universal CMDB (10.10) Page 159 of 534



UI
Element
(A-Z) Description

Horizontal
Spacing

Enables you to set theminimum horizontal distance between graph nodes.

Select one of the following options:

l Between Graph Nodes. Set a horizontal space around each graph node in the
layer.

Default value: 20

l Between Edges. Set a horizontal space between elements in the layer.

Default value: 12

Layout
Quality

Adjusts the quality of the layout produced to fit your application's needs. The
quality reflects the number of steps or themethod used to produce the layout. For
example, high quality is sharper but takes more time to set the layout.

Select one of the following options:

l Draft. Set the layout to draft quality.

l Medium. Set the layout to medium quality.

l Proof. Set the layout to proof quality.

Vertical
Spacing

Enables you to set theminimum vertical distance between graph nodes.

Select one of the following options:

l Between Graph Nodes. Set a vertical space around each graph node in the
layer.

Default value: 100

l Between Edges. Set a vertical space between elements in the layer.

Default value: 20

Symmetric Tab

To access Click theSymmetric tab in the Layout Properties dialog box.

Important
information

The Symmetric tab displays a clear representation of complex networks. The
symmetric layout emphasizes the symmetries that may occur in a graph.

User interface elements are described below:
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UI
Element
(A-Z) Description

Layout
Quality

Adjusts the quality of the layout produced to fit your application's needs. The quality
reflects the number of steps or themethod used to produce the layout. For example,
high quality is sharper but takes more time to set the layout.

Select one of the following options:

l Draft. Produces faster results (faster thanMedium and Proof).

l Medium. Produces a result that is a combination of Draft and Proof, that is, it
produces amore accurate graph layout than Draft, but not as accurate as Proof.

l Proof. Produces amore refined result but takes more time.

Note: The differences between the speed and resulting layout of each quality
setting varies depending on the nature of the graph being laid out. You can try
each option to determine which works best for you.
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UI
Element
(A-Z) Description

Spacing Allows you to set constant horizontal and vertical spacing around each graph node in
the layer. The value you specify is a guideline for the layout, so that it is possible that
the spacing for a particular pair of graph nodes might be different from the one you
specified. The larger the graph node spacing, the farther apart the graph nodes are
spaced in the final layout.

Default value: 50

The following figure illustrates smaller and larger spacing:

Routing Tab

To access Click theRouting tab in the Layout Properties dialog box.

Important
information

The Routing tab enables you to produce drawings that leave graph nodes
essentially where they are, and reroute the lines orthogonally.

User interface elements are described below:

UI
Element
(A-Z) Description

Fix Node
Positions

Maintain the position of all the graph nodes in the display. Clear this option for the
layout to move the graph nodes if it is necessary to improve the layout. The
movement is minimal, avoids overlaps, andminimizes bend points.

Fix Node
Sizes

Maintain the size of a graph node. Clear this option if you want the layout to
increase the size of a graph node if it is necessary tomaintain the specified
relationship spacing whenmore than one relationship is attached to the same side
of the graph node.
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UI
Element
(A-Z) Description

Horizontal
Spacing

Enables you to set theminimum horizontal distance between graph nodes.

Select one of the following options:

l Between Graph Nodes. Set a horizontal space around each graph node in the
layer.

Default value: 20

l Between Edges. Set a horizontal space between elements in the layer.

Default value: 12

Vertical
Spacing

Enables you to set theminimum vertical distance between graph nodes.

Select one of the following options:

l Between Graph Nodes. Set a vertical space around each graph node in the
layer.

Default value: 20

l Between Edges. Set a vertical space between elements in the layer.

Default value: 12

Main Menu
This feature contains the options for working with the topology map.

To access Located in the upper left portion of the screen.

Important
information

The specific options contained within theMainMenu drop-downs are detailed
in "Toolbar Options" on page 167.

See also l "Topology MapOverview" on page 146

l "Topology MapUser Interface" on page 147

User interface elements are described below:

UI
Element
(A-Z) Description

Edit Contains selection options for the topology map.

Modeling Guide
Chapter 6: Working with Topology Map

HP Universal CMDB (10.10) Page 163 of 534



UI
Element
(A-Z) Description

Editor
Item

Contains the topology map shortcut menu options for the current manager.

Note: This drop-down does not appear in CI TypeManager.

Layout Contains options for changing the layout of the topology map.

Note: This drop-down does not appear in Reports.

Managers Contains links to the different UCMDB modules.

Operations Contains options for printing or exporting the topology map.

Resources Contains the left pane shortcut menu options for the current manager.

Note: This drop-down does not appear in IT UniverseManager or Reports,
and in CI TypeManager it is calledCI Types.

Tools Contains the User Preferences, User Profile, Log Configuration, Screen Capture,
and Refresh User Authentication tools.

View Enables you to hide or display the different panes of themodule.

Print Dialog Box
This dialog box enables you to print the contents of the topology map.

To access Select Operations > Print.

Important
information

The results of printing a topology map is similar to a screen capture. Therefore,
before printing, it is recommended to:

l Define your print settings and arrange the contents of the topology map
according to your requirements. For details, see "Print Setup Dialog Box" on
the next page.

l Arrange the contents of the topology map for print. You can use the Layout
option and Layout Properties. For details about the layout options, see
"Layout Properties" on page 172. For details about layout properties, see
"Layout Properties Dialog Box" on page 148.

Relevant
tasks

"How to Print and Save a Topology Map to File" on page 201
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See also l "Topology MapOverview" on page 146

l "Topology MapUser Interface" on page 147

User interface elements are described below:

UI Element (A-Z) Description

Number of copies Enter the number of copies you want to print.

Properties Define document properties as required.

Print Preview Dialog Box
This dialog box enables you to preview the content of the topology map before printing.

To access Select Operations > Print Preview.

Relevant tasks "How to Print and Save a Topology Map to File" on page 201

See also l "Topology MapOverview" on page 146

l "Topology MapUser Interface" on page 147

User interface elements are described below:

Menu
Item Description

Print Setup. Opens the Print Setup dialog box where you can define the print
settings.

Print. Prints themap. For details, see "Print Dialog Box" on the previous page.

Zoom In. Zooms in to focus on specific details of themap.

Zoom Out. Zooms out to view themap.

Fit. Fit the complete view in the pane.

Print Setup Dialog Box
This dialog box enables you to define the print settings for a topology map.

To access Select Operations > Print Setup.

Relevant tasks "How to Print and Save a Topology Map to File" on page 201
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See also l "Topology MapOverview" on page 146

l "Topology MapUser Interface" on page 147

User interface elements are described below:

UI Element
(A-Z) Description

Actual Size Print the view as it really is.

Color Set the text color.

Font Set the required font.

Page Setup Set the printer settings.

Pages Divide themap into rows and columns and print each section separately. Enter
the number of columns and rows in thePage Columns andPage Rows boxes.

Position Select the position of the caption from thePosition list.

Print
Background

Print the background behind the view.

Print
Border

Print themapwith a border. Click Color to select the required border color.

Print
Caption

Enter the caption in the text area and click Font to select the required custom
font.

Print Crop
Marks

Print the cropmarks.

Print
Current
Selection

Print the selected graph nodes and their relationships.

Print
Current
Window

Print the part of the view that appears in the pane.

Print Entire
Drawing

Print the complete view.

Print Page
Numbers

Print the page numbers.

Zoom Level Print the view at the current zoom level.
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Toolbar Options
The following table contains a description of each Topology Map toolbar option, organized
alphabetically.

Button Option Name Use This Option to...

Additions Count Calculate the number of instances that are
created as a result of an Enrichment Rule.
The number of TQL query node instances and
relationships that are created appear next to
the Enrichment query nodes/relationships, as
seen in the figure below.

Note: This option appears in the toolbar
in Enrichment Manager only.

Advanced Pane Toggle between hiding and displaying the
Advanced Pane at the bottom center of the
screen.

To access:Select View > Advanced Pane.

Calculate Query
Result Count

Calculate the number of instances found for
each TQL query node/relationship.

Change Label
Length/Properties

Enter themaximum number of characters that
the labels should contain.

To access: In IT UniverseManager and the
Modeling Studio, select Layout > Change
Label Properties. In the other managers,
select Layout > Change Label Length.
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Button Option Name Use This Option to...

CI Types Tree Toggle between hiding and displaying the CI
Type Selector at the right of the screen.

To access:Select View > CI Types Tree.

Note: In theModeling Studio, this option
is called CI Types.

Create Relationship In most managers, create a relationship
between two existing TQL query nodes. For
details, see "How to AddQuery Nodes and
Relationships to a TQLQuery" on page 25.

In IT UniverseManager, create a relationship
between existing CIs. For details, see
"Attaching Existing CIs" on page 188.

Delete Selected Item
(s)

Delete a CI from IT UniverseManager or a
TQL query node from Impact Analysis
Manager or Enrichment Manager.

Drag Map Drag the view.

To access:Open the drop-downmenu in the
Mode box or select View > Drag Map. In IT
UniverseManager and theModeling Studio,
select Layout > Dragging Mode.

Drill Down One Layer Move down one level in the topology map.
This option is enabled only if there is an
additional CI layer below it, created by setting
the hierarchy of the view. For details on
setting the hierarchy, see "Setting the View
Hierarchy" on page 243.

Note: This option appears only in IT
UniverseManager.

Enable/Disable
Related CIs Retrieval

Toggle between disabling and enabling the
redrawing of the topology mapwith related
CIs when selecting a new CI in the CI
Selector.

Note: This option appears only in IT
UniverseManager in the Related CIs tab.
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Button Option Name Use This Option to...

Entities Tree Toggle between hiding and displaying the
manager specific entities tree at the left of the
screen.

To access:Select View > Entities Tree.

Note: In theModeling Studio, each of the
tabs of the Left pane (Resources, CI
Types, CI Selector) is listed as a
separate option.

Export Map to Image Save the topology map to a file. For details,
see "Export Map to Image Dialog Box" on
page 147.

To access:Select Operations > Export Map
to Image.

Fit to Window Fit the completemap in the pane.

To access:Select Layout > Fit to Window.

Generate Direct Link Generate a direct link to a view or CI.

To access:Select Edit > Generate Direct
Link.

Go Up One Layer Move up one level in the topology map. This
option is enabled only if there is an additional
CI layer above it, created by setting the
hierarchy of the view. For details on setting
the hierarchy, see "Setting the View
Hierarchy" on page 243.

Note: This option appears only in IT
UniverseManager.

Hide All Inheritance
From Map

Toggle between showing and hiding
Inheritance_f relationships and their
connecting query nodes.

To access:Select Layout > Hide All
Inheritance From Map.

Note: This option is only active in the
toolbar in CI TypeManager.
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Button Option Name Use This Option to...

Hide All Query Node
Labels

Toggle between showing or hiding the
CI/CIT/query node/pattern labels.

To access:Select Layout > Hide All Query
Node Labels.

Note: This option is not available in IT
UniverseManager and theModeling
Studio.

Hide All Relationship
Labels

Toggle between showing or hiding the
relationship labels.

To access:Select Layout > Hide All
Relationship Labels.

Note: This option is calledHide edges'
labels in IT UniverseManager and the
Modeling Studio.

Hide All
Relationships

Toggle between showing and hiding the
relationships in the displayedmap.

To access:Select Layout > Hide All
Relationships.

Note: This option is not available in IT
UniverseManager and theModeling
Studio.

Hide/Show Get
Related CIs pane

Toggle between hiding and displaying the Get
Related CIs pane.

Note: This option appears only in IT
UniverseManager in the Related CIs tab.
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Button Option Name Use This Option to...

Interactive Zoom l Decrease the view magnification by
clicking and pushing the pointer upwards.

l Magnify the view by clicking and pulling
the pointer downwards.

To access:Open the drop-downmenu in the
Mode box or select View > Interactive
Zoom.

Note: This option is not available in IT
UniverseManager and theModeling
Studio.

Layout Select the layout display from the list. The
options are:

l Hierarchical Layout. Enables you to
display the precedence relations in the
topology map.

l Hierarchical Layout with Orthogonal
Routing. Displays a hierarchical layout
with edges composed exclusively of
horizontal and vertical lines, forming right
angles where they intersect.

l Symmetric Layout. Enables you to
display clear representations of complex
networks.

l Circular Layout. Groups a graph's nodes
into groups or clusters.

l Orthogonal Layout. Displays a layout
with edges composed exclusively of
horizontal and vertical lines, forming right
angles where they intersect.

For further details about each of the options,
see "Layout Properties Dialog Box" on page
148.

Note: These layout options are only
relevant for Enrichment Manager, CIT
Manager, and Impact Analysis Manager.
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Button Option Name Use This Option to...

Layout Properties Define the view's layer layout, by assigning
positions for the query nodes and
relationships of the view. For details, see
"Layout Properties Dialog Box" on page 148.

To access:Select Layout > Layout
Properties.

Log Configuration Open the Log Configuration dialog box.

To access:Select Tools > Log
Configuration.

Map overview Open a small box with a copy of the topology
map. This is useful in large views when
zooming in.

To access:Select Layout >Map Overview.
In IT UniverseManager and theModeling
Studio, select Layout > Show Map
Overview.

Maximize
Workspace/Restore
Workspace

Toggle between the regular display and a full-
screen display of the topology map.

Navigation Take the pointer to the next connected
CI/CIT/TQL query node in a clockwise
direction.

l Left-click to move in a clockwise direction.

l Right-click to point to the next
CI/CIT/query node/pattern in a clockwise
direction.

To access:Open the drop-downmenu in the
Mode box or select View > Navigation.

Note:

l You can use this option only on
CI/CIT/query nodes/patterns that are
connected by relationships.

l This option is not available in IT
UniverseManager and theModeling
Studio.
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Button Option Name Use This Option to...

New CI Define a new unrelated CI. For details, see
"Working with CIs" on page 183.

Note: This option appears in the toolbar
in IT UniverseManager only.

New Related CI Define a new related CI. For details, see
"Working with CIs" on page 183.

Note: This option appears in the toolbar
in IT UniverseManager only.

Place in Center Place the selected CI/CIT/query
nodes/pattern in the center of themap.

To access:Select Layout > Place in
Center.

Note: This option is not available in IT
UniverseManager and theModeling
Studio.

Print Print the contents of the topology map. For
details, see "Print Dialog Box" on page 164.

To access:Select Operations > Print...

Print Preview Preview the contents of themap before
printing.

To access:Select Operations > Print
Preview.

Print Setup Define print settings for printing the topology
map. For details, see "Print Setup Dialog
Box" on page 165.

To access:Select Operations > Print
Setup...

Remove Enrichment
Results

Remove the instances created from an
Enrichment rule from the CMDB.

Note: This option appears in the toolbar
in Enrichment Manager only.

Modeling Guide
Chapter 6: Working with Topology Map

HP Universal CMDB (10.10) Page 173 of 534



Button Option Name Use This Option to...

Screen Capture Take a snapshot of the screen using the
Screen Capture tool.

To access:Select Tools > Screen Capture.

Select Select a CI/CIT/TQL query node or multiple
CIs/CITs/TQL query nodes.

To access:Open the drop-downmenu in the
Mode box or select View > Select. In IT
UniverseManager and theModeling Studio,
select Layout > Selection Mode.

Select All Select all the CIs and relationships in a
selected layer.

To access:Select Edit > Select All.

Note: This option is not available in IT
UniverseManager and theModeling
Studio.

Select All Query
Nodes

Select all the query nodes in a selected layer.

To access:Select Edit > Select All Query
Nodes.

Note: This option is not available in IT
UniverseManager and theModeling
Studio.

Select Columns Enables you to select the columns to be
displayed. For details, see "Select Columns
Dialog Box" on page 530.

Note: This option is displayed in Text
mode of IT UniverseManager only.

Set Change
Timeframe

Open the Change Timeframe dialog box,
which enables you to set the period for the
display of added or changed CI indicators.

Note: This option appears in the toolbar
in IT UniverseManager only.
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Button Option Name Use This Option to...

Show Candidates for
Deletion

Identify the CIs in the current view which are
candidates for deletion.

Note: This option appears in the toolbar
in IT UniverseManager only.

Show Schedule Info Display the scheduling information for the
selected job. For details, see "Discovery
Scheduler Dialog Box" in theHP Universal
CMDB Data Flow Management Guide.

Note: This option appears in the toolbar
inData Flow Management > Discovery
Module/Jobs > Dependency Map tab.
For details, see "Dependency Map Tab"
in theHP Universal CMDB Data Flow
Management Guide.

Sort Column Content Enables you to set the order of the visible
columns. For details, see "Sort Column
Content Dialog Box" on page 531.

Note: This option is displayed in Text
mode of IT UniverseManager only.

Straighten Straightens any selected relationship
between two query nodes that has angles.

To access:Select Layout > Straighten.

Note: This option is only available in
Enrichment Manager and Impact
Analysis Manager.

User Preferences Opens the User Preferences dialog box which
enables you to reset warningmessage
preferences. For details, see "User
Preferences Dialog Box" on page 92.

To access:Select Tools > User
Preferences.
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Button Option Name Use This Option to...

User Profile Opens the User Profile dialog box which
displays the user details for the user currently
logged in.

To access:Select Tools > User Profile

Zoom In Zoom in on a specific section of the topology
map by clicking and drawing a selection
rectangle around the part to magnify. The area
you select is displayed at the highest
percentage that fits in the topology map.

To access:Open the drop-downmenu in the
Mode box or select View > Zoom In. In IT
UniverseManager and theModeling Studio,
select Layout > Zoom in.

Topology Map Sidebar
The following table contains a description of each Topology Map sidebar option. The Topology Map
sidebar appears in IT UniverseManager and theModeling Studio.

Button Option Name Use This Option to...

Move Layout
Toolbar to
Right/Left

Move the sidebar to the right or left side of the screen.

Zoom In/Out Zoom in or out on the topology map.

Selection
Mode/Dragging
Mode

Toggle between Selectionmode and Draggingmode in the topology
map.

Refresh to get
an optimal
layout

Refresh the topology map to optimize the layout.

Fit to Window Fit the completemap in the pane.
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Button Option Name Use This Option to...

Change Map
Layout

Select themap layout. The following options are available:

l Hierarchical Layout. Enables you to display the precedence
relations in the topology map.

l Hierarchical Layout with Orthogonal Routing. Displays
a hierarchical layout with edges composed exclusively of
horizontal and vertical lines, forming right angles where they
intersect.

l Circular Layout. Groups a graph's nodes into groups or
clusters.

l Orthogonal Layout. Displays a layout with edges
composed exclusively of horizontal and vertical lines, forming
right angles where they intersect.

l Symmetric Layout. Enables you to display clear
representations of complex networks.

Map Settings You canmodify the following settings:

l Hide/Show Edges' Labels. Hide or display the labels of all
relationships.

l Hide/Show Count Indicators. Hide or display the count
indicators for the query nodes.

l Enable/Disable Edges' Highlighting. Highlight all the
relationships to and from the selected query node.

l Hide/Show Legend. Toggle between hiding and displaying
the topology map legend.

Map Tools The following tools are available:

l Show Map Overview. Open a small box with a copy of the
topology map. This is useful in large views when zooming in.

l Print. Print the topology map.

l Export Map to Image. Save the topology map to a file.
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Button Option Name Use This Option to...

Expand All
Groups

Expand all the CI groupings in the topology map.

Note: This option is only available when a grouping option is
selected.

Collapse All
Groups

Collapse all the CI groupings in the topology map.

Note: This option is only available when a grouping option is
selected.
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IT Universe Manager Overview
IT UniverseManager enables you tomanage the content of your IT Universemodel. The following
tasks represent the basic functionality of the application:

l Creating CIs without creating relationships. You can define new CIs that are added to the
CMDB individually, so that no new relationships are created. For details, see "Creating a Non-
Related CI" on page 184.

l Creating CIs with relationships for them. You can define new CIs and attach them to
existing CIs, so defining a new CI and a new relationship in the CMDB. For details, see
"Creating a Related CI" on page 184.

l Adding existing CIs and creating relationships for them. You can attach CIs to an existing
CI, so creating new relationships for existing CIs. For details, see "Attaching Existing CIs" on
page 188.

l Deleting CIs. You can delete CIs from the CMDB. For details, see "Deleting CIs" on page 184.

l Getting Impact Analysis results. You can run the Impact rules you defined for a view to
simulate how certain defined changes impact your system, and to discover the root causes of
the changes. For more information about Impact rules, see "Impact Analysis Manager
Overview" on page 430.

l Taking a snapshot of a view. HP Universal CMDB enables you to display the status of a view
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in one snapshot by comparison with its status taken at a different time. For details on how to
take snapshots, see "How to Take a Snapshot of a View" on page 201.

Populating the IT Universe Model
The IT Universemodel in the CMDB contains the CIs and relationships produced by the CI-
generating tools that operate within HP Universal CMDB. Most CIs and relationships originate from
one of the following sources:

l Data Flow Management (DFM). Automatically creates CIs and relationships based on the
discovered IT resources and topology in your company's infrastructure. For details, see Data
Flow Management Overview in theHP Universal CMDB Data Flow Management Guide.

l IT Universe Manager. Enables you tomanually create CIs and relationships that represent
logical and physical elements of the business. For details, see "Working with CIs" on page 183.

l Enrichment Manager. Enables you to add CIs and relationships to the CMDB by receiving
data from the attributes of Enrichment query nodes as defined in the Enrichment TQL query. For
details, see "Enrichment Manager" on page 489.

Working with Views in IT Universe Manager
In IT UniverseManager, you analyze data at the view level. Views are subsets of the IT Universe,
containing only those CIs relating to a specific area of interest. All views are based on a pattern
which determines the content of the view.

l Pattern views and template-based views are built from a TQL (Topology Query Language) query
that defines the structure of the view. The view displays only those CIs and relationships that
satisfy the query definition.

l Perspective-based views are built manually, by selecting a group of CIs and applying
perspectives to them. A perspective is a pattern used to define which related CIs are included in
the view.

You build all views in theModeling Studio, using the appropriate editor for each view type. For
information on the different view types and how they function, see "View Formats" on page 242.

Note: Youmust haveUpdate permissions for a view to edit the view. If you do not have the
necessary permissions, contact your HP Universal CMDB Administrator.

CIs created by DFM are automatically added to each view where the CIs (and their relationships) fit
the TQL definition for the view. When you open a view in the CI Selector, the TQL query for the view
queries the CMDB for CIs that match the defined pattern. If there are nomatches (for example, in
the case of a view for a DFM process where the process has not yet run) then the view remains
empty.
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You can also include CIs from external data sources (federated CIs) in your view, by defining the
query to run over integration points for federated data sources. The federated CIs appear in the view
with an arrow icon indicating that they are from a federated source.

For details on federated data sources, see "Integration Studio Overview " in theHP Universal
CMDB Data Flow Management Guide.

Note: For out-of-the-box queries that have integration points defined, the data source is set as
UCMDB.

When you define a new CI while working in any view in IT UniverseManager, the CI (and any
associated relationship) is created in the CMDB. The CI is added to your current view only if it
meets the view's TQL specifications.

If the created CI and relationship do not meet the TQL requirements, then the CI and relationship
are created in the CMDB but are not visible in the view. Similarly, if you attach an existing CI to a CI
in the view, and the new pattern does not meet the TQL requirements, then the attached CIs do not
appear in the view, but the relationship is still created.

Templates and Template-based Views
If you open a template in IT UniverseManager, it is displayed in the topology map like a pattern
view. Click theShow Template Parameters button in the CI Selector toolbar to open the
Template Parameter Values dialog box, where you can change the values of the template
parameters and thereby affect the view results displayed in the topology map. You can try different
parameter values and see the resulting topology map, but you cannot save changes to the template
itself. To save the view results as a template-based view with the selected parameters, click the
Save As View button in the Template Parameter Values dialog box.

You can also create a direct link to a template in IT UniverseManager and insert the parameter
values directly into the URL. For details, see "How to Create a Direct Link to a Template with
Parameter Values" on page 104.

View Lifecycle
If you do not access a view from the CI Selector for a specified period of time, the view is cleared
out, to savememory in the system. It is not deleted from the CMDB; the view can be retrieved by
clicking on it. The default time period for clearing out unused views is one hour.

Note: Views defined as persistent are not cleared out and always remain in thememory.

Hidden Views
You can designate a view as a hidden view that does not appear in IT UniverseManager by defining
a bundle for hidden views and assigning the view to that bundle.

To designate a view as a hidden view:
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1. In the Infrastructure Settings Manager, select Hidden Bundles Names in CI Selector.

2. Enter the name of the new bundle as the default value and save the setting.

3. In theModeling Studio, open the relevant view and click theView Definition Properties
button in the toolbar.

4. In the View Definition Properties dialog box, select the hidden views bundle and assign the
view to it.

View Tree Structure
Views are organized in a hierarchical tree format in the left pane of IT UniverseManager, which is
known as the CI Selector. The view name appears in the View box above the tree and acts as the
containing folder for the CIs in the view.

The first level of the CI Selector tree consists of the query nodes for the root CIs. A root CI is the
starting point for a view subtree. A view may contain any number of subtrees. Under the root CIs
come the branch CIs, expanding down to the leaf CIs as the last query nodes at the ends of each
branch.

The CIs at each level in a subtree are considered to be attached to the CI on the branch directly
above. This attachment generally depicts a dependent relationship, so that the higher branch
(closer to the root CI) represents a component of your business that depends on the CIs on the next
branch down (closer to the leaf CIs) in the business process. For example, an application depends
on the servers running the application.

The attachment between a higher and a lower query node is referred to as a parent-child
relationship. The parent CI may havemany attached child CIs, and the child CIs pass operational
status to the parent.

The tree topology is determined by the hierarchy defined for the view. In a pattern view, these are
defined for the specific view. In a template-based or a perspective-based view, the hierarchy is
defined as part of the template or perspective. For details on defining the hierarchy, see "Setting the
View Hierarchy" on page 243.

Working with CIs
In IT UniverseManager, you can create related and non-related CIs, delete CIs, edit the CI
properties, and remove out-of-date CIs using the agingmechanism.

This section includes the following topics:

l "Creating a Non-Related CI" on the next page

l "Creating a Related CI" on the next page

l "Deleting CIs" on the next page
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l "CI Properties" on the next page

l "Removing Out of Date CIs Using the AgingMechanism" on the next page

Creating a Non-Related CI

You can define a new CI in IT UniverseManager by clicking theNew CI button in the toolbar.
The New CI dialog box opens, which enables you to define the properties for the new CI. The CI is
created in the CMDB. For details, see "New CI/New Related CI Dialog Box" on page 229.

Note: The CI is added to the view only if it meets the specifications of the pattern of the view,
template, or perspective.

A CI created in this way is added as an independent entity without any relationship to any other
existing CI in the CMDB.

Creating a Related CI
You can define a new CI to be added as a parent, child, or sibling of an existing CI.

To define a new related CI:

1. Select the CI in your view to which you want to attach the new CI.

2. Click theNew Related CI button in the toolbar.

3. In the New Related CI dialog box, define the properties and relationship for the CI. For details,
see "New CI/New Related CI Dialog Box" on page 229.

The CI and relationship are created in the CMDB.

Note: The CI and relationship are added to the view only if they meet the specifications of
the pattern of the view, template, or perspective.

Deleting CIs
You can delete a CI by selectingDelete from CMDB from the shortcut menu in IT Universe
Manager. The CI is deleted from the CMDB and from all views. If the CI has children, they are not
automatically deleted when you delete the parent CI. If you delete a CI without first deleting the
relationship between the CI and any child CIs that appear with the parent CI in a view, the child CIs
are removed from the view.

If the child CIs do not appear in any other view, they remain in the CMDB without appearing in a
view. The child CIs might appear in the future in views where they meet the pattern requirements.

One exception to this rule is when the relationship between a child and parent CI is aComposition
relationship; in that case, when the parent CI is deleted, the contained CI is also removed from the
CMDB. For example, if a node CI is the container for a child CPU CI, then when the node CI is
deleted, the CPU is also removed from the CMDB.
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When you delete a CI that was created by the DFM process, the CI is restored the next time that
DFM runs (if the CI is still valid), and it reappears in all relevant views.

Note: Sometimes, a CI is deleted from the CMDB but it still appears in a TQL query because
the query was not yet updated due to its priority level. When the query is consumed in IT
UniverseManager, UCMDB cannot find any of the CI's properties, and it is displayed with a no
label name in the topology map.

CI Properties
In IT UniverseManager, you can edit the properties of a CI. The CI properties are divided into
several categories which appear in the New CI dialog box:

l The general properties of a CI are common to all CIs. Some general properties are defined
automatically during CI creation; others can only be definedmanually in the New CI dialog box.

l CIT-specific properties are created as part of the CIT definition in the CI TypeManager. The
values for the CIT-specific properties are taken from the CIs discovered during DFM. The values
can also be enteredmanually, when youmanually create CIs to represent entities in your
infrastructure. For details, see "CI TypeManager" on page 448.

l Key properties can be general or CIT-specific properties, whichmust be assigned a value to
create an instance of the CI type.

You can access the Configuration Item Properties dialog box to view the CI properties from IT
UniverseManager by right-clicking the CI and selectingProperties or by clicking the Properties tab
in the Advanced pane. You can also edit the CI properties if you have the necessary permissions
for editing CIs. For details on CI properties, see "Configuration Item Properties Dialog Box" on page
207.

The CIT-specific properties are displayed in theSpecific Properties section of the Configuration
Item Properties dialog box when you sort the properties using theCategorized button. Some
properties for the automatically created CIs can be edited, however, if the CI is configured toAllow
CI Update (in the General Properties), then DFMmay override your changes when it updates the
CI. A description of the selected property can be found in the Description area at the bottom of the
Configuration Item Properties dialog box.

Some of the CIT-specific properties for DFM CIs are set by default to bemonitored for changes.
When one of these properties has beenmodified, information on the change can be viewed in a CI
change report. For more information, see "CI Change Report" on page 351.

Removing Out of Date CIs Using the Aging Mechanism
If a CI or relationship is not updated or refreshed over a period of time (for example, a CI is not
rediscovered by DFM and nomanual update occurs), an agingmechanism deletes the CI from the
CMDB. For details, see "CI Lifecycle and the AgingMechanism" in theHP Universal CMDB
Administration Guide.

Note: The following actions that apply to CIs cannot be performed on federated CIs:
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l Editing the CI properties

l Deleting the CI

l Creating a relationship to another CI

l Viewing the CI History

l Adding the CI to a Discovery job

l Removing the CI from aDiscovery job

Working with Relationships
Many of the relationships between CIs in the CMDB are created automatically, for example, by
DFM. In addition, you can create relationships manually in IT UniverseManager, Enrichment
Manager, Impact Analysis Manager, or theModeling Studio.

This section includes the following topics:

l "Creating Relationships" below

l "Creating Hierarchical Relationships" on the next page

l "Attaching Existing CIs" on page 188

l "Setting the View Hierarchy" on page 188

l "Relationship Properties" on page 188

l "Viewing Related CIs" on page 188

l "Deleting Relationships" on page 189

l "Inter-Layer Relationships" on page 189

Creating Relationships
You can create relationships by right-clicking a CI or multiple CIs in the CI Selector pane or the
Topology Map and selectingRelate to CI from the shortcut menu. In the Topology Map, you can
define a relationship between two CIs in the view by drawing a line between the two, using the

Create Relationship button from the toolbar. Either of these actions opens the Insert
Relationship dialog box. For details, see "Insert Relationship Dialog Box" on page 213.

You can create as many relationships as necessary between a CI in the CMDB and other CIs.
Each new relationship exists as its own entity in the CMDB, and has its own properties that can be
edited in IT UniverseManager (as described in "Configuration Item Properties Dialog Box" on page
207). You can also createmore than one relationship between the same two CIs, when each
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relationship is based on a different relationship type. In the following example, host7 has both a
Backbone and a Talk relationship with switch3.

Note: If a Running Software CI is related to another CI with a Containment relationship, you
cannot create another Containment relationship from the Running Software CI.

Creating Hierarchical Relationships
By attaching one CI to another in IT UniverseManager you create a hierarchical relationship
(parent-child) between them, so that one CI is influenced by the other.

Certain relationships defined in this way are restricted to the relationship type usage (if the
relationship is between two non-monitoring CIs), or the relationship typeMonitored By (if the child
CI in the relationship is amonitor type CI); however, other relationship types are used between
specific types of CIs. For example, if a relationship is defined between two node CIs, there are
several possible relationship types.

Note:When you attach a child CI to a parent CI, you are creating that relationship in the
CMDB. The child therefore impacts on the parent CI in every view where the relationship
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exists, and is displayed in every view where the child and relationship match the TQL query.

Attaching Existing CIs
You can attach existing CIs using the Insert Relationship dialog box. The dialog box has two
modes:

l Selecting the CIs that you want to attach.

l Defining the relationship between the original CI and the CIs to attach.

When selecting the CIs to attach, you can select multiple CIs from a view to attach to the original
CI. However, all CIs that you want to attach in one operationmust have the same relationship type.
For example, you cannot attach a CI that uses the relationship usage in the same operation as a CI
that uses the relationshipMonitored By.

Setting the View Hierarchy
After setting the query node and relationship definitions of a view, you can set a hierarchy for the
view. This enables you to define the organizational structure of CIs in the view by displaying
selected CIs at different levels. When no hierarchy is defined, the Topology Map or table displays
all CIs included in the query results on one level by default. For example, if the query results include
nodes and IP Subnets, both CI types are displayed on the same level in the Topology Map or table.

Note: Themaximum number of CIs that can be displayed in a single layer of the Topology Map
is 900. If a view contains a layer with more than 900 CIs, the view is not displayed in the
Topology Map until the hierarchy is changed. However, a layer with more than 900 CIs can be
displayed in a table in Text mode.

For details on setting the hierarchy, see "Setting the View Hierarchy" on page 243.

Relationship Properties
Relationships have properties, similar to CIs. You can access the Configuration Item Properties
dialog box to view the relationship properties from IT UniverseManager by right-clicking the
relationship and selectingProperties or by clicking the Properties tab in the Advanced pane. You
can also edit the relationship properties if you have the necessary permissions for editing CIs. For
details on relationship properties, see "Configuration Item Properties Dialog Box" on page 207.

Note: For relationships of type composition connected to a CI of type Node Element or its
descendant CI types, relationship properties are not saved. When a TQL query containing such
a relationship is run, the default values for the relationship properties are used even if you
edited the properties.

Viewing Related CIs
You can view all the CIs related to a selected CI in the topology map. Select a CI in a view and then
select theRelated CIs tab. TheGet Related CIs pane enables you to select the scope of the
display. If you select View, the topology map displays only the selected CI and its related CIs in the
view (nomatter where it is in the view hierarchy). If you select CMDB, it displays the selected CI
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and all of its related CIs in the CMDB. You can also filter the results from theGet Related CIs pane
by CI type and apply perspectives to a CI. For details, see "Get Related CIs Pane" on page 227.

You can also display Related CIs using the Get Related CIs from CMDB dialog box. For details,
see "Get Related CIs From CMDB Dialog Box" on page 212.

Deleting Relationships
The Topology Map shows only the relationships for the CIs that are part of the current view;
however, the same relationships may also be part of other views. When you delete a relationship in
IT UniverseManager, it is deleted from the CMDB and from all views.

When a relationship is deleted, the CI on the other end of the relationship may remain in the view, if
it still matches the pattern of the view. However, if the deleted relationship is a composition link, the
target CI is deleted with it.

In a perspective-based view, you can remove the CI completely from the view (without deleting it
from the CMDB), by hiding it from the view in the Perspective-based View Editor in theModeling
Studio.

When you delete a relationship that was created by the DFM process, the relationship is restored
the next time that DFM runs (if the relationship is still valid), and it reappears in all relevant pattern
views.

It can take a few minutes to delete subtrees, or multiple CIs and relationships, from a view.

Inter-Layer Relationships
In certain circumstances, IT UniverseManager displays a relationship between CIs in a layer of a
view that does not reflect an actual relationship between the CIs in that layer, but rather a
relationship between CIs on deeper layers of the view. Such a relationship is known as an inter-
layer relationship.

For example, in the following view, two node CIs are related to each other with a dependency
relationship. Each is also related to an IP Subnet by amembership relationship and the view
hierarchy is defined such that the nodes are on the layer beneath the IP Subnet.
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When you consume the view in IT UniverseManager, the relationship between the node CIs (which
are under different IP Subnets) is displayed in the higher layer of the view as a relationship between
the parent IP Subnets, even though the actual relationship only exists between the CIs in the lower
layer of the view. You can double-click the relationship to display the full path between the IP
Subnets.

Another form of inter-layer relationship occurs when the sameCI appears under more than one
parent CI of the same type in the layer above it. In such a case, the child CI and its relationships are
duplicated in the view display, due to the hierarchy definition. The relationships of such child CIs
result in inter-layer relationships between the parent CIs. This type of inter-layer relationship is
known as a duplication metalink.

For example, in the following view, a single node CI appears under two IP Subnet CIs in the
hierarchy. The node and its children thus appear twice in the view - once under each IP Subnet.
Each node is effectively related to the child CIs of the node under the other IP Subnet, which
generates an inter-layer relationship between the two IP Subnets.
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Inter-layer relationships and duplicationmetalinks are displayed in gray in the topology map. The
following options are available for viewing inter-layer relationships (defined in the View Definition
Properties dialog box inModeling Studio):

l None. Hide all inter-layer relationships.

l Inter-Layer. Display inter-layer relationships of the first type, but not duplicationmetalinks.

l Full. Display all inter-layer relationships, including duplicationmetalinks.

A tooltip for the inter-layer relationship displays the inner relationships which it represents. If there is
only one inner relationship, the relationship label displays that relationship type. If there aremultiple
inner relationships, the label becomes Inter-layer and the tooltip displays a list of all the inner
relationships. If there aremore than ten inner relationships, only the first ten are displayed, and a
note indicates that there aremore inner relationships.

How to Create CIs and Relationships
This task describes how to create related and non-related CIs, as well as relationships between
CIs, in the CMDB.

This task includes the following steps:

l "Define a New Non-related CI" on the next page

l "Define a New Related CI" on the next page

l "Attach Existing CIs" on the next page
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Define a New Non-related CI

Click theNew CI button in the toolbar. In the New CI dialog box, select a CI type from the tree
and define the properties for the new CI. For details, see "New CI/New Related CI Dialog Box" on
page 229.

Define a New Related CI

Click theNew Related CI button in the toolbar. In theNew Related CI dialog box, select a CI
type from the tree and define the properties for the new CI. On the Relationship page of the dialog
box, select the type of relationship and define its properties. For details, see "New CI/New Related
CI Dialog Box" on page 229.

Attach Existing CIs
Select a CI in a view. Right-click the CI and select Relate to CI. In the Insert Relationship dialog
box, select a target CI. On the Relationship page of the dialog box, select the type of relationship
and define its properties. For details, see "Insert Relationship Dialog Box" on page 213.

How to View Related CIs
The following steps describe the options for viewing related CIs in IT UniverseManager.

l "Display Related CIs" below

l "Select the Scope of the Display" below

l "Filter the Related CIs" below

l "Apply Perspectives to a CI" on the next page

Display Related CIs
In IT UniverseManager, select a CI in the Topology map or the CI Selector and select theRelated

CIs tab. Click theEnable Related CIs Retrieval button. The selected CI is displayed with its
related CIs. Select a different CI or multiple CIs from the CI Selector, and the display changes
accordingly.

Note: You can display the Related CIs content in mapmode or in text mode.

For details on the Get Related CIs user interface, see "Get Related CIs Pane" on page 227.

Select the Scope of the Display
In the Get Related CIs pane, select the scope of the related CIs display. Click theShow Related
CIs button. The display changes according to your selection.

Filter the Related CIs
In the Filter Related CIs by CI Type section, select the CI types to appear in the related CIs
display. Click the Filter Related CIs button. The filtered results appear in the tab. The scope
selected above still applies and the display is reduced according to your filter selection.
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Apply Perspectives to a CI
In the Apply Perspectives to CI section, select the perspectives to apply to your selected CI. Click
theApply Perspectives button. The results are displayed in the tab.

Note: This feature is only relevant whenCMDB is selected as the scope.

How to Check the Status of Application Discovery
(Rediscover a View)

As an application owner or administrator, you need to be kept informed of any problems with your
application. So, for example, it is important to know that discovery is working properly and that its
current configuration can connect to the application database. This section explains how to run the
rediscovery procedure that enables you to check the current status of the discovery of an
application.

Note:

l Set up and configuration is performed by the UCMDB administrator. For details, see
"Prerequisites" below.

l Rediscovery is performed by the application owner/administrator. For details, see "Access
the View" on the next page.

l You do not need any knowledge of Data Flow Management (DFM) to run this procedure.

l By default, you can run the rediscovery procedure on views that contain fewer than 10,000
CIs. For details on changing this number, see "Important information" on page 238.

This task includes the following steps:

l "Prerequisites" below

l "Access the View" on the next page

l "View Results in the View" on the next page

l "Schedule the Rediscovery" on the next page

1. Prerequisites

Note: This step is performed by the UCMDB administrator.

a. In DFM, create amodule that contains the jobs that must discover the application. For
details, see How to RunModule/Job-Based Discovery in theHP Universal CMDB Data
Flow Management Guide.
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b. Activate themodule and all the jobs. The jobs must remain activated.

c. Verify that themodule has run without errors. For details, see Error Messages Overview
and Discovery Module/Jobs - Details Tab in theHP Universal CMDB Data Flow
Management Guide.

d. Correct any errors in the application and confirm that DFM finds no errors during the next
run.

Caution: The application owner cannot rediscover a view if DFM is reporting errors.
Youmust set an error-free baseline.

e. In theModeling Studio, define a view that includes the application CI or CIs to be
rediscovered. These are the CIs that are created when you activate the jobs that discover
the application. For details, see "How to Create a Pattern View" on page 255.

f. Notify the application owner of the name of the view.

2. Access the View

Note: This step is performed by the application owner/administrator.

In IT UniverseManager, access the view that includes the application CIs to be rediscovered.
For details, see "How to Search for CIs in SearchMode" on page 129.

3. View Results in the View
a. Check the complete application. Click theShow Discovery and Changes Summary

button in the CI Selector toolbar. TheShow Discovery Status and Changes of View
dialog box is displayed. The dialog box displays information about which jobs and trigger CI
discovered the CIs in the view, on the last occasion that DFM ran the discovery for the
jobs. For details, see "Show Discovery Status and Changes Dialog Box" on page 238.

To run the discovery, click theRerun Discovery button. To view information about the jobs
and trigger CIs, use the links to drill down. For details, see Error Messages Overview in the
HP Universal CMDB Developer ReferenceGuide.

b. Check specific components of your application. Select the component's CI in the
Topology Map pane and display the Discovery tab in the Advanced pane. For details, see
"Show Discovery Status and Changes Dialog Box" on page 238.

To rediscover several CIs, press CTRL, select the CIs and display the Discovery tab.

To run the discovery, click theRerun Discovery button.

4. Schedule the Rediscovery
You can schedule how often the rediscovery procedure should run. In the Job Definition

Modeling Guide
Chapter 7: IT UniverseManager

HP Universal CMDB (10.10) Page 194 of 534



window, choose theRerun Discovery on View action. For details, see Job Definition Dialog
Box.

How to Retrieve Impact Analysis Results – Scenario
Impact Analysis Manager enables you to create an Impact rule that allows you to simulate the
impact certain infrastructure changes have on your system. The results of the Impact rule are
displayed in IT UniverseManager. The Impact Analysis results in this task describe how a change
in CPU operation impacts the node to which it is connected.

This task includes the following steps:

l "Define an Impact Analysis TQLQuery " below

l "Define an Impact Rule" on the next page

l "Create a View in theModeling Studio" on page 197

l "Get Impact Analysis Results" on page 197

1. Define an Impact Analysis TQL Query
To define an Impact Analysis TQL query, you need to create an Impact rule and then add the
TQL query nodes and relationships that define the query.

To create an Impact Analysis TQL query, selectManagers > Modeling > Impact Analysis
Manager. For details about how to add query nodes and relationships to a query, see "How to
AddQuery Nodes and Relationships to a TQLQuery" on page 25.

Example of an Impact Analysis TQL Query:

In this Impact Analysis TQL query, a CPU and a node are linked by a Composition
relationship.
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2. Define an Impact Rule
When you define an Impact rule, youmust specify the required causal relationship between the
query nodes. Define one query node as the trigger, or the query node that represents the
changes you want to make to the system, and another query node as the one that is impacted.

Right-click the query node you want to define as the trigger and select Define Impacted to
open the Impacted Query Nodes dialog box. Select the query node that you want the trigger
query node to impact and click Next. Then click theAdd button to open the Impact Rules
Definition dialog box to set conditions for defining impacted query nodes. For details about how
to define an Impact rule, see "Impact Rules Definition Dialog Box" on page 442.

Note: The change state option in the Impact rule definition is no longer relevant for Impact
Analysis. The only supported state is operation.

Example of an Impact Rule:

The Conditions area in the Impact Rules Definition dialog box defines the conditions under
which the simulated change in the system is triggered. The Severity area defines the
severity of the impact on the impacted query node.

The Impact rule in this example states that when the CPU operation is not in the normal
state, the node is impacted. Since the severity is set to 100% of the trigger's severity, the
severity of the node is the same as the severity of the CPU, which is determined when
Impact Analysis is run.
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In the resulting TQL query, an upward arrow appears next to the query node defined as the
trigger query node and a downward arrow appears next to the query node defined as the
impacted query node.

3. Create a View in the Modeling Studio
Go to theModeling Studio and create a view matching the TQL query of the Impact rule you
defined. For details, see "Pattern View Editor" on page 300.

4. Get Impact Analysis Results
SelectManagers > Modeling > IT Universe Manager and select the required view in the CI
Selector. To get Impact Analysis results, run the Impact rule on a CI instance in the topology
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map that is a trigger. Right-click a trigger CI and select Run Impact Analysis to open the Run
Impact Analysis dialog box. In the dialog box, select the Impact rules to run. If you want to
select Only Impact rules located in specified bundle, make sure to add your Impact rule to the
required bundle using the Properties option for the selected Impact rule. For details, see
"Impact Rule Groups Page" on page 446.

For details on how to run an Impact rule, see "Run Impact Analysis Dialog Box" on page 235.

Example for Getting Impact Analysis Results:

An Impact Analysis TQL query is created containing a CPU and node connected by a
Composition relationship. The CPU query node is defined as the trigger query node and
the query node of type node is defined as the impacted query node.

The following Impact rule is defined for the query.

Right-click a CPU CI in the view, and select Run Impact Analysis to open the Run
Impact Analysis dialog box. Set the trigger severity to a value other thanNormal.
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To see results, click one of the following:

n Show in Views. This assigns a status to all the CIs in the view. Only the node CI
connected to the CPU CI (whose severity was changed), becomes impacted. The
trigger CI and the impacted CI turn orange because the trigger severity was set as
Major (7) on the scale in the Run Impact Analysis dialog box, which is assigned an
orange color.
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n Show Map. A map appears in a separate window containing only the trigger CPU CI
and the node CI it impacted. The relationship connecting the two CIs contains the name
of the Impact rule defined in Impact Analysis Manager.

Note: Optionally, you can create a URL that enables you to embed themap. For
details, see "Direct Link Parameters – Impact Map Page" on page 112.

n Generate Report. Generates an Impact Analysis report that displays a list of CIs that
are impacted in the system as a result of the simulated changes. For details, see "Run
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Impact Analysis Dialog Box" on page 235.

How to Take a Snapshot of a View
You can take a snapshot of a view in IT UniverseManager, save it, and then compare snapshots of
the same view taken at different times using the Compare Snapshots Report. For details on how to
take a snapshot of a view, see "Save Snapshot Dialog Box" on page 237. For details on how to
view actual differences in the compared views, see "Compare Snapshots Report" on page 366.

How to Print and Save a Topology Map to File
You can print the content of any topology map and then save it to file. Before printing, it is
recommended to define your print settings and arrange the contents of the topology map according
to your requirements. For details on how to define print settings, see "Print Setup Dialog Box" on
page 165. For details on how to preview the content of the topology map before printing, see "Print
Preview Dialog Box" on page 165. For details on how to print the content of a topology map, see
"Print Dialog Box" on page 164. For details on how to save a topology map to file, see "Export Map
to Image Dialog Box" on page 147.

IT Universe Manager User Interface
This section includes (in alphabetical order):

Add CIs toModel Dialog Box 202

Add CIs to View Dialog Box 202

Change TimeframeDialog Box 203

CI/Relationship History Dialog Box 204

Configuration Item Properties Dialog Box 207

Generate Sub Report Dialog Box 212

Get Related CIs From CMDB Dialog Box 212

Insert Relationship Dialog Box 213

IT UniverseManager Page 217

New CI/New Related CI Dialog Box 229

Recently Discovered By Dialog Box 234

Run Impact Analysis Dialog Box 235

Save Snapshot Dialog Box 237

Show Discovery Status and Changes Dialog Box 238
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Show Impact Pane 239

Add CIs to Model Dialog Box
This dialog box enables you to add selected CIs to amodel.

To access SelectManagers > Modeling > IT Universe Manager. Right-click a CI or
multiple CIs in the CI Selector and select Add CIs to Model.

Important
information

This feature is only relevant for instance basedmodels. You cannot add selected
CIs to a pattern basedmodel.

See also l "IT UniverseManager Overview" on page 180

l "IT UniverseManager User Interface" on the previous page

l "Business CI Models" on page 247

User interface elements are described below:

UI Element (A-Z) Description

<Model tree> WhenExisting Model is selected, select amodel from the tree.

Define New CI
Properties

WhenNew Model is selected, define the name and properties of the
model.

Existing Model Select Existing Model to add the selected CIs to an existingmodel.

New Model Select New Model to add the selected CIs to a new model.

Select CI Type WhenNew Model is selected, select a CI type for themodel.

Add CIs to View Dialog Box
This dialog box enables you to add selected CIs to a perspective based view.

To
access

SelectManagers > Modeling > IT Universe Manager. Right-click a CI or multiple
CIs in the CI Selector and select Add CIs to View.

See
also

l "IT UniverseManager Overview" on page 180

l "Working with Views in IT UniverseManager" on page 181

l "IT UniverseManager User Interface" on the previous page

User interface elements are described below:
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UI Element (A-
Z) Description

<View tree> WhenExisting View is selected, select a view from the tree.

Existing View Select Existing View to add the selected CIs to an existing perspective
based view.

New View Select New View to add the selected CIs to a new perspective based view

View Name WhenNew View is selected, edit the name of the view.

Change Timeframe Dialog Box
This dialog box enables you to display changes in the topology map and set the time frame for the
changes to display.

To access SelectManagers > Modeling > IT Universe Manager. Click theSet Change

Timeframe button in themain toolbar or the IT Universe status bar.

Important
information

When the change indicators are displayed in the topology map, amessage
appears in the IT Universe status barChange Timeframe is Active.

To hide the indicators, open the dialog box and select Do not display changes,

or select theReset Change Timeframe button in the IT Universe status bar.

See also l "IT UniverseManager Overview" on page 180

l "IT UniverseManager User Interface" on page 201

User interface elements are described below:

UI Element (A-Z) Description

Display changes
according to the
selected
timeframe

Select this option to display an indicator next to each CI that was added or
changed within the selected period as follows:

l Indicator for an added CI

l Indicator for a changed CI

Select a time period from the drop-down list. If you select Custom, click the

ellipsis button to select theDate From andDate Until fields. The
changes to the CIs of the view within the selected period are displayed in the
map.

When the indicators are displayed, you can click the indicator to open the CI
History dialog box, which displays the history for the CI over the selected
period.

Modeling Guide
Chapter 7: IT UniverseManager

HP Universal CMDB (10.10) Page 203 of 534



UI Element (A-Z) Description

Do not display
changes

Select this option to hide the change indicators.

CI/Relationship History Dialog Box
This dialog box displays a list of CI or relationship attributes in which changes have occurred as
well as the differences between two configuration files.

To access In IT UniverseManager, right-click the selected CI or relationship in the CI
Selector or the Topology Map and select CI History.

Note: CI and relationship history data is also available in the History tab of
the Advanced pane in IT UniverseManager.

Important
information

All CI and relationship attributes are included in the History, except for attributes
marked with theNot Tracked for History qualifier in the CI TypeManager. For
details, see "Add/Edit Attribute Dialog Box" on page 458.

Note: In amulti-tenancy environment, the CI History dialog box only displays
history events that are relevant to the tenants associated with yourView CIs
permission. However, Remove CI/relationship events that occurred before
an upgrade to UCMDB version 10.01 are displayed independent of the
tenants associated with theView CIs permission.

See also l "IT UniverseManager Overview" on page 180

l "IT UniverseManager User Interface" on page 201

User interface elements are described below:

UI Element (A-Z) Description

Refresh. Refreshes the data in the table.
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UI Element (A-Z) Description

Show Difference. Enables you to view the difference between
two history entries for the content of a configuration file. This is
relevant in the following situations:

l Select two history entries for theDocument Content
attribute for CIs of the typeConfiguration Document to
compare to each other.

l Select one history entry for theDocument Content
attribute for CIs of the typeConfiguration Document to
compare to the current content for that CI.

Click theShow difference button to open the Visualdiff report,
which displays a comparison of the two entries. Text added to
the second entry appears highlighted in yellow. Text removed
from the first entry appears highlighted in red. Differences
between the entries appear highlighted in green.

Modeling Guide
Chapter 7: IT UniverseManager

HP Universal CMDB (10.10) Page 205 of 534



UI Element (A-Z) Description

Export Data To File. Enables you to export the history data.
Choose the export format from the following options:

l XLS. The table data is formatted as an .xls (Excel) file that
can be displayed in a spreadsheet.

l PDF. The table data is exported in PDF format.

Note:When exporting to PDF, select a reasonable
number of columns to display to ensure that the report
is legible.

l RTF. The table data is exported in Rich Text Format.

l CSV. The table data is formatted as a comma-separated
values (CSV) text file that can be displayed in a
spreadsheet.

Note: For the CSV formatted table data to display
correctly, the comma (,) must be defined as the list
separator. InWindows, to verify or modify the list
separator value, open Regional Options from the
Control Panel, and on the Numbers tab ensure that the
comma is defined as the List Separator value. In Linux,
you can specify the list separator in the application that
opens the CSV file.

l XML. The table data is formatted as an XML file that can be
opened in a text or XML editor.

Tip: To extract HTML code from the report:

l Open the file in an HTML editor

l Copy the relevant table into the target file

Attribute The name of the attribute.

Change Date The date when the last change occurred.
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UI Element (A-Z) Description

Filter by Filter the data in the table by one or more of the following filters:

l Time Range. Select the time period for which the CI history
is displayed.

l Change Type. Select the type of changes displayed in the
table.

l Attribute. Select the attribute types displayed in the table.

Modified By Indicates the cause of the change. For example, the field can
contain the name of a user or a DFM job.

New Value The new value of the attribute.

Old Value The previous value of the attribute.

Configuration Item Properties Dialog Box
This dialog box enables you to view and edit basic information for an existing CI or relationship.

To access SelectManagers > Modeling > IT Universe Manager and use one of the
following:

l Select a CI or relationship in the topology map or a CI in the CI Selector. In the
Advanced Pane, select theProperties tab and click Edit.

l Select a CI or relationship in the topology map or a CI the CI Selector and click

theShow CI Properties button.

l Right-click a CI or relationship in the Topology map or a CI in the CI Selector
and select Properties.
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Important
information

The Configuration Item Properties dialog box contains two types of properties:

l General properties, which include general information about the CI or
relationship. These properties are common to all CITs and are documented
below.

l CIT-specific properties, which include properties specific to that CI. These
properties vary according to the type of CI or relationship and are not
documented.

When you sort the properties by category, the CIT-specific properties appear at
the top of the list and the general properties appear at the bottom.

You can view a description of the selected property in the Description Area at the
bottom of the dialog box. Click theShow/Hide Description Area button to
display the Description Area.

Mandatory fields are denoted by an asterisk.

Note: HP Universal CMDB does not fully support surrogate pairs and
combining characters.

See also l "CI Lifecycle and the AgingMechanism" in theHP Universal CMDB
Administration Guide

l "Working with CIs" on page 183

l "IT UniverseManager User Interface" on page 201

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

Categorized. Displays the properties by category.

Alphabetic. Displays the properties alphabetically.

Show/Hide Description Area. Toggles between showing and hiding the
description area at the bottom of the CI Properties dialog box.

Expand. Expands the properties tree when the properties are displayed by
category.

Collapse. Collapses the properties tree when the properties are displayed by
category.
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UI Element
(A-Z) Description

Export Data To File. Enables you to export the table data. Choose the export
format from the following options:

l Excel. The table data is formatted as an .xls (Excel) file that can be displayed
in a spreadsheet.

l PDF. The table data is exported in PDF format.

Note:When exporting to PDF, select a reasonable number of columns to
display to ensure that the report is legible.

l RTF. The table data is exported in Rich Text Format.

l CSV. The table data is formatted as a comma-separated values (CSV) text file
that can be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the comma (,)
must be defined as the list separator. InWindows, to verify or modify the
list separator value, open Regional Options from the Control Panel, and on
the Numbers tab ensure that the comma is defined as the List Separator
value. In Linux, you can specify the list separator in the application that
opens the CSV file.

l XML. The table data is formatted as an XML file that can be opened in a text or
XML editor.

Tip: To extract HTML code from the report:

n Open the file in an HTML editor

n Copy the relevant table into the target file
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UI Element
(A-Z) Description

<Quick
filter>

Enter a string in the Quick filter box to filter the property names and values. Click
the left end of the box to open the drop-downmenu of filter options:

l Select All to search for the filter string in both property names and property
values. Select Name to search for the filter string in property names only.
Select Value to search for the filter string in property values only.

l Select Case sensitive to search for the filter string exactly as entered. Select
Case insensitive to ignore the case of the filter string.

l Select Use wild cards to use the wildcard symbol * in the filter string.

l SelectMatch from start to search for the filter string at the beginning of a
property name or value. SelectMatch exactly to search for the exact filter
string. Select Match anywhere to search for the filter string anywhere in the
properties.

Actual
Deletion
Period

The number of days after which the CI or relationship is deleted.

Allow CI
Update

When selected, this option allows the DFM process to automatically update the
CI or relationship properties with information that it discovers. If you change the
value of a property supplied by the DFM process, the value is overridden by the
discovered value.

When this option is cleared, the CI or relationship properties are not overridden by
the DFM process.

Apply Click Apply to save the changes made to the CI or relationship properties.

CI Type The type of the CI or relationship (read-only value). For information about CITs in
HP Universal CMDB, see "CI TypeManager" on page 448.

Created By The user name of the administrator whomanually created the CI or relationship,
where applicable (read-only value).

Create
Time

The date and time when the CI or relationship was created.

Deletion
Candidate
Period

The period after which the CI becomes a candidate for deletion when the aging
mechanism is enabled.

Description A brief description of the CI or relationship.

Display
Label

The name of the CI or relationship as it appears in the CI Selector.
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UI Element
(A-Z) Description

Edit In the Properties tab of the Advanced pane, you can view aCI's properties but you
cannot edit them. Click Edit to open the Configuration Item Properties dialog box
where you can edit the properties.

Enable
Aging

If a CI or relationship is not updated or refreshed over a period of time (for
example, a CI is not rediscovered by DFM and nomanual update occurs), an
agingmechanism deletes the CI from the CMDB. For details, see "The Aging
Mechanism Overview" in theHP Universal CMDB Administration Guide.

True: the agingmechanism is enabled for this CI or relationship.

False: the agingmechanism is disabled for this CI or relationship.

Note:

l If the agingmechanism is disabled in Aging Status, this field is ignored.

l This field is displayed for certain CIs only.

l The default value is determined by the default value of theEnable Aging
attribute for the CI type of the selected CI.

Global Id The internal ID of the CI or relationship in the CMDB (read-only value).

Last
Access
Time

The time that the CI or relationship was last accessed, whether when being
updated or being discovered by DFM. This field is only displayed for certain CIs or
relationships.

This parameter is used by the agingmechanism. For details, see "CI Lifecycle
and the AgingMechanism" in theHP Universal CMDB Administration Guide.

Note: By default, this property is updated every time the CI is touched by a
running discovery job or integration. To prevent this property from being
updated by a discovery job or integration, go to the Data Flow Management
module, and in theAdapter Management > Adapter Configuration tab,
clear theUpdate last access time option. For more details, see "Adapter
Configuration Tab" in theHP Universal CMDB Data Flow Management
Guide.

Last
Modified
Time

The date and time when the CI or relationship properties were last updated.

Name The name of the CI or relationship.

Note Enables you to enter other information about the CI or relationship.
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UI Element
(A-Z) Description

Origin An ID for the source that automatically created the CI or relationship, or the
application where the CI or relationship was created (read-only value).

Reset Click theReset button to restore the original property settings of the CI or
relationship.

Updated by The user name of the administrator who updated the CI or relationship properties.

User Label Enables you to define a display label for the CI or relationship. If no value is
entered, the CI name appears as the default label.

Shortcut Menu

Menu Item Description

Copy Property
Name and Value

Copies the name and value of the selected property to thememory.

Generate Sub Report Dialog Box
This dialog box enables you to generate a Sub Report for the selected CI.

To access In IT UniverseManager, right-click a CI in the topology map or the CI Selector and
select Generate Sub Report.

Important
information

A SubReport enables you to apply a perspective to a selected CI and view the
results in report format. Select a perspective from the list and click OK. The Sub
Report opens in a separate window.

See also l "IT UniverseManager Overview" on page 180

l "IT UniverseManager User Interface" on page 201

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

<List of available perspectives> The list includes only perspectives that are designated as a
Sub Report perspective in its Report Properties. Only
perspectives matching the selected CI type are displayed.

Description A description of the selected perspective.

Get Related CIs From CMDB Dialog Box
This dialog box enables you to view the CIs related to a specified CI in the CMDB inmap or table
format.
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To access In IT UniverseManager, right-click the required CI and select Get Related CIs.

Important
information

TheGet Related CIs From CMDB dialog box is a standalone version of the
Related CIs tab in IT UniverseManager. You can control the content of the
display using the features in the Get Related CIs pane. For details, see "Get
Related CIs Pane" on page 227.

You cannot select the scope of the related CIs displayed in the Get Related CIs
From CMDB dialog box. The scope is the entire CMDB.

Note: The text mode format includes the icons found in the CI Instances
dialog box. For details, see "CI Instances Dialog Box" on page 64.

Relevant
tasks

"How to View Related CIs" on page 192

See also l "IT UniverseManager Overview" on page 180

l "IT UniverseManager User Interface" on page 201

Insert Relationship Dialog Box
This dialog box enables you to attach CIs to the CI you selected in the CI Selector.

To access In IT UniverseManager, right-click a CI in the Topology Map or the CI Selector,
and select Relate to CI.

Important
information

To create a relationship between two CIs, select the source CI in the CI Selector
or the Topology Map and then select Relate to CI from the shortcut menu. On the
first page of the dialog box (the CI Selection page), you select the target CI(s).
Then click Relationship, to select the relationship type on the second page of the
dialog box.

You can also create a relationship between two CIs graphically by clicking the

Create Relationship button in the toolbar and drawing a line between the two
CIs. In this case, a smaller version of the Insert Relationship dialog box opens,
which contains the following tabs:

l Select Relationship. Displays a tree with the available relationship types.
Select the required relationship.

Note: You can double-click the relationship you select to save using the
default properties.

l Relationship Properties. Displays the properties of the selected relationship.
You can edit the properties as described in "Define Relationship Properties
Pane" on page 215.
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Relevant
tasks

"How to Create CIs and Relationships" on page 191

See also l "CI Selector" on page 133

l "Relationship Page" below

User interface elements are described below:

UI Element
(A-Z) Description

Adds the selected CIs in the left pane to the Target CIs pane.

Removes the selected CIs from the Target CIs pane (this does not delete the
CIs from the CMDB).

Select target
CIs

Select a view to display in the view tree and select CIs tomove to the Target
CIs pane.

For details on theSelect target CIs pane, see "CI Selector" on page 133.

Source CI The CI you selected as the source CI.

Target CIs Displays the CIs you have selected as target CIs for the relationship.

Relationship Page

This page enables you to define the relationship to be created between the original CI and the CIs
selected in the CI Selection page of the dialog box.

To access Click theRelationship button from the Insert Relationship dialog box.

Important
information

When definingmultiple relationships, you can define different descriptions and
property values for each relationship. Skip the property definitions here and edit
each relationship individually after it is created.

User interface elements are described below:

Select Relationship Pane

UI Element
(A-Z) Description

Direction Select the direction of the relationship.

For some relationship types (for example, Composition, or between a group CI
and amonitor CI), only one direction is valid.
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UI Element
(A-Z) Description

Relationship Define the type of relationship created between the original CI and the CIs being
attached. Select an option from the list.

Source CI Displays the name of the CI on the first end of the relationship. This is the CI that
you selected in the view.

Target CI Displays the name of the CI on the second end of the relationship, that is
attached to the original CI.

Define Relationship Properties Pane

UI Element
(A-Z) Description

Actual
Deletion
Period

The period after which the relationship is deleted when the agingmechanism is
enabled.

Allow CI
Update

When the value is set to true, the DFM process automatically updates the
relationship.

Created By The user name of the administrator whomanually created the relationship, where
applicable.

Create
Time

The date and time when the relationship was created.

Deletion
Candidate
Period

The number of days after which the relationship becomes a candidate for deletion.

Description A detailed description of the relationship.

Destination
Network
Address

Defined only for route links. Indicates the destination network address to which
this route is configured.
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UI Element
(A-Z) Description

Enable
Aging

If a CI or relationship is not updated or refreshed over a period of time (for
example, a CI is not rediscovered by DFM and nomanual update occurs), an
agingmechanism deletes the CI from the CMDB. For details, see "CI Lifecycle
and the AgingMechanism" in theHP Universal CMDB Administration Guide.

True: the agingmechanism is enabled for this CI or relationship.

Default value: false. The default value for DFM CIs is true.

Note:

l If the agingmechanism is disabled, this field is ignored.

l This field is only displayed for certain CIs.

Last
Access
Time

The time that the relationship was last accessed, whether when being updated or
being discovered by DFM. This field is only displayed for certain CIs.

This parameter is used by the agingmechanism. For details, see "CI Lifecycle
and the AgingMechanism" in theHP Universal CMDB Administration Guide.

Last
Modified
Time

The date and time when the relationship properties were last updated.

Must When the value is set to true, the child CI is dominant when the percentage rule is
used to calculate status for the parent CI. If the CI has low status, the parent must
take the child CI status, if necessary overriding the percentage rule calculation.
This is useful to give emphasis to an important CI. For example, youmight want
to defineMust for a database CI, so that status is critical all the way up the
subtree if the database falls, regardless of the status of the other CIs in the
subtree.

Themust status defined for a relationship applies for that relationship only – it is
not used in any other relationships of the child CI. This field is only relevant when
working with HP Business ServiceManagement.

Name A brief description of the relationship. If no value is entered, the relationship type
is used in place of the name.

Note Enables you to enter other information about the relationship.

Origin An ID for the source that automatically created the relationship, or the application
where the relationship was created.

Updated
By

The user name of the administrator who updated the CI properties.
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UI Element
(A-Z) Description

User Label Enables you to define a display label for the relationship. If no value is entered, the
relationship name appears as the default label.

Weight When aweight value is entered, the child CI is givenmore weight in percentage
calculations, when percentage rule is used to calculate status for the parent CI.
For example, if a child CI is given a weight of 3, then it has three times more
impact on the parent status calculation than its unweighted siblings.

The weight defined for a relationship applies for that relationship only – it is not
used in any other relationships the child CI may have. This field is only relevant
when working with HP Business ServiceManagement.

IT Universe Manager Page
This page enables you to define andmanage the CIs and relationships in your views.

To access Select IT Universe Manager from the NavigationMenu or selectManagers >
Modeling > IT Universe Manager.

Important
information

The IT UniverseManager page contains the following panes:

l CI Selector. Displays the CIs of a selected view. You can select the view
from a drop–down list or search for a specific CI. For details, see "CI Selector"
on page 133.

l Topology Map. Displays the CIs of a selected view inMapmode or Text
mode.

l Advanced Pane. Displays properties, history, and discovery for the selected
CI or view.

l Get Related CIs. This pane can be accessed from the Related CIs tab of the
Topology Map. It controls the content of the display in the tab.

In IT UniverseManager, you can create new CIs, modify existing CIs, or delete
CIs. All of these actions have a direct effect on the entire IT Universemodel. For
example, if you delete a CI in your view, that CI is deleted from the IT Universe
model and no longer appears in any view.
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Relevant
tasks

l "How to Create CIs and Relationships" on page 191

l "How to Print and Save a Topology Map to File" on page 201

l "How to Check the Status of Application Discovery (Rediscover a View)" on
page 193

l "How to Retrieve Impact Analysis Results – Scenario" on page 195

l "How to Take a Snapshot of a View" on page 201

l "How to View Related CIs" on page 192

See also l "IT UniverseManager Overview" on page 180

l "Working with Views in IT UniverseManager" on page 181

l "CI Selector" on page 133

l "Topology MapOverview" on page 146

l "IT UniverseManager User Interface" on page 201

Topology Map
This area displays the CIs of the currently selected view in graphical or table format. By default, the
CIs are displayed in graphical format.

To access SelectManagers > Modeling > IT Universe Manager.

Important
information

You can customize the Topology Map shortcut menu to include other commands
(for example, ping, run a program, open a URL) from within CI TypeManager. For
details, see "Create Configuration Item Type/Relationship/Calculated
RelationshipWizard" on page 466.

Note: For grouped CIs and the relationships between them, not all of the
shortcut menu options are active. Grouped CIs appear in parentheses in the
CI Selector and in the Topology Map. You can double-click a link to a grouped
CI to open the Link Map, which displays the individual CIs and relationships.
Right-click a CI or relationship in the Link Map to display the regular shortcut
menu. For details about grouping CIs, see "Query NodeGrouping Dialog
Box" on page 312.

See also "Working with Topology Map" on page 146

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element (A-Z) Description

Map mode Map. Displays the selected layer of CIs in topology map format.

Note: If the selected layer of the view is too large to display in
topology map format, a message appears with a link to display
the layer in text format.

Text mode Text. Displays the attribute properties of the CIs in the selected
layer in table format.

For details on some of the toolbar icons in Text Mode, see "CI
Instances Dialog Box" on page 64.

Specify the CIT you want displayed in the table. The table also
includes the children of the selected CIT.

Note: This option is displayed in Text mode only.

<Breadcrumbs> At the top of the topology map, the breadcrumbs indicate the
relevant query nodes in each layer of the view for the path to the
selected layer. The first item in the path is the Top Layer. When
you select a CI from the layer below, the parent CI forms the next
item in the breadcrumb path. You can click on any item in the path
to display that layer in the topology map.

<CI type attributes> The columns appearing in Text mode represent the CIT attributes
of the selected CIs.
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UI Element (A-Z) Description

<Group by> The CIs in the topology map are displayed according to the default
grouping selected in the view definition. When consuming the view
in IT UniverseManager, you canmanually select a different
groupingmethod. The available options are:

l Group by Layer. Group the CIs according to the value of the
layer attribute of their CI type.

l Group by CI Type. Group the CIs according to their CI type.

l Group by Classification. Group the CIs according to the value
of the classification attribute of their CI type.

l No Grouping. Do not group CIs.

Note:

l This option is available in Mapmode only.

l When a grouping option is selected, each group contains an
indicator displaying the number of CIs in the group. If a
group contains a large number of CIs, it opens in collapsed
format, displaying only the name and count indicator. Click
the + sign button to expand the group and display all the
CIs. You can set the threshold of CIs for automatically
collapsing the group by modifying the Initially expand
group max CIs threshold setting in the Infrastructure
Settings Manager.

<IT Universe Status Bar> The status bar below the topology map indicates the status of the
following processes:

l if Impact Analysis is active or not

l if Change Timeframe is active or not

l if Candidates for Deletion are shown or not

l the time of the last update of the data
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UI Element (A-Z) Description

<Legend> Indicates the icons displayed next to CIs with any of the following
special statuses:

l Added.WhenChange Timeframe is active, indicates that the
CI was added.

l Candidate for Deletion. Indicates that the CI is a candidate for
deletion.

l Changed.WhenChange Timeframe is active, indicates that
the CI was changed.

l Drill Down One Layer. Indicates that there are CIs under the
CI on a lower layer.

l External. Indicates that the CI is a federated CI.

l Impacted.When Impact Analysis is active, indicates an
impacted CI.

l Impacted and Trigger.When Impact Analysis is active,
indicates a trigger CI that is impacted.

l Note. Indicates that a note was added for the CI.

l Trigger.When Impact Analysis is active, indicates a trigger CI.

<Main Menu> For details, see "MainMenu" on page 163.

<Query Node> The query nodes in the topology map represent CIs.

Hold the pointer over a query node to display its tooltip which
describes the type of the CI.

<Relationship> The links in the topology map represent relationships.

Hold the pointer over a relationship to display its tooltip, which
describes the type of the relationship.

Note:When you select a calculated relationship, theDelete

button in the toolbar is disabled.
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UI Element (A-Z) Description

<Toolbar> For details, see "Toolbar Options" on page 167.

Note:When accessing the Topology map via direct links, the
toolbar includes options from the Related CIs Map. For details,
see "Get Related CIs From CMDB Dialog Box" on page 212.

<Tooltip> Hold the pointer over a CI to display a tooltip which shows CI data.
The tooltip displays all attributes for the CI which aremarked with
one of the following qualifiers:

l Comparable

l Asset Data

l Managed

When you hold the pointer over a count indicator, the tooltip
displays the breakdown of the CIs under it by CI type. When a
grouping option is selected, hold the pointer over the group to
display a tooltip showing the breakdown of CIs in the group by
CI type.

<Topology Map
Sidebar>

For details, see "Topology Map Sidebar" on page 176.

Related CIs Click theRelated CIs tab to display the interdependencies of the
selected CI within the view or the entire CMDB. You can control
the scope of the display from theGet Related CIs pane.

View Results Click theView Results tab to display an entire layer within a view.

IT Universe Manager Shortcut Menu

The IT UniverseManager page includes the following elements (listed alphabetically) available by
right-clicking a CI or relationship in the CI Selector pane or the Topology Map:
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Menu Item Description

Actions Select one of the following options:

l Add CI to Discovery Job. Displays the Add CI to Discovery Job dialog
box, which enables you tomanually invoke a DFM job for the selected
CI. You can use this option to discover additional information about the
CI through one of the available DFM jobs.

l Remove CI from Discovery Job. Displays the Remove CI from
Discovery Job dialog box, which enables you tomanually remove a CI
from the DFM job.

l Show Discovery Progress. Opens the Discovery Progress dialog box
for the selected CI.

l Recently Discovered By. Opens the Recently Discovered By dialog
box for the selected CI.

l Open CI Credentials. Displays theProtocol Parameter dialog box,
which enables you to view the details of a previously-defined credential
for that CI. You cannot make any changes. This option is only relevant
for CIs that include a credentials property.

For details, see "Protocol Parameter Dialog Box" in theHP Universal
CMDB Data Flow Management Guide.

l Edit CI Credentials. Displays theChoose Credentials dialog box,
which enables you to choose another credentials set or edit the existing
credentials. This option is only relevant for CIs that include a credentials
property.

For details, see the supported protocols in theHP UCMDB Discovery
and Integrations Content Guide.

l Reprocess Scan File. Reprocesses the scan files for the selected
node.

Note: This option is only available for CIs of type node or its
subtypes.

Add CIs to
Model

Adds selected CIs to a new or existingmodel.

Add CIs to View Adds selected CIs to a new or existing perspective based view.
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Menu Item Description

Assign Tenants Open the Assign Tenants dialog box which enables you to assign tenants to
the CI.

Note: This option is only available whenmulti-tenancy is enabled.

CI/Relationship
History

Displays the CI History dialog box. For details, see "CI/Relationship
History Dialog Box" on page 204.

Compare CIs
Report

Run aCompare CIs Report for the selected CI. For details, see "Compare
CIs Report" on page 361.

Note: This option is only active when one or two CIs are selected.

Delete from
CMDB

Enables you to delete the selected CI or relationship from the view and from
the CMDB.

Note:When you delete a parent CI, the selected CI and its children are
removed from the view, but only the selected CI is removed from the
database.

Generate Sub
Report

Opens theGenerate Sub Report dialog box, which enables you to select
perspectives for the CI to create a Sub Report. For details, see "Generate
Sub Report Dialog Box" on page 212.

Get Related CIs Opens theGet Related CIs from CMDB dialog box. For details, see "Get
Related CIs From CMDB Dialog Box" on page 212.

Label Select one of the following options:

l Edit Label. Opens the Edit Label dialog box which enables you to edit
the name of the CI.

l Restore Default Label. Resets the CI name to its default value from the
CMDB.
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Menu Item Description

Merge CIs Opens theMerge CIs dialog box enabling you tomanually merge Running
Software, Node, and Business Element CIs.

In theMerge CIs dialog box, select one of the CIs to be themain CI. The
other CIs, themerging CIs, aremerged into themain CI. CIs aremerged
as follows:

l Properties from themerging CIs that do not exist in themain CI are
copied to themain CI.

l Properties that exist in both themain andmerging CIs aremerged
according to the defined reconciliation priority:

n If all the CIs have the same priority, then themain CI's property is
retained.

n If the CIs have different priorities, the property of the CI with the
higher priority is used.

After themerge, the Global ID of themain CI remains, and themerging CIs
are deleted.

Note:

l This option is only relevant when at least two CIs of type Running
Software, Node, or Business Element are selected. CIs can only be
merged if their CI types are on the same branch in the Class Model.

l When youmerge CIs, the topologies of the views that contain those
CIs are updated.

Example:
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Menu Item Description

Note Select one of the following options:

l Add Note. Opens an editing box where you can add a note to the CI.

l Delete Note. Deletes all text saved in a note for the selected CI.

Open
UCMDB Browser

Opens the UCMDB Browser.

Note: This option is only available when a single CI is selected. It is
not relevant for relationships.

Properties Displays the Properties page for the selected CI or relationship. For details,
see "Configuration Item Properties Dialog Box" on page 207.

Relate to CI Opens the Insert Relationship dialog box. For details, see "Insert
Relationship Dialog Box" on page 213.

Run Impact
Analysis

Enables you to run the Impact rule you defined in the Impact Analysis
Manager. Displays the Run Impact Analysis dialog box. For details, see
"Impact Analysis Manager" on page 430.

Note: You can only see Impact Analysis results if you defined an
Impact rule for that view in Impact Analysis Manager.

Show
Compound Path

Appears only for compound relationships. Displays the Link Map for the
selected relationship, which shows the CIs involved in the compound
relationship.

Show Impact Enables you to select a CI that is defined by an Impact rule as a root cause
CI, and to display all the CIs that are impacted by it, and their statuses, in a
separate window.

This option appears only after the following has occurred:

l You defined an Impact rule for the selected view in Impact Analysis
Manager (for details, see "Impact Analysis Manager" on page 430).

l You clickedShow in Views in the Run Impact Analysis dialog box.

l Impact Analysis results appear in the Topology Map.

For example, suppose an Impact rule is defined (for an IP AddressCI) that
specifies that the rule impacts nodes, ports, and client-servers linked to the
IP Address.

By using theShow Impact option, you can display all CIs that are impacted
by the IP AddressCI.
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Menu Item Description

Show Root
Cause

This option enables you to retrieve root cause information for CIs that are
impacted by a chain of Impact rules. The output of Show Root Cause
displays a logical map that describes a chain of trigger/impacted CITs that
impact the CI.

The root cause CI is displayed in a separate window. If only one Impact rule
is defined for this CI, the Impact Analysis window is directly displayed.

This option appears only after the following has occurred:

l You defined an Impact rule for the selected view in the Impact Analysis
Manager (for details see, "Impact Analysis Manager" on page 430).

l You clickedShow in Views in the Run Impact Analysis dialog box.

l Impact Analysis results appear in the Topology Map.

A window is displayed containing the root cause CI and all the other CITs in
the Impact rule chain.

To view the information about specific CIs that are triggered or impacted by
the Impact rule, double-click the relationship connecting the CIs. A map is
displayed.

Advanced Pane
User interface elements are described below:

UI
Element
(A-Z) Description

Discovery
tab

Displays the discovery progress for the selected CIs. For details, see "Discovery
Progress Dialog Box" in theHP Universal CMDB Data Flow Management Guide.

History
tab

Displays the history for the selected CI. For details, see "CI/Relationship History
Dialog Box" on page 204.

Properties
tab

Displays the selected CI's properties (the same properties that appear in the
Configuration Item Properties dialog box). You can view the properties in the
properties tab, but youmust open the dialog box to edit the properties. For details,
see "Configuration Item Properties Dialog Box" on page 207.

Get Related CIs Pane
This pane enables you to control the different options for viewing related CIs for a selected CI.
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To access Appears in the Related CIs tab of IT UniverseManager. If it is hidden, click the

Show Get Related CIs pane button in the toolbar to display it.

Important
information

You can control the display in the Related CIs tab with the following controls:

l Set the scope of the display

l Filter the related CIs by CI type

l Apply perspectives to the selected CI

It is possible to display related CIs for several CIs at the same time. Hold down
theCTRL key to select multiple CIs at the same time in the CI Selector or the
topology map.

Note: You can select to run the Get Related CIs search over integrated CIs
also. If the search results include CIs from a federated data source, they
appear in the topology mapwith an arrow icon, indicating that they are
federated CIs However, you cannot display related CIs of a federated CI.

Relevant
tasks

"How to View Related CIs" on page 192

User interface elements are described below:

UI Element
(A-Z) Description

Back. Displays the previous search results.

Forward. Display the next search results.

Clear Current Display.When the button is selected, the related CIs are added
to the current results. When it is not selected, the current display content is
cleared and only the new related CIs are displayed.

Display search results with/without grouping.When the button is selected,
the related CIs are displayed with the hierarchical grouping of the applied
perspective. When it is not selected, the related CIs are displayed without any
grouping.
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UI Element
(A-Z) Description

Select Target Integration Points. Enables you to include integrated CIs in your
search results. Select the required integration points from the pop-up dialog box.

Note: If you select a disconnected integration point for your search, an error
message appears when the search is run, asking if you want to see local
search results.

Apply
perspectives
to CI

Select perspectives from the list to apply to the selected CI. Only perspectives
relevant to the selected CI appear in the list. The selected CI is used as content
for the selected perspectives and the view results are displayed.

Note: Application of perspectives is only relevant whenCMDB is selected
as the scope. The feature is inactive whenView is selected as the scope.

Filter
Related CIs
by CI Type

Select the CI types from the list to display in the related CI results. Only the
selected CI types appear in the displayed results.

Select
scope

Select the scope of the related CIs displayed:

l View. All related CIs in the selected view.

l CMDB. All related CIs in the CMDB.

Note: This feature is not available in the Get Related CIs from CMDB dialog
box opened from the shortcut menu.

Show
Related CIs

Click to display the related CIs according to your selection.

New CI/New Related CI Dialog Box
This dialog box enables you to define a new CI or a new related CI.

To access In IT UniverseManager, click theNew CI button in the toolbar to create a
non-related CI. Select a CI in the topology map and click theNew Related CI

button to create a related CI.
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Important
information

To define a new CI, select the CI type from the tree at the top of the dialog box.
The CI types in the tree that are available to be instantiated appear in black. The
CI types in faded text cannot be instantiated.

Edit the properties in the Define new CI properties area. The table below includes
the properties which are common to all CIs. In addition, there are other properties
specific to each CI.

If you are creating a related CI, click Relationship to go to the relationship mode
of the dialog box. Select a relationship and edit its properties.

Relevant
tasks

"How to Create CIs and Relationships" on page 191

See also l "CI Selector" on page 133

l "Relationship Dialog Box" on page 232

l "CI Lifecycle and the AgingMechanism" in theHP Universal CMDB
Administration Guide

User interface elements are described below:

UI Element
(A-Z) Description

Actual
Deletion
Period

The period after which the CI is deleted when the agingmechanism is enabled.

Allow CI
Update

When the value is set to true, this option enables the DFM process to
automatically update the CI properties with information that it discovers. If you
change the value of a property supplied by the DFM process, the value is
overridden by the discovered value.

When the value is set to false, the CI properties are not overridden by the DFM
process.

Created By The user name of the administrator whomanually created the CI, where
applicable.

Create Time The date and time when the CI was created.

Deletion
Candidate
Period

The period after which the CI becomes a candidate for deletion when the aging
mechanism is enabled.

Description A description of the CI.

Display
Label

The label that appears for the CI in the topology map.
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UI Element
(A-Z) Description

Enable
Aging

If a CI or relationship is not updated or refreshed over a period of time (for
example, a CI is not rediscovered by DFM and nomanual update occurs), an
agingmechanism deletes the CI from the CMDB. For details, see "The Aging
Mechanism Overview" in theHP Universal CMDB Administration Guide.

True: the agingmechanism is enabled for this CI.

False: the agingmechanism is disabled for this CI.

The default value is determined by the default value of theEnable Aging
attribute of the CI type.

Note:

l If the agingmechanism is disabled in Aging Status, this field is ignored.

l This field is displayed for certain CIs only.

l You can change the default value for all new CIs of this type by editing
the default value of theEnable Aging attribute for this CI type. For
details, see "How to Enable and Run the AgingMechanism" in theHP
Universal CMDB Administration Guide.

Is Candidate
For Deletion

Indicates if the CI is a candidate for deletion.

Last Access
Time

The time that the CI was last accessed, whether when being updated or being
discovered by DFM. This field is displayed only for certain CIs.

This parameter is used by the agingmechanism. For details, see "CI Lifecycle
and the AgingMechanism" in theHP Universal CMDB Administration Guide.

Last
Modified
Time

The date and time when the CI properties were last updated.

Name The name of the CI.

Note Enables you to enter other information about the CI.

Origin An ID for the source that automatically created the CI, or the application where
the CI was created.

Relationship For a related CI, click Relationship to go to the relationship mode of the dialog
box.
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UI Element
(A-Z) Description

Select CI
Type

Enables you to select the CI type from the tree for the new CI. The CI types that
are available for the selected CI or view appear active in the CI type tree. The
other CI types appear in faded text and cannot be selected.

To limit the CI type tree to CI types from the current view, select CI Types from
the current view on the right. To display all CI types in the tree, select All CI
Types.

Updated By The user name of the administrator who updated the CI properties.

User Label Enables you to define a display label for the CI. If no value is entered, the CI
name appears as the default label.

Relationship Dialog Box

This page enables you to define the relationship between the new CI and the CI selected in the
view, as well as the properties of the relationship.

To access Click Relationship from the New Related CI dialog box.

Important
information

This page only appears for new related CIs.

User interface elements are described below:

UI Element
(A-Z) Description

Allow CI
Update

When the value is set to true, the DFM process automatically updates the
relationship.

CI Definition CI Definition. Returns to the CI properties mode of the dialog box.

Created By The user name of the administrator whomanually created the relationship, where
applicable.

Create Time The date and time when the relationship was created.

Description A description of the relationship.

Direction Select the relationship direction from the drop-down box.
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UI Element
(A-Z) Description

Enable
Aging

If a CI or relationship is not updated or refreshed over a period of time (for
example, a CI is not rediscovered by DFM and nomanual update occurs), an
agingmechanism deletes the CI from the CMDB. For details, see "The Aging
Mechanism Overview" in theHP Universal CMDB Administration Guide.

True: the agingmechanism is enabled for this relationship.

False: the agingmechanism is disabled for this relationship.

The default value is determined by the default value of theEnable Aging
attribute of the CI type.

Note:

l If the agingmechanism is disabled in Aging Status, this field is ignored.

l This field is displayed for certain relationships only.

l You can change the default value for all new relationships of this type by
editing the default value of theEnable Aging attribute for this
relationship type. For details, see "How to Enable and Run the Aging
Mechanism" in theHP Universal CMDB Administration Guide.

Last Access
Time

The time that the relationship was last accessed, whether when being updated or
being discovered by DFM. This field is only displayed for certain relationships.

This parameter is used by the agingmechanism. For details, see "CI Lifecycle
and the AgingMechanism" in theHP Universal CMDB Administration Guide.

Must When the value is set to true, the child CI is dominant when the percentage rule
is used to calculate status for the parent CI. If the CI has low status, the parent
must take the child CI status, overriding the percentage rule calculation if
necessary. This is useful to give emphasis to an important CI. For example, you
might want to defineMust for a database CI, so that status is critical all the way
up the subtree if the database falls, regardless of the status of the other CIs in
the subtree.

TheMust status defined for a relationship applies to that relationship only – it is
not used in any other relationships of the child CI. This field is only relevant when
working with HP Business ServiceManagement.

Name The name of the CI.

Network
Address

Defined only for route links. Indicates the destination network address to which
this route is configured.

Note Enables you to enter other information about the CI.
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(A-Z) Description

Origin An ID for the source that automatically created the relationship, or the application
where the relationship was created.

Relationship Enables you to define the type of relationship that is created between the two
CIs.

Source CI The name of the CI on the first side of the relationship. This is the CI that you
selected in the view.

Target CI The name of the CI on the second side of the relationship. This is the new CI that
you are creating.

Updated By The user name of the administrator who updated the relationship properties.

Update Time The date and time when the CI properties were last updated.

User Label Enables you to define a display label for the relationship.

Weight When aweight value is entered, the child CI is givenmore weight in percentage
calculations, when the percentage rule is used to calculate status for the parent
CI. For example, if a child CI is given a weight of 3, then it has three times more
impact on the parent status calculation than its unweighted siblings.

The weight defined for a relationship applies to that relationship only – it is not
used in any other relationships of the child CI. This field is only relevant when
working with HP Business ServiceManagement.

Recently Discovered By Dialog Box
This dialog box displays the discovery jobs that discovered the selected CI within the specified
time period.

To
access

In IT UniverseManager, right-click a CI and select Actions > Recently Discovered
By from the shortcut menu.

User interface elements are described below:

UI Element
(A-Z) Description

Refresh. Refreshes the data.

Discovered
On

The date the CI was discovered by the discovery job.
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UI Element
(A-Z) Description

From Date Select the time period to check for jobs that discovered the selected CI. You can
select Custom and a specific date to search all discovery jobs from that date until
now.

Job Name The name of the job that discovered the selected CI.

Probe The probe on which the CI was discovered.

Trigger CI The trigger CI for the discovery job.

Run Impact Analysis Dialog Box
This dialog box enables you to run the Impact rule you defined in Impact Analysis Manager for that
view.

To access SelectManagers > Modeling > IT Universe Manager. Right-click a trigger
query node in the Topology Map and select Run Impact Analysis or click the

Run Impact Analysis Now button in the IT Universe status bar.

Important
information

You can:

l Display in a new window all the CIs that are impacted by the trigger CI. The
relationships in themap represent the Impact rules. The name of the
relationship is the name of the Impact rule you defined in the Impact Analysis
Manager. For details, see "Show Map" on page 237.

l Simulate how the statuses of the impacted CIs are impacted. For details, see
"Show in Views" on the next page.

l Generate a report that displays a list of CIs that are impacted in the system as
a result of the simulated changes. For details, see "Generate Report" on the
next page.

Note: This dialog only appears if an Impact rule is defined for that view. For
details, see "Impact Analysis Manager" on page 430.

Relevant
tasks

"How to Retrieve Impact Analysis Results – Scenario" on page 195

See also l "IT UniverseManager Overview" on page 180

l "Impact Analysis Manager Overview" on page 430

l "IT UniverseManager User Interface" on page 201

User interface elements are described below:
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UI Element (A-Z) Description

All Impact rules Select to execute all impact rules in the system in the impact analysis.

Generate Report Generates an Impact Analysis report, which displays information that is
divided as follows:

l Grouping by CIT. All the impacted CIs (the CIs that are impacted in
the system as a result of the simulated changes), sorted by CIT.

l Affected Application. All the impacted CIs that belong to a specific
business service.

l Triggered CIs. The CIs that represent the changes you want to
make to the system.

For details on the Impact Analysis report, see "Impact Analysis Report"
on page 384.

Impact rules bundle Select the bundle containing the required impact rules for the impact
analysis.

Only Impact rules
located in specified
bundle

Select to execute the impact rules from the specified bundle in the
impact analysis.

Show in Views Simulates how the statuses of the impacted CIs are impacted for the
selected state. The Topology Map displays the statuses of the trigger
CIs as well as all statuses of the CIs that are impacted by it.

The Topology Map also displays the Impact Analysis indicators:

l A trigger CI is marked by this indicator: .

l A CI that is both an impacted and a trigger CI is marked by this

indicator: .

l An impacted CI is marked by this indicator: .

Note: The statuses that appear here and the colors that represent
each status are defined in the severity list for that state in the
System TypeManager. For details, see "Create/Update
List/Enumeration Definition Dialog Box" on page 482.
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UI Element (A-Z) Description

Show Map Enables you to select an Impact rule, and then display in a new window,
a simulation of all the CIs that are impacted by the trigger CI for the
selected state. If only one Impact rule is defined for this CI, the Impact
Rules window is displayed directly. For more details, see "Show Impact
Pane" on page 239.

The relationships in themap represent the Impact rules and the name of
the relationship is the name of the Impact rule you defined in the Impact
Analysis Manager.

Note: Show Map enables you to view the results of multiple
triggers.

Trigger Severity Select the required severity on the scale.

Note: The severity scale was defined for the state in the System
TypeManager. For details, see "System TypeManager" on page
451.

For example, you can create an Impact rule in the Impact Analysis
Manager that defines the severity of the trigger query node as other than
Warning (1). If you select a severity other thanWarning (1), for
example,Minor (3), the condition is met and the simulated changes in
the system are triggered.

For details, see the "Impact Rules Definition Dialog Box" on page 442.

Save Snapshot Dialog Box
This dialog box enables you to take a snapshot of a view and save it.

To access In IT UniverseManager, click theSnapshot button in the CI Selector and
select Save Snapshot.

Important
information

You can compare snapshots of the same view taken at different times using the
Compare Snapshots Report. For details, see "Compare Snapshots Report" on
page 366.

Relevant
tasks

l "How to Take a Snapshot of a View" on page 201

l "How to Compare Snapshots" on page 337

See also l "IT UniverseManager Overview" on page 180

l "IT UniverseManager User Interface" on page 201

User interface elements are described below:
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UI Element (A-
Z) Description

Description A description of the snapshot (optional).

Note A note about the snapshot (optional).

View Name The name of the view as it appears in the CI Selector. This field cannot be
edited.

Show Discovery Status and Changes Dialog Box
This dialog box enables you to find recent changes, for example, to an application, by rediscovering
the CIs and jobs in a view.

To access In IT UniverseManager:

l To rediscover all CIs of a view, click theShow Discovery and Changes

Summary button in the toolbar of theBrowse Views tab in the CI
Selector. TheShow Discovery Status and Changes dialog box is displayed.

l To rediscover one CI or several CIs in a view, select the CI and display the
Discovery tab in the Advanced pane.

Important
information

By default, you can run the rediscovery procedure on views that include less than
10,000 CIs.

To increase the number of CIs that you can rediscover in a view:

1. Access the Infrastructure Settings Manager (Administration >
Infrastructure Settings Manager).

2. Select theMax CIs in view supported to rediscover setting in the
infrastructure settings table.

3. Click theValue column and change the number.

4. Restart the server for the change to take effect.

For details on working with the Infrastructure Settings Manager, see
"Infrastructure Settings Manager" in theHP Universal CMDB Administration
Guide.

Relevant
tasks

"How to Check the Status of Application Discovery (Rediscover a View)" on page
193

See also l "Discovery Control Panel - Details Tab" in theHP Universal CMDB Data Flow
Management Guide

l "IT UniverseManager User Interface" on page 201
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User interface elements are described below:

UI Element (A-Z) Description

Refresh. Refreshes the status of the selected CIs.

This button is disabled when there is no data to be reloaded.

Rerun Discovery. Reruns the discovery.

Discovery Progress
Status on View

For details, see "Discovery Control Panel - Details Tab" in theHP
Universal CMDB Data Flow Management Guide.

History Changes on
View

For details, see "CI/Relationship History Dialog Box" on page 204.

Show Impact Pane
This page opens a window that displays the statuses of the trigger CI as well as all statuses of the
CIs that are impacted by it.

To access In the Run Impact Analysis Dialog box, click Show Map.

If Impact Analysis is already active, click on the Impact Analysis Is Active link
in the IT Universe status bar.

Important
information

The following tabs are available:

l Impact Results. Displays amap of all CIs impacted by the selected CI.

l Trigger CIs. Displays a table of information on the selected trigger CIs.

You can only see Impact Analysis results if you defined an Impact rule for that
view in Impact Analysis Manager. For details, see "Impact Analysis Manager" on
page 430.

To view information about specific CIs that are triggered or impacted by the
Impact rule, double-click the relationship connecting the CIs. A map is displayed.

The relationships in themap represent the Impact rules. The name of the
relationship is the name of the Impact rule you defined in the Impact Analysis
Manager.

Relevant
tasks

"How to Retrieve Impact Analysis Results – Scenario" on page 195

See also l "IT UniverseManager Overview" on page 180

l "Impact Analysis Manager Overview" on page 430

l "IT UniverseManager User Interface" on page 201

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element (A-
Z) Description

<Legend> Indicates the icons displayed next to CIs with any of the following special
statuses:

l Added.WhenChange Timeframe is active, indicates that the CI was
added.

l Candidate for Deletion. Indicates that the CI is a candidate for deletion.

l Changed.WhenChange Timeframe is active, indicates that the CI was
changed.

l Drill Down One Layer. Indicates that there are CIs under the CI on a
lower layer.

l External. Indicates that the CI is a federated CI.

l Impacted.When Impact Analysis is active, indicates an impacted CI.

l Impacted and Trigger.When Impact Analysis is active, indicates a
trigger CI that is impacted.

l Note. Indicates that a note was added for the CI.

l Trigger.When Impact Analysis is active, indicates a trigger CI.

<Relationship> The relationships represent the Impact rule you defined in the Impact
Analysis Manager. For details, see "Impact Rules Definition Dialog Box" on
page 442.

<The statuses
and the colors
that represent
each one>

The statuses that appear and the colors that represent each status are the
ones that are defined in the severity list for that state in the System Type
Manager. For details, see "Create/Update List/Enumeration Definition Dialog
Box" on page 482.

<Toolbar> The Show Impact pane toolbar contains most of the buttons in the IT
UniverseManager toolbar.

<Topology Map
Sidebar>

For details, see "Topology Map Sidebar" on page 176.
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Chapter 8: Modeling Studio
This chapter includes:

Modeling Studio Overview 241

View Formats 242

Building a Business View 242

Templates and Perspectives 245

Predefined Folders and Views 246

Creating Template Based Views 247

Business CI Models 247

Building a Perspective Based View 249

Revealed CIs andWatchpoints 251

How to Create a Pattern View 255

How to Create a Template 256

How to Create a Perspective 257

How to Create a Dynamic Widget 259

How to Create a Template Based View 261

How to CreateMultiple Template Based Views 262

How to Define Report Settings 263

How to Build an Instance-basedModel 264

How to Build a New Pattern-basedModel 265

How to Build a Perspective-based View Based on aModel 266

How to Build a Perspective-based View Based on a Collection of CIs 267

Modeling Studio User Interface 267

Modeling Studio Overview
Modeling Studio is a tool for creating andmanaging views. You can create your own views, or work
with the out-of-the-box (factory) views provided with your HP Universal CMDB installation.

The IT Universemodel in the configurationmanagement database can be very large, holding
thousands of configuration items (CIs). A view enables you to build a subset of the overall IT
universemodel, containing only those CIs relating to a specific area of interest. You can define your
own views to display only the information that is relevant to your organization's business needs.
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HP Universal CMDB supports three view formats: pattern views, template based views, and
perspective based views, which are populated through different processes. For details, see "View
Formats" below.

View Formats
HP Universal CMDB supports three view formats, by which to populate your view:

l Pattern views are built from a Topology Query Language (TQL) query that defines the structure
of the view. You can create a new TQL query as you build the view or base the view on an
existing query. The view displays only those CIs and relationships that satisfy the query
definition. When the view is displayed or refreshed, theModeling Studio queries the CMDB for
all elements that fit the query, and automatically updates the view with those elements.

l Template based views are based on a TQL query, to which a template is then applied. The
template is a reusable view that includes parameters, which are saved as part of the template.
This enables you to build multiple views with the same settings without having to re-enter the
parameter information. The view displays only those CIs and relationships that satisfy the query
definition and the conditions of the template. For details on templates, see "Templates and
Perspectives" on page 245.

l Perspective based views are built by selecting a collection of individual CIs and applying a
special type of template, known as a perspective, to it. Instance views, which no longer exist,
are replaced by perspective based views. For details on perspectives, see "Templates and
Perspectives" on page 245.

When you select a view for editing from the view tree in the left pane, it opens on the editing pane in
the appropriate editor.

Building a Business View
In theModeling Studio, you can define your own views tomodel your business environment.

This section includes the following topics:

l "The Structure of a View" below

l "Setting the View Hierarchy" on the next page

l "Topology Reports" on page 245

The Structure of a View
The views you create should provide the business users with logical representations of your
company's structure, processes, and goals. Tomeet these requirements, you generally build
multiple views representing different aspects of your business; for example, you could build
business views that revolve around any of the following:
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l Company structure, so that data is organized by the geographical location of branches, or by
data centers.

l Business processes, so that data is organized by line of business, or by applications.

l Business goals, so that data is organized by sales, or by key customers.

The views depend on the particular demands of your organization and the actual hierarchical
structure of the views should reflect those demands.

The usual hierarchical format of a view is as follows:

l Top level. The highest levels of the view, consisting of the root CI and the branches below it,
are normally built from logical Business CI types such as Location, Line of Business,
Customer, Application, and so on.

l Intermediate level. The intermediate branches of the view normally consist of System CI
types, representing actual hardware and software and/or monitoring group CI types,
representing groups containingmonitors.

l Bottom level. The lowest level of the view, consisting of leaf CIs at the ends of the subtrees, is
built from theMonitorCI types.

Note: The bottom level is only relevant when amonitoring solution such as HP Business
ServiceManagement is connected andmodeled in the CMDB.

Setting the View Hierarchy
The Pattern View Editor enables you to set the view hierarchy using the Hierarchy pane on the right
side of the screen. There are twomethods available for setting the hierarchy: Manual andRule-
based. Themanual method is selected by default.

l Manual Hierarchy Method

In themanual hierarchy method, the query nodes of the view are displayed in a tree format. You
can create the hierarchy by manually dragging a selected query node under another query node
or by using the toolbar buttons. The system only allows you tomove a query node under another
query node when the resulting hierarchy is valid. For details, see "Hierarchy Pane" on page 302.

It is possible to place a single query node from the view into the hierarchy multiple times. You
can then adjust the hierarchy so that the query node appears in different layers, according to the
required layout. The view results in such an instance would be the same as if you added another
query node to the TQL query. Using the same query node twice in the hierarchy enables you to
achieve the desired view results using a simpler TQL query.

Query Node Grouping

When setting the view hierarchy manually, you can create subgroups to group CIs by different
criteria for the convenience of viewing the display. Click theAdd Group By
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button and select one of the options. You can create a subgroup for CIs of the same type in
the Topology Map using theAdd Group by CI Type option. You can create a subgroup for a
specific query node by selecting theAdd Group by View Node option. You can group CIs by a
common attribute using theAdd Group by Attribute button and entering a regular expression
as described in "Query NodeGrouping Dialog Box" on page 312. For details about regular
expressions, see "Regular Expression Examples" on page 533.

You can also create nested groups (a query node group inside another query node group) to help
fine-tune the TQL query results that are displayed in the Topology Map.

For example, after grouping query nodes of type node by their CIT, you can use their operation
state attribute to createmore focused groups.

l Rule-Based Hierarchy Method

In the rule-based hierarchy method, you define hierarchy rules, using the Hierarchy Rules dialog
box. You select a source CIT, target CIT, relationship type, and relationship direction, which
define the conditions for a hierarchy rule. Any CIs in the view which satisfy the defined
conditions are subject to the rule, that is, the target CI is placed on the layer below the source
CI. For details on defining hierarchy rules, see "Hierarchy Rules Dialog Box" on page 276.

Hiding and Displaying Query Nodes in the View Results
You can select to hide certain query nodes so they do not appear in the view results. The following
options are available:

l Hide/Show Element in Query Results. These options are available by right-clicking a query
node in the Query Definition pane. CIs matching a query node that is set as hidden are excluded
from the query results. You cannot set all of the query nodes as hidden; at least one query node
must be shown for the query definition to be valid.

l Set View Node Invisible/Visible. These options are available by right-clicking a query node in
the Hierarchy pane. CIs matching a query node that is set as invisible are excluded from the
view results. However, if a function is defined in the Report Layout pane, it takes invisible query
nodes into account. For example, aCount function will include CIs corresponding to invisible
query nodes in the total count.

When a query node is set as invisible in the hierarchy, all of its descendants are automatically
set as invisible. This enables you to hide an entire branch of the view results. The query
definition cannot have visible query nodes under an invisible query node. When an invisible
query node is set as visible, its descendants are not changed automatically.

A valid hierarchy definitionmust have at least one visible query node, other than the root query
node. The root query node can never be set as invisible.

When the TQL query is calculated, UCMDB first filters the query results by theHide/Show
Element in Query Results settings. The query results are then filtered again by theSet Query
Node Invisible/Visible settings. The final view results reflect the combination of both filters and
are displayed in IT UniverseManager, the Result Preview inModeling Studio, and the topology
report for the view in Reports.
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Topology Reports
You can view the data of any view in report format in the Reports module. Such a report is called the
topology report of the view. You define the topology report settings in the Report tab of the Pattern
View Editor in theModeling Studio. For details on Topology Reports, see "Topology Reports
Overview" on page 334.

Templates and Perspectives
A template is a reusable pattern view with defined parameters. You use templates to build template-
based views, setting the values of the parameters for each specific view. Any changes made to a
template affect all existing views based on that template.

Template-based views can be opened in IT UniverseManager, like pattern views. You can also
open the template itself in IT UniverseManager to view the results for various parameter values. If
you want to save the results, youmust save it as a template-based view. You define templates,
template-based views, and pattern views in the Pattern View Editor.

Perspectives are a type of template designed to be applied to a specific collection of CIs, similar to
the pattern in a pattern view. For example, a perspective could comprise a node containing an IP
Address. In that case, the resulting perspective-based view would include all the CIs from among
the CIs in the CI selection, along with the IP Addresses contained in the node CIs.

Themost basic perspective is known as the Content Only perspective and consists of only the
query node itself. If you apply the Content Only perspective to a CI collection, the resulting view
contains only the selected CIs themselves.

Perspectives are also created and edited in the Pattern View Editor. You can havemultiple views,
templates, and perspectives open in the Pattern View Editor simultaneously, each with its own tab.

Perspectives do not appear in the list of views in IT UniverseManager, however perspective-based
views can be opened in IT UniverseManager, like all other views. For details, see "Building a
Perspective Based View" on page 249.

In summary, the Views tree in the Resources tab of the CI Selector in theModeling Studio can
include the following distinct entities:

l pattern views

l templates

l template based views

l perspectives

l perspective based views

You can filter the tree to select the types of views or templates to display.

The following table summarizes the types of views and where they are created and viewed:
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Type of View Created in:
Can be opened in IT Universe
Manager

Pattern View Pattern View Editor Yes

Template Pattern View Editor Yes, for the current session only

Template-based View Pattern View Editor Yes

Perspective Pattern View Editor No

Perspective-based
View

Perspective-based View
Editor

Yes

Predefined Folders and Views
The Views tree in the Resources tab of the CI Selector in theModeling Studio includes predefined
folders and views, as described in the following sections:

l "Predefined Folders" below

l "Factory Views" below

l "Predefined Perspectives" below

Predefined Folders
The hierarchical file folder system in the CI Selector can help you organize your views. Predefined
folders are provided for the out-of-the-box views; you canmodify these folders, or add additional
folders according to your organization's requirements.

Factory Views
Your HP Universal CMDB installation includes out-of-the-box pattern views, templates, and
perspectives. These views provide a quick start for working with the CMDB.

The out-of-the-box views are initially empty. As soon as CIs are added to the CMDB by one of the
CI generators, the TQL query built into each pattern view is able to identify the CIs that meet the
pattern requirements, and add them to the view.

Views for CIs are created when a discovery process is run; the out-of-the-box views that are
provided correspond to the relevant Universal Discovery packages. For example, the Oracle view
(Root > Database > Oracle > Oracle) is populated with CIs that are created when Data Flow
Management activates the Database - Oracle module. For details on running DFM, see
"Module/Job-Based Discovery Workflow" in theHP Universal CMDB Data Flow Management
Guide.

Some of the out-of-the-box views are considered basic to the system and cannot be deleted from
the folders.

Predefined Perspectives
HP Universal CMDB also provides out-of-the-box perspectives. One example is the Content Only
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perspective, which includes only the elements of the view content itself, without any additional CIs.

Creating Template Based Views
Template-based views based on the same template contain the same query nodes and
relationships. They differ only in their parameter values. You create template-based views using the
Template-based View wizard. The wizard enables you to createmultiple views at one time based
on the same template. When creatingmultiple views, you have the option of entering parameter
values manually or importing them from aCSV file. The CSV file must be formatted correctly for the
wizard to import the values. It must contain the name of at least one of the template parameters in
the first row and it must contain at least one record. The records should be in separate rows and the
parameter values for each record should be in the same row, separated by commas.

The wizard also provides an Advanced Naming feature, which enables you to define an expression
for the view names based on parameter values. For example, if your base template is called
Server_Template, and one of the template parameters is Serial Number, you could define the
view names to beServer <Serial Number>. In this way, the wizard automatically inserts the
respective value of the parameter Serial Number into the name of each view.

An alternate way to assign names to the views when importing values from aCSV file is to include
a column in the file called template_based_view_name. The file entries corresponding to this
column are automatically entered by the wizard as the view names. Note that this namingmethod
overrides the Advanced Naming feature; that is, view names are assigned the entries in the
template_based_view_name column of the file, even when the Advanced Naming feature is
selected.

For details on creating template-based views, see "Template-based View Wizard" on page 321.

You can also edit the parameters of a template-based view when the view is open in the Editor,
from the Template Parameter Values dialog box. For details, see "Template Parameter Values
Dialog Box" on page 325.

You cannot edit the report layout for a template-based view. To change the report layout, you need
tomake changes in the base template of the view.

Business CI Models
This section includes the following topics:

l "Instance-basedModels" on the next page

l "Pattern-basedModels" on the next page

l "Defining a Pattern-basedModel over an Instance-basedModel" on page 249

The collection of CIs which compose the view content of perspective-based views can be selected
in two ways. You can select CIs from the CI Selector and drag them onto the editing pane. In this
case, you can build a view by applying a perspective to the collection and the collection cannot be
reused in another view without repeating the selection process. The other way to select the CIs to
appear in the view is by creating amodel.
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A model is a reusable collection of CI instances that define a business entity, such as a business
service or line of business. By creating amodel, you are building a CI collection that can be reused
with other perspectives to create different views. Any changes you subsequently make to the
model are reflected in all the views based on that model. There are two types of models: instance-
basedmodels and pattern-basedmodels.

Instance-based Models
You build an instance-basedmodel by first selecting a business CI to serve as its basis. The
available business CIs include group, application, business service, business unit, and line of
business. Then, you can add CIs to your model in the following ways:

l Manually, by dragging CIs from the CI Selector into theModel Editor

l Revealing related CIs using a reveal path and selecting the ones to add to themodel

l Defining a watchpoint for a selected CI and automatically adding CIs to themodel

You can also begin building amodel by dragging CIs onto the empty canvas and selectingCreate a
new model.

Themodel you create is a CI itself and the CIs in your model are related to themodel by Contains
relationships. Youmust save your model before applying a perspective to it to build a view.

Caution: The changes youmake in amodel affect the entire universe, not just the views
based on that model. Thus, if you delete a CI from amodel, you are deleting the relationship
that existed between the CIs from the CMDB.

When working in IT UniverseManager, you can add selected CIs directly to a new model or an
existingmodel. For details, see "Add CIs toModel Dialog Box" on page 202.

Pattern-based Models
Another type of model you can build is a pattern-basedmodel. In a pattern-basedmodel, you define
a TQL query to determine the CIs included, rather than selecting themmanually. You can base your
pattern-basedmodel on an existing TQL query or create a new TQL query.

Youmust designate at least one query node in themodel's TQL query as output for themodel. The
CIs of that type whichmatch the pattern of the TQL query are the ones included in themodel output.

The pattern-basedmodel created is saved as a CI like an ordinary model, and can be used to form
the content of a perspective-based view. The new TQL query created is saved as an ordinary query
and can be used as the basis for a pattern view.

Pattern-basedmodels are not updated continuously. Eachmodel is calculated at the time it is
saved and the TQL query runs at specific intervals to update themodel. All existing pattern-based
models are updated at the same time. To set the frequency of the pattern-basedmodel updates,

click the button in the Resources tab of the left pane to open the Pattern Based
Model Scheduler dialog box. The settings you select also apply to all pattern-basedmodels created
subsequently. For details, see "Pattern BasedModel Scheduler Dialog Box" on page 297.

Note:
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l When you export a pattern-basedmodel in PackageManager, the underlying TQL query of
themodel, as well as an enrichment used to update themodel content, are added to the
package. When you view the package resource, or deploy or undeploy the package, only
those resources are displayed. Themodel name does not appear. A pattern-basedmodel
exported from UCMDB 10.x cannot be imported into a UCMDB version earlier than 10.00.

l When you delete a pattern-basedmodel (either from theModeling Studio or from the IT
Universe), the Business Enrichment, Job Scheduler, and pattern-basedmodel CI are also
deleted.

Defining a Pattern-based Model over an Instance-based Model
When defining a pattern-basedmodel, it is possible build it on top of an existing instance-based
model. In this case, only the pattern of themodel that you build is visible on the canvas, as in a new
pattern-basedmodel. However, the CIs in the instance-basedmodel also remain in the new model
and appear in the view results when themodel is used to build a perspective-based view. Similarly,
when you access themodel in IT UniverseManager, both the CIs in the instance-basedmodel and
those retrieved by the pattern-basedmodel are visible. Themodel is saved with the name of the
original instance-basedmodel, in effect creating a hybrid model with both instance-based and
pattern-based components.

If you delete themodel, only the additional pattern-based part of themodel is deleted. Themodel
reverts to an instance-basedmodel and the CIs included in it become visible in theModel Editor.

Building a Perspective Based View
A perspective based view is composed of perspectives applied to amodel or a collection of CIs.
The perspective is a special type of template which is designed to be applied to a subset of the IT
Universemodel.

The Content pane of the Perspective-based View Editor displays themodels or CIs you have
selected to serve as the basis of your view. The Perspective pane displays the selected
perspectives. The Preview pane displays the resulting view based upon your content and
perspective selections. When youmake a change in the content or perspective selections, the view
is updated accordingly in the Preview pane. For details, see "Perspective-based View Editor" on
page 306.

This section includes the following topics:

l "Content" on the next page

l "Perspectives" on the next page

l "Views Based onMultiple Perspectives" on page 251

l "Including and Excluding Child CIs" on page 251
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Content
The content in a perspective based view can be selected in two ways:

l You can add individual CIs to the view manually, using the CI Selector. The CIs in the collection
are independent of each other. In this case, the collection of CIs is not defined as amodel and
cannot be reused in another view.

l You can add one or moremodels to the view, using the CI Selector. Alternatively, you can start
by working with amodel in theModel Editor and select Generate View for SelectedModel to
build a view based on that model. In this case, the identical content can be used to build another
view by selecting the samemodels.

You can select both individual CIs andmodels to form the content of a perspective based view,
however in that case, themodels are treated as ordinary CIs. Themodels themselves are included
in the view without their hierarchy of child CIs.

When working in IT UniverseManager, you can add selected CIs directly to the content of a new or
an existing perspective based view. For details, see "Add CIs to View Dialog Box" on page 202.

Perspectives
The perspectives you select for your view determine which CIs are included in the view. A
perspective is a reusable pattern, similar to a template. The difference between a perspective and a
regular template is that the perspective includes one or more query nodes designated as contact
query nodes. A contact query node is a query node in the pattern which is used to apply the pattern
to specific content and it is indicated by a small icon that appears next to the query node .

For example, in the following perspective, a query node of typeWindows is designated as the
contact query node and it has an IP Address related to it by a containment relationship.

When this perspective is applied to a CI collection, the resulting view contains all the CIs in the
original collection as well as the IP Addresses connected to theWindows CIs in the collection (the
CIs that were added by applying the perspective).

A perspective can have several contact query nodes, but every disconnected graph within a
perspectivemust have at least one contact query node.

If youmake a change to a perspective, all views based on that perspective are affected.
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Views Based on Multiple Perspectives
You can select multiple perspectives to apply to the content of your view. There are two ways to
select multiple perspectives:

l Perspective groups

l Perspective chains

In a perspective group, you select two or more perspectives to apply simultaneously to the same
input content.

In a perspective chain, you select two or more perspectives at different levels of the view creation.
The perspective in the first level is applied to the original view content to generate results in the form
of a CI collection that serves as input content for the next level. The perspective in the second level
is then applied to this content to generate the view results. You can build views based onmultiple
levels of perspectives, each one generating input content for the following level.

It is possible to apply both of the abovemethods at the same time, that is, by selectingmultiple
perspectives in each of the levels of a perspective selection.

For example, select a collection of IP SubnetCIs as your input content and select a perspective
that adds the nodeCIs related to the IP Subnets as the first level perspective. The results of this
stage consist of the original IP Subnets and their related nodes. Then add a second perspective
level and select two perspectives for it: one that adds CPU CIs related to nodes and one that adds
File System CIs related to nodes. The final results include the original IP Subnets, their related
nodes, and the CPUs and File Systems related to those nodes.

These options help to simplify the process of creating a perspective-based view, by breaking down
the functionality of a perspective into its component parts. Instead of building a separate large and
complex perspective for each required view, you can construct a custom perspective combination
tomatch the requirements of your specific case from smaller andmore basic perspectives.

Including and Excluding Child CIs
When adding CIs that have children to a view, the CI and its children are only included in the view if
the pattern of the perspective includes children for the selected CI type. In that case, children are
included for all CIs of that type. After creating a view, you can hide specific CIs from the view by
selecting the CI in the View Results pane and selectingHide CI from View from the shortcut
menu or clicking theHide CI from View button in the toolbar. This option is only available for CIs
that were added to the view via the perspective and were not part of the original content on which
the view was based. Thus, if the view was based on a collection of CIs, the CIs in that collection
cannot be hidden from the view. If the view was based on amodel, themodel itself cannot be
hidden from the view, but the CIs contained in themodel can be hidden.

Revealed CIs and Watchpoints
TheModeling Studio provides two advancedmethods of adding CIs to an existingmodel: revealing
related CIs and defining watchpoints.

This section includes the following topics:
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l "Revealing CIs" below

l "Watchpoints" on page 254

Revealing CIs
One approach to building amodel is to add CIs related to the CIs in themodel. TheModeling Studio
provides a tool to help you reveal those CIs. The process of revealing related CIs involves
constructing a reveal path, which is a chain of CI types that are related to each other. The first item
in your reveal path is the CI type of the CI from which you started to reveal CIs. TheModeling
Studio locates all of its related CIs and lists their CI types. By selecting one of those types, you
build the next step of your path. All the related CIs of that type appear in the lower pane of the dialog
box. You can select the ones you want to include in your model. The process is repeated to build
the following step of the path.

For example, if you begin to reveal CIs from aCI of typeWindows, theModeling Studio may reveal
related CIs of types Interface, Network, and IP. If you select Network, the related CIs of type
Network appear in the lower pane and can be added to themodel by dragging them into the CIs
Basket or clicking the CIs Basket icon:

Click Next to build the next step of the path using Network as your selection. TheModeling Studio
reveals related CIs of typeWindows, Unix, and IP. Unix is selected and the Unix CIs appear in the
lower pane and can be added to themodel by dragging the selected ones into the CIs Basket pane:
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Click Next to build the next step of the path using Unix as your selection:
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In this case, a reveal path ofWindows > Network > Unixwas constructed. At each step, you
have the option of adding any of the revealed related CIs to your model. For details on revealing
CIs, see "Reveal CIs Dialog Box" on page 315.

It is also possible to construct a reveal path without revealing CIs. For details, see
"Create/Edit/Save Reveal Path Dialog Box" on page 274.

Watchpoints
Another method of locating related CIs to add to themodel is by defining a watchpoint for a selected
CI in themodel. A watchpoint is amechanism which is triggered when a new related CI of a
specified type is created. Every watchpoint is defined in connection with a reveal path. If a new
related CI of any CI type included in the path is created, the watchpoint is triggered and an indicator
appears next to themodel. For details on defining a watchpoint, see "New Watchpoint Dialog Box"
on page 296.

Note: Youmust save a new model before defining watchpoints for its CIs.

All the related CIs detected by the watchpoint are displayed in theWatchpoints Updates dialog box.
The dialog box enables you to select the ones to add to your model and the ones to suppress, or
exclude from your model. For details, see "Watchpoints Updates Dialog Box" on page 332.

You also have the option to include the detected CIs in your model automatically by selecting the
check box in the New Watchpoint dialog box. In this case, all CIs detected by the watchpoint are
added to themodel.
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A watchpoint can also be used to detect CIs included in themodel which are no longer related to the
model. If such CIs are found along the reveal path connected to the watchpoint, they also appear in
theWatchpoints Updates dialog box. You can accept the suggestion to remove the CIs from your
model, or you can suppress the suggestion, thereby keeping the CIs in your model.

Note:

l Although a watchpoint is defined for an individual CI, the watchpoint results display related
CIs of the CI types included in the reveal path for all CIs in themodel.

l When adding CIs to amodel using watchpoints or revealed CIs in amulti-tenancy
environment, only CIs with a consumer tenant matching the owner tenant or consumer
tenants of themodel are added.

How to Create a Pattern View
This task describes how to create a pattern view and define its TQL query.

This task includes the following steps:

l "Open a New View in the Pattern View Editor" below

l "AddQuery Nodes and Relationships to a TQLQuery" below

l "Set the View Hierarchy" on the next page

l "Set the View Properties" on the next page

l "Define the Report Settings - Optional" on the next page

l "Set Permissions" on the next page

1. Open a New View in the Pattern View Editor

Click New and select Pattern View. In the New Pattern View dialog box, select the base
TQL query on which your new view is based, or select Create new query to build a new TQL
query. The Pattern View Editor opens. For details, see "New Pattern
View/Template/Perspective Dialog Box" on page 295.

2. Add Query Nodes and Relationships to a TQL Query
Add the query nodes and relationships that define the query. For details on how to add query
nodes and relationships to a TQL query, see "How to AddQuery Nodes and Relationships to a
TQLQuery" on page 25.

Note: If you are starting with a blank view, youmust add at least one query node in order
to save your view.
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3. Set the View Hierarchy
Set the hierarchy for the view by moving the required query nodes in the Hierarchy pane. For
details, see "Setting the View Hierarchy" on page 243.

When you are finished, click Save to save the view.

4. Set the View Properties
Set the view properties, such as the priority and the default layout for the view in the View
Definition Properties dialog box. For details, see "Query/View Definition Properties Dialog
Box" on page 313.

5. Define the Report Settings - Optional
Select the Report tab in the Pattern View Editor. Select the attributes you want to include in the
report for each query node of the view. You can also set the order of the report columns, set the
sort order of each column, and add a chart. For details, see "How to Define Report Settings" on
page 263.

6. Set Permissions
Apply viewing and editing permissions to users and user groups for the new view. You set
permissions inManagers > Security > Roles Manager. For details, see "Roles Manager
Page" in theHP Universal CMDB Administration Guide.

How to Create a Template
This task describes how to define a new template.

This task includes the following steps:

l "Open a New Template in the Pattern View Editor" below

l "AddQuery Nodes and Relationships to a TQLQuery" on the next page

l "Set Parameter Values" on the next page

l "Set the Template Hierarchy" on the next page

l "Set the Template Properties" on the next page

l "Define the Report Settings - Optional" on the next page

l "Set Permissions" on the next page

1. Open a New Template in the Pattern View Editor

Click New and select Template. In the New Template dialog box, select the base TQL
query on which your new template is based, or select Create new query to build a new TQL

Modeling Guide
Chapter 8: Modeling Studio

HP Universal CMDB (10.10) Page 256 of 534



query. For details, see "New Pattern View/Template/Perspective Dialog Box" on page 295

2. Add Query Nodes and Relationships to a TQL Query
Add the query nodes and relationships that define the query. For details on how to add query
nodes and relationships to a TQL query, see "How to AddQuery Nodes and Relationships to a
TQLQuery" on page 25.

Note: If you are starting with a blank template, youmust add at least one query node in
order to save your template.

3. Set Parameter Values
Right-click a query node or relationship in the TQL query and select Query Node Properties. In
the Attributes tab, add an attribute with a parameterized value. For details, see "Query
Node/Relationship Properties Dialog Box" on page 72.

Note: If you do not set any parameters, when you try to save your template, youmust
save it as a pattern view.

4. Set the Template Hierarchy
Set the hierarchy for the template by moving the required query nodes in the Hierarchy pane.
For details, see "Setting the View Hierarchy" on page 243.

When you are finished, click Save to save the template.

5. Set the Template Properties
Set the template properties, such as the priority and the default layout for the template in the
View Definition Properties dialog box. For details, see "Query/View Definition Properties
Dialog Box" on page 313.

6. Define the Report Settings - Optional
Select the Report tab in the Pattern View Editor. Select the attributes you want to include in the
report for each query node of the view. You can also set the order of the report columns, set the
sort order of each column, and add a chart. For details, see "How to Define Report Settings" on
page 263.

7. Set Permissions
Apply viewing and editing permissions to users and user groups for the new template. You set
permissions inManagers > Security > Roles Manager. For details, see "Roles Manager
Page" in theHP Universal CMDB Administration Guide.

How to Create a Perspective
This task describes how to define a new perspective.
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This task includes the following steps:

l "Open a New Perspective in the Pattern View Editor" below

l "AddQuery Nodes and Relationships to a TQLQuery" below

l "Select a Contact Query Node" below

l "Set the Perspective Hierarchy" below

l "Set the Perspective Properties" below

l "Define the Report Settings - Optional" on the next page

l "Set Permissions" on the next page

1. Open a New Perspective in the Pattern View Editor

Click New and select Perspective. In the New Perspective dialog box, select the base
TQL query on which your new Perspective is based, or select Create new query to build a
new TQL query. For details, see "New Pattern View/Template/Perspective Dialog Box" on
page 295.

2. Add Query Nodes and Relationships to a TQL Query
Add the query nodes and relationships that define the query. For details on how to add query
nodes and relationships to a TQL query, see "How to AddQuery Nodes and Relationships to a
TQLQuery" on page 25.

3. Select a Contact Query Node
Select at least one query node in the TQL query to be a contact query node. Right-click the
query node and select Use As Contact Query Node.

Note: If you do not select a contact query node, when you try to save your perspective,
youmust save it as a pattern view.

4. Set the Perspective Hierarchy
Set the hierarchy for the perspective by moving the required query nodes in the Hierarchy pane.
For details, see "Setting the View Hierarchy" on page 243.

When you are finished, click Save to save the perspective.

5. Set the Perspective Properties
Set the perspective properties, such as the priority and the default layout for the perspective in
the View Definition Properties dialog box. For details, see "Query/View Definition Properties
Dialog Box" on page 313.
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6. Define the Report Settings - Optional
Select the Report tab in the Pattern View Editor. Select the attributes you want to include in the
report for each query node of the view. You can also set the order of the report columns, set the
sort order of each column, and add a chart. For details, see "How to Define Report Settings" on
page 263.

7. Set Permissions
Apply viewing and editing permissions to users and user groups for the new perspective. You
set permissions inManagers > Security > Roles Manager. For details, see "Roles Manager
Page" in theHP Universal CMDB Administration Guide.

How to Create a Dynamic Widget
This task describes how to define a new dynamic widget for the UCMDB Browser.

This task includes the following steps:

l "Create a New Dynamic Widget in the Pattern View Editor" below

l "AddQuery Nodes and Relationships to a TQLQuery" below

l "Select Attributes for theWidget" on the next page

l "Set Values for theWidget's Attributes" on the next page

1. Create a New Dynamic Widget in the Pattern View Editor

Click New and select Dynamic Widget. In the New Dynamic Widget dialog box, select
the base TQL query on which your new dynamic widget is based, or select Create new query
to build a new TQL query.

2. Add Query Nodes and Relationships to a TQL Query
In the View tab, add the query nodes and relationships that define the query. For details, see
"How to AddQuery Nodes and Relationships to a TQLQuery" on page 25.

Note: The root (and only the root) of the folding definition in the TQL query must be
designated as a contact query node for the dynamic widget to display data about that node
in the UCMDB Browser. If no contact query node is specified, the TQL query is saved as a
pattern view and not as a dynamic widget.

a. Specify whether to use amanual (default) or rule-based hierarchy when defining the TQL
query. For details, see "Setting the View Hierarchy" on page 243.
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Note: If you are starting with a blank widget, youmust add at least one query node in
order to save your widget.

b. For each property for which you want data to be displayed in notifications in the dynamic
widget, do the following:

i. Right-click a node in the topology map and select Query Node Properties.

ii. Click the Element Layout tab.

iii. Select theSelect attributes for layout radio button.

iv. In the Conditions pane, select eitherAll (to display all attributes of the selected node)
orSpecific Attributes (to display only the attributes you select).

v. Select attributes in the Available Attributes pane and click to add them to the
Specific Attributes pane.

vi. Click OK when you are finished.

3. Select Attributes for the Widget
In the Report tab, select a node in the Hierarchy pane, and choose the attributes for that node
for which you want data to be displayed in the widget.

Note: In the Hierarchy pane in either the Report tab or the View tab, you can specify a
grouping option on any node. Although you can choose between different grouping options,
the CI's attributes are always displayed in groups by CI type when you view the dynamic
widget in the UCMDB Browser inWidget Details mode. To set a grouping option, right-
click a node in the hierarchy tree and select one of the grouping options (attribute, CI type,
or view node).

4. Set Values for the Widget's Attributes
In theWidget tab, select a node and specify how and where you want the selected attributes to
be visible in the widget. For details, see "Pattern View Editor" on page 300.

Select theShow path check box to cause the UCMDB Browser to display the route in the
dynamic widget from a specific node in the view definition to all the node's children.

Select theBrowser CI access control check box to ensure that the dynamic widget displays
data only according to the permissions that were specified on the Browser CI Access Control
tab in the Roles manager. If the check box is not selected, the dynamic widget will display all
data, without permission enforcement.

When you are finished, click Save .
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How to Create a Template Based View
This task describes how to define a single template based view.

This task includes the following steps:

l "Prerequisites" below

l "Define a New Template Based View" below

l "Select a Template" below

l "Select theMethod for Adding Parameter Values" below

l "Set Parameters" below

l "Set Permissions" below

1. Prerequisites
If you want to base your view on a new template, create the template first. For details, see
"How to Create a Template" on page 256.

2. Define a New Template Based View

You define a new template based view using the Template-based View wizard. Click New
and select Template Based View.

3. Select a Template
On the Select Template page of the wizard, select a template on which to base your view. For
details, see "Select Template Page" on page 321.

4. Select the Method for Adding Parameter Values
On the Import Parameter Values page of the wizard, select themethod for adding the
parameter values. For details, see "Import Parameter Values Page" on page 322.

5. Set Parameters
On the Enter Parameters page, enter the parameter values for the view. For details, see "Enter
Parameters Page" on page 323.

Note: You can also edit the parameters from within the Editor after creating the view, by
selecting Show Parameters from the toolbar or the shortcut menu.

When you are finished, click Finish to open the view in the Editor. Click Save to save the
view.

6. Set Permissions
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Apply viewing and editing permissions to users and user groups for that view. You set
permissions inManagers > Security > Roles Manager. For details, see "Roles Manager
Page" in theHP Universal CMDB Administration Guide.

How to Create Multiple Template Based Views
This task describes how to definemultiple template-based views.

This task includes the following steps:

l "Prerequisites" below

l "Define New Template Based Views" below

l "Select a Template" below

l "Select theMethods for Adding Parameter Values and Naming Views" below

l "Set Parameters" below

l "Select the Location for Saving the Views" on the next page

l "Save the Views" on the next page

l "Set Permissions" on the next page

1. Prerequisites
If you want to base your views on a new template, create the template first. For details, see
"How to Create a Template" on page 256.

2. Define New Template Based Views

You define new template based views using the Template-based View wizard. Click New
and select Template Based View.

3. Select a Template
On the Select Template page of the wizard, select a template on which to base your views. For
details, see "Select Template Page" on page 321.

4. Select the Methods for Adding Parameter Values and Naming Views
On the Import Parameter Values page of the wizard, select themethod for adding the
parameter values. Also, if you want to use the Advanced Naming feature, select the check box
on this page. For details, see "Import Parameter Values Page" on page 322

5. Set Parameters
On the Enter Parameters page, enter the parameter values for the view. If you selected to
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import the parameter values from aCSV file, they are automatically entered in the table. You
can edit the view names and parameter values manually on this page. You can also add new
views to the table or delete views from the table. For details, see "Enter Parameters Page" on
page 323.

6. Select the Location for Saving the Views
On the Select Location page, select the location in the view tree in which to save the new
views. For details, see "Select Location for Views Page" on page 324.

7. Save the Views
On the Summary page, review the details of the views you created. If there are no further
changes, click Save to save the views in the selected location.

8. Set Permissions
Apply viewing and editing permissions to users and user groups for each view created. You set
permissions inManagers > Security > Roles Manager. For details, see "Roles Manager
Page" in theHP Universal CMDB Administration Guide.

How to Define Report Settings
This task describes how to define report settings for a view, template, or perspective.

This task includes the following steps:

l "Prerequisites" below

l "Select Attributes to Appear as Report Columns" below

l "Add Function Columns to the Report - Optional" on the next page

l "Set the Sort Order of the ColumnContent" on the next page

l "Add a Chart to the Report - Optional" on the next page

l "Set the Report Properties" on the next page

1. Prerequisites
After defining the content and hierarchy of a view, template, or perspective, you can define the
report settings. Select the Report tab in the Pattern View Editor.

2. Select Attributes to Appear as Report Columns
For each query node in the view, select the query node in the Hierarchy pane and select the
attributes to appear as columns in the report for that query node. You select attributes in the
Query Node Definition pane by moving them from the Attributes list to the Report Layout list.
Set the order of the columns using the arrow buttons in the Report Layout list. For details, see
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"Pattern View Editor" on page 300.

3. Add Function Columns to the Report - Optional
You have the option of adding a column for a selected query node consisting of data derived
from a function performed on one of its child query nodes. Click theAdd Function button
to open the Add Function dialog box where you can select the relevant settings. For details,
see "Add/Edit Function Dialog Box" on page 269.

4. Set the Sort Order of the Column Content

Click theSet Sort Order button to open the Sort ColumnContent dialog box. Determine
the columns by which to sort the report by moving columns from the Available Columns list to
the Sorted Columns list. Use the arrow buttons to set the sort order of the columns. Use the
Sort Ascending/Sort Descending buttons to set the sort direction for each column. For details,
see "Sort ColumnContent Dialog Box" on page 320.

5. Add a Chart to the Report - Optional
You have the option of adding a chart to your report, in place of a table, for a selected layer of
the view. When the necessary conditions for adding a chart are satisfied, theDefine Chart link
in the Chart Properties section of the Query Node Definition pane is active. Click the link and
enter the chart settings. For details, see "Chart Properties" on page 305.

6. Set the Report Properties

Select the View tab in the Pattern View Editor. Select theReport Properties button to
assign a title and subtitle to the report and to select the report format. For details, see "Report
Properties Dialog Box" on page 401.

How to Build an Instance-based Model
This task describes how to build an instance-based business CI model which can serve as the
basis for a view.

This task includes the following steps:

l "Create the New Model" below

l "Add CIs to theModel Manually" on the next page

l "Reveal CIs" on the next page

l "DefineWatchpoints for CIs in theModel" on the next page

1. Create the NewModel

In theModeling Studio, click New and select Instance Based Model to open the New
Model dialog box. Select a CI type and enter the values for its properties. For details, see "New
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Model Dialog Box" on page 294.

Note: You cannot create an instance-basedmodel with an already existing name.

2. Add CIs to the Model Manually
In the CI Selector, search for the CIs you want to include in your model. Select them and drag
them into themodel.

Tip: You can select more than one CI by holding theCTRL key while selecting CIs.

3. Reveal CIs
Select a CI in themodel and reveal its related CIs along a reveal path. Add selected CIs from
among the revealed CIs to your model. When you are done, save themodel. For details, see
"Reveal CIs Dialog Box" on page 315.

4. Define Watchpoints for CIs in the Model
Right-click a CI in themodel and selectWatchpoint > New Watchpoint. The New
Watchpoint dialog box opens. Select a reveal path and click OK. A small icon appears next to
the CI indicating that a watchpoint is defined for it. For details, see "New Watchpoint Dialog
Box" on page 296.

How to Build a New Pattern-based Model
This task describes how to build a new pattern-basedmodel which can serve as the basis for a
perspective-based view.

This task includes the following steps:

l "Define the New Model" below

l "Enter theModel Details" on the next page

l "Select a TQLQuery" on the next page

l "AddQuery Nodes and Relationships to a TQLQuery" on the next page

l "Set Output Query Nodes" on the next page

l "Save theModel" on the next page

1. Define the NewModel

You define a new pattern-basedmodel using the Pattern-basedModel wizard. Click New
and select Pattern Based Model.
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Note: You cannot create a pattern-basedmodel with an already existing name.

2. Enter the Model Details
On the first wizard page, select New Model. Then select a CI type for themodel and enter the
properties. For details, see "Select CI Type Page" on page 299.

3. Select a TQL Query
On the next wizard page, select a TQL query for themodel. You can create a new TQL query or
select an existing query from the tree. The TQLQuery Editor opens with the selected query.
For details, see "Query Selection Page" on page 300.

4. Add Query Nodes and Relationships to a TQL Query
Add the query nodes and relationships that define the query. For details on how to add query
nodes and relationships to a TQL query, see "How to AddQuery Nodes and Relationships to a
TQLQuery" on page 25.

5. Set Output Query Nodes
Select one or more query nodes in the TQL query to serve as output for themodel by right-
clicking them and selectingAdd to Model Output. The query node is indicated by a small icon
next to it.

6. Save the Model
When you are finished, save themodel with a unique name. If you created a new TQL query,
the query is also saved independently of themodel and can be re-used as a regular TQL query.

How to Build a Perspective-based View Based on a
Model

This task describes how to build a view in theModeling Studio based on amodel and a perspective.

This task includes the following steps:

l "Open theModel" below

l "Select a Perspective" on the next page

l "Save the View" on the next page

1. Open the Model
In theModeling Studio, selectModels as the Resource type in the left pane, select the

relevant model, and click Open Model in the left pane toolbar.

Modeling Guide
Chapter 8: Modeling Studio

HP Universal CMDB (10.10) Page 266 of 534



2. Select a Perspective
In theModel Editor, right-click themodel and select Generate View for selected model. The
Creating New View dialog box opens. Select perspectives to apply to themodel. For details,
see "Creating New View Dialog Box" on page 275.

3. Save the View
The Perspective-based View Editor opens with your new view. Optionally, build a perspective
chain by selecting perspectives for additional levels of the view creation. Rename the view and
save it in the correct folder. For details, see "Perspective-based View Editor" on page 306.

How to Build a Perspective-based View Based on a
Collection of CIs

This task describes how to build a view in theModeling Studio based on a collection of CIs and a
perspective.

This task includes the following steps:

l "Create the New View" below

l "Add CIs to the View" below

l "Select a Perspective and Save the View" below

1. Create the New View

In theModeling Studio, click New and select Perspective Based View to open the
Perspective-based View Editor. For details, see "Perspective-based View Editor" on page 306.

2. Add CIs to the View
In the CI Selector, search for the CIs you want to include in your view. Select them and drag
them into the view. For details on the CI Selector, see "CI Selector" on page 133.

Tip: You can select more than one CI by holding theCTRL key while selecting CIs.

3. Select a Perspective and Save the View
In the Perspective pane, select perspectives to apply to your CI collection. Optionally, you can
build a perspective chain by selecting perspectives for additional levels of the view creation.
Rename the view and save it in the correct folder. For details, see "Perspective-based View
Editor" on page 306.

Modeling Studio User Interface
This section includes (in alphabetical order):
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Add/Edit Function Dialog Box 269

ChangeQuery Node/Relationship Type Dialog Box 270

ChooseOperation for Selected Items Dialog Box 272

Conditions of Related CIs Dialog Box 273

Create/Edit/Save Reveal Path Dialog Box 274

Creating New View Dialog Box 275

Cycle Definition Dialog Box 275

Hidden CIs Dialog Box 276

Hierarchy Rules Dialog Box 276

Left Pane 277

Manage CI Watchpoints Dialog Box 283

Model Editor 284

Modeling Studio Page 291

Models Containing Selected CI Dialog Box 293

New Model Dialog Box 294

New Pattern View/Template/Perspective Dialog Box 295

New Watchpoint Dialog Box 296

Open Reveal Path Dialog Box 297

Pattern BasedModel Scheduler Dialog Box 297

Pattern BasedModel Wizard 299

Pattern View Editor 300

Perspective-based View Editor 306

Query NodeGrouping Dialog Box 312

Query/View Definition Properties Dialog Box 313

Reveal CIs Dialog Box 315

SaveQuery Dialog Box 317

Save View/Template/Perspective Dialog Box 318

Select Integration Points Dialog Box 319

Sort ColumnContent Dialog Box 320

Template-based View Wizard 321

Template Parameter Values Dialog Box 325

TQLQuery Editor 326
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Views Containing Selected CI Dialog Box 331

Watchpoints Updates Dialog Box 332

<Query/Template/Perspective Name> Dependencies Dialog Box 333

Add/Edit Function Dialog Box
This dialog box enables you to define which of the query node's functions and parameters you want
to include in the report.

To access Click theAdd Function button under the Report Layout box in the Query
Node Definition pane of the Pattern View Editor.

Important
information

When defining the report columns for a selected query node in a view, template, or
perspective, you can define a column consisting of data deriving from a function
defined for one of its child query nodes. Select the relevant child query node,
attribute, and function that you want to define.

First, select the required query node and function. The attribute list adjusts to
display the relevant attribute for the selected combination. Select the required
attribute.

Relevant
tasks

"How to Define Report Settings" on page 263

See also l "Building a Business View" on page 242

l "Modeling Studio User Interface" on page 267

User interface elements are described below:

UI Element
(A-Z) Description

Attribute Select an attribute from the list.
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UI Element
(A-Z) Description

Function From the Function list, select the function you want to use to calculate the
results on these columns.

The following are the available options:

l Average. The average value of the selected attribute for all the CI instances
of the selected query node.

l Concatenated List. Lists the values of the selected attribute for all the CI
instances of the selected query node.

l Count. Calculates the number of CI instances of the selected query node.

l Distinct List. Lists the unique values of the selected attribute for all the CI
instances of the selected query node.

l Max. Themaximum value of the selected attribute for all the CI instances of
the selected query node.

l Min. Theminimum value of the selected attribute for all the CI instances of
the selected query node.

l Sum. The sum of the selected attribute values for all the CI instances of the
selected query node.

Related
Query Node

The child query node on which you want to perform the function.

Title The name of the function attribute displayed in the report.

Change Query Node/Relationship Type Dialog Box
This dialog box enables you to change the CI type of a TQL query node or relationship after you
have created a TQL query.

To access In the TQLQuery Editor or Pattern View Editor, right-click the required query node
and select Change Query Node Type. For relationships, right-click the required
relationship and select Change Relationship Type.

Important
information

You can change the CI type of the selected query node to any other valid type
based on the existing relationships and conditions of the selected query node.
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Relevant
tasks

l "How to Define a TQLQuery" on page 23

l "Implement a Discovery Adapter" in theHP Universal CMDB Developer
ReferenceGuide

l "How to Create a Pattern View" on page 255

See also l "Building a Business View" on page 242

l "Modeling Studio User Interface" on page 267

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

Expand All. Expands all the folders in the tree.

Collapse All. Collapses all the folders in the tree.

Tree View Click Tree View to select the display format of the CI type/Relationship
tree. The following options are available:

l by Display label

l by Class name

l by Legacy class name

<CI
type/Relationship
tree>

Select the required CI type or relationship.

Relationship
Direction

Select the direction of the relationship.

Note: Only relevant for relationships.

Relationship
Name

The name of the relationship.

Note: Only relevant for relationships.
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UI Element (A-Z) Description

Relationship
Restrictions

Select an option to define how to handle relationships between identical
query nodes or self relationships in the query results. A self relationship is a
relationship that leads from a query node to itself.

l Allow All Relationships. All relationships appear in the query results.

l Allow Self Relationships only. Only self-relationships (a relationship
that leads to itself) appear in the query results.

l Allow Non Self Relationships only. Self-relationships do not appear
in the query results.

Note: Only relevant for relationships.

Choose Operation for Selected Items Dialog Box
This dialog box enables you to createmodels and views from selected CIs.

To access In theModeling Studio, drag CIs from the CI Selector onto the empty canvas.

Important
information

You can drag individual or multiple CIs onto the canvas. You can select ordinary
CIs and/or models to drag onto the canvas. To select multiple CIs, hold theCTRL
key while selecting CIs.

See also l "Building a Business View" on page 242

l "Business CI Models" on page 247

l "Modeling Studio User Interface" on page 267

User interface elements are described below:

UI Element
(A-Z) Description

Create a
new model

Select to build amodel comprising the CIs in your selection. If the CIs you
dragged onto the canvas include at least one CI that has no valid links to any of
themodel CI types, this option is disabled.

Create a
new view

Select to build a view based on the CI collection formed by your selection.

Edit the
model of
the selected
CI

Select to edit the selectedmodel in theModel Editor.

Note: This option only appears when a single model is dragged onto the
canvas.
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Conditions of Related CIs Dialog Box
This dialog box enables you to define conditions for the CI types in a reveal path.

To
access

Click theAdd Condition orEdit Condition buttons from the Conditions column of
the Reveal CIs dialog box.

See
also

l "Revealed CIs andWatchpoints" on page 251

l "Modeling Studio User Interface" on page 267

User interface elements are described below:

UI Element (A-
Z) Description

Add the attribute condition you have defined.

Delete an attribute condition.

Move a selected row up.

Move a selected row down.

View the condition definition.

And/Or Click inside theAnd/Or field and select eitherAnd orOr to link multiple
conditions.

Attribute name Select an attribute from the list.

Brackets Click inside theBrackets box to display a list of brackets you can use to
build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in the CI Instances
dialog box.

Not Select NOT if you want the condition statement to do the opposite of what is
defined.

Note: If you select NOT, query results do not include data from the CI
instances that were not assigned a value. For example, your system
contains three node CIs: Node1 is assigned the value A, Node2 is
assigned the value B and Node3 is not assigned a value. You create a
query to retrieve all nodes that are equal to A and select NOT; the results
of your query only include Node2 because Node3 is not assigned a
value.
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UI Element (A-
Z) Description

Operator Select the required operator. For details, see "Attribute Operator Definitions"
on page 38.

Value Enter or select the value of the attribute. TheValue options vary according to
the attribute type you select.

Create/Edit/Save Reveal Path Dialog Box
This dialog box enables you to define a new reveal path or edit an existing path.

To
access To define a new reveal path, click theReveal button from theModel Editor, and

select Create Reveal Path.

To edit an existing reveal path, select a path from theOpen Reveal Path dialog box and
click Edit.

To save a reveal path, click Save Path from the Reveal CIs dialog box.

See
also

l "Revealed CIs andWatchpoints" on page 251

l "Modeling Studio User Interface" on page 267

User interface elements are described below:

UI Element
(A-Z) Description

Description Enter a description of the path.

Name Enter the name of the path.

Preview Opens the Reveal CIs dialog box displaying the related CIs in the path.

Note: This button does not appear in the Save Reveal Path dialog box.

Reveal
Path

Build the path by clicking the button to open a dialog box with a CI type tree.
Select the CI type for the next item in the path.

When you hold the pointer over a reveal path item, the following options are
available:

l Delete Selected Item(s). Deletes the selected item from the reveal path.

l Add condition. Opens the Conditions of Related CIs dialog box, which
enables you to set conditions for the reveal path item.

l Refine Query Node Type. Opens a CI type tree, which enables you to
change the CI type of the reveal path item.
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Creating New View Dialog Box
This dialog box enables you to select a perspective to create a view from amodel.

To access In theModeling Studio, right-click amodel in theModel Editor, Perspective-based
View Editor, or CI Selector and select Generate view for selected Model or click

theGenerate view for selected model button from theModel Editor.

Important
information

You select perspectives in the left pane andmove them to the right pane using the
arrow buttons.

Relevant
tasks

"How to Build a Perspective-based View Based on aModel " on page 266

See also l "Building a Business View" on page 242

l "Modeling Studio User Interface" on page 267

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

Available Perspectives A list of the available perspectives to apply to your model.

Selected Perspectives The perspectives you selected to apply to your model.

Cycle Definition Dialog Box
This dialog box enables you to define a cyclical hierarchy in a view.

To access In theModeling Studio, right-click a query node in the Hierarchy pane of the
Pattern View Editor and select Define Cycles.

Important
information

You can extend the TQL query definition of a view by defining a cycle in the view
hierarchy. Select a query node in the Hierarchy pane to be the source query node.
The Cycle Definition dialog box displays the valid target query nodes for that
source. The target query node in the cycle, along with its hierarchy, is treated as a
child or sibling of the source query node (depending on your folding rule selection).

Relevant
tasks

"How to Create a Pattern View" on page 255, "How to Create a Template" on
page 256, "How to Create a Perspective" on page 257

See also l "Building a Business View" on page 242

l "Modeling Studio User Interface" on page 267

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element
(A-Z) Description

Folding
Rule

Select one of the following options:

l Folded cycle under source. The target query node becomes a child of the source
query node.

l Flattened cycle under parent. The target query node becomes a sibling of the
source query node.

Target Displays the valid target query nodes for the selected source query node. A query
node is defined as a valid target query node if all of the following conditions are true:

l it is related to the source query node

l it is an ancestor of the source query node (or the source query node itself)

l it is a query based node (not a grouping node)

Hidden CIs Dialog Box
This dialog box enables you to restore hidden CIs to a view.

To
access

From the Perspective-based View Editor, click theShow Hidden CIs button from the
toolbar of the View Results pane.

See
also

l "Building a Perspective Based View" on page 249

l "Modeling Studio User Interface" on page 267

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

<check box> Select the check boxes for the CIs you want to restore.

CI Type The CI type of the excluded CI.

Name The name of the excluded CI.

Restore Click Restore to include the selected CIs in the view.

Select All Click Select All to select all the CIs in the list for inclusion in the view.

Unselect All Click Unselect All to clear the check boxes of all the CIs in the list.

Hierarchy Rules Dialog Box
This dialog box enables you to set the hierarchy of a view by defining hierarchy rules.
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To access From the Hierarchy pane of the Pattern View Editor, whenRule Based is

selected as the hierarchy method, click theAdd Hierarchy Rule button from
the toolbar.

Important
information

For each hierarchy rule you define, select a source CI type, target CI type,
relationship, and direction.

Relevant
tasks

"How to Create a Pattern View" on page 255, "How to Create a Template" on
page 256, "How to Create a Perspective" on page 257

See also l "Building a Business View" on page 242

l "Modeling Studio User Interface" on page 267

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

Add. Adds a hierarchy rule.

Delete. Deletes the selected hierarchy rule.

Relationship Select a relationship from the drop-down list to edit the selected hierarchy
rule.

Relationship
Direction

Select a direction from the drop-down list to edit the selected hierarchy rule.

Source Select a CI type for the source CI type from the drop-down tree to edit the
selected hierarchy rule.

Target Select a CI type for the target CI type from the drop-down tree to edit the
selected hierarchy rule.

Left Pane
This area enables you to browse views (including dynamic widgets) and TQL queries, search for
CIs or models to open in the Editor pane, and select CI types to use in the TQLQuery Editor or
Pattern View Editor.

To access Located to the left of the Editor pane inModeling Studio.
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Important
information

The following tabs are available:

l Resources. Enables you to select amodel, view, or TQL query to open
in the Editor pane.

l CI Selector. See "CI Selector" on page 133.

l CI Types. Enables you to select CI types from the tree to add as a query
node to your TQL query.

See also l "Templates and Perspectives" on page 245

l "Modeling Studio User Interface" on page 267

Resources Tab

Important
information

WhenViews orQueries is selected as the resource type, you can drag and drop
views, queries, or folders tomove them from one folder to another.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

New Folder. Creates a new folder in the resource tree.

Note: This button only appears whenQueries orViews are selected as the
resource type.

Delete. Deletes the selected resource from the CMDB.

Note:When you delete a resource with dependent resources, the
dependent resources are also deleted. Dependent resources can include
queries, views, or custom reports.

Refresh. Refreshes the resource tree.

Expand All. Expands all the folders in the resource tree.

Note: This button only appears whenQueries orViews are selected as the
resource type.
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UI Element
(A-Z) Description

Collapse All. Collapses all the folders in the resource tree.

Note: This button only appears whenQueries orViews are selected as the
resource type.

When Queries orViews are selected as the resource type, click Hide Empty
Folders to display only folders containing views or TQL queries.

WhenModels is selected as the resource type, click Show only models with
content to display only models containing CIs.

Filter Tree/Table.

WhenViews is selected as the resource type, click Filter Tree to filter the
types of views, templates, and dynamic widgets that appear in the tree.

WhenQueries is selected as the resource type, click Filter Tree to filter the
TQL queries that appear in the tree by query type.

WhenModels is selected as the resource type, click Filter Table to filter the
models in the table by CI type.

Filter Tree by Bundle. Allows you to filter queries or views by predefined
bundle.

If you select more than one bundle from the available list, each resource that
belongs to at least one of the bundles is displayed.

Note: This button is active only when the Filterable Bundles List setting is
configured in the Infrastructure Settings Manager. For details, see
"Infrastructure Settings Manager Page" on page 1.

Open Query. Opens the selected TQL query in a new tab.

Note: This button only appears whenQueries is selected as the resource
type.

Open View. Opens the selected view in a new tab.

Note: This button only appears whenViews is selected as the resource
type.
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UI Element
(A-Z) Description

CI Properties. Enables you to view the properties of the selectedmodel.

Note: This button only appears whenModels is selected as the resource
type.

Show views containing selected CI/model. Displays a list of views including
the selected CI or model.

Note: This button only appears whenModels is selected as the resource
type.

Open Model. Opens the selectedmodel in theModel Editor.

Note: This button only appears whenModels is selected as the resource
type.

Pattern Based Model Scheduler. Enables you tomodify the starting time and
repeat interval for all pattern-basedmodels.

Note: This button only appears whenModels is selected as the resource
type.

Assign Tenants. Opens the Assign Tenants dialog box which enables you to
assign tenants to amodel.

Note:

l This button only appears whenModels is selected as the resource type.

l This button is only available whenmulti-tenancy is enabled.

Import From XML. Enables you to import XML files that contain saved views
or queries to theModeling Studio.

Note: This button only appears whenQueries orViews are selected as the
resource type.
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UI Element
(A-Z) Description

Export To XML. Enables you to export the view or query as an XML script. This
option can be used tomove a view or query from one workstation to another.

Note: This button only appears whenQueries orViews are selected as the
resource type.

<Resources> WhenViews orQueries is selected as the resource type, the available views or
TQL queries are displayed under their respective folders in tree format. When
Models is selected as the resource type, the available models are displayed in a
table.

For views, the following view types are included:

l Denotes a pattern view.

l Denotes a template.

l Denotes a template-based view.

l Denotes a perspective.

l Denotes a perspective-based view.

l Denotes an automation flow mapping. Only relevant when the
Automation Flow Adapter has been deployed. For details, see the
UCMDB Browser documentation.

l Denotes a dynamic widget.

Resource
Type

Select the resource type to display in the pane. The available options are
Models, Views, andQueries.

Resources Tab Shortcut Menu

The Resources tab includes the following elements (listed alphabetically) available by right-clicking
a resource:

Menu Item Description

Assign Tenants Open the Assign Tenants dialog box which enables you to assign
tenants to the resource.

Create a new
View/Template/Perspective

Create a new view, template, or perspective.
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Menu Item Description

Delete Delete the selected resource from the CMDB.

Note:When you delete a resource with dependent
resources, the dependent resources are also deleted.
Dependent resources can include queries, views, or custom
reports.

Export To XML Export the view or query as an XML script. This option can be
used tomove a view or query from one workstation to another.

Manage Security Assign the selected resource to specific roles or resource
groups.

Note: This option is not relevant for models.

New Folder Create a new folder in the resource tree.

New Template Based View Edit the parameters of the selected template to define a new
template-based view.

Note: This option is only active when a template is selected
in the view tree.

Open Query/View/Model Open the selected view, TQL query, or model in a new tab.

Properties Opens the CI Properties dialog box for the selectedmodel.

Note: This option is only relevant for models.

Refresh Refresh the resource tree.

Remove Remove the selectedmodel.

Note: This option is only relevant for models.

Rename Folder Rename the selected folder.

Save As Save the selected TQL query with a new name.

Show containing views Opens the Views containing selected CI dialog box for the
selectedmodel.

Note: This option is only relevant for models.
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CI Types Tab
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

Expand All. Expands all the folders in the CI Type tree.

Collapse All. Collapses all the folders in the CI Type tree.

Tree View Displays the format of the CI type tree. The following options are available:

l by Display label

l by Class name

l by Legacy class name

Add Selected CITs to Query. Adds the selected CI type to the TQL query which
is open in the Editor pane.

Note: This button is only active when a view or TQL query is open in the
Editor pane.

Refresh. Refreshes the CI Type tree.

<CI Type
tree>

The available CI types are displayed in tree format.

CI Types Tab Shortcut Menu

The CI Types tab includes the following elements (listed alphabetically) available by right-clicking a
CI type:

Menu Item Description

Add Selected
CITs to Query

Select to add the selected CI type to the TQL query open in the Editor pane.

Go to CI Type
Definition

Takes you directly to the selected CI type in CIT Manager.

Show Element
Instances

Opens the CI Instances window, which displays all instances of the selected
CIT. For details, see "CI Instances Dialog Box" on page 64.

Manage CI Watchpoints Dialog Box
This dialog box enables you to add or remove watchpoints for a CI in amodel.
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To
access From within amodel in theModel Editor, click theWatchpoint button and select

Manage CI Watchpoints or right-click a CI in themodel and selectWatchpoint >
Manage CI Watchpoints.

See
also

l "Revealed CIs andWatchpoints" on page 251

l "Modeling Studio User Interface" on page 267

User interface elements are described below:

UI Element
(A-Z) Description

Add Opens the New Watchpoint dialog box which enables you to add a new
watchpoint.

Remove
Deletes the selected watchpoint.

Automated A check mark indicates that the new CIs found by the watchpoint are to be
added to the view automatically.

Source CI Displays the CI forming the beginning of the reveal path.

Watchpoint
Name

The name of the reveal path associated with the watchpoint.

Watchpoint
Path

Displays the reveal path for the watchpoint.

Model Editor
This feature enables you to create and edit models.

To access In theModeling Studio, click theNew button and select Instance Based
Model to create a new model or selectModels as the Resource type and open an
existingmodel.
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Important
information

TheModel Editor contains the following panes:

l Content pane. Lists the CIs andmodels contained in themodel.

l Information pane. Displays the properties, related CIs and watchpoints for
the selected CI or model.

You can drag CIs from the CI Selector into the Content pane of an existingmodel
to add them to themodel. However, you cannot drag in a CI that is already
included in themodel.

You can drag CIs from the CI Selector into the Related CIs tab of the Information
pane provided that the selected source and target CI can be related by a usage
relationship.

Relevant
tasks

"How to Build an Instance-basedModel " on page 264

See also l "Business CI Models" on page 247

l "Modeling Studio User Interface" on page 267

Content Pane
User interface elements are described below:

UI Element (A-Z) Description

Map. Displays the CIs as icons in a diagram.

Text. Displays the CIs in a list.

CI Properties. Opens the Configuration Item Properties dialog box for
the selected CI.

Show models containing selected CI. Displays a list of themodels
containing the selected CI.

Show views containing selected CI/model. Displays a list of the
views containing the selected CI or model.

Open selected model in a new tab. Opens the selectedmodel in a
separateModel Editor tab.

Generate view for selected model. Enables you to create a view
based on the current model. The Creating New View dialog box opens,
which enables you to select a perspective to apply.

Remove Selected CI(s) from the Model. Removes a selected CI from
themodel (it remains in the CMDB).
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UI Element (A-Z) Description

Insert new model Opens the New Model dialog box which enables you
to define a new model within the existingmodel.

Expand All. Expands themodel hierarchy.

Collapse All. Collapses themodel hierarchy.

Reveal. Includes the following options:

l Start Revealing. Opens the Reveal CIs dialog box. For details, see
Reveal CIs dialog box.

l Create Reveal Path. Opens the Create Reveal Path dialog box. For
details, see Create Reveal Path dialog box.

l Open Reveal Path. Opens theOpen Reveal Path dialog box. For
details, seeOpen Reveal Path dialog box.

Watchpoint. Includes the following options:

l Watchpoints Updates. Enables you to display the watchpoint
results and select CIs to add to themodel. For details, see
Watchpoints Updates dialog box.

l New Watchpoint. Enables you to define a new watchpoint for the
selected CI. For details, see New Watchpoint dialog box.

l Manage CI Watchpoints. Enables you to add new watchpoints to
the CI or remove existing ones. For details, seeManage CI
Watchpoints dialog box.

CI Collection. Enables you to group CIs in a collection under amodel.
Select one of the following options:

l Insert New CI Collection. Create a new empty CI Collection. After
creating the collection, you can drag CIs into it from the CI Selector,
the related CIs tab, or from themodel itself.

l Join to CI Collection. Select a CI or several CIs in themodel and
join them to an existing CI collection or form a new collection.

l Decompose CI Collection. Select a CI collection and decompose
it. Its CIs remain directly under themainmodel.
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UI Element (A-Z) Description

Find. Toggles between displaying and hiding the Find box and arrow
controls.

Note: This button only appears in Text mode.

Refresh. Refreshes themap to optimize the layout.

Note: This button only appears in Mapmode.

Fit to Window. Resizes themap to fit the size of the pane.

Note: This button only appears in Mapmode.

Select the functionality of the cursor from theMode drop-down. The
following options are available:

l Select

l DragMap

l Zoom In

Note: This feature only appears in Mapmode.

Print. Enables you to select Print, Print Preview or Print Setup.

Show External Relationships. Displays the related CIs for the
selected CI.

Note: This button only appears in Mapmode.

Hide External Relationships. Hides the related CIs of the selected CI.

Note: This button only appears in Mapmode.

Indicates that watchpoints are defined for the current CI.

Indicates that the watchpoints have detected new CIs related to the
current model. Click it to open theWatchpoints Updates dialog box.

CI Type column Displays the type of each CI in themodel.
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UI Element (A-Z) Description

Find Enter a CI name or a portion of a CI name in the Find box to locate a CI
in themodel.

Find Next Click to go to the next occurrence of the selected search phrase in the
model.

Find Previous Click to go to the previous occurrence of the selected search phrase in
themodel.

Highlight Click to highlight all occurrences of the search phrase in themodel.

Name column Displays the name of each CI in themodel.

Shortcut Menu Options

Menu Item Description

CI Collection Click CI Collection to group CIs in a collection under amodel. Select one of
the following options:

l Insert New CI Collection. Create a new empty collection. After creating
the collection, you can drag CIs into it from the CI Selector, the related
CIs tab, or from themodel itself.

l Join to CI Collection. Select a CI or several CIs in themodel and join
them to an existing CI collection or form a new group.

l Decompose CI Collection. Select a CI collection and decompose it. Its
CIs remain directly under themainmodel.

Fit to Window Resizes themap to fit the size of the pane.

Note: This option only appears in Mapmode.

Generate view
for selected
model

Creates a view based on the current model. The Creating New View dialog
box opens which enables you to select a perspective to apply.

Hide External
Relationships

Hides the related CIs from themap.

Note: This option only appears in Mapmode.

Insert New
Model

Opens the New Model dialog box which enables you to create a new model
within the existingmodel.

Modeling Guide
Chapter 8: Modeling Studio

HP Universal CMDB (10.10) Page 288 of 534



Menu Item Description

Open selected
model in a new
tab

Opens the selectedmodel in a separateModel Editor tab.

Print Select one of the following options:

l Print

l Print Preview

l Print Setup

Properties Opens the Configuration Item Properties dialog box for the selected CI.

Refresh Layout Refreshes themap and optimizes themap layout.

Note: This option only appears in Mapmode.

Remove
Selected CI(s)
from the Model

Deletes the selected CIs from themodel (it remains in the CMDB).

Reveal The following options are available:

l Start Revealing. Opens the Reveal CIs dialog box. For details, see
Reveal CIs dialog box.

l Open Reveal Path. Opens theOpen Reveal Path dialog box. For details,
seeOpen Reveal Path dialog box.

Select Select the functionality of the cursor. The following options are available:

l Select

l DrapMap

l Zoom In

Note: This option only appears in Mapmode.

Show
Containing
Models

Displays a list of themodels containing the selected CI.
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Menu Item Description

Show
Containing
Views

Displays a list of the views containing the selected CI or model.

Show External
Relationships

Displays the related CIs for the selected CI.

Note: This option only appears in Mapmode.

Watchpoint The following options are available:

l Watchpoints Updates. Display the watchpoint results and select CIs to
add to themodel. For details, seeWatchpoints Updates dialog box.

l New Watchpoint. Define a new watchpoint for the selected CI. For
details, see New Watchpoint dialog box.

l Manage CI Watchpoints. Add new watchpoints to the CI or remove
existing ones. For details, seeManage CI Watchpoints dialog box.

Zoom Select the size of themap from the list of percents.

Note: This option only appears in Mapmode.

Information Pane - Properties Tab
This area displays the properties of the selected CI.

Important
information

This pane is identical to the Properties tab of the Information pane in IT Universe
Manager. For details, see "Configuration Item Properties Dialog Box" on page
207.

Information Pane - Related CIs Tab
This area displays the CIs related to themodel by one of the triplets that includes an Impacted By
(Potentially) relationship.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A-Z) Description

Click to delete the relationship to the selected CI.
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UI
Element
(A-Z) Description

Click Invert Direction to switch the direction of the relationship for the selected
CI.

Note: This option is only active for CIs related by a usage relationship.

<CI list> Lists the name and CI type of the CIs related to themodel by usage relationships,
as well as the direction of the relationship.

Filter by Select a field by which to filter the results and enter the value in the by box.

Information Pane - Watchpoints Tab
This area displays the watchpoints defined for the selected CI.

User interface elements are described below:

UI Element
(A-Z) Description

Click to open theManage CI Watchpoints dialog box, which enables you to
edit the watchpoint.

Automated Indicates whether the new CIs found by the watchpoint are automatically
added to the view.

Source CI Displays the CI forming the beginning of the reveal path.

Watchpoint
Name

The name of the reveal path associated with the watchpoint.

Watchpoint
Path

Displays the reveal path of the watchpoint.

Modeling Studio Page
This page enables you to create and edit models and views.

To access SelectModeling Studio from the NavigationMenu or selectManagers >
Modeling > Modeling Studio.
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Important
information

TheModeling Studio page contains the following panes:

l Left pane. Enables you to search for CIs or select a view, model, or TQL
query to open. For details, see "Left Pane" on page 277.

l Editor pane. Displays the topology map of a selected view, model, or TQL
query.

The Editor pane is a blank canvas before any views or models are opened. When
you open a view, model, or TQL query, the relevant editor appears there. Multiple
views, models, and queries can be open at the same time in the Editor pane, each
within a separate tab.

Relevant
tasks

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

l "How to Create a Dynamic Widget" on page 259

l "How to Create a Template Based View" on page 261

l "How to CreateMultiple Template Based Views" on page 262

l "How to Build an Instance-basedModel " on page 264

l "How to Build a New Pattern-basedModel " on page 265

l "How to Define Report Settings" on page 263

l "How to Build a Perspective-based View Based on a Collection of CIs" on
page 267

l "How to Build a Perspective-based View Based on aModel " on page 266

See also l "Building a Perspective Based View" on page 249

l "Business CI Models" on page 247

l "Creating Template Based Views" on page 247

l "Templates and Perspectives" on page 245

l "View Formats" on page 242

l "Modeling Studio User Interface" on page 267

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element
(A-Z) Description

New
New. Select one of the following options:

l Instance Based Model. To create a new instance basedmodel.

l Pattern Based Model. To create a new pattern basedmodel.

l Pattern View. To create a new pattern view.

l Template Based View. To create a new template-based view.

l Perspective Based View. To create a new perspective-based view.

l Template. To create a new template.

l Perspective. To create a new perspective.

l Dynamic Widget. To create a new dynamic widget for the UCMDB Browser.

l Query. To create a new TQL query.

l Automation Flow Mapping. To create an automation flow mapping. Only
relevant when the Automation Flow Adapter has been deployed. For details, see
the UCMDB Browser documentation.

Save. Saves the changes to your view, model, or query.

For views, a dialog box opens which enables you to rename your view and save it in
the appropriate folder.

Save As. Enables you to save your view, model, or TQL query under a new name.

Undo. Reverses the last change youmade.

Redo. Repeats the last action you took.

Maximize Workspace. Toggles between the regular display and a full-screen display
of the editor.

<Menu> For details, see "MainMenu" on page 163.

Models Containing Selected CI Dialog Box
This dialog box enables you to display a list of themodels containing the selected CI.
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To
access

Click theShow models containing selected CI button in theModel Editor or
select Show containing models from the shortcut menu.

See
also

l "Business CI Models" on page 247

l "Modeling Studio User Interface" on page 267

User interface elements are described below:

UI Element
(A-Z) Description

CI Properties. Opens the Configuration Item Properties dialog box for the
selectedmodel.

Show views containing selected CI/model. Displays a list of views
containing the selectedmodel.

Remove model. Deletes the selectedmodel.

CI Type Displays the CI types of themodels containing the selected CI.

Find Enter amodel name or a portion of amodel name in the Find box to locate it in
the list.

Find Next Click to go to the next occurrence of the selected search phrase in the list.

Find
Previous

Click to go to the previous occurrence of the selected search phrase in the list.

Name Displays the names of themodels containing the selected CI.

Note: The name of the current model appears in faded text.

New Model Dialog Box
This dialog box enables you to define a reusablemodel containing a collection of CIs.

To access Click theNew button and select Instance Based Model or drag a
CI from the tree in the CI Selector onto the editing pane and select
Create a new model.

Relevant tasks "How to Build an Instance-basedModel " on page 264

See also l "Business CI Models" on page 247

l "Modeling Studio User Interface" on page 267

User interface elements are described below:
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UI Element
(A-Z) Description

Define new
CI Properties

Enter the values for the CI properties. Youmust enter values for required
properties. The required properties aremarked with an asterisk.

Select CI
Type

Select a CI type from the list to serve as the basis for your model.

New Pattern View/Template/Perspective Dialog Box
This dialog box enables you to define a new pattern view, template, or perspective using the Pattern
View Editor.

To access In theModeling Studio, click theNew button and select Pattern View,
Template, or Perspective from the drop-downmenu.

Important
information

After making your selection and clickingOK, you go directly to the Pattern View
Editor to begin building your view. For details, see "Pattern View Editor" on page
300.

Relevant
tasks

"How to Create a Pattern View" on page 255, "How to Create a Template" on
page 256, "How to Create a Perspective" on page 257

See also l "Building a Business View" on page 242

l "Modeling Studio User Interface" on page 267

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A-Z) Description

Find Next. Goes to the next occurrence of the selected search phrase in the list of
TQL queries.

Find Previous. Goes to the previous occurrence of the selected search phrase in the
list of TQL queries.

Highlight All. Highlights all occurrences of the search phrase in the list of TQL
queries.

<TQL
query
tree>

Displays the existing TQL queries in tree format.

Choose
base
query

If you want to base your new view on an existing TQL query, select this option and
select a TQL query from the tree. The Pattern View Editor opens with the selected
TQL query on the canvas.
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UI
Element
(A-Z) Description

Create
new
query

If you want to base your new view on a new TQL query, select this option. The
Pattern View Editor opens with a blank canvas.

Find Enter a TQL query name or a portion of a query name in the Find box to locate a TQL
query in the list.

New Watchpoint Dialog Box
This dialog box enables you to define a watchpoint for a CI in amodel.

To access
From within amodel in theModel Editor, click theWatchpoint button and
select New Watchpoint or right-click a CI in themodel and selectWatchpoint >
New Watchpoint.

Important
information

If no reveal paths are found for the selected CI, no watchpoints can be defined.

You cannot define watchpoints for CIs in a new model until you save themodel.

Relevant
tasks

"How to Build an Instance-basedModel " on page 264

See also l "Revealed CIs andWatchpoints" on page 251

l "Modeling Studio User Interface" on page 267

User interface elements are described below:

UI Element (A-Z) Description

Automatically
update model

Select to automatically add all revealed CIs from the selected path to the
model.

Note: In amulti-tenancy environment, this action requires Data Update
permission in connection with all tenants of themodel.

Control updates
manually

Select to manually add revealed CIs from the selected path to themodel.

Select
Watchpoint
reveal path

Select a reveal path from the drop-down list.

Show reveal
paths for CI type

Select a CI type from the drop-down list. All reveal paths beginning with that
CI type appear in the list in the lower drop-down box.
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Open Reveal Path Dialog Box
This dialog box enables you to open an existing path.

To access
From within amodel in theModel Editor, click theReveal button and select
Open Reveal Path or right-click a CI in themodel and select Reveal > Open
Reveal Path.

Important
information

After selecting the reveal path you want to use, click Execute. If CIs are found on
the selected path, the Reveal CIs dialog box opens for that path. If no CIs are
found, amessage appears stating that no CIs were found on the path.

See also l "Revealed CIs andWatchpoints" on page 251

l "Modeling Studio User Interface" on page 267

User interface elements are described below:

UI Element (A-Z) Description

Description column Displays the descriptions of the existing paths.

Edit Opens the Edit Reveal Path dialog box which enables you to edit the
selected path.

Execute Opens the Reveal CIs dialog box for the selected reveal path.

Find Enter a path name or a portion of a path name in the Find box to locate a
path in the list.

Find Next Click to go to the next occurrence of the selected search phrase in the
list of paths.

Find Previous Click to go to the previous occurrence of the selected search phrase in
the list of paths.

Highlight Click to highlight all occurrences of the search phrase in the list of paths.

Name column Displays the names of the existing paths.

Remove Deletes the selected path.

Show reveal paths
for CI type

Select a CI type from the drop-down list. All paths beginning with the
selected CI appear in the table below.

Pattern Based Model Scheduler Dialog Box
This dialog box enables you to set the starting date and time and the repeat interval for Pattern-
basedmodels.
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To access In theModeling Studio, click thePattern Based Model Scheduler button in
the Resources tab of the left pane.

Important
information

All the pattern-basedmodels are updated at the same time. The settings you
select apply to all existing pattern-basedmodels as well as those created
subsequently. The default starting time for model updates is the server time at the
time the first model is created. When you open the dialog box, the default starting
time is the current server time at that moment. The default repeat interval is 12-
hours.

Relevant
tasks

"How to Build a New Pattern-basedModel " on page 265

See also l "Business CI Models" on page 247

l "Modeling Studio User Interface" on page 267

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

Advanced Pattern Based Model
Scheduler Updates

Select this option to schedule the pattern-basedmodel
updates using a Cron expression.

Cron Expression WhenAdvanced Pattern Based Model Scheduler
Updates is selected, enter a Cron expression.

For a description of the fields used in Cron expressions
and examples of how to use them, see, "Cron
Expressions" on page 338.

Daily Pattern Based Model
Scheduler Updates

Select this option to schedule the pattern-basedmodel
updates using a starting date and time and a repeat
interval.

Repeat interval WhenDaily Pattern Based Model Scheduler Updates
is selected, select an option for the repeat interval (in
hours). This determines the frequency of the pattern-based
model updates.

Note: The repeat interval must be evenly divisible in a
24-hour period to ensure that the updates are
performed at the same hours each day.

Server time Displays the time on the server.

Start at Select a starting date and time for the pattern-basedmodel
updates.

Validate Expression After entering a Cron expression, click theValidate
Expression button to confirm that the expression is valid.

Modeling Guide
Chapter 8: Modeling Studio

HP Universal CMDB (10.10) Page 298 of 534



Pattern Based Model Wizard
This wizard enables you to build a pattern-basedmodel.

To access In theModeling Studio, click theNew button and select Pattern Based
Model from the drop-downmenu.

Important
information

When you create a pattern-basedmodel, themodel is saved as a CI, as with an
instance-basedmodel. If you based your model on a new TQL query, the query is
also saved and appears in the TQL query tree.

When you build a pattern-basedmodel over an existing instance-basedmodel, the
model is saved with the name of the instance-basedmodel.

If you create a new pattern-basedmodel with the same name as a previously
deleted pattern-basedmodel, you can select an old query on which to base the
new pattern-basedmodel or you can create a new query.

Relevant
tasks

"How to Build a New Pattern-basedModel " on page 265

Wizard
map

The Pattern BasedModel Wizard contains:

"Select CI Type Page" > "Query Selection Page"

See also l "Pattern-basedModels" on page 248

l "Modeling Studio User Interface" on page 267

Select CI Type Page

This wizard page enables you to select a CI type for themodel and define its details.

Wizard map The Pattern BasedModel Wizard contains:

"Select CI Type Page" > "Query Selection Page"

User interface elements are described below:

UI
Element
(A-Z) Description

Existing
Model

Select Existing Model to build a pattern-basedmodel over an existing instance-
basedmodel. Select an existingmodel from the tree.

New
Model

Select New Model to create a new pattern-basedmodel (unrelated to any other
model). In theSelect CI Type section, select a CI type from the list to serve as the
basis for your model. Then enter the values for the CI properties in theDefine New CI
Properties section.
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Query Selection Page

This wizard page enables you to select a TQL query upon which themodel is based.

Wizard map The Pattern BasedModel Wizard contains:

"Select CI Type Page" > "Query Selection Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A-Z) Description

Find Next. Goes to the next occurrence of the selected search phrase in the list of
TQL queries.

Find Previous. Goes to the previous occurrence of the selected search phrase in the
list of TQL queries.

Highlight All. Highlights all occurrences of the search phrase in the list of TQL
queries.

<TQL
Query
tree>

Displays the existing TQL queries in tree format.

Choose
base
query

If you want to base your model on an existing TQL query, select this option and select
a query from the tree. The TQLQuery Editor opens with the selected query on the
canvas.

Create
new
query

If you want to base your model on a new TQL query, select this option. The TQL
Query Editor opens with a blank canvas.

Note:When you create a pattern-basedmodel based on a new query, the
query's priority is automatically set toNot Active.

Find Enter a TQL query name or a portion of a query name in the Find box to locate a query
in the list.

Pattern View Editor
This feature enables you to build and edit pattern views, templates, and perspectives.
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To access To open a new view in the Pattern View Editor, go to theModeling Studio, click

theNew button and select the required type of view.

To open an existing view in the Pattern View Editor, go to the Resources tab of
the left pane in theModeling Studio and select Views as the Resource type.
Right-click a view in the tree and select Open View or double click a view or drag
a view onto the Editor pane. The topology map of the view opens in the Editor
pane.

Important
information

You can access the Editor in one of the followingmodes:

l InViewmode, the following panes are included:

n Query Definition pane. For details, see "TQLQuery Editor" on page 326.

n Advanced pane. For details, see "Advanced Pane" on page 1.

n Hierarchy pane. Enables you to set the hierarchy of the view. (Located in
the right portion of the Editor page.)

l InReportmode, the following panes are included:

n Hierarchy pane. Enables you to set the hierarchy of the view. (Located in
the left portion of the Editor page.)

n Query Node Definition. Enables you to select the attributes to be included
in the report and to set their order.

l InWidgetmode, the following panes are included:

n Hierarchy pane. Enables you to set the hierarchy of the view. (Located in
the left portion of the Editor page.)

n Widget Node Definition. Enables you to specify options for the CI's
attributes to be included in the dynamic widget.

Note:Widget mode is available only when creating or editing a
dynamic widget.

Note: To save your view, template, perspective, or dynamic widget, use the
Save button in theModeling Studio main toolbar.
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Relevant
tasks

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

l "How to Create a Dynamic Widget" on page 259

See also l "Building a Perspective Based View" on page 249

l "Templates and Perspectives" on page 245

l "Modeling Studio User Interface" on page 267

Hierarchy Pane
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A-Z) Description

Add Group By. Enables you to create a subgroup in the hierarchy. The following
options are available:

l Add Group By Attribute. Opens theQuery NodeGrouping dialog box, which
enables you to select an attribute for a subgroup in the hierarchy.

l Add Group By CI Type. Create a subgroup in the hierarchy for the CI type of
the selected query node.

l Add Group by View Node. Create a subgroup in the hierarchy for the selected
query node only.

Note: You cannot define subgroups on a contact query node of a perspective.

Edit Group By Attribute. Opens theQuery NodeGrouping dialog box, which
enables you to edit the attribute for a subgroup in the hierarchy.

Rename. Enables you to rename the selected query node.

Delete View NodeDeletes the selected query node from the hierarchy tree.

Move View Node Layer Up.Moves the selected query node one layer higher in
the hierarchy.
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UI
Element
(A-Z) Description

Move View Node Layer Down.Moves the selected query node under the query
node above it in the hierarchy.

Note: If the selected query node is located at the top of the hierarchy tree,
clickingMove View Node Layer Down places it under the query node
beneath it in the hierarchy.

Move View Node Up.Moves the selected query node up in the hierarchy tree.
The query node order in the hierarchy determines the query node order in the report
generated for the view in Reports.

Move View Node Down.Moves the selected query node down in the hierarchy
tree. The query node order in the hierarchy determines the query node order in the
report generated for the view in Reports.

Preview. Displays a preview of the topology report.

Note: This option only appears in the Hierarchy pane when Report mode is
selected.

Report Properties. Opens the Report Properties dialog box, which enables you to
set the title, subtitle, and format for the view's topology report. For details, see
"Report Properties Dialog Box" on page 401.

<Hierarchy
tree>

The query nodes of the TQL query are arranged in a hierarchical tree reflecting the
hierarchy defined for the view.

You can click and drag query nodes to change the hierarchy. When you click a
query node and begin to drag it, the query nodes under which it is possible to place
your query node are highlighted in green.

Hierarchy
Method

Select themethod of setting the hierarchy:

l Manual. Set the hierarchy manually, by dragging query nodes and using the
toolbar buttons.

l Rule Based. Open the Hierarchy Rules dialog box which enables you to set
rules for the hierarchy.

Shortcut Menu

The Hierarchy pane includes the following elements (listed alphabetically) available by right-clicking
a query node in the hierarchy tree:
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Menu Item Description

Add Group
By Attribute

Select Add Group By Attribute to open theQuery NodeGrouping dialog box,
which enables you to select an attribute for a subgroup in the hierarchy.

Add Group
By CI Type

Select Add Group By CI Type to create a subgroup in the hierarchy for the CI
type of the selected query node.

Add Group
By View
Node

Select Add Group By View Node to create a subgroup in the hierarchy for the
selected query node only.

Define
Cycles

Select Define Cycles to define a cyclical hierarchy. For details, see "Cycle
Definition Dialog Box" on page 275.

Delete View
Node

Select to delete the selected query node from the hierarchy tree.

Move View
Node Down

Select to move the selected query node down in the hierarchy tree.

Move View
Node Layer
Down

SelectMove View Node Layer Down to place the selected query node under
the query node above it in the hierarchy.

Note: If the selected query node is located at the top of the hierarchy tree,
selectingMove View Node Layer Down places it under the query node
beneath it in the hierarchy

Move View
Node Layer
Up

SelectMove View Node Layer Up to place the selected query node one layer
higher in the hierarchy.

Move View
Node Up

Select to move the selected query node up in the hierarchy tree.

Rename Select to rename the selected query node.

Set View
Node
Invisible

Select to set the selected query node invisible. CIs of this type do not appear in
the view results.

When this option is selected, aHidden in Query Results indicator appears
in the corner of the selected query node in the hierarchy tree.

Set View
Node Visible

Select to set the selected query node visible. CIs of this type appear in the view
results.

Subgraph
Hierarchy

Enables you to define whether the subgraph defined for the selected query node
is displayed as flat or as folded under the query node.

Note: This option is only relevant for query nodes that have a defined
subgraph.
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Query Node Definition Pane

Important
information

TheQuery Node Definition pane is disabled for template based views. Tomake
changes to the report layout, edit the based template of the view. When you open
a template based view in the Editor and select the Report tab, a warningmessage
appears containing a link to the base template of the view.

User interface elements are described below:

UI
Element
(A-Z) Description

UpMoves a selected attribute up in the report layout order.

Down.Moves a selected attribute down in the report layout order.

Edit. Enables you to edit the function for the selected attribute.

Delete. Deletes the selected attribute from the report layout.

Moves the selected attributes to the Report Layout list.

Add
Function

Click Add Function to open the Add Function dialog box, which enables you to
define the functions to include in the report for the selected query node. Each
function that you add is treated as an attribute and becomes a column in the report.

Note: This button is only active if there is a query node below the selected
query node in the view hierarchy.

Attributes The list of available attributes for the selected query node.

Define
Chart

Click Define Chart to display the data for the current layer of the view in a graphical
chart format. The Chart Properties fields are displayed.

The Define Chart option is only active for a query node or a grouping node that:

l is the top layer of the view and has a layer below it in the view hierarchy

l is the only query node on its layer of the view

l has at least one numeric attribute selected for the report layout

Report
Layout

Displays the list of attributes selected to appear in the report. Use the toolbar
buttons to change the order of the attributes in the report and to add functions.

Set Sort
Order

Click to open the Set Column Sort Order dialog box which enables you to set the
order of the report columns.

Chart Properties
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The Chart Properties portion of the pane includes the following elements (listed alphabetically):

UI Element
(A-Z) Description

Remove Chart. Removes the chart from the report. The report is generated in
table format.

Breakdown
by

The chart is broken down by the CI or grouping node display label. This is fixed
for all reports.

Chart Type Select Pie to create a pie chart orBar to create a bar chart.

Value Select a value from the drop-down list.

Widget Definition Pane
User interface elements are described below:

UI Element
(A-Z) Description

<Enforce
Browser CI
access
control>

Select this check box to ensure that the dynamic widget displays data only
according to the permissions that were specified on the Browser CI Access
Control tab in the Roles manager. If the check box is not selected, the dynamic
widget displays all data, without permission enforcement.

<Show
path>

Select this check box to cause the UCMDB Browser to display the route in the
dynamic widget from a specific node in the view definition to all the node's
children.

Attribute
name

The attributes for the selected node that are displayed in the dynamic widget.

Details Specifies whether this attribute appears in theWidget Details mode.

Group
Name

Specifies the name under which the attribute is grouped in theWidget Details
mode.

Overview Specifies whether this attribute appears in the CI Overview mode.

Refocusable Specifies whether this attribute is displayed as a hyperlink, able to refocus on the
CI on which the attribute is defined.

Perspective-based View Editor
This feature enables you to create and edit perspective-based views.
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To access In theModeling Studio, click theNew button and select Perspective Based
View to create a new view or drag CIs from the CI Selector onto the blank canvas
and select Create a new view.

To open an existing view in the Editor, select Views as the resource type in the
Resources pane, select the required perspective-based view from the tree, and

click Open View or double-click the view.

Important
information

The Perspective-based View Editor contains the following panes:

l Content pane. Drag CIs and/or models onto this pane to include them in your
view.

l Perspective pane. Select perspectives to apply to the content to build a view.

l View Results pane. Displays a topology mapwith a preview of the current
view. This pane includes most of the IT UniverseManager functionality.

Relevant
tasks

l "How to Build a Perspective-based View Based on aModel " on page 266

l "How to Build a Perspective-based View Based on a Collection of CIs" on
page 267

See also l "Building a Perspective Based View" on page 249

l "Modeling Studio User Interface" on page 267

Content Pane
User interface elements are described below:

UI
Element
(A-Z) Description

Show View Results in IT Universe. Goes directly to the current view in IT
UniverseManager.

Properties. Opens the Configuration Item Properties dialog box for the selected CI.

Show models containing selected CI. Displays a list of themodels containing the
selected CI.

Show views containing selected CI/model. Displays a list of the views
containing the selected CI or model.

Open selected model in a new tab. Opens the selectedmodel in a separate
Model Editor tab.
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UI
Element
(A-Z) Description

Generate view for selected model. Enables you to create a view based on the
selectedmodel. Opens the Creating New View dialog box where you can select a
perspective to apply.

Remove Base CIs. Removes the selected CI from the view content.

View Definition Properties. Opens the View Definition Properties dialog box which
enables you to set properties for the view.

Find. Toggles between displaying and hiding the Find box and arrow controls.

CI Type
column

Displays the type of each CI in the view.

Find Enter a CI name or a portion of a CI name in the Find box to locate a CI in the view.

Find
Next

Click to go to the next occurrence of the selected search phrase in the view.

Find
Previous

Click to go to the previous occurrence of the selected search phrase in the view.

Highlight Click to highlight all occurrences of the search phrase in the view.

Name
column

Displays the name of each CI in the view.

Shortcut Menu Options

Menu Item Description

Generate view
for selected
model

Select to create a view based on the selectedmodel. The Creating New
View dialog box opens which enables you to select a perspective to apply.

Open selected
model in a new
tab

Opens the selectedmodel in a separateModel Editor tab.

Properties Opens the Configuration Item Properties dialog box for the selected CI.

Remove Base
CIs

Deletes the selected CI or model from the view content.
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Menu Item Description

Show
Containing
Models

Click to display a list of themodels containing the selected CI.

Show
Containing
Views

Click to display a list of the views containing the selected CI or model.

Perspective Pane
User interface elements are described below:

UI Element
(A-Z) Description

Remove perspective step. Deletes the selected level of the perspective
selection.

Move step up. Shifts the perspective selection from the current level to the
previous one.

Move step down. Shifts the perspective selection from the current level to the
following one.

Add perspective step. Adds a new level to the perspective selection. The
results of the previous perspective level serve as the input content for the new
level.

Select perspectives. Opens a dialog box with the available perspectives. Move
the required perspectives from the available column to the selected column using
the arrow buttons.

To view a perspective definition, select a perspective in either column and click
theOpen Definition link. The perspective definition opens in a separate tab.

Apply Over
Model
Hierarchy

For views based onmodels, select theApply Over Model Hierarchy check
box to include themodel hierarchy in the view and apply the perspectives to the
CIs included in themodel as well as to themodel itself. Clear the check box to
exclude themodel hierarchy from the view and apply the perspectives to the
model itself only. In this case, themodel is treated as an ordinary CI.

Note: This option is disabled for a view based on a collection of CIs or on a
model and a collection of CIs.

Perspectives Lists the selected perspectives.

A default perspective appears in the window before any selection is made. You
can set the value of the default perspective using theSelected perspectives for
new perspective based views infrastructure setting.
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View Results Pane
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-
Z) Description

Map Displays the view results in Mapmode.

Text Displays the view results in Text mode.

Group by Select a groupingmethod for the CIs in the topology map. The available
options are:

l Group by Layer. Group the CIs according to the value of the layer
attribute of their CI type.

l Group by CI Type. Group the CIs according to their CI type.

l Group by Classification. Group the CIs according to the value of the
classification attribute of their CI type.

l No Grouping. Do not group CIs.

Note:

l This option is available in Mapmode only.

l When a grouping option is selected, each group contains an indicator
displaying the number of CIs in the group. If a group contains a large
number of CIs, it opens in collapsed format, displaying only the name
and count indicator. Click the + sign button to expand the group and
display all the CIs. You can set the threshold of CIs for automatically
collapsing the group by modifying the Initially expand group max
CIs threshold setting in the Infrastructure Settings Manager.

Create Relationship. Creates a relationship between two CIs in the view.

Go Up One Layer.Moves up one level in the topology map.

Drill Down One Layer.Moves down one level in the topology map.

Delete from CMDB. Deletes the selected CI from the CMDB.

Show CI Properties. Opens the Configuration Item Properties dialog box for
the selected CI.

Refresh. Refreshes the view results.
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UI Element (A-
Z) Description

Hide CI from View. Hides the selected CI from the view. This option is only
relevant for CIs that were added to the view via the perspective. You cannot
hide CIs from the original view content from the view.

Note: Hidden CIs can be restored from the Hidden CIs dialog box.

Show Hidden CIs. Opens the Hidden CIs dialog box which enables you to
restore CIs that were hidden from the view manually.

Create view based on selected CI/s. Enables you to create a new view
based on the CIs selected from the View Results pane.

Expand preview display. Displays the preview in a separate pane.

<Breadcrumbs> At the top of the topology map, the breadcrumbs indicate the relevant query
nodes in each layer of the view for the path to the selected layer. The first
item in the path is the Top Layer. When you select a CI from the layer below,
the parent CI forms the next item in the breadcrumb path. You can click on
any item in the path to display that layer in the topology map.

<Legend> Indicates the icons displayed next to CIs with any of the following special
statuses:

l Added.WhenChange Timeframe is active, indicates that the CI was
added.

l Candidate for Deletion. Indicates that the CI is a candidate for deletion.

l Changed.WhenChange Timeframe is active, indicates that the CI was
changed.

l Drill Down One Layer. Indicates that there are CIs under the CI on a
lower layer.

l External. Indicates that the CI is a federated CI.

l Impacted.When Impact Analysis is active, indicates an impacted CI.

l Impacted and Trigger.When Impact Analysis is active, indicates a
trigger CI that is impacted.

l Note. Indicates that a note was added for the CI.

l Trigger.When Impact Analysis is active, indicates a trigger CI.

Modeling Guide
Chapter 8: Modeling Studio

HP Universal CMDB (10.10) Page 311 of 534



UI Element (A-
Z) Description

<Topology
Map>

The topology map in the View Results pane follows the layout of the topology
map in IT UniverseManager. For details, see "Topology Map" on page 218.

<Topology Map
Sidebar>

For details, see "Topology Map Sidebar" on page 176.

Shortcut Menu Options

Menu
Item Description

<IT
Universe
Shortcut
Menu
options>

The IT UniverseManager shortcut menu options are available. For details, see "IT
UniverseManager Page" on page 217.

Create
view
based on
selected
CI/s

Select Create view based on selected CI/s to create a new view based on the
CIs selected from the View Results pane.

Hide CI
from View

Click to hide the selected CI from the view. This option is only relevant for CIs that
were added to the view via the perspective. You cannot hide CIs from the original
view content from the view. In the case of a view based on amodel, themodel
cannot be hidden but its CIs can.

Show
Hidden
CIs

Restore hidden CIs to the view.

Query Node Grouping Dialog Box
This dialog box enables you to define a new grouping of CIs or to edit an existing grouping.

To
access

Click theAdd Group by button in the Hierarchy pane of the Pattern View Editor
and select Add Group by Attribute or right-click the required query node and select
Add Group by Attribute from the shortcut menu.

Relevant
tasks

"How to Create a Pattern View" on page 255, "How to Create a Template" on page
256, "How to Create a Perspective" on page 257

See also l "Building a Business View" on page 242

l "Modeling Studio User Interface" on page 267
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User interface elements are described below:

UI Element (A-Z) Description

Expression capture
group index

Enter the number of the relevant portion of the regular expression. Enter
0 if the entire expression is relevant.

Group by Select an attribute from the drop-down list.

Mask to group by Enter a regular expression pattern representing the structure of the
selected attribute.

For details, see "Query NodeGrouping" on page 243.

Query/View Definition Properties Dialog Box
This dialog box enables you to configure the properties of a TQL query or view.

To access In theModeling Studio, click theQuery/View Definition Properties button in
the TQLQuery Editor or Pattern View Editor.

Important
information

In the View Definition Properties dialog box, you can select a default layout for the
view. Select an option underMap Layout or underGroup by (only one option can
be selected).

Relevant
tasks

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

l "How to Define a TQLQuery" on page 23

See also l "Building a Business View" on page 242

l "Modeling Studio User Interface" on page 267

User interface elements are described below:

UI Element (A-Z) Description

Base Query Select an existing TQL query on which to base your new query. Click

Clear Base Query to remove the selected base query.

Note:

l This field is only relevant for TQL queries.

l This field is optional.

Modeling Guide
Chapter 8: Modeling Studio

HP Universal CMDB (10.10) Page 313 of 534



UI Element (A-Z) Description

Bundles A method of grouping TQL queries or views by category. Select the
bundles associated with the current query or view or create a new
bundle for it.

Note: This field is optional.

Description A description of the TQL query or view.

Group by Select a default layout for the view, when consuming it in IT Universe
Manager or the view preview. The available options are the ones
described under Group by in "Topology Map" on page 218.

Note:

l This field is only relevant for views.

l If you select a default layout (other thanNo Grouping) from
this drop-down, theMap Layout field is disabled.

Inter-Layer Links Set the scope of inter-layer relationships displayed in the topology
results. For details, see "Inter-Layer Relationships" on page 189.

Note: This field is only relevant for views.

Managed by
Configuration Manager

Select the check box to denote the view as managed in HP Universal
CMDB ConfigurationManager.

Note: This field is only relevant for views and only when HP
Universal CMDB ConfigurationManager is configured and
running.

Map Layout Select a default layout for the view, when consuming it in IT Universe
Manager or the view preview. The available options are the ones
appearing under Layout in theMainMenu.

Note:

l This field is only relevant for views.

l This field is only active whenNo Grouping is selected under
Group by.

Persistent Select to define the TQL query as persistent. A persistent query
remains in thememory permanently.
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UI Element (A-Z) Description

Priority Select a priority level for the TQL query or view from the drop-down
list (Low, Medium, High, Express, Not Active). This setting
determines how often the query should be rerun automatically by the
system to include updated information from the CMDB.

Note:When you change the priority of a view, the priority of the
TQL query on which the view is based is also changed.

Scope Select the scope of the TQL query from the drop-down list.

Note: This field is only relevant for Integration TQL queries.

Type Select the type of the TQL query from the drop-down list.

Note: This field is only relevant for TQL queries.

View refresh rate in
Configuration Manager

If the view is set as Managed by Configuration Manager, select
the view refresh rate from the drop-down list.

Note: This field is only relevant for views and only when HP
Universal CMDB ConfigurationManager is configured and
running.

View type in
Configuration Manager

If the view is set as Managed by Configuration Manager, select
the view type from the drop-down list.

Note: This field is only relevant for views and only when HP
Universal CMDB ConfigurationManager is configured and
running.

Reveal CIs Dialog Box
This dialog box enables you to search for CIs related to the CIs in amodel and add them to the
model.

To access
In theModel Editor of theModeling Studio, select a CI, click theReveal
button, and select Start Revealing or right-click a CI in themodel and select
Reveal > Start Revealing.
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Important
information

The upper pane displays the CI types of the CIs related to the selected CI. The
lower pane displays the CIs of the type selected in the upper pane.

The first step in the reveal path is the CI type of the CI you began with. When you
select a CI type from the list in the upper pane, that CI type becomes the second
step in the path. Click Next to display the CI types available for the next step of
the path.

The number at the top of the box in parentheses indicates the length of the
constructed path thus far.

Relevant
tasks

"How to Build an Instance-basedModel " on page 264

See also l "Revealed CIs andWatchpoints" on page 251

l "Modeling Studio User Interface" on page 267

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

Delete Selected Item(s). Deletes a selected item from the CIs basket.

CI Properties. Opens the CI Properties dialog box for the selected CI.

Add CIs to basket. Adds a selected CI from the lower pane to the CIs basket.

Find Next. Goes to the next occurrence of the selected search phrase in the list of
CIs.

Find Previous. Goes to the previous occurrence of the selected search phrase in
the list of CIs.

<Lower
pane>

Displays a list of related CIs of the type selected in the upper pane.

CI count Indicates how many related CIs of each type were found.

CIs Basket Displays the related CIs you selected to include in themodel.

CI Type Displays a list of CI types of the CIs related to the selected CI.

Conditions A check mark indicates that conditions were defined for the selected CI type.
Click the Conditions column for the CI type you want to select and click theAdd
Condition orEdit Condition button to open the Conditions of Related CIs dialog
box. This enables you to define and edit conditions for the CI type.

Find Enter a CI name or a portion of a CI name in the Find box to locate a CI in the list of
CIs.
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UI Element
(A-Z) Description

Finish Click Finish when you have finished adding CIs to the CI basket.

Next Click Next to display the CI types available for the next step of the path.

Reveal
path

Displays the reveal path being constructed.

Clicking the blue arrows in the path displays a drop-down list of the CI types
available for the next step of the path.

Clicking the CI types in the path displays the following options:

l Jump to page. Refreshes the table with the available CI types for the selected
step of the path.

l Edit Condition. Opens the Conditions of Related CIs dialog box.

l Delete Selected Item(s). Deletes the selected CI type from the reveal path
(the path ends at the previous CI type).

Save Path Opens the Save Reveal Path dialog box which enables you to save the path. This
option is only active when a unique reveal path has been constructed.

Save Query Dialog Box
This dialog box enables you to save a new TQL query.

To access In theModeling Studio, click Save when defining a new TQL query.

Relevant tasks "How to Define a TQLQuery" on page 23

See also l "Viewing TQLQuery Results" on page 17

l "Modeling Studio User Interface" on page 267

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

New Folder. Creates a new folder in the resource tree.

Delete. Deletes the selected resource from the CMDB.

Refresh. Refreshes the resource tree.

Expand All. Expands all the folders in the resource tree.
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UI Element
(A-Z) Description

Collapse All. Collapses all the folders in the resource tree.

Find Next. Goes to the next occurrence of the selected search phrase in the
tree.

Find Previous. Goes to the previous occurrence of the selected search
phrase in the tree.

Highlight All. Highlights all occurrences of the search phrase in the tree.

<Resource
tree>

Select a folder in the tree in which to save the query.

Find Enter a folder name or a portion of a name in the Find box to locate a folder in
the list.

Query Name Enter the name of the new TQL query.

Save View/Template/Perspective Dialog Box
This dialog box enables you to save a new pattern view, template-based view, perspective-based
view, template, or perspective.

To
access

In theModeling Studio, click theSave button when defining a new pattern view,
template-based view, perspective-based view, template, or perspective.

See
also

l "Building a Business View" on page 242

l "Modeling Studio User Interface" on page 267

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

New Folder. Creates a new folder in the resource tree.

Delete. Deletes the selected resource from the CMDB.

Refresh. Refreshes the resource tree.

Expand All. Expands all the folders in the resource tree.

Collapse All. Collapses all the folders in the resource tree.
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UI Element
(A-Z) Description

Find Next. Goes to the next occurrence of the selected search phrase in the
tree.

Find Previous. Goes to the previous occurrence of the selected search
phrase in the tree.

Highlight All. Highlights all occurrences of the search phrase in the tree.

<Resource
tree>

Select a folder in the tree in which to save the view, template, or perspective.

Find Enter a folder name or a portion of a name in the Find box to locate a folder in
the list.

New query Select New query if the view is based on a new TQL query.

Note: This field is not relevant for template-based views and perspective-
based views.

View Name Enter the name of the new view, template, or perspective.

Select Integration Points Dialog Box
This dialog box enables you to select integration points to access the required data sources for a
TQL query node.

To access In theModeling Studio, right-click a TQL query node and select Select
Integration Points.

Important
information

You can select the data sources from which the TQL query generates the results
for each query node. For details on data sources, see "Integration Studio
Overview " in theHP Universal CMDB Data Flow Management Guide.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

<Integration
Point list>

A list of integration points for available data sources.
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UI Element
(A-Z) Description

All
Integration
Points

Enables you to include CIs from all UCMDB and external data sources for the
selected query node in the TQL query results.

Note: Only includes integration points where the CI type of the selected
query node is marked as federated.

Local Data
Source

Enables you to include CIs from the UCMDB only for the selected query node in
the TQL query results.

Select
Integration
Points

Enables you to select integration points to include CIs from the required data
sources only for the selected query node in the TQL query results.

Sort Column Content Dialog Box
This dialog box enables you to set the order of the column content in a report.

To access In theModeling Studio, click Set Sort Order in the Query Node Definition pane of
the Pattern View Editor (in Report mode).

Important
information

The report is sorted by columns following the order of the attributes in the Sorted
Columns pane. Each selected column is sorted in ascending or descending order
according to your selection.

Relevant
tasks

"How to Define Report Settings" on page 263

See also l "Building a Business View" on page 242

l "Modeling Studio User Interface" on page 267

User interface elements are described below:

UI Element (A-
Z) Description

Move to Sorted Columns.Moves the selected attribute to the Sorted
Columns pane.

Move to Available Columns.Moves the selected attribute to the Available
Columns pane.

Moves all the attributes to the Sorted Columns pane.

Moves all the attributes to the Available Columns pane.
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UI Element (A-
Z) Description

Moves the selected attribute down in the Sorted Columns list.

Moves the selected attribute up in the Sorted Columns list.

Sort Ascending. Sorts the selected column in ascending order.

Sort Descending. Sorts the selected column in descending order.

Available
Columns

The attributes selected to appear as columns in the report.

Sorted
Columns

The columns selected to be sorted.

Template-based View Wizard
This wizard enables you to define template-based views manually or by importing parameter data
from aCSV file.

To access Click theNew button and select Template Based View.

Important
information

The wizard enables you to createmultiple template-based views based on the
same template. When creatingmultiple views, the wizard includes the Save
Views page as the final page. When creating a single template-based view, the
wizard finishes with the Parameters page and opens the new view in the Editor.
You can save the new view from within the Editor.

Relevant
tasks

l "How to Create a Template Based View" on page 261

l "How to CreateMultiple Template Based Views" on page 262

Wizard
map

The Template-based View Wizard contains:

"Select Template Page" > "Import Parameter Values Page" > "Enter Parameters
Page" > "Select Location for Views Page" > "Summary Page" > "Save Views
Page"

See also l "Building a Business View" on page 242

l "Modeling Studio User Interface" on page 267

Select Template Page

This wizard page enables you to select a template on which to base your view.
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Important
information

If you don't want to use any of the templates in the tree, you can create a new
template first and then build a view based on it. For details on creating a template,
see "How to Create a Template" on page 256.

Wizard
map

The Template-based View Wizard contains:

"Select Template Page" > "Import Parameter Values Page" > "Enter Parameters
Page" >"Select Location for Views Page" > "Summary Page" > "Save Views
Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

Refresh. Refreshes the template tree.

Expand All. Expands all the folders in the template tree.

Collapse All. Collapses all the folders in the template tree.

Find Next. Goes to the next occurrence of the selected search phrase in the
tree.

Find Previous. Goes to the previous occurrence of the selected search
phrase in the tree.

Highlight All. Highlights all occurrences of the search phrase in the tree.

<Template
tree>

Displays the existing templates in tree format.

Find Enter a template name or a portion of a name in the Find box to locate a
template in the list.

Import Parameter Values Page

This wizard page enables you to import parameter values from aCSV file.

Important
information

If you are creating a large number of views based on the same template, you can
save the parameter values in a CSV file and import them directly into the wizard.

Note: If the CSV file contains any non-English characters, youmust use
UTF-8 encoding to ensure that the characters are displayed properly.

Wizard
map

The Template-based View Wizard contains:

"Select Template Page" > "Import Parameter Values Page" > "Enter
Parameters Page" >"Select Location for Views Page" > "Summary Page" >
"Save Views Page"
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

Add
parameter
values
manually

Select this option to enter the parameter values manually, whether for a single
view or for multiple views.

Import
parameter
values
from a
CSV file

Select this option to import the parameter values from aCSV file. Click the ellipsis

button to browse your files for the required file.

Use
Advanced
Naming

Select theUse Advanced Naming option to automatically name the created
views based on parameter values. In the box, enter an expression containing at
least one parameter name in angle brackets. The views are named based on the
values of the selected parameter.

Enter Parameters Page

This wizard page enables you to set the values of the template's parameters for each new view
created.

Important
information

If you are creatingmultiple views, click Next after you set the parameter values to
proceed to the Save Views page. If you are creating a single view, click Finish
after you set the parameter values to open the new view in the Editor.

Wizard
map

The Template-based View Wizard contains:

"Select Template Page" > "Import Parameter Values Page" > "Enter Parameters
Page" > "Select Location for Views Page" > "Summary Page"> "Save Views
Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

Add view instance. Adds a new view instance.

Remove view instance. Deletes the selected view instance.

<Parameter
columns>

In each parameter column, enter or select the required parameter value for each
view.

Reset Click to reset the selected parameter to its original value.
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UI Element
(A-Z) Description

Use
Advanced
Naming

Select theUse Advanced Naming option to automatically name the created
views based on parameter values. In the box, enter an expression containing at
least one parameter name in angle brackets. The views are named based on the
values of the selected parameter.

Note: All view names must be unique.

View Name Enter names for each of the new views, or use the default names assigned.

Select Location for Views Page

This wizard page enables you to select the location in which to save the created views.

Important
information

All created views must be saved in the same location

Wizard
map

The Template-based View Wizard contains:

"Select Template Page" > "Import Parameter Values Page" > "Enter Parameters
Page" > "Select Location for Views Page" > "Summary Page"> "Save Views
Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

New Folder. Creates a new folder in the view tree.

Refresh. Refreshes the view tree.

Expand All. Expands all the folders in the view tree.

Collapse All. Collapses all the folders in the view tree.

Find Next. Goes to the next occurrence of the selected search phrase in the
tree.

Find Previous. Goes to the previous occurrence of the selected search phrase
in the tree.

Highlight All. Highlights all occurrences of the search phrase in the tree.

<View tree> Select a folder (or the root) from the view tree.

Find Enter a template name or a portion of a name in the Find box to locate a
template in the tree.
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Summary Page

This wizard page displays the details of the created views before saving.

Wizard
map

The Template-based View Wizard contains:

"Select Template Page" > "Import Parameter Values Page" > "Enter Parameters
Page" > "Select Location for Views Page" > "Summary Page" > "Save Views Page"

User interface elements are described below:

UI
Element
(A-Z) Description

Save view
summary

A summary of the views created including the name of the base template, the
number of views created, and the location selected for saving the views.

Save Views Page

This wizard page enables you to save the new views you created.

Important
Information

This wizard page is only relevant when you are creatingmultiple template-based
views.

Wizard
map

The Template-based View Wizard contains:

"Select Template Page" > "Import Parameter Values Page" > "Enter Parameters
Page" > "Select Location for Views Page" > "Summary Page"> "Save Views
Page"

User interface elements are described below:

UI Element
(A-Z) Description

Save
Results

A table displays the names of the new views and amessage indicating whether
each view was saved successfully or not.

Template Parameter Values Dialog Box
This dialog box enables you to edit the parameters of a template-based view.

To access From within a template-based view in theModeling Studio, right-click a query
node with parameters defined and select Show Node Parameters, or click the
Show Parameters button in the toolbar.
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Important
information

When you open the dialog box from the shortcut menu by right-clicking a query
node with parameters defined, the dialog box only displays the parameters for the
selected query node. When you open the dialog box from the toolbar, it displays all
the parameters defined for any of the query nodes in the view.

Relevant
tasks

"How to Create a Template Based View" on page 261

See also l "Building a Business View" on page 242

l "Modeling Studio User Interface" on page 267

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

<Parameters> Edit the values of the parameters.

TQL Query Editor
This feature enables you to build and edit TQL queries.

To access To open a new TQL query in the TQLQuery Editor, go to theModeling Studio,

click theNew button and select Query.

To open an existing TQL query in the TQLQuery Editor, go to the Resources tab
of the left pane in theModeling Studio and select Queries as the Resource type.
Right-click a TQL query in the tree and select Open Query or double click a TQL
query or drag a TQL query onto the empty canvas. The TQL query opens in a new
tab.

Important
information

To save your TQL query, use theSave button in theModeling Studio main toolbar.

Relevant
tasks

"How to Define a TQLQuery" on page 23

See also l "Viewing TQLQuery Results" on page 17

l "Modeling Studio User Interface" on page 267

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element
(A-Z) Description

Show View Results in IT Universe. Goes directly to the selected view in IT
UniverseManager.

Note: This button only appears for views, templates, or perspectives.

Create Relationship. Enables you to draw a relationship from one query node to
another.

Calculate Query Result Count. Calculates the number of instances found for
each TQL query node or relationship.

Preview. Displays a preview of the TQL query results as they would appear in IT
UniverseManager.

Delete. Deletes the selected query node or relationship from the query.

Query/View Definition Properties.

For queries, opens theQuery Definition Properties dialog box which enables you to
edit the type, scope, and priority of the TQL query.

For views, opens the View Definition Properties dialog box.

Report Properties. Opens the Report Properties dialog box, which enables you to
set the title, subtitle, and format for the view's topology report. For details, see
"Report Properties Dialog Box" on page 401.

Note: This button only appears for views, templates, or perspectives.

Assign Tenants. Opens the Assign Tenants dialog box which enables you to
assign tenants to the resource.

Note: This button is only available whenmulti-tenancy is enabled.

Manage Security. Enables you to assign the selected resource to specific roles or
resource groups.

Show Parameters. Opens the Template Parameter Values dialog box which
enables you to edit the parameters of a query node in a template-based view.

Note: This button only appears for template-based views.
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UI
Element
(A-Z) Description

<Legend> Indicates the icons displayed next to CIs with any of the following special
designations:

l It is defined as a contact query node in a perspective

l It is a federated CI

l It has attributes defined

l It has selected identities defined

l It is hidden in the query results

l It is defined as the output query node of a pattern-basedmodel

l It has a subgraph defined

<Main
menu>

For details, see "MainMenu" on page 163.

<Shortcut
menu
options>

For details, see "Shortcut MenuOptions" on page 33.

<Topology
Map
Sidebar>

For details, see "Topology Map Sidebar" on page 176.

Advanced Pane
This area displays the properties, conditions, and cardinality for the selected query node and
relationship.

Important
information

The Advanced pane appears in the lower part of the window in the following
managers and user interfaces: Modeling Studio, Impact Analysis Manager,
Enrichment Manager, the Input Query Editor and Trigger Query Editor in DFM.

A small green indicator appears next to the tabs that contain data.
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Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

User interface elements are described below:

UI
Elements
(A-Z)

Description

If the window is not wide enough to display all the tabs, use the left and right
arrows tomove to the required tab.

Click Show List to display a list of the available tabs for the current module. You
can select a tab from the list.

Attributes Displays the attribute conditions defined for the query node or the relationship. For
details, see "Attribute Tab" on page 74.

Cardinality Cardinality defines how many query nodes you expect to have at the other end of
a relationship. For example, in a relationship between a node and an IP Address, if
the cardinality is 1:3, the TQL query retrieves only those nodes that are connected
to between one and three IP Addresses. For details, see "Cardinality Tab" on
page 76.

Data
Sources

Displays the data sources set for the selected query node.

Note: This tab appears only in theModeling Studio.
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UI
Elements
(A-Z)

Description

Details Displays the following information:

l CI Type/Element Type. The CIT of the selected query node/relationship.

l Element Name. The name of the query node or relationship. This appears only
in theModeling Studio.

l Show in query results. A green check indicates that the selected query
node/relationship is visible in the topology map. A redmark indicates that it is
not visible. In theModeling Studio, this is indicated by the word Yes or No.

l Include subtypes. A green check indicates that both the selected CI and its
children are displayed in the topology map. A redmark indicates that only the
selected CI appears. This item does not appear in theModeling Studio.

Edit Click Edit to open the relevant dialog box for the selected tab.

Element
Layout

Displays the attributes selection for the selected query node or relationship. It lists
the attributes selected to be included in the query results (whenSpecific
Attributes is selected as the attributes condition). It also lists the excluded
attributes and any selected qualifiers for attributes. For details, see "Element
Layout Tab" on page 82.

Note: This tab appears only in theModeling Studio.

Element
Type

Displays the subtype conditions defined for the query node or relationship. For
details, see "Element Type Tab" on page 80.

Note: This tab appears only in theModeling Studio.

Enrichment
Rules

Displays the Enrichment rule defined for the selected query node or relationship. If
the Enrichment rule is used to update the attributes of a CI, click Edit to open the
Query Node/Relationship Definition dialog box and edit the rule if required. For
details, see "Query Node/Relationship Definition Dialog Box" on page 514.

Note: This tab appears only in Enrichment Manager.
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UI
Elements
(A-Z)

Description

Impacted
Query
Nodes

Indicates which query node is impacted by the changes that occur in the selected
trigger query node. If required, you can click Edit to open andmodify the Impacted
Query Nodes dialog box. For details, see "Impacted Query Nodes Dialog Box" on
page 441.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node or the relationship. For
details, see "Qualifier Tab" on page 84.

Note: This tab appears only in Enrichment Manager and Impact Analysis
Manager.

Selected
Identities

Displays the element instances that are used to define what should be included in
the TQL query results. For details, see "Identity Tab" on page 85.

Views Containing Selected CI Dialog Box
This dialog box enables you to display a list of the views containing the selected CI.

To
access Click theShow views containing selected CI/model button in theModel Editor

or select Show containing views from the shortcut menu.

See
also

l "Building a Business View" on page 242

l "Modeling Studio User Interface" on page 267

User interface elements are described below:

UI
Element
(A-Z)

Description

Show View Results in IT Universe. Goes directly to the selected view in IT
UniverseManager.

Delete Selected Item(s). Deletes the selected view.

Disconnect view from perspective. Disconnects the selected view from its
perspective. The view becomes a pattern view.

Find Enter a view name or a portion of a view name in the Find box to locate it in the list.
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UI
Element
(A-Z)

Description

Find Next Click to go to the next occurrence of the selected search phrase in the list.

Find
Previous

Click to go to the previous occurrence of the selected search phrase in the list.

Highlight Click to highlight all occurrences of the search phrase in the list.

View
Name

Displays the list of views dependent on the selected template or perspective.

Note: The name of the current view appears in faded text.

Watchpoints Updates Dialog Box
This dialog box displays the changes found in related CIs by a watchpoint defined for amodel.

To access
From within amodel in theModel Editor, click theWatchpoint button and
selectWatchpoints Updates or right-click a CI in themodel and select
Watchpoint > Watchpoints Updates.

Important
information

TheWatchpoints Updates dialog box indicates any changes found involving the
CIs related to themodel via the associated reveal path. If a new related CI is
found which is not included in themodel, the suggested update is an added CI. If a
CI in themodel is found to no longer be related via the path, the suggested update
is a removed CI.

This option is only enabled when watchpoints are defined for themodel and CIs
have been found.

See also l "Revealed CIs andWatchpoints" on page 251

l "Modeling Studio User Interface" on page 267

User interface elements are described below:

UI Element (A-
Z)

Description

Accept Select the check boxes for the CIs you want to add to your model or remove
from your model.

Accept All Click Accept All to apply all the suggested changes to your model.

CI The names of the CIs found by the watchpoint.

CI Type The types of the CIs found by the watchpoint.
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UI Element (A-
Z)

Description

Clear All Click Clear All to clear the check boxes for all the found CIs.

Restore Select the check boxes for the CIs in the Suppressed CIs pane that you
want to consider for inclusion in your model.

Show/Hide
Suppressions

Toggle between hiding and displaying the Suppressed CIs pane of the dialog
box.

Suggested
Update

Indicates whether the suggested change is an added CI or a removed CI.

Suppress Select the check boxes for the CIs you want to exclude from your model or
leave in your model.

Suppress All Click Suppress All to decline all the suggested changes to your model.

<Query/Template/Perspective Name> Dependencies
Dialog Box

This dialog box enables you to clarify the status of dependent resources when saving changes to a
query, template, or perspective.

To access In theModeling Studio, make a change to a query, template, or perspective with
dependent resources. When you click Save, the dialog box opens.

Important
information

Any changemade to a resource affects the views or custom reports based on that
resource. Before the changes are saved, you need to specify the desired result on
the dependent resources. For each dependent resource, select one of the
available options: Delete or Re-Apply.

Dependent resources include views based on a query, template, or perspective,
and custom reports based on a view, for example, a View Change report.

User interface elements are described below:

UI
Element
(A-Z)

Description

Delete Select this option to delete the selected dependent resource.

Re-Apply Select this option to apply the revised query, template, or perspective to the
selected dependent view. The view type remains the same as it was previously
(pattern view, template-based view, or perspective-based view). In the case of
custom reports, the report is updated according to the revised view.

Resource The dependent resources are displayed in a tree format.
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Chapter 9: Reports
This chapter includes:

Topology Reports Overview 334

Custom Reports Overview 335

How to View a Topology Report 335

How to Generate a Custom Report 335

How to Compare CIs 336

How to Compare Snapshots 337

Cron Expressions 338

Reports User Interface 339

Reports on Non-English Locales - Notes and Limitations 428

Topology Reports Overview
Topology reports provide amethod of displaying the data from views in a report format. Every view
defined in theModeling Studio has a corresponding topology report in the Reports module. The
report settings are defined in the view definition in Report mode in the Pattern View Editor. For
details, see "Pattern View Editor" on page 300.

For details on selecting the CIs to be displayed in a view, see "Working with the CI Selector" on
page 128.

Perspectives, perspective-based views and template-based views also have topology reports. The
reports settings for such views are based on the settings defined in the base template or
perspective.

You can open a template in the Reports module and edit the template parameters. You can then
save the template instance as a template-based view by clickingSave As View.

Report Properties
There are two formats for the topology report tables:

l Flat. In a flat report, the top layer of the report is displayed with the CIs with children appearing
as links. You can click a CI to drill down to see its children. You can navigate back to higher
layers of the report using the breadcrumbs appearing at the top of the report.

l Hierarchical. In a hierarchical report, all the CIs of the report are displayed in the same table, in
tree format. CIs with children are expandable to display the child CIs beneath them.

Another important difference between flat and hierarchical reports relates to the definition of charts
for the report. In a flat report, you can define a chart for any layer of the report, even if a higher layer
is in table format. In hierarchical reports, you cannot define a chart for a layer if the layer above it is
in table format.
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The report format can be set in the Report Properties dialog box, available in bothModeling Studio
and the Reports module. For details, see "Report Properties Dialog Box" on page 401.

Custom Reports Overview
Custom reports consist of charts and tables that help you track and analyze the health of your
monitored environment. They enable you to view and assess performance data collected by HP
Universal CMDB and stored in the CMDB. When generating reports, you can specify various report
settings, such as time range or location, as well as drill down to see further information.

How to View a Topology Report
This task describes how to create a report based on a previously saved view or pattern.

This task includes the following steps:

l "Prerequisite" below

l "Select a Report" below

l "Edit Template Parameters" below

1. Prerequisite
(Optional) Use theModeling Studio to define a new view. For details, see "Modeling Studio" on
page 241.

2. Select a Report
In the Reports module, select an existing Topology report which corresponds to a view of the
same name. Double-click it or right-click it and select Open Report. The report opens in the
right pane. For details, see "Topology Report" on page 416.

3. Edit Template Parameters
If you selected a report corresponding to a template, edit the template parameters and generate
the report. Click Save As View to save it as a template-based view.

How to Generate a Custom Report
This task describes how to define and generate a report based on a custom layout.

This task includes the following steps:

l "Select the Report Type" on the next page

l "Specify the Required Parameters" on the next page

l "Generate the Report" on the next page
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1. Select the Report Type
In the Custom Reports pane, do one of the following:

n Right-click a report name and select Create New Report.

n Click theCreate New Report button and select the required report.

n Double-click a report name.

2. Specify the Required Parameters
Specify the parameters required by the report type that you selected. For details about the
parameters required by each report type, see the relevant report listed in "Reports User
Interface" on page 339.

3. Generate the Report
Click Generate to build the report. If desired, you can refine the parameters and click Generate
again to view an updated report.

How to Compare CIs
This task explains how to compare the hierarchies of two compound CIs, view a CI's configuration
document, and show the difference between two configuration documents.

This task includes the following steps:

l "Select the Required CIs" below

l "View aCI's Configuration Document" on the next page

l "Show the Difference Between TwoConfiguration Documents" on the next page

1. Select the Required CIs
In IT UniverseManager, select the two CIs you want to compare. The hierarchies of the two
compound CIs are compared in the Compare CIs report (for details, see "Compare CIs Report"
on page 361). You can choose to compare two CIs that appear in a selected view, or in the
CMDB. For details, see "CI Selector" on page 133.

Example of Nonmatching CIs:

In this example, theNo Matching CI icon is displayed next to the CI
LABM3QCRNDDB03 because it has no corresponding CI on the other side.
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TheShow Different Attribute Values icon is displayed next to theMemorySize
properties for the CIs LABM3QCRNDDB02 and LABM3ASTDB01 since they have
differentMemorySize values.

2. View a CI's Configuration Document
Select a CI of the CITConfiguration Document and view the configuration document. For
details, see "Compare CIs Report" on page 361.

3. Show the Difference Between Two Configuration Documents
Select two CIs of the CIT Configuration Document and view the difference between the two
configuration documents. For details, see "Compare CIs Report" on page 361.

How to Compare Snapshots
This task describes how to take a snapshot of a view, and to compare two snapshots of a specific
view taken at different times.

This task includes the following steps:

l "Take a Snapshot of a View " below

l "Save Snapshots on a Periodic Basis" on the next page

l "Compare Snapshots" on the next page

1. Take a Snapshot of a View
a. Select a view in IT UniverseManager or a Topology report in the Reports module.
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b. Click theSnapshot button and select Save Snapshot to take a snapshot of the view
and save it. For details, see the "Save Snapshot Dialog Box" on page 237.

2. Save Snapshots on a Periodic Basis
Optionally, you can schedule snapshots to be taken of a certain view at specific times by
defining a task. For details, see "Schedule Report/Snapshot Dialog Box" on page 409.

3. Compare Snapshots
Compare the snapshots of a view taken at different times. SelectModeling > Reports and
create a Compare Snapshots Report. For details, see "Compare Snapshots Report" on page
366.

Example of Snapshots of a View Taken at Different Times:

In the following example, theDeleted Item icon next to the vmamqa278 CI in the left
pane, indicates that the CI has been deleted in the newer view.

Cron Expressions
A Cron Expression is a string composed of six or seven fields separated by white space. Six of the
fields aremandatory, and one is optional.

The following table contains the fields used in a Cron Expression.
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Field Name Allowed Values Allowed Special Characters

Seconds 0-59 , - * /

Minutes 0-59 , - * /

Hours 0-23 , - * /

Day of month 1-31 , - * ? / LW C

Month 1-12 or JAN-DEC , - * /

Day of week 1-7 or SUN-SAT , - * ? / L C #

Year (optional) empty, 1970-2099 , - * /

The following table contains examples of how to use Cron expressions.

Cron
Expression Meaning

0 0 12 * * ? The task runs every day at 12:00 PM.

0 15 10 ? * * The task runs at 10:15 AM every day.

0 15 10 * * ?
2011

The task runs at 10:15 AM every day during the year 2011.

0 0/5 14 * * ? The task runs every 5minutes starting at 2 PM and ending at 2:55 PM, every
day.

0 15 10 15 * ? The task runs at 10:15 AM on the 15th day of every month.

0 15 10 ? * 6L The task runs at 10:15 AM on the last Friday of every month.

0 15 10 ? * 6#3 The task run at 10:15 AM on the third Friday of every month.

Reports User Interface
This section includes (in alphabetical order):

Agent Status Report 341

Application BreakdownReport 342

Application License Report 345

Asset Report 346

Changed Application Report 348

Changed Views Report 350

CI Change Report 351

CMDB Utilization Report 356
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Compare Archives Report 357

Compare CIs Report 361

Compare Snapshots Report 366

Database BreakdownReport 371

Delete Candidates Report 374

Dependency Report 376

Discovery Errors Report 377

Generic BreakdownReport 379

GoldMaster Report 381

Hardware Component Summary Report 383

Impact Analysis Report 384

Job List Dialog Box 386

Network Device BreakdownReport 388

NodeOS BreakdownReport 391

Node Summary Report 394

Node Summary by VLAN Report 395

Number of Changes Report 397

Recognized Applications Report 399

Report Properties Dialog Box 401

Reports Page 401

Scan File Status Report 406

Scanner Execution Details Report 408

Schedule Report/Snapshot Dialog Box 409

Software Utilization Report 413

Solaris Zone Report 415

Topology Report 416

View Change Report 417

VMware Host Report 420

VMware Virtual Center Report 421

Zone-Based Discovery Errors Report 422

Report Toolbar Options 424
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Agent Status Report
This report displays the status of all installed discovery agents that have been updated by the
Upgrade UD Agent discovery job.

To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Agent Status Report.

l UnderDiscovery Status:

n Double-click Agent Status Report

n Right-click Agent Status Report and select Create New Report.

n Select Agent Status Report, and drag it onto the right pane.

Important
information

The report displays detailed information on each discovery agent including the
display label, agent version, port, platform, and probe name.

Use theSelect Columns button to select the attributes to display in the
report.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A-Z) Description

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut menu. For
details, see "IT UniverseManager Shortcut Menu" on page 222

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Modeling Guide
Chapter 9: Reports

HP Universal CMDB (10.10) Page 341 of 534



UI
Element
(A-Z) Description

Group By Select a groupingmethod for displaying the data. The available options are:

l None

l Job Status

l Agent Version

Job
Status

Select an option from the drop-down list to filter the results by the job status of the
agent's discovery jobs.

Application Breakdown Report
This report displays a breakdown of major applications and their versions. Major applications are
Running Software CITs that have been assigned theMAJOR_APP class qualifier. For details, see
"Qualifiers Page" on page 472.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Application Breakdown
Report.

l UnderBreakdown:

n Double-click Application Breakdown Report

n Right-click Application Breakdown Report and select Create New
Report.

n Select Application Breakdown Report, and drag it onto the right pane.

Relevant
tasks

"How to Generate a Custom Report" on page 335
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-
Z) Description

<Bar graph/
Pie chart>

Each segment of the pie chart/column in a bar graph represents a different
application.

Click a slice/bar to view the application sorted by version, and then drill down
to see the application instances and their attributes.

When you hold themouse over each segment/bar, a tooltip indicates the
name of the application, the number of CI instances found for each
application, the percentage of the pie it represents (when viewing the
information in pie chart format), and the CI type the slice/bar represents.

The legend below the pie chart provides the name of each CI, and on the
lower level, their versions.

<Breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut
Menu>

Drill down to the level of individual CIs and right-click a CI in the report to
access the IT UniverseManager shortcut menu. For details, see "IT
UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

City Select the city for which you want to view application breakdown data, or
select All to show the breakdown for all cities.

Note: This is only relevant for CITs that contain data in theCity
attribute.

Country or
Province

Select the country or province for which you want to view application
breakdown data, or select All to show the breakdown for all countries or
provinces.

Note: This is only relevant for CITs that contain data in theCountry or
Province attribute.

Include All
Integration
Points

Select the check box to include federated CIs in the report. When the check
box is cleared, only local CIs are included in the report.

Modeling Guide
Chapter 9: Reports

HP Universal CMDB (10.10) Page 344 of 534



UI Element (A-
Z) Description

State Select the state for which you want to view application breakdown data, or
select All to show the breakdown for all states.

Note: This is only relevant for CITs that contain data in theState
attribute.

Application License Report
This report displays all the application instances detected in the system that require a license.

To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Application License
Report.

l Under Inventory:

n Double-click Application License Report

n Right-click Application License Report and select Create New Report.

n Select Application License Report, and drag it onto the right pane.

Important
information

The top level of the report displays the number of application instances for each
application, vendor, or related node, depending on the grouping option selected.
This is based on the license type for each application as defined in the SAI files.

In any layer, you can use theSelect Columns button to select the attributes
to display in the report.

Relevant
tasks

"How to Generate a Custom Report" on page 335
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut
menu. For details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Group By Select themethod for displaying the data. The available options are:

l Application Name

l Vendor Name

l Related Node

License
Required

For each application, vendor, or related node, displays the number of
applications that require a license. Click the number to drill down and view
the application instances.

On the drill down screen, if the number in the Components column is greater
than 1, then the selected application has licensing components.

Asset Report
This report displays a list of all the CIs in a specified view, their attribute values, as well as their
child CIs in the CMDB. You use Asset reports to view and analyze the contents of the view and
focus on the data that is of interest to you. For example, an Asset report can display a list of all the
servers that are part of a specific application contained in the view.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Asset Report.

l UnderGeneral:

n Double-click Asset Report

n Right-click Asset Report and select Create New Report.

n Select Asset Report, and drag it onto the right pane.

Important
information

The report only includes attributes that aremarked with theAsset Data qualifier in
theAttributes tab in the CI TypeManager. For more details, see "Add/Edit
Attribute Dialog Box" on page 458.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

<Shortcut
menu>

For details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Include
information
based on

Select one of the following:

l CMDB. Includes information from the selected view as well as information
about the child CIs and their attribute values in the CMDB.

In this option, the report includes CIs that are connected to the CIs in selected
view by relationships with theContainer qualifier. For example, the report
includes the CPU andmemory of a server that is contained in the view.

l View. Includes only information about the CIs and their attributes that are
contained in the selected view.

View Enables you to select a view by opening the View Selector. For details, see "CI
Selector" on page 133.

Note:When you generate an Asset report from a specific view, the report
retains the same hierarchical structure as the relevant view in the Topology
Map.
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Changed Application Report
This report displays a bar graph showing the number of detected changes in applications within a
defined period.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Changed Application
Report.

l UnderChange:

n Double-click Changed Application Report

n Right-click Changed Application Report and select Create New Report.

n Select Changed Application Report, and drag it onto the right pane.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-
Z) Description

<Bar graph> Each bar represents a different application type. The colors in each bar
represent the different types of changes that occurred in the application.

Each color in the legend represents a different type of change. The CI type of
each application is displayed under the relevant bar.

When you hold themouse over each bar, a tooltip indicates the number of
changes that have occurred (such as the adding, removing, or updating of
CIs, depending on the color), as well as the CI type the bar represents.

Click the required color in the bar to drill down to see a list of the CIs that
have changed.

<Breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Date from Configure a start date and time for the report.

Date until Configure an end date and time for the report.

Time range Select a time frame over which to display the detected changes. The system
automatically provides the starting and ending dates in theDate from and
Date until boxes.

Note: If you select Custom, you canmanually configure a start and end
date in theDate from andDate until boxes.
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Changed Views Report
This report displays the number of changes that occurred in a specific view within a defined period.

To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Changed Views Report.

l UnderChange:

n Double-click Changed Views Report

n Right-click Changed Views Report and select Create New Report.

n Select Changed Views Report, and drag it onto the right pane.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element
(A-Z) Description

<Bar
graph>

Each bar represents a different view. The name of each view is displayed under the
relevant bar. The colors in each bar represent the different types of changes that
occurred in the view (added, removed, or updated).

When you hold themouse over the relevant color in each bar, a tooltip indicates the
name of the view, the change type, and the number of CI instances that changed in
the view.

See the legend to verify the change type each color represents.

If snapshots were taken of a view at different times, you can click a bar to open the
Compare Views by Snapshots dialog box and display the differences between the
views. For details, see "Compare Snapshots Report" on page 366.

Note: Only views with changes that reflect the differences between two
snapshots, one taken before theDate from date (or, if not available, then after
theDate from date) and another snapshot taken before theDate until date in
the Changed Views report appear in the report.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Date from Configure a start date and time for the report.

Date until Configure an end date and time for the report.

Time
range

Select a time frame over which to display the changes. The system automatically
provides the starting and ending dates in theDate from andDate until boxes.

Note: If you select Custom, you canmanually configure a starting and ending
date in theDate from andDate until boxes.

CI Change Report
The CI Change report enables you to view and analyze the actual changes made to a specific CI
and its children. This can help with possible troubleshooting issues related to this CI. For example,
youmay be able to trace the cause of the problem to changes in the CI. Alternatively, the source of
the troubleshooting issue could be related to expected changes which failed to occur. This report
enables you to view CI attribute changes, as well as CIs that were added to or removed from aCI
and its children.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select CI Change Report.

l UnderChange:

n Double-click CI Change Report

n Right-click CI Change Report and select Create New Report.

n Select CI Change Report, and drag it onto the right pane.
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Important
information

Only those CIs whose CIs whose properties aremarked as eitherManaged or
Comparable appear in the report. For details, see "Add/Edit Attribute Dialog Box"
on page 458.

CI Change reports display:

l Changes that occurred in a selected CI and all children of the CI that are
related by the relationship specified in theChange Report link name
infrastructure setting. The default value of this setting is an empty value,
(managed_relationship), that enables you to track changes of all relationship
attributes that are not marked as Not Tracked in History.
To change the CIs displayed in the generated report, go toManagers >
Administration > Infrastructure Settings Manager and edit the following
settings:

n Select Change Report link name to retrieve CIs that are linked by the
selected calculated relationship. Change the value of the setting to the name
of the relationship as it appears in theName box (not theDisplay Name box)
in the Details page of the selected relationship in the CI TypeManager. For
details, see "Details Page" on page 467. If empty the class name is
considered to bemanaged_relationship.

n Select Change Report link qualifier to retrieve CIs that are defined with a
qualifier. Change the value of the setting to the name of the required qualifier.
For information about qualifiers, see "Qualifiers Page" on page 472. If empty
the qualifier is considered to beContainer.

l CIs with aComposition relationship that were added to, or removed from, a
CI.

Note: In amulti-tenancy environment, the CI Change report only displays
changes that are relevant to the tenants associated with yourView CIs
permission. However, Remove CI/relationship events that occurred before
an upgrade to UCMDB version 10.01 are displayed independent of the
tenants associated with theView CIs permission.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below:

UI Element
(A-Z) Description

Date from Configure a start date and time for the report.

Date until Configure an end date and time for the report.

Modeling Guide
Chapter 9: Reports

HP Universal CMDB (10.10) Page 353 of 534



UI Element
(A-Z) Description

Include
information
based on

Select one of the following:

l CMDB. Display the changes that occurred to the CI and its children in the
entire CMDB.

l View. Display the changes that occurred to the CI and its children in the
selected view.

Selected CIs Select the required CIs. Opens the Select CI/View dialog box. For details, see
"Working with the CI Selector" on page 128.

Time range Select a time frame over which to display the changes. The system
automatically provides the starting and ending dates in theDate from andDate
until boxes.

Note: If you select Custom, you canmanually configure a starting and
ending date in theDate from andDate until boxes.

CI Changes Tab

Important
Information

To view the change history of a CI, right-click anywhere in the row of the
required CI and select CI History.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A-Z) Description

<Toolbar> For details, see "Report Toolbar Options" on page 424.

<Shortcut
menu>

For details, see "IT UniverseManager Shortcut Menu" on page 222.

Attribute
Name

The name of the CI attribute that was changed.

Change
Date

The date at which the change occurred.

Changer The name of the user that manually modified the CI's property, or the name of the
Data Flow Probe that automatically discovered a changemade to the CI's property.

Class
Name

The CI type of the changed CI.
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UI
Element
(A-Z) Description

Display
Label

The label of the path from the root to the CI.

A backslash (\) in a CI name indicates a parent-child relationship with the format:
<parent_CI>\<child_CI>. For example, the entry 16.59.63.0\Windows provides
change information for the Windows CI that is the child of the 16.59.63.0CI.

New
Value

The new value of the CI attribute.

Old Value The previous value of the CI attribute (before the change).

Relationship Changes Tab

Important
Information

To view the change history of a CI, right-click anywhere in the row of the
required CI and select CI History.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

<Shortcut
menu>

For details, "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Change
Date

The date at which the update was performed.

Changer The name of the user that manually modified the CI's property, or the name of the
Data Flow Probe that automatically discovered a changemade to the CI's
property.

Container
Label

The label of the path from the root to the container CI.

A backslash (\) in a CI name indicates a parent-child relationship with the format:
<parent_CI>\<child_CI>. For example, the entry 16.59.63.0\Windows provides
change information for the WindowsCI that is the child of the dancer.hp.comCI.

Event Type You can have one of the following values:

l Add Related CI. A contained CI was added to the container CI using a
Composition relationship.

l Remove Related CI. A contained CI that was linked to a container CI using
aComposition was removed.
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UI Element
(A-Z) Description

Link Type The type of the relationship.

New Value The new value of the relationship attribute.

Old Value The previous value of the relationship attribute (before the change).

Related
Label

The label of the path from the root to the contained CI.

Relationship
Attribute

The name of the relationship attribute that was changed.

CMDB Utilization Report
This report displays general CMDB statistics. For example, the statistics can include the number of
Impact rules created, how many CIs are contained in the CMDB, or how many snapshots have
been taken.

To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select CMDB Utilization
Report.

l UnderGeneral:

n Double-click CMDB Utilization Report

n Right-click CMDB Utilization Report and select Create New Report.

n Select CMDB Utilization Report, and drag it onto the right pane.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element (A-Z) Description

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Name The name of the CMDB statistic.

Value The number of instances for the CMDB statistic found in the system.

Compare Archives Report
This report enables you to compare two archived reports or an archived report to the current version
of the report.

Modeling Guide
Chapter 9: Reports

HP Universal CMDB (10.10) Page 357 of 534



To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Compare Archives
Report.

l UnderCompliance:

n Double-click Compare Archives Report

n Right-click Compare Archives Report and select Create New Report.

n Select Compare Archives Report, and drag it onto the right pane.

Alternatively, in the Topology Reports pane, select two archives of the same

report and click theCompare Report Archives button.

Important
information

l The Compare Archives report is only available for topology reports.

l You can compare the current version of a report to an archive of that report or
two archives of the same report, but you cannot compare archives of different
reports.

l The only format available for previewing and exporting the Compare Archives
report is the Excel format.

Relevant
tasks

l "How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

Expand All. Expands the entire hierarchical tree structure of the CIs you
selected.

Collapse All. Collapses the hierarchical tree structure of the CIs you selected.

Previous Difference. Finds the previous occurrence of an itemmarked as
changed.

Next Difference. Finds the next occurrence of an itemmarked as changed.
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UI Element
(A-Z) Description

Show Configuration Files Differences. Shows the difference between the
content of the two configuration files. Configuration files use the .xml, .txt or .ini
extensions.

Select a CI of the CITConfiguration File in both panes and click theShow
Differences button. A window opens displaying the differences (marked in blue) in
the configuration files.

Show Only Different CIs in Tree. In the <Properties panes>, displays only the
part of the tree structure containing CIs that do not match.

Show Only Different Attribute Values. In the <Properties panes>, toggles
between displaying all the attribute values of the selected CI or only the attribute
values that have changed.

Synchronize Selection. Enables you to select a CI on one side and have its
corresponding CI automatically selected on the other side.

The default state for theSynchronize Selection button is selected. Deselecting
this button allows you to select different CIs from each of the two trees. This
enables you to compare two different CIs and see their different properties.

Contains An Updated Item. Indicates that a CI's attribute value has changed.
For example, aContains an Updated Item icon is displayed next to the 10.0.0.0
CI in the figure below since the attribute of its child CI 10.168.100.3 icon has
changed.

Deleted Item. Indicates that a CI has been deleted from the view.
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UI Element
(A-Z) Description

New Item. Indicates that a new CI has been added to the view.

Updated Item. Indicates that the attribute value of a CI has changed.

For example, the figure below shows that the CIs LABM3MAM16 displays the
Updated Item icon because it was updated with a new Version value, as

indicated by theShow Only Different Attribute Values icons (see the
Name andValue columns in the bottom panes underneath the tree structure).

<Left and
right
panes>

Displays a hierarchical tree structure of all the CIs in the view for each archive.
The left side always represents the older of the two archives.

<Properties
pane>

Displays the attributes of the selected CI.

The Properties pane contains the following fields:

l Name. Displays the name of the selected CI as defined in the CI's label.

l Value. Displays the attribute value for the currently selected CI.
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UI Element
(A-Z) Description

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut menu.
For details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Available
Archives

Displays the available archives of the report selected in theReport with archives
field. Select the two archives you want to compare.

Note: Visible when theShow Report Parameters button is pressed.

Report with
archives

Displays the name of the report whose archives you want to compare. Only
reports with archives are displayed.

Note: Visible when theShow Report Parameters button is pressed.

Compare CIs Report
This report enables you to compare the hierarchies of two compound CIs. A compound CI is a CI
that is linked to another CI by a relationship with the CONTAINER qualifier. You can display the
compared CIs and their child CIs that appear in a selected view, or in the CMDB.
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To access SelectManagers > Modeling > IT Universe Manager. Right-click a CI in the
Topology Map and select Compare CIs Report

or

SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Compare CIs Report.

l UnderCompliance:

n Double-click Compare CIs Report

n Right-click Compare CIs Report and select Create New Report.

n Select Compare CIs Report, and drag it onto the right pane.

Important
information

l The Compare CIs page is divided into two panes. Each side displays a
hierarchical tree structure of the CIs you selected. When you select a CI on
one side, the corresponding CI on the other side is automatically selected,
providedSynchronize Selection is pressed.

l You can compare only two CIs of the sameCI type or one of the CI type's
children in the hierarchy.

l The only format available for previewing and exporting the Compare CIs report
is the Excel format.

Relevant
tasks

l "How to Compare CIs" on page 336

l "How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

Previous Difference. Finds the previous occurrence of an itemmarked as
changed.

Next Difference. Finds the next occurrence of an itemmarked as changed.

Show Configuration Files Differences. Shows the difference between the
content of the two configuration files. Configuration files use the .xml, .txt or
.ini extensions.

Select a CI of the CITConfiguration File in both panes and click theShow
Differences button. A window opens displaying the differences (marked in blue)
in the configuration files.
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UI Element
(A-Z) Description

Show Only Different CIs in Tree. In the <Properties panes>, displays only
the part of the tree structure containing CIs that do not match.

Show Only Different Attribute Values. In the <Properties panes>, toggles
between displaying all the comparable attribute values of the selected CI or only
the attribute values that are different.

Synchronize Selection. Enables you to select a CI on one side and have its
corresponding CI automatically selected on the other side.

The default state for theSynchronize Selection button is selected.
Deselecting this button allows you to select different CIs from each of the two
trees. This enables you to compare two different CIs and see their different
properties.

Contains An Updated Item. Indicates that a CI's attribute value has changed.
For example, aContains an Updated Item icon is displayed next to the
IpAddressCI in the figure below since the attribute of its child CI 10.168.100.2
icon has changed.

No Matching CI. Indicates that a CI in one pane does not match any
corresponding CI in the other pane.

The following example displays theNo Matching CI icon next to theWindows
icon because it does not have a corresponding CI in the other pane.

Modeling Guide
Chapter 9: Reports

HP Universal CMDB (10.10) Page 364 of 534



UI Element
(A-Z) Description

Updated Item. Indicates that the attribute value of a CI has changed.

For example, the figure below shows that the CIs 10.0.0.2 and 16.59.124.1
display theUpdated Item icon because they was updated with a new IP
Network Mask value, as indicated by theShow Only Different Attribute

Values icons (see theName andValue columns in the bottom panes
underneath the tree structure).

Enables you tomove to the next or previous result of the search for the string
entered in the Find field.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

<Shortcut
menu>

For details, see "IT UniverseManager Shortcut Menu" on page 222.

<Properties
pane>

Displays the attributes of the selected CI.

The Properties pane contains the following fields:

l Name. Displays the attribute name for the selected CI, which was marked
as Comparable in the CI TypeManager.

l Value. Displays the attribute value for the currently selected CI.

<Left and
right panes>

Displays a tree of the compared CIs and their child CIs that appear in the
selected view or in the CMDB, depending on whether you selected theView or
theCMDB options.
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UI Element
(A-Z) Description

Compare in Select one of the following:

l CMDB. Includes the selected CIs and their child CIs that appear in the entire
CMDB.

l View. Includes the selected CIs and their child CIs that appear only in a
specific view.

Compared CI Enables you to select the two CIs you want to compare. Click to open the
CIs Selector dialog box. For details, see "CI Selector" on page 133. The CI you
select in the top box is displayed in the left pane and the CI you select in the
bottom box is displayed in the right pane.

Find Find. Enter a search name or a portion of a search name in the Find field to
locate it in the list.

Mutual View If both of the CIs you are comparing exist within the same view, the name of the
view is displayed in this field. Otherwise, the field displays the words No
mutual view.

Compare Snapshots Report
This report enables you to compare two snapshots of a specific view taken at different times. It
enables you to visualize the differences between the views by comparing the statuses of the view
at the times the snapshots were taken.

Modeling Guide
Chapter 9: Reports

HP Universal CMDB (10.10) Page 366 of 534



To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Compare Snapshots
Report.

l UnderCompliance:

n Double-click Compare Snapshots Report

n Right-click Compare Snapshots Report and select Create New Report.

n Select Compare Snapshots Report, and drag it onto the right pane.

Note: You can also take and compare snapshots in IT UniverseManager (for
details, see "Save Snapshot Dialog Box" on page 237).
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Important
information

l You can compare a current snapshot to a previous snapshot or two snapshots
taken in the past.

l You can define a schedule that takes snapshots of a specific view on a
periodic basis and saves them. For details, see "Schedule Report/Snapshot
Dialog Box" on page 409.

l The only format available for previewing and exporting the Compare Snapshots
report is the Excel format.

Note: Snapshots taken in a version prior to UCMDB 10.00 cannot be
compared with snapshots taken in UCMDB 10.00 or higher.

Relevant
tasks

l "How to Compare Snapshots" on page 337

l "How to Generate a Custom Report" on page 335

See also l "Save Snapshot Dialog Box" on page 237

l "Schedule Report/Snapshot Dialog Box" on page 409

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

Expand All. Expands the entire hierarchical tree structure of the CIs you
selected.

Collapse All. Collapses the hierarchical tree structure of the CIs you selected.

Previous Difference. Finds the previous occurrence of an itemmarked as
changed.

Next Difference. Finds the next occurrence of an itemmarked as changed.

Show Configuration Files Differences. Shows the difference between the
content of the two configuration files. Configuration files use the .xml, .txt or .ini
extensions.

Select a CI of the CITConfiguration File in both panes and click theShow
Differences button. A window opens displaying the differences (marked in blue) in
the configuration files.

Show Only Different CIs in Tree. In the <Properties panes>, displays only the
part of the tree structure containing CIs that do not match.
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UI Element
(A-Z) Description

Show Only Different Attribute Values. In the <Properties panes>, toggles
between displaying all the attribute values of the selected CI or only the attribute
values that have changed.

Synchronize Selection. Enables you to select a CI on one side and have its
corresponding CI automatically selected on the other side.

The default state for theSynchronize Selection button is selected. Deselecting
this button allows you to select different CIs from each of the two trees. This
enables you to compare two different CIs and see their different properties.

Contains An Updated Item. Indicates that a CI's attribute value has changed.
For example, aContains an Updated Item icon is displayed next to the 10.0.0.0
CI in the figure below since the attribute of its child CI 10.168.100.3 icon has
changed.

Deleted Item. Indicates that a CI has been deleted from the view.

New Item. Indicates that a new CI has been added to the view.
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UI Element
(A-Z) Description

Updated Item. Indicates that the attribute value of a CI has changed.

For example, the figure below shows that the CIs LABM3MAM16 displays the
Updated Item icon because it was updated with a new Version value, as

indicated by theShow Only Different Attribute Values icons (see the
Name andValue columns in the bottom panes underneath the tree structure).

<Left and
right
panes>

Displays a hierarchical tree structure of all the CIs in the view for that snapshot
version. The left side always represents the older of the two versions.

<Properties
pane>

Displays the attributes of the selected CI.

The Properties pane contains the following fields:

l Name. Displays the name of the selected CI as defined in the CI's label.

l Value. Displays the attribute value for the currently selected CI.

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut menu.
For details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.
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UI Element
(A-Z) Description

Available
Snapshots

Displays the current status and previously saved snapshots of the view selected
in theView with Snapshots field. Select the two snapshots you want to
compare.

By default, snapshots that have been empty for 3months are hidden.

Note: Visible when theShow Report Parameters button is pressed.

View with
snapshots

Displays the name of the view whose snapshots you want to compare. Only
views for which snapshots have been taken are displayed.

Note: Visible when theShow Report Parameters button is pressed.

Database Breakdown Report
This report displays the breakdown of database types and versions. You can view all databases
deployed in the system or the databases deployed at a specific location.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Database Breakdown
Report.

l UnderBreakdown:

n Double-click Database Breakdown Report

n Right-click Database Breakdown Report and select Create New Report.

n Select Database Breakdown Report, and drag it onto the right pane.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

Modeling Guide
Chapter 9: Reports

HP Universal CMDB (10.10) Page 372 of 534



UI Element (A-
Z) Description

<Bar graph/Pie
chart>

Each segment of the pie chart/column in a bar graph represents a different
database.

Click a slice/bar to view the database sorted by version, and then click again
to drill down to see the version information in table format.

When you hold themouse over each segment/bar, a tooltip indicates the
name of the database, the number of CI instances found for each database,
the percentage of the pie it represents (when viewing the information in pie
chart format), and the CI type the slice/bar represents.

The legend below the pie chart provides the name of each CI, and on the
lower level, their versions.

<Breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut
Menu>

Drill down to the level of individual CIs and right-click a CI in the report to
access the IT UniverseManager shortcut menu. For details, see "IT
UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

City Select the city for which you want to view database breakdown data, or
select All to show the breakdown for all cities.

Note: This is only relevant for CITs that contain data in theCity
attribute.

Country or
Province

Select the country or province for which you want to view database
breakdown data, or select All to show the breakdown for all countries or
provinces.

Note: This is only relevant for CITs that contain data in theCountry or
Province attribute.

Include All
Integration
Points

Select the check box to include federated CIs in the report. When the check
box is cleared, only local CIs are included in the report.
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UI Element (A-
Z) Description

State Select the state for which you want to view database breakdown data, or
select All to show the breakdown for all states.

Note: This is only relevant for CITs that contain data in theState
attribute.

Delete Candidates Report
This report displays the CITs and relationships that were deleted within a defined period, and the
ones that are about to be deleted.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Delete Candidates
Report.

l UnderGeneral:

n Double-click Delete Candidates Report

n Right-click Delete Candidates Report and select Create New Report.

n Select Delete Candidates Report, and drag it onto the right pane.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A-Z) Description

<Bar
graph>

Each segment of the column in a bar graph represents a CIT of a CI or a
relationship.

Click a bar to drill down to display the CITs and relationships that were deleted/are
about to be deleted in table format.

When you hold themouse over the relevant color of each bar, a tooltip indicates the
number of CIs and relationships that were deleted or the ones that are about to be
deleted and the CI type the bar represents.

The legend shows which color represents the CIs and relationships that were
deleted, and which color represents those that are about to be deleted. The CIT of
each CI or relationship is displayed underneath.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Date from Configure a start date and time for the report.

Date until Configure an end date and time for the report.

Time
range

Select a time frame over which to display the detected changes. The system
automatically provides the starting and ending dates in theDate from andDate
until boxes.

Note: If you select Custom, you canmanually configure a starting and ending
date in theDate from andDate until boxes.
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Dependency Report
This report enables you to generate a list of all the relationships of the typeDependency that
connect between servers in the selected view, or between the servers in the CMDB and the servers
within the selected view.

The report includes relationships that:

l Exist between databases and clients

l Exist between clients and servers

l Are created as a result of anMQ connection

To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Dependency Report.

l UnderGeneral:

n Double-click Dependency Report

n Right-click Dependency Report and select Create New Report.

n Select Dependency Report, and drag it onto the right pane.

Important
information

You can create new TQL queries in Enrichment Manager using theDependency
relationship to describe the connection between nodes. Every new Dependency
relationship that is used appears in the Dependency report.

Relevant
tasks

"How to Generate a Custom Report" on page 335
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

<Shortcut menu> For details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Include information
based on

Select one of the following:

l CMDB. Display all the servers in the CMDB that are dependent on
the servers in the selected view.

l View. Display all the dependencies between the servers in the
selected view.

View Select the required view.

The generated report includes the following elements (listed alphabetically):

UI Element (A-Z) Description

Clients The list of clients that are linked to the servers.

Counter The number of clients to which the server is connected.

Node The servers in the selected view.

Relationship The display label of the relationship in the Topology Map.

Discovery Errors Report
This report enables you to uncover specific problems that Data Flow Management encounters
during a run, for example, incorrect credentials.

To access SelectManagers > Modeling > Reports. In theCustom Reports pane,
do one of the following:

l Click theCreate New Report button and select Discovery Errors
Report.

l UnderDiscovery Status:

n Double-click Discovery Errors Report

n Right-click Discovery Errors Report and select Create New
Report.

n Select Discovery Errors Report, and drag it onto the right pane.
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Important
information

l Choose which columns to display by clicking theSelect Columns
button.

l Hide a column by right-clicking its header and selectingRemove
Column.

l Hide empty columns by right-clicking a header and selectingRemove
Empty Columns.

l Change the order of columns by dragging and dropping a column header.

Note: The Discovery Errors report is only relevant for errors in jobs that
are currently active.

See also l "Discovery Progress Dialog Box" in theHP Universal CMDB Data Flow
Management Guide

l "Error Messages Overview" in theHP Universal CMDB Developer
ReferenceGuide

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A-Z) Description

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut menu. For
details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Discovery
Module

Select themodule for which to display errors. You can select all modules or specific
modules.

Generate Click to generate a list of errors

Severity Select the types of error to display. For error definitions, see "Error Severity Levels"
in theHP Universal CMDB Developer ReferenceGuide.

Note: You can select multiple error types.

Time
range

Select a time frame over which to display the errors. The system automatically
provides the start and end dates in theDate from andDate until boxes.

Note: If you select Custom, you canmanually configure a start and end date
in theDate from andDate until boxes.

The generated report includes the following elements (listed alphabetically):
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UI Element (A-Z) Description

CI Type The CIT of the trigger CI.

Error Message The detailed error message.

Error Summary A brief summary of the error.

Job The job for which the error was reported.

Probe The Data Flow Probe that reported the error.

Related IPs IPs known to be related to the trigger CI.

Related Node The node that is related to the trigger CI.

Severity The error severity level (Warning, Error, Fatal Error).

Time Error Reported The time the error was reported.

Trigger CI The trigger CI on which the error was reported.

Generic Breakdown Report
This report displays the breakdown of CI types by the following:

l The CITs grouped under the selected CIT in the CIT tree

l A CIT attribute

For more details about CI types, see "CI TypeManager" on page 448.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Generic Breakdown
Report.

l UnderBreakdown:

n Double-click Generic Breakdown Report

n Right-click Generic Breakdown Report and select Create New Report.

n Select Generic Breakdown Report, and drag it onto the right pane.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element (A-
Z) Description

<Bar graph/Pie
chart>

Each segment of the pie chart/column in a bar graph represents a CIT or a
CIT attribute, depending on how that level has been broken down.

Click a slice/bar to drill down to the next level, if one has been defined. You
can generate a report that has up to three different levels. You can also
display the information in table format.

When you hold themouse over the relevant segment/bar, a tooltip indicates
the number of CI instances found for that CIT or CIT attribute, the percentage
of the pie it represents (when viewing the information in pie chart format), and
the CIT or CIT attribute the slice/bar represents.

<Breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut
Menu>

Drill down to the level of individual CIs and right-click a CI in the report to
access the IT UniverseManager shortcut menu. For details, see "IT
UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Breakdown by Select the required breakdown for the first level.

CIT to break
down

The CIT whose instances are broken down by the selected attributes.

Include All
Integration
Points

Select the check box to include federated CIs in the report. When the check
box is cleared, only local CIs are included in the report.

Then by (Optional) Select the required breakdown for the second and third levels.

Gold Master Report
This report compares one or more CIs to another CI that has been designated as aGoldMaster,
and specifies which of the compared CIs are configured differently from theGoldMaster CI.

The report compares the attribute values of the GoldMaster CIs to the attribute values of the
Compared CI of the sameCIT.

Note:

l TheGoldMaster report only displays a CI attribute comparison if the values are different.

l GoldMaster reports are not available for federated CIs.
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If a section is empty, it means that all attribute values of the GoldMaster CIs and the Compared
CIs for that CIT are identical. In such a case, the attributes in the next layer in the subgraph are
compared, and the next one, and so on.

Once the compared CIs in a layer are found to have different attributes, the GoldMaster report does
not continue the comparison of other layers in the subgraph for differences.

To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

Click theCreate New Report button and select Gold Master Report.

UnderCompliance:

l Double-click Gold Master Report

l Right-click Gold Master Report and select Create New Report.

l Select Gold Master Report, and drag it onto the right pane.

Important
information

Only attributes that have been assigned theComparable qualifier in the CIT
Manager can be compared. For details, see "CI TypeManager" on page 448.

Relevant
tasks

"How to Compare Snapshots" on page 337

User interface elements are described below:
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UI Element (A-
Z) Description

<Shortcut
menu>

For details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424

Attribute Name The name of the CI attribute.

Compared CIs Enables you to select the CIs whose attribute values you want to compare to
the GoldMaster CI. Opens the CI Selector. For details, see "CI Selector" on
page 133.

Display
Identical
Attribute
Values

Select this check box if you want to include the compared CIs whose
configuration is identical to that of the GoldMaster CI.

Note: If you do not select this check box, theValue in Gold Master CI
andValue in Compared CI columns of CIs with identical attribute
values are empty.

Display Label The display name of the Compared CI.

Exclude CI
types

Select the CI types to exclude from the report.

Master CI Enables you to select the CI you want to use as aGoldMaster CI. Opens the
CI Selector. For details, see "CI Selector" on page 133.

Value in
Compared CI

The value of the attribute in the Compared CI.

Value in Gold
Master CI

The value of the attribute in the GoldMaster CI.

Hardware Component Summary Report
This report displays data for all the node elements of hardware types detected in the system.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Hardware Component
Summary Report.

l Under Inventory:

n Double-click Hardware Component Summary Report

n Right-click Hardware Component Summary Report and select Create
New Report.

n Select Hardware Component Summary Report, and drag it onto the right
pane.

Important
information

The top level of the report displays the number of elements for each device type.
Click on a number to drill down to the next layer and view a list of the individual
hardware components with detailed data.

The hardware components displayed in the report include CPUs, disk devices,
fans, hardware boards, I/O slots, interfaces, memory units, physical ports, power
supplies, printers and SCSI adapters.

Use theSelect Columns button to select the attributes to display in the
report.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut
menu. For details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Impact Analysis Report
This report displays a list of CIs that are impacted in the system as a result of simulated changes.
For details, see "Run Impact Analysis Dialog Box" on page 235
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Impact Analysis
Report.

l UnderGeneral:

n Double-click Impact Analysis Report

n Right-click Impact Analysis Report and select Create New Report.

n Select Impact Analysis Report, and drag it onto the right pane.

Relevant
tasks

"How to Generate a Custom Report" on page 335

See also l "Impact Analysis Manager" on page 430

l "Run Impact Analysis Dialog Box" on page 235

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

<Shortcut Menu> Right-click a CI in the report to access the IT Universe
Manager shortcut menu. For details, see "IT Universe
Manager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Rule Bundle Enables you to select the rule group with which the
Impact Analysis rule works.
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UI Element (A-Z) Description

Severity Sets the severity level that we want to simulate for the
triggered CIs.

Triggered CIs Select the CIs that represent the changes you want to
make to the system. Opens the CI Selector.

Affected Application Tab
This tab displays all the CIs that belong to a specific business application, which were affected by
the triggered CI severity change.

User interface elements are described below:

UI Element (A-Z) Description

Display Label The name of the CI or relationship as it appears in the topology map.

Trigger Severity The severity selected in theSeverity box.

Grouping by CIT Tab
This tab displays all the CIs related to the triggered CIs that are impacted in the system as a result
of the simulated changes, sorted by CI type.

User interface elements are described below:

UI Element (A-Z) Description

Display Label The name of the CI or relationship as it appears in the topology map.

Trigger Severity The severity selected in theSeverity box.

Triggered CIs Tab
This tab displays all the CIs that represent the changes you want to make to the system. The CIs in
this tab are the CIs selected in the Triggered CIs box.

User interface elements are described below:

UI Element (A-Z) Description

Display Label The name of the CI or relationship as it appears in the topology map.

Job List Dialog Box
This dialog box displays a list of the reports/snapshots that were scheduled to run in the "Schedule
Report/Snapshot Dialog Box" on page 409.
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To
access

l To display a list of reports scheduled to run, select Managers > Modeling >

Reports. On the Reports page, click theShow Scheduled Report Jobs
button.

l To define a schedule for taking snapshots, selectManagers > Modeling >
Reports. In the Topology Reports pane, select the required view, click the

Snapshots button, and then select Show Scheduled Snapshot Jobs.

Relevant
tasks

l "How to View a Topology Report" on page 335

l "How to Generate a Custom Report" on page 335

User interface elements are described below:

UI Element
(A-Z) Description

Insert New Scheduled Report. Enables you to define a new job using the
Schedule Report dialog box.

Edit Job. Enables you to edit the selected job using the Schedule Report dialog
box.

Create Copy. Enables you to create a copy of the selected job. Opens a new job
in the Schedule Report dialog box that uses the details of the selected job.

Remove Job. Deletes the selected job from the list of scheduled jobs.

Run Job Immediate. Runs the selected job.

Pause Job. Pauses the selected job. Enabled only if the job has aPending
status.

Resume Job. Resumes the selected job.

Note: TheResume button is enabled only for jobs that have aPaused
status.

Refresh. Refreshes the list of scheduled jobs.

Clear filter. Clears the current filter.

Change visible columns. Enables you to select the columns to be displayed.
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UI Element
(A-Z) Description

Current
Status

The current status of each scheduled job:

l Running. The job is currently executing.

l Pending. The job is waiting for the scheduling requirements to be fulfilled.

l Completed. The job has finished executing.

l Paused. The job has been paused.

Note: If a job has aCompleted status, and you want to resume running the
job, you can either click Run Job Immediate or change theNext Execution
Time to the current time. If you change it to a future time, the status changes
toPending.

Description A description of the scheduled job as defined in the Schedule Report dialog box.

Execution
Status

The job's current execution status:

l Success. The job completed successfully (denoted by the icon).

l Failure. The job failed to execute (denoted by the icon). Hold the pointer
over the icon to display:

n A description of the error

n The related HP Universal CMDB internal exception

l None. The job has not yet been executed.

Last
Execution
Time

The last time the report ran.

Name The name of the scheduled job as defined in the Schedule Report dialog box.

Next
Execution
Time

The next time the report is scheduled to run.

Time Zone The time zone in which the job is scheduled to run.

Network Device Breakdown Report
This report displays a breakdown of network devices. Only the network devices that meet the
following conditions appear in the report:
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l The CIT of the network device has been assigned the qualifierNETWORK_DEVICES. For
details, see "Qualifier Tab" on page 84.

l The network device is defined with the following attribute condition: Host is complete = True.
For details, see "Attribute Tab" on page 74.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Network Device
Breakdown Report.

l UnderBreakdown:

n Double-click Network Device Breakdown Report

n Right-click Network Device Breakdown Report and select Create New
Report.

n Select Network Device Breakdown Report, and drag it onto the right
pane.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-
Z) Description

<Bar graph/Pie
chart>

Each segment of the pie chart/column in a bar graph represents a different
network device.

Click a slice/bar to drill down to see the number of CI instances per network
device.

When you hold themouse over each segment/bar, a tooltip indicates the
name of the network device, the number of CI instances found for each
network device, the percentage of the pie it represents (when viewing the
information in pie chart format), and the CI type the slice/bar represents.

Click a segment/bar to view a specific network device sorted by
manufacturer. Click a segment/bar again to view the details of the CI
instances found for that network device for that manufacturer in table format.

Each color in the legend represents a different network device.

<Breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Toolbar> For details, see "Report Toolbar Options" on page 424.
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UI Element (A-
Z) Description

City Select the city for which you want to view operating system breakdown data,
or select All to show the breakdown for all cities.

Note: This is only relevant for CITs that contain data in theCity
attribute.

Country or
Province

Select the country or province for which you want to view operating system
breakdown data, or select All to show the breakdown for all countries or
provinces.

Note: This is only relevant for CITs that contain data in theCountry or
Province attribute.

Include All
Integration
Points

Select the check box to include federated CIs in the report. When the check
box is cleared, only local CIs are included in the report.

State Select the state for which you want to view operating system breakdown
data, or select All to show the breakdown for all states.

Note: This is only relevant for CITs that contain data in theState
attribute.

Node OS Breakdown Report
This report displays a breakdown of operating systems. You can view all deployed operating
systems or you can view data for operating systems at a certain location or running on a certain
subnet.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Node OS Breakdown
Report.

l UnderBreakdown:

n Double-click Node OS Breakdown Report

n Right-click Node OS Breakdown Report and select Create New Report.

n Select Node OS Breakdown Report, and drag it onto the right pane.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element (A-
Z) Description

<Bar graph/Pie
chart>

Each segment of the pie chart/column in a bar graph represents a different
operating system.

Click a slice/bar to drill down to see the number of CI instances per operating
system in table format.

When you hold themouse over each segment/bar, a tooltip indicates the
name of the operating system, the number of CI instances found for each
operating system, the percentage of the pie it represents (when viewing the
information in pie chart format), and the CI type the slice/bar represents.

<Breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut
Menu>

Drill down to the level of individual CIs and right-click a CI in the report to
access the IT UniverseManager shortcut menu. For details, see "IT
UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

City Select the city for which you want to view operating system breakdown data,
or select All to show the breakdown for all cities.

Note: This is only relevant for CITs that contain data in theCity
attribute.

Country or
Province

Select the country or province for which you want to view operating system
breakdown data, or select All to show the breakdown for all countries or
provinces.

Note: This is only relevant for CITs that contain data in theCountry or
Province attribute.

Filter Select one of the following:

l By Location. Select the required location.

l By Subnet. Enter the required subnet. You can use the wildcard
character asterisk (*) to include several subnets. For example, 1 1 *.

Include All
Integration
Points

Select the check box to include federated CIs in the report. When the check
box is cleared, only local CIs are included in the report.
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UI Element (A-
Z) Description

State Select the state for which you want to view operating system breakdown
data, or select All to show the breakdown for all states.

Note: This is only relevant for CITs that contain data in theState
attribute.

Node Summary Report
This report displays all the nodes detected in the system and the hardware installed on them.

To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Node Summary Report.

l Under Inventory:

n Double-click Node Summary Report

n Right-click Node Summary Report and select Create New Report.

n Select Node Summary Report, and drag it onto the right pane.
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Important
information

If you select one of the grouping options, the top level of the report displays the
number of nodes for each group. Click on the number of nodes to drill down to the
next layer and view data for those nodes. If you selectedNone as the grouping
option, all the nodes appear in the top layer.

The second layer also contains some summary columns with numbers that are
clickable links (for example, Disk Devices displays the number of disk devices
for each node). Click the number to drill down to the next layer and view detailed
data.

In any layer, you can use theSelect Columns button to select the attributes
to display in the report.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut
menu. For details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Group By Select themethod for displaying the data. The available options are:

l None

l Location

l OS Family

Node Summary by VLAN Report
This report displays all the nodes detected in the system grouped by VLAN.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Node Summary by
VLAN Report.

l Under Inventory:

n Double-click Node Summary by VLAN Report

n Right-click Node Summary by VLAN Report and select Create New
Report.

n Select Node Summary by VLAN Report, and drag it onto the right pane.

Important
information

The top level of the report displays the number of devices for each VLAN. You can
click the number to drill down to view detailed data on each VLAN. Use theSelect

Columns button to select the attributes to display in the report.

Note: Nodes not connected to a VLAN are not displayed in the report.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut
menu. For details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Modeling Guide
Chapter 9: Reports

HP Universal CMDB (10.10) Page 396 of 534



Number of Changes Report
This report displays the number of detected changes in a CIT (additions, deletions, or updates)
within a defined time period.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Number of Changes
Report.

l UnderChange:

n Double-click Number of Changes Report

n Right-click Number of Changes Report and select Create New Report.

n Select Number of Changes Report, and drag it onto the right pane.

Important
information Note: In amulti-tenancy environment, the Number of Changes report only

displays changes that are relevant to the tenants associated with yourView
CIs permission. However, Remove CI/relationship events that occurred
before an upgrade to UCMDB version 10.01 are displayed independent of the
tenants associated with theView CIs permission.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A-Z) Description

<Bar
graph/Pie
chart>

On the first level, each segment of the pie chart/column in a bar graph represents a
CIT of a CI or a relationship in which there was a detected change. The legend
displays the colors that represent each CIT.

When you hold themouse over the relevant color of each segment/bar, a tooltip
indicates the number of changes that occurred for that CIT the percentage of the pie
it represents (when viewing the information in pie chart format), and the CI type the
slice/bar represents

Click a slice/bar to drill down to the second level. to view the types of changes that
occurred for each CIT and the CIT's children. The colors in each segment/bar
represent the different types of changes that occurred in the application. See the
legend to verify the change type each color represents.

Click the required color to drill down to see the number of CIs or relationships for
that type of change in table format. Once you do the second drill down, you get the
instances that represent the changes described.

Changes of type added or updated are taken from the CMDB. Changes of type
deleted are taken from the CI or relationship history.
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UI
Element
(A-Z) Description

<Shortcut
Menu>

Drill down to the level of individual CIs and right-click a CI in the report to access
the IT UniverseManager shortcut menu. For details, see "IT UniverseManager
Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Date from Configure a start date and time for the report.

Date until Configure an end date and time for the report.

Time
range

Select a time frame over which to display the detected changes. The system
automatically provides the starting and ending dates in theDate from andDate
until boxes.

Note: If you select Custom, you canmanually configure a starting and ending
date in theDate from andDate until boxes.

Recognized Applications Report
This report displays all the installed applications on the node where you are running the discovery
probe.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Recognized
Applications Report.

l Under Inventory:

n Double-click Recognized Applications Report

n Right-click Recognized Applications Report and select Create New
Report.

n Select Recognized Applications Report, and drag it onto the right pane.

Important
information

The top level of the report displays the number of installed applications for each
application. You can drill down to view detailed data on specific installed
applications.

Use theSelect Columns button to select the attributes to display in the
report. When the report is grouped by Application Name or Vendor Name, a
column called Installed On is available at the level of installed applications (after
drilling down). The column displays the location where the application is installed
and provides a clickable link to the node.

When the report is grouped by Related Node, a column called Installed Software
is available, which displays the number of installed applications on that node. It
also provides a clickable link to drill down and display the applications' details.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut
menu. For details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.
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UI Element (A-
Z) Description

Group By Select themethod for displaying the data. The available options are:

l Application Name

l Vendor Name

l Related Node

Report Properties Dialog Box
This dialog box enables you to set the report title and subtitle.

To
access

Click theReport Properties button in the report toolbar in the Reports module or in
the TQL Query Editor toolbar in Modeling Studio.

See
also

"Topology Reports Overview" on page 334

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

Format Select the report format. The following options are available:

l Flat. The CIs in the top layer are displayed as links. You can click a CI to drill
down to display its children.

l Hierarchical. All CIs of the report are displayed in one table in tree format.

Sub Report
Perspective

Select theSub Report Perspective check box tomake this perspective
available for building a Sub Report in the Generate Sub Report dialog box.

Note: This check box is only available in the Report Properties dialog box for
perspectives.

Subtitle Enter the report subtitle.

Title Enter the report title.

Reports Page
This page enables you to create Topology reports based on the data in views, as well as a number
of predefined Custom report types.
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To access Managers > Modeling > Reports

Relevant tasks l "How to View a Topology Report" on page 335

l "How to Generate a Custom Report" on page 335

l "How to Compare CIs" on page 336

l "How to Compare Snapshots" on page 337

See also l "Report Toolbar Options" on page 424

l "Custom Reports Overview " on page 335

l "Topology Reports Overview" on page 334

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A-Z) Description

<Left
pane>

The following panes are included:

l Topology Reports. Displays reports of the views and templates that were
created using theModeling Studio. For details, see "Topology Report" on page
416.

l Custom Reports. Displays various preset types of reports in chart or table
format. For details, see "Reports User Interface" on page 339.

<Right
pane>

Displays the selected report.

Left Pane
User interface elements are described below:

UI Element
(A-Z) Description

Create New Report. Enables you to select the type of report that you want to
create.

In the Topology Reports pane, select Pattern View, Perspective, or Template,
and you go directly to theModeling Studio to create the selected type of
resource.

In the Custom Reports pane, select a report from the list of Custom reports.
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UI Element
(A-Z) Description

Open Report. Generates an existing report in the Report pane.

Show View Definition. Displays the selected view's definition in theModeling
Studio. For details, see "Modeling Studio" on page 241.

Note: This option is available only for Topology Reports.

Delete Report.

l In the Custom Reports pane, deletes the selected report.

l In the Topology Reports pane, deletes the archived report.

Compare Report Archives. Opens the Compare Archives report when two
archives of the same report are selected.

Note: This option is available only for Topology Reports.

Schedule Report. Opens the Schedule Report dialog box, which enables you
to define a job that:

l Schedules the generation of a report

l Specifies one or more formats in which to send the report, and the report's
recipients

l Specifies the recurrence of the job

For more information on the Schedule Report dialog box, see, "Schedule
Report/Snapshot Dialog Box" on page 409.

Note: This option is available only before you generate a report or when you
open a saved report.

Show Scheduled Reports Jobs. Opens the Job List dialog box, which
displays the reports that have been scheduled to run. For details, see "Job List
Dialog Box" on page 386.
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UI Element
(A-Z) Description

Snapshots. Enables you to do the following:

l Save a snapshot of the active report. For details, see "Save Snapshot Dialog
Box" on page 237.

l Compare a previously saved snapshot to the active report or to another
snapshot. For details, see "Compare Snapshots Report" on page 366.

l Schedule snapshots to be saved. For details, see "Schedule
Report/Snapshot Dialog Box" on page 409.

l Display the currently scheduled snapshot jobs. or details, see "Job List
Dialog Box" on page 386.

Note: This option is available only for Topology Reports.

Send Mail. Opens the SendMail dialog box. You can send an email containing
the generated report in various formats, or as a direct link. For details on the
various formats, see "Report Toolbar Options" on page 424.

Select one or more of the available formats for the generated report to be sent as
attachments to an email recipient.

Note:

l Required fields aremarked with an asterisk.

l When entering an email address, ensure that the email's domain is a
valid one.

l In the SendMail dialog box, the From field is populated with the email
address defined in the user details for the current user. If no email is
defined for the current user, the default email address of the customer is
used.

Generate Direct Link. Creates a direct link to the specific location on the
server of the selected report, or to the data that you have exported as a specific
format.
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UI Element
(A-Z) Description

Export Report. Enables you to select the format for previewing and exporting
the report. The available options are:

l CSV. The report data is formatted as a comma-separated values (CSV) text
file that can be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the comma
(,) must be defined as the list separator. InWindows, to verify or modify
the list separator value, open Regional Options from the Control Panel,
and on the Numbers tab ensure that the comma is defined as the List
Separator value. In Linux, you can specify the list separator in the
application that opens the CSV file.

l PDF. The report data is exported in PDF format.

Note:When exporting to PDF, select a reasonable number of columns
to display to ensure that the report is legible.

l XLS. The report data is formatted as an .xls (Excel) file that can be displayed
in a spreadsheet.

Note: For large reports, you can reduce the time required for exporting
the report by setting a fixed column size using theColumn Size For
XLS Export setting in the Infrastructure Settings Manager.

l XML. The report data is formatted as an XML file that can be opened in a text
or XML editor.

Tip: To extract HTML code from the report:

l Open the file in an HTML editor

l Copy the relevant table into the target file

Note:When you export a generated report, a dialog box opens asking
whether you want to open the exported file. You can define whether to hide
or display this message using the "User Preferences Dialog Box" on page
92.
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UI Element
(A-Z) Description

Refresh. Refreshes the report tree.

Expand All. Expands the tree structure.

Collapse All. Collapses the tree structure.

Assign Tenants. Opens the Assign Tenants dialog box which enables you to
assign tenants to the selected custom report.

Note:

l This option is only relevant when a saved Custom Report is selected.

l This option is only available whenmulti-tenancy is enabled.

Manage Security. Enables you to assign permission for the selected custom
report to specific roles or to add the report to selected resource groups.

Note: This option is only available for Custom Reports.

Hide Empty Folders. Toggles between displaying all folders and only folders
that contain reports.

Find the next occurrence of the phrase/Find the previous occurrence of
the phrase. Enables you tomove to the next or previous result of the search for
the string entered in the Find field.

Highlights all occurrences of the phrase. Highlights all occurrences in the
CI tree of the string entered in the Find field.

Find Enter a search name or a portion of a search name in the Find field to locate it in
the list.

Scan File Status Report
This report displays the scan files generated by the Inventory Discovery by Scanner discovery
job.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Scan File Status
Report.

l UnderDiscovery Status:

n Double-click Scan File Status Report

n Right-click Scan File Status Report and select Create New Report.

n Select Scan File Status Report, and drag it onto the right pane.

Important
information

TheHost column indicates the node on which the scan file is generated. TheRun
Date andUpgrade Date columns display the latest run and upgrade times for the
scanner . TheScanner Configuration andProbe Name columns display the
configuration file and data flow probe gateway last used by the scanner. There is a
hidden column calledScan File Path, which displays the full path of the scan file
stored on the Data Flow Probe. To display this column, add it to the visible

columns manually using theSelect Columns button every time a new report
is generated.

You can download the selected scan file to the local machine by right-clicking a
scan file and selectingDownload Scan File from the context menu. If the
Inventory Tools are installed on the computer, when you open the downloaded
scan file, the Viewer application is launched to display the contents of the scan
file. For more information, see "Inventory Tools" on page 1.

Right-click a scan and select View Communication Log to display the scanner
log for debug information. This option is only available when the scan did not finish
successfully.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element
(A-Z) Description

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut menu. For
details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Date from Configure a start date and time for the report.

Date until Configure an end date and time for the report.

Time
range

Select a time frame over which to display the scan files. The system automatically
provides the starting and ending dates in theDate from andDate until boxes.

Note: If you select Custom, you canmanually configure a starting and ending
date in theDate from andDate until boxes.

Scanner Execution Details Report
This report displays runtime data from all Inventory Discovery jobs.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Scanner Execution
Details Report.

l UnderDiscovery Status:

n Double-click Scanner Execution Details Report

n Right-click Scanner Execution Details Report and select Create New
Report.

n Select Scanner Execution Details Report, and drag it onto the right pane.

Important
information

The report displays the following data for each Inventory Discovery job: the
display label of the host being scanned, the scanner version, the start time,
duration, schedule and status of the job, the probe name, any error messages and
the last successful execution time for the job.

Use theSelect Columns button to select the attributes to display in the
report.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A-Z) Description

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut menu. For
details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Group By Select a grouping option for the displayed data.

Job
Status

Select an option from the drop-down list to filter the results by the job status of the
discovery job.

Schedule Report/Snapshot Dialog Box
This dialog box enables you to define a schedule for running reports, and then send them by email to
specified recipients. You can also define a schedule for taking snapshots of a specific view. You
can see the list of reports/snapshots that have been scheduled to run in the "Job List Dialog Box"
on page 386.
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To
access

l To schedule reports to run, selectManagers > Modeling > Reports. In the
Topology Reports or Custom Reports pane, select a report and click the

Schedule Report button.

l To define a schedule for taking snapshots, selectManagers > Modeling >
Reports. In the Topology Reports pane, select the required view, click the

Snapshots button, and then select Schedule Snapshot. Alternatively, in IT
UniverseManager, click theSnapshots button in the CI Selector,and then select
Schedule Snapshot.

Relevant
tasks

l "How to Compare CIs" on page 336

l "How to Compare Snapshots" on page 337

The following elements are included:

UI Element (A-Z) Description

Click to validate the Cron expression you entered in theCron
Expression box.

(Appears only when you select Day of Month.) Clears the selected
dates in the calendar.

Actions The available options are:

l Mail. Sends the report to themail recipient in theSend box.

l Archive. Archives the report result in the database.

l Save to File System. Saves the report to the UCMDB Server file
system (in theUCMDBServer/Runtime folder). This option is only
available when the path is configured, using theReport root folder
setting in Infrastructure Settings Manager.

Note:

l This feature is only available when defining a schedule for
running reports.

l You can select multiple options (for example, Mail and Save to
File System).

Cron Expression Enter a Cron expression to schedule a job. For a description of the fields
used in Cron expressions and examples of how to use them, see "Cron
Expressions" on page 338.

Description A description of the scheduled job.
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UI Element (A-Z) Description

Ends Select one of the following options:

l Never. Do not specify an end date.

l Until. Choose the date and time by which you want the action to
stop running.

Note: This element is not relevant if you define a report to run only
once.

Formats
Note: Available only when defining a schedule for running reports.

Select the format for the report. Available when you select theMail or
Save to File System options under Actions.

The available options are:

l Excel. The report data is formatted as an .xls (Excel) file that can be
displayed in a spreadsheet.

l PDF. The report data is exported in PDF format.

Note:When exporting to PDF, select a reasonable number of
columns to display to ensure that the report is legible.

l CSV. The report data is formatted as a comma-separated values
(CSV) text file that can be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the
comma (,) must be defined as the list separator. InWindows, to
verify or modify the list separator value, open Regional Options
from the Control Panel, and on the Numbers tab ensure that the
comma is defined as the List Separator value. In Linux, you can
specify the list separator in the application that opens the
CSV file.

l XML. The report data is formatted as an XML file that can be opened
in a text or XML editor.

l Direct Link. Send an email containing the report data as a direct link.
(Only relevant for theMail option.)

Locale Select the language for the report.
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UI Element (A-Z) Description

Name The name of the scheduled job.

Repeat Select one of the following actions:

l Once. Activates a job only once.

l Interval. Runs a job on the basis of a fixed interval. You can select
an interval of minutes, hours, days, or weeks.

l Day of Month. Runs a job every month on the selected dates.

l Weekly. Runs a job on a weekly basis. Select the day or days on
which you want the action to run.

l Monthly. Runs a job on amonthly basis. Select themonth or months
in which you want the job to run.

l Yearly. Runs a job on a yearly basis.

l Cron. Use a Cron expression to schedule a job. For a description of
the fields used in Cron expressions and examples of how to use
them, see, "Cron Expressions" on page 338.

Repeat every (Appears only when you select Interval or Yearly.) Select a value for
the interval between successive runs.

For example, if you select Yearly and then 2, the job runs every second
year.

Repeat on (Appears only when you select Day of Month, Weekly, or Monthly.)
Select the days or dates on which to run the job.

For example, if you selectMonthly and then January and July, the job
runs on the specified date and time in January and July.

Report Enables you to select the Topology or Custom report you want to run.
Opens the Select Report dialog box.
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UI Element (A-Z) Description

Send to
Note: Available only when defining a schedule for running reports.

Define the recipients who can automatically receive scheduled reports

throughmail. Click theOpen Address Book button to open the
Message Recipients dialog box and select anmail recipient.

You can use theAdd, Edit, andDelete buttons in theMessage
Recipients dialog box tomodify themail list.

Note: The recipients that appear in theMessage Recipients dialog
box are updated with the email recipients defined in the "Recipients
Manager Page" in theHP Universal CMDB Administration Guide.

Server Time The exact server time according to the client's time zone.

Starts Choose the time and date when you want the job to begin running.

Time Zone Set the required time zone.

Software Utilization Report
This report displays all the installed software on the current machine with utilization data.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Click theCreate New Report button and select Software Utilization
Report.

l Under Inventory:

n Double-click Software Utilization Report

n Right-click Software Utilization Report and select Create New Report.

n Select Software Utilization Report, and drag it onto the right pane.

Important
information

The top level of the report displays the number of installed applications for each
software type. You can drill down to view utilization data on specific software
applications.

Use theSelect Columns button to select the attributes to display in the
report. When the report is grouped by Application Name or Vendor Name, a
column called Installed On is available at the level of installed applications (after
drilling down). The column displays the location where the software is installed
and provides a clickable link to the node.

When the report is grouped by Related Node, a column called Installed Software
is available, which displays the number of installed applications on that node. It
also provides a clickable link to drill down and display the applications' details.

Applications with no utilization data do not appear in the report.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut
menu. For details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.
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UI Element (A-
Z) Description

Group By Select themethod for displaying the data. The available options are:

l Application Name

l Vendor Name

l Related Node

Scope Select the scope of the report. The available options are:

l Last Month. Displays applications with utilization data in the last month.

l Last Quarter. Displays applications with utilization data in the last
quarter.

l Last Year. Displays applications with utilization data in the last year.

l All. Displays all applications with utilization data.

Show In-focus
Utilization Only

Select this check box to configure the report to display only the utilization
data for the time that an application was in focus (when it was in the
foreground).

When the check box is cleared, the report displays utilization data for the
time that an application was running (even when it was in the background).

Solaris Zone Report
This report displays information about Solaris zones. Solaris zones are isolated virtual
environments running applications on one physical host machine.

To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Right-click Solaris Zone Report and select Create New Report.

l Click theCreate New Report button and select Solaris Zone Report.

l Double-click Solaris Zone Report.

l Select Solaris Zone Report and drag it onto the right pane.
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Important
information

The top level of the report displays information on the Solaris zones. Click the
number in the Non-global Zone Count column to drill down to the next layer, which
displays information on the non-global zones that are hosted on the global zone. In
the second layer, you can click the number in the Network Devices column to drill
down to the next layer and view information about the network devices available
to this zone.

Use theSelect Columns button to select the attributes to display in the
report.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut
menu. For details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Topology Report
This report displays the topology of a view in report format.

To access SelectModeling > Reports. In the Topology Reports pane, select the required
report from the tree.

Important
information

Every view in UCMDB can be displayed in report format. You define the settings
for the report in the Report tab of the view inModeling Studio.

Templates can be opened in Reports also. You can edit the template parameters
and save the instance as a view.

Relevant
tasks

"How to View a Topology Report" on page 335

User interface elements are described below:
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UI
Element
(A-Z) Description

<Bar
graph/Pie
chart>

Each segment of the pie chart/column in a bar graph represents a CI on the
selected level of the view.

Click a slice/bar to drill down to the next level, if one exists. You can also display
the information in table format.

When you hold themouse over the relevant segment/bar, a tooltip indicates the
number of instances found for that CIT, the percentage of the pie it represents
(when viewing the information in pie chart format), and the CIT or CIT attribute the
slice/bar represents.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Reset Resets the template parameters to their original values.

Note: Only relevant for templates.

Save As
View

Click to save the instance as a template-based view with the selected parameter
values.

Note: Only relevant for templates.

View Change Report
This report displays the changes to CIs or relationships, in a selected view. This can help with
possible troubleshooting issues related to these CIs. For example, the changes in a CI may enable
you to conclude that these changes are the cause of the problem. By the same token, the source of
the troubleshooting issue could be related to expected changes which failed to occur.
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To access SelectModeling > Reports. In theCustom Reports pane, do one of the
following:

l Click theCreate New Report button and select View Change Report.

l UnderChange:

n Double-click View Change Report

n Right-click View Change Report and select Create New Report.

n Select View Change Report, and drag it onto the right pane.
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Important
information

Only those CIs whose properties aremarked as Managed appear in the report.
For details, see "Add/Edit Attribute Dialog Box" on page 458.

View Change reports display:

l Changes on only CIs that exist in the view.

l Changes that occurred in a selected CI and all children of the CI that are
related by the relationship specified in theChange Report link name
infrastructure setting. The default value of this setting is an empty value,
(managed_relationship), that enables you to track changes of all relationship
attributes that are not marked as Not Tracked in History.
To change the CIs displayed in the generated report, go toManagers >
Administration > Infrastructure Settings and edit the following settings:

n Select Change Report link name to retrieve CIs that are linked by the
selected calculated relationship. Change the value of the setting to the
name of the relationship as it appears in theName box (not theDisplay
Name box) in the Details page of the selected relationship in the CI Type
Manager. For details, see "Details Page" on page 467.

n Select Change Report link qualifier to retrieve CIs that are defined with a
qualifier. Change the value of the setting to the name of the required
qualifier. For information about qualifiers, see "Qualifiers Page" on page
472.

l CIs with aComposition relationship that were added to, or removed from, a
CI.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below:

UI
Element
(A-Z) Description

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut menu. For
details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Date from Configure a start date and time for the report.

Date until Configure an end date and time for the report.
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UI
Element
(A-Z) Description

Time
range

Select a time frame over which to display the changes. The system automatically
provides the starting and ending dates in theDate from andDate until boxes.

Note: If you select Custom, you canmanually configure a starting and ending
date in theDate from andDate until boxes.

View Select the view for which you want to review changes. Opens the Select CI/View
dialog box. For details, see "Working with the CI Selector" on page 128.

CI Changes Tab
For information on the CI Changes tab, see "CI Changes Tab" on page 354.

Relationship Changes Tab
For information on the Relationship Changes tab, see "Relationship Changes Tab" on page 355.

VMware Host Report
This report displays information about the VMware hosts (VMware ESX servers) and the VMware
virtual machines hosted on the ESX servers.

To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Right-click VMware Host Report and select Create New Report.

l Click theCreate New Report button and select VMware Host Report.

l Double-click VMware Host Report.

l Select VMware Host Report and drag it onto the right pane.
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Important
information

The top level of the report displays information on each of the VMware hosts
detected in the system. Click the number in the VM Count column to drill down to
the next layer and view detailed information about all of that host's VMware virtual
machines.

Use theSelect Columns button to select the attributes to display in the
report.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut
menu. For details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

VMware Virtual Center Report
This report displays information about Virtual Centers, whichmanage the physical servers (VM
hosts) and the virtual machines (VMs) they are running as a single, logical pool of resources.
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To access SelectManagers > Modeling > Reports. In theCustom Reports pane, do one
of the following:

l Right-click VMware Virtual Center Report and select Create New Report.

l Click theCreate New Report button and select VMware Virtual Center
Report.

l Double-click VMware Virtual Center Report.

l Select VMware Virtual Center Report and drag it onto the right pane.

Important
information

The top level of the report displays information on the Virtual Centers. Click the
number in the VMware Host Count column to drill down to the next layer, which
displays information on each of the VMware hosts in that Virtual Center.

In the second layer, you can click the number in the VM Count column to drill
down to the next layer and view detailed information about all of that host's
VMware virtual machines.

Use theSelect Columns button to select the attributes to display in the
report.

Relevant
tasks

"How to Generate a Custom Report" on page 335

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut
Menu>

Right-click a CI in the report to access the IT UniverseManager shortcut
menu. For details, see "IT UniverseManager Shortcut Menu" on page 222.

<Toolbar> For details, see "Report Toolbar Options" on page 424.

Zone-Based Discovery Errors Report
This report enables you to uncover specific problems that Data Flow Management encounters while
running activities in the selectedManagement Zones, for example, incorrect credentials.
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To access SelectModeling > Reports. In theCustom Reports pane, do one of the
following:

l Click theCreate New Report button and select Zone-Based
Discovery Errors Report

l UnderDiscovery Status:

n Double-click Zone-Based Discovery Errors Report

n Right-click Zone-Based Discovery Errors Report and select Create
New Report

n Select Zone-Based Discovery Errors Report, and drag it onto the right
pane

Important
information l Choose which columns to display by clicking theSelect Columns

button.

l Hide a column by right-clicking its header and selectingRemove Column.

l Hide empty columns by right-clicking a header and selectingRemove
Empty Columns.

l Change the order of columns by dragging and dropping a column header.

Relevant tasks "How to Generate a Custom Report" on page 335

See also l "Discovery Progress Dialog Box" in theHP Universal CMDB Data Flow
Management Guide

l "Error Messages Overview" in theHP Universal CMDB Developer
ReferenceGuide

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

<Toolbar> For details, see "Report Toolbar Options" on the next page.

Activity
Type

Select the type of discovery activity for which to display errors. To display all
types of discovery activity errors, select All.

Management
Zones

Select theManagement Zones for which to display errors. You can select all
Management Zones, or specific Management Zones.

Generate Click to generate the report.
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UI Element
(A-Z) Description

Severity Select the types of error to display. For error definitions, see "Error Severity
Levels" in theHP Universal CMDB Developer ReferenceGuide.

Note: You can select multiple error types.

Time range Select a time frame over which to display the errors. The system automatically
provides the start and end dates in theDate from andDate until boxes.

Note: Tomanually customize theDate from andDate until values, select
Custom from the Time Range list.

The generated report includes the following elements (listed alphabetically):

UI Element (A-Z) Description

CI Type The CIT of the trigger CI.

Error Message The detailed error message.

Error Summary A brief summary of the error.

Job The job for which the error was reported.

Probe The Data Flow Probe that reported the error.

Related IPs IPs known to be related to the trigger CI.

Related Node The node that is related to the trigger CI.

Severity The error severity level (Warning, Error, Fatal Error).

Time Error Reported The time the error was reported.

Trigger CI The trigger CI on which the error was reported.

Report Toolbar Options
This section describes the toolbar options for the Report pane.

UI Element (A-Z) Description

Displays the parameters that are defined for the report.

Save Report. Saves the selected report.
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UI Element (A-Z) Description

Report Properties. Opens the Report Properties dialog box, which
enables you to set the report title, subtitle, and format.

Schedule Report. Opens the Schedule Report dialog box, which enables
you to define a job that:

l Schedules the generation of a report

l Specifies one or more formats in which to send the report, and the
report's recipients

l Specifies the recurrence of the job

For more information on the Schedule Report dialog box, see, "Schedule
Report/Snapshot Dialog Box" on page 409.

Note: This option is only available before you generate a report or
when you open a saved report.

Send Mail. Opens the SendMail dialog box. You can send an email
containing the generated report in various formats, or as a direct link. For
details on the various formats, see "Report Toolbar Options" on the
previous page.

Select one or more of the available formats for the generated report to be
sent as attachments to an email recipient.

Note:

l Required fields aremarked with an asterisk.

l In the SendMail dialog box, the From field is populated with the
email address defined in the user details for the current user. If no
email is defined for the current user, the default email address of
the customer is used.

Archive Report. Enables you to save the report results in the database.

After the report is archived, a button appears next to the report name.

Note: Enabled only for Topology andGoldMaster reports.

Generate Direct Link. Creates a direct link to the specific location on the
server of the selected report, or to the data that you have exported as a
specific format.
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UI Element (A-Z) Description

Export Report.

Enables you to select the format for previewing and exporting the report.
The available options are:

l CSV. The report data is formatted as a comma-separated values
(CSV) text file that can be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the
comma (,) must be defined as the list separator. InWindows, to
verify or modify the list separator value, open Regional Options
from the Control Panel, and on the Numbers tab ensure that the
comma is defined as the List Separator value. In Linux, you can
specify the list separator in the application that opens the
CSV file.

l PDF. The report data is exported in PDF format.

Note:When exporting to PDF, select a reasonable number of
columns to display to ensure that the report is legible.

l XLS. The report data is formatted as an .xls (Excel) file that can be
displayed in a spreadsheet.

Note: For large reports, you can reduce the time required for
exporting the report by setting a fixed column size using the
Column Size For XLS Export setting in the Infrastructure
Settings Manager.

l XML. The report data is formatted as an XML file that can be opened in
a text or XML editor.

Tip: To extract HTML code from the report:

l Open the file in an HTML editor

l Copy the relevant table into the target file
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UI Element (A-Z) Description

Assign Tenants. Opens the Assign Tenants dialog box which enables
you to assign tenants to the selected custom report.

Note:

l This option is only available for saved reports.

l This option is only available whenmulti-tenancy is enabled.

Manage Security. Enables you to assign permission for the report to
specific roles or to add the report to selected resource groups.

Note: This option is only available for saved reports.

Bar Chart. Displays the generated report as a bar chart.

Pie Chart. Displays the generated report as a pie chart.

Table. Displays the generated report in tabular format.

Show Short Labels. Toggles between displaying the chart labels
minimal/maximum information.

Note: This option is available only for pie charts.

Show Legend. Toggles between hiding and displaying the chart's
legend.

Note: This option is available only for pie charts.

Slice chart. Toggles between displaying the pie chart with exploded and
unexploded segments.

Note: This option is available only for pie charts.

Expand All. Expands the tree structure.

Collapse All. Collapses the tree structure.

Delete from CMDB. Deletes the selected CI from the CMDB.

Properties. Opens the Configuration Item Properties dialog box for the
selected CI.
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UI Element (A-Z) Description

Refresh. Refreshes the report tree.

Select Columns. Enables you to select the columns you want to display
in the report. For details, see "Select Columns Dialog Box" on page 530.

Sort Column Content. Enables you to set the sort order of the selected
column's content.

Find. Toggles between displaying and hiding the Find utility.

Find the next occurrence of the phrase/Find the previous
occurrence of the phrase. Enables you tomove to the next or previous
result of the search for the string entered in the Find field.

Highlights all occurrences of the phrase. Highlights all occurrences in
the CI tree of the string entered in the Find field.

Generate Report. Enables you to generate the selected report.

Note: This button appears disabled prior to defining the report
parameters.

<breadcrumbs> Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Generated
report>

Displays the active generated report.

Find Enter a search name or a portion of a search name in the Find field to
locate it in the list.

Reports on Non-English Locales - Notes and
Limitations

l HP Universal CMDB does not support custom report names that contain more than 50multi-
byte characters.

l If a report is created in one language locale and sent by email from another language locale, the
report contains system information in the languages of the server and the original locale.

l If a report file name contains multi-byte characters (for example, in Japanese, Chinese, or
Korean) and the report is sent as an email attachment, the name becomes unreadable.
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l When exporting a CI instance to a PDF file, multi-byte characters (such as Japanese, Chinese,
Korean, and so on) may not be displayed properly in the PDF file.

l When saving a snapshot of a topology report, the name can have amaximum of 25 non-English
characters.

Modeling Guide
Chapter 9: Reports

HP Universal CMDB (10.10) Page 429 of 534



Chapter 10: Impact Analysis Manager
This chapter includes:

Impact Analysis Manager Overview 430

How to Define an Impact Rule –Workflow 430

Impact Analysis Manager User Interface 433

Impact Analysis Manager Overview
Impact Analysis Manager enables you to define the interdependencies between components in
your IT infrastructure to simulate how infrastructure changes (for example, a new software
installation or upgrade) can impact your system.

By creating Impact rules based on TQL queries, you can determine the true origin of a problem and
its business impact. Each Impact rule you define is attached to a specific Impact Analysis TQL
query. For more information about TQL queries, see "Topology Query Language" on page 15.

You define Impact rules to specify a causal relationship between two or more Impact Analysis
query nodes. Define one query node as the trigger, or the query node that represents the changes
you want to make to the system, and another query node as the one that is impacted. After the
causal relationship is established, Impact Analysis Manager enables you to determine the effect of
the changes occurring in root cause query nodes.

You then run the Impact rules in IT UniverseManager to simulate how the changes impact your
system and discover the root causes of the changes (for details, see "Run Impact Analysis Dialog
Box" on page 235). This enables you to evaluate and handle accordingly, the possible implications
of any action, update, new deployment, or a failure of the service delivery.

A simulated change in an impacted CI can alter the CI's map status, which is manifested through
an addition of a status icon to the CI's symbol. The Topology Map displays the statuses of the
trigger CIs as well as all statuses of the CIs that are impacted by it. Each color represents a
different status.

For details about the status icons and the colors that represent them, see "Show Impact Pane" on
page 239.

You can then generate a report displaying the following:

l CIs in the system that are impacted by the changes.

l Trigger CIs (the CIs that represent the changes you want to make to the system).

l CIs that belong to a specific business service.

How to Define an Impact Rule – Workflow
This section describes how to define an Impact rule whereby a change in CPU operation impacts
the node to which it is connected.
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This task includes the following steps:

l "Create an Impact Analysis TQLQuery" below

l "Define an Impact Rule" below

1. Create an Impact Analysis TQL Query
To create an Impact Analysis TQL query, you need to create an Impact Analysis TQL and then
add the TQL query nodes and relationships that define the query.

SelectManagers > Modeling > Impact Analysis Manager to open the Impact Analysis
Manager. For details about how to create an Impact Analysis TQL query, see "New Impact
Rule/Impact Rule Properties/Save As Impact RuleWizard" on page 443. For details about how
to add query nodes and relationships to a query, see "How to AddQuery Nodes and
Relationships to a TQLQuery" on page 25.

Example of an Impact Analysis TQL Query:

In this Impact Analysis TQL query, a CPU and a node are linked by a Composition
relationship. The TQL query results must comply with the direction of the arrows.

Note: An Impact Analysis TQL query is subject to certain validation restrictions. For
details, see "Troubleshooting and Limitations" on page 93.

2. Define an Impact Rule
When you define an Impact rule, youmust specify the required causal relationship between the
query nodes. Define one query node as the trigger, or the query node that represents the
changes you want to make to the system, and another query node as the one that is impacted.

Right-click the query node you want to define as the trigger query node and select Define
Impacted to open the Impacted Query Nodes dialog box. Select the query node you want the
trigger query node to impact. Then click theAdd button to open the Impact Rules Definition
dialog box to set conditions for defining impacted query nodes. For details about how to define
an Impact rule, see "Impact Rules Definition Dialog Box" on page 442.
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Note: The change state option in the Impact rule definition is no longer relevant for Impact
Analysis. The only supported state is operation.

Example of an Impact Rule:

The Conditions area in the Impact Rules Definition dialog box defines the conditions under
which the simulated change in the system is triggered. The Severity area defines the
severity of the impact on the impacted query node.

The Impact rule in this example states that when the CPU operation is not in the normal
state, the node is impacted. Since the severity is set to 100% of the trigger's severity, the
severity of the node is the same as the severity of the CPU, which is determined when
Impact Analysis is run.

In the resulting TQL query, an upward arrow appears next to the query node defined as the
trigger query node and a downward arrow appears next to the query node defined as the
impacted query node.
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Note: To retrieve the Impact Analysis results, youmust run the Impact rule in IT
UniverseManager. For details, see "How to Retrieve Impact Analysis Results –
Scenario" on page 195.

Impact Analysis Manager User Interface
This section includes (in alphabetical order):

Details Dialog Box 433

Impact Analysis Manager Page 434

Impacted Query Nodes Dialog Box 441

Impact Rules Definition Dialog Box 442

New Impact Rule/Impact Rule Properties/Save As Impact RuleWizard 443

Details Dialog Box
This dialog box displays the new Impact rule you created in the Impact Rules Definition dialog box.

To access In the Impact Analysis Manager, click Next in the Impacted Query Nodes dialog
box.

Relevant
tasks

"How to Define an Impact Rule –Workflow" on page 430

See also l "Impact Analysis Manager Overview" on page 430

l "Impact Analysis Manager User Interface" above

User interface elements are described below:
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UI Element (A-
Z) Description

Description The description of the new Impact rule.

State The category you chose from theState list in the Impact Rules Definition
dialog box.

Impact Analysis Manager Page
This page enables you to define Impact rules.

To access Select Impact Analysis Manager from the NavigationMenu or selectManagers
> Modeling > Impact Analysis Manager.

Important
information

When selecting query nodes to function as Impact Analysis triggers, they must
comply with certain restrictions. For details, see "Troubleshooting and
Limitations" on page 93.

Relevant
tasks

"How to Define an Impact Rule –Workflow" on page 430

See also l "Impact Analysis Manager Overview" on page 430

l "Impact Analysis Manager User Interface" on the previous page

Impact Rules Pane
This area displays a hierarchical tree structure of predefined folders and Impact rules. Each Impact
rule is associated with a TQL query.

Important
information

You can create your own Impact rules, or work with the default rules provided with
your HP Universal CMDB installation.

The predefined folders are provided for the default Impact rules; you canmodify
these folders, or add additional folders according to your organization's
requirements.

You can drag and drop Impact rules or folders tomove them from one folder to
another.

User interface elements are described below:

UI Element (A-Z) Description

New Folder. Creates a new folder.

New. Creates an Impact rule. Opens the New Impact
RuleWizard.
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UI Element (A-Z) Description

Delete. Deletes the selected folder or Impact rule.

Refresh. Refreshes the data content of the hierarchical
tree structure that may have beenmodified by other users.

Save. Saves the Impact rule to the CMDB. (Enabled only
when a new Impact rule is created or when changes are
made to an existing one.)

Properties. Opens the Impact Rule Properties Wizard.
Enables you to change the description of the rule.

Assign Tenants. Opens the Assign Tenants dialog box
which enables you to assign tenants to the impact rule.

Note: This button is only available whenmulti-
tenancy is enabled.

Manage Security. Enables you to assign the selected
impact rule to specific roles or resource groups.

Preview. Generates a preview of the results of the
selected Impact rule.

Export To XML. Enables you to export an Impact rule to
an XML file.

Import From XML. Enables you to import XML files that
contain saved Impact rules to the Impact Analysis
Manager.

Represents a folder.

Represents an Impact rule.

<Impact Rules tree> Displays the existing Impact rules in tree format.

Note: Only Impact rules appear in the tree. TQL
queries of type Impact Analysis (created in the
Modeling Studio) do not appear.

The following options are available by right-clicking a folder or Impact rule:
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UI Element
(A-Z) Description

Assign
Tenants

Opens the Assign Tenants dialog box which enables you to assign tenants to
the selected impact rule.

Note: This option is only available whenmulti-tenancy is enabled.

Delete Delete the selected folder or Impact rule.

Export To
XML

Displays a standard Save As dialog box, enabling you to save the Impact rule
as an XML script. This option can be used tomove an Impact rule from one
workstation to another, provided the related TQL query is also relocated.

Import From
XML

Imports XML files that contain saved Impact rules to Impact Analysis Manager.

Manage
Security

Assign the selected impact rule to specific roles or resource groups.

New Creates an Impact rule. Opens the New Impact RuleWizard.

New Folder Creates a new folder.

Preview Generates a preview of the results of the selected Impact rule.

Properties Opens the Impact Rule Properties Wizard. Enables you to change the
description of the rule.

Rename
Folder

Rename the folder.

Save (Enabled only when a new Impact rule is created or when changes aremade to
an existing one.) Saves the Impact rule to the CMDB.

Save As Displays the Save As Impact RuleWizard, enabling you to create new Impact
rules based on an existing query.

Editing Pane
This area displays the selected Impact rule, which consists of query nodes that are defined in the
TQL query and the relationships between them.

Important
information

l When you select a folder in the Impact Rules pane, the editing pane is empty.

l When you select an Impact rule in the Impact Rules pane, the editing pane
displays the selected rule, which consists of TQL query nodes that are defined
in the TQL query and the relationships between them.
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Relevant
tasks

"How to AddQuery Nodes and Relationships to a TQLQuery" on page 25

See also When selecting query nodes to function as Impact Analysis triggers, they must
comply with certain restrictions. For details, see "Troubleshooting and
Limitations" on page 93.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-
Z) Description

Indicates a trigger query node. Located to the right of the trigger query node's
icon.

Indicates an impacted query node. Located to the right of the impacted query
node's icon.

Indicates query nodes that are both impacted and trigger query nodes.

<Main Menu> For details, see "MainMenu" on page 163.

<Query Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between two query nodes.

<Shortcut
menu options>

For details, see "Shortcut MenuOptions" on page 33.

<Toolbar> For details, see "Toolbar Options" on page 167.

<Tooltip> Hold the cursor over a query node or relationship to view its tooltip.

The tooltips contain the following information:

l Element name. The name of the query node.

l CI Type. The CIT of the query node as defined in the CI TypeManager.
For details, see "CI TypeManager" on page 448.

l Definitions of the selected query nodes and relationships. The
attribute conditions, as described in "Query Node/Relationship Properties
Dialog Box" on page 72.

l Names of the trigger and the impacted query nodes. This is only
relevant if the query node over which the cursor is hovering is the trigger
query node.

CI Type Selector
This area displays a hierarchical tree structure of the CI Types found in the CMDB.
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Important
information

The CI Type Selector is part of Enrichment Manager, Impact Analysis Manager,
and Trigger TQL Editor.

To create or modify a TQL query, click and drag query nodes to the Editing pane
and define the relationship between them. Your changes are saved to the CMDB.
For details, see "How to AddQuery Nodes and Relationships to a TQLQuery" on
page 25.

Note: The number of instances of each CIT in the CMDB is displayed to the
right of each CIT.

Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "How to Create a Pattern View" on page 255

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements (A-Z) Description

Add CI Type to Map.Moves the selected CI type to the Editing pane.

Refresh. Refreshes the CI type tree.

Search. Searches for the CI type entered.

Expand All. Expands all subtrees within the CI type tree.

Collapse All. Collapses the subtrees within the CI type tree.

<Search window> Enter the name or part of a name of a CI type for which to search.

Shortcut Menu Options

The CI Type Selector includes the following elements (listed alphabetically) available by right-
clicking a CI Type:

Menu Item Description

Add CI Type
to Map

Select to add the selected CI type to the Editing pane.
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Menu Item Description

Go to CI
Type
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT
Instances

Opens the CIT Instances window, which displays all instances of the selected
CIT. For details, see "CI Instances Dialog Box" on page 64.

Advanced Pane
This area displays the properties, conditions, and cardinality for the selected query node and
relationship.

Important
information

The Advanced pane appears in the lower part of the window in the following
managers and user interfaces: Modeling Studio, Impact Analysis Manager,
Enrichment Manager, the Input Query Editor and Trigger Query Editor in DFM.

A small green indicator appears next to the tabs that contain data.

Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

User interface elements are described below:

UI
Elements
(A-Z)

Description

If the window is not wide enough to display all the tabs, use the left and right
arrows tomove to the required tab.

Click Show List to display a list of the available tabs for the current module. You
can select a tab from the list.

Attributes Displays the attribute conditions defined for the query node or the relationship. For
details, see "Attribute Tab" on page 74.
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UI
Elements
(A-Z)

Description

Cardinality Cardinality defines how many query nodes you expect to have at the other end of
a relationship. For example, in a relationship between a node and an IP Address, if
the cardinality is 1:3, the TQL query retrieves only those nodes that are connected
to between one and three IP Addresses. For details, see "Cardinality Tab" on
page 76.

Data
Sources

Displays the data sources set for the selected query node.

Note: This tab appears only in theModeling Studio.

Details Displays the following information:

l CI Type/Element Type. The CIT of the selected query node/relationship.

l Element Name. The name of the query node or relationship. This appears only
in theModeling Studio.

l Show in query results. A green check indicates that the selected query
node/relationship is visible in the topology map. A redmark indicates that it is
not visible. In theModeling Studio, this is indicated by the word Yes or No.

l Include subtypes. A green check indicates that both the selected CI and its
children are displayed in the topology map. A redmark indicates that only the
selected CI appears. This item does not appear in theModeling Studio.

Edit Click Edit to open the relevant dialog box for the selected tab.

Element
Layout

Displays the attributes selection for the selected query node or relationship. It lists
the attributes selected to be included in the query results (whenSpecific
Attributes is selected as the attributes condition). It also lists the excluded
attributes and any selected qualifiers for attributes. For details, see "Element
Layout Tab" on page 82.

Note: This tab appears only in theModeling Studio.

Element
Type

Displays the subtype conditions defined for the query node or relationship. For
details, see "Element Type Tab" on page 80.

Note: This tab appears only in theModeling Studio.
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UI
Elements
(A-Z)

Description

Enrichment
Rules

Displays the Enrichment rule defined for the selected query node or relationship. If
the Enrichment rule is used to update the attributes of a CI, click Edit to open the
Query Node/Relationship Definition dialog box and edit the rule if required. For
details, see "Query Node/Relationship Definition Dialog Box" on page 514.

Note: This tab appears only in Enrichment Manager.

Impacted
Query
Nodes

Indicates which query node is impacted by the changes that occur in the selected
trigger query node. If required, you can click Edit to open andmodify the Impacted
Query Nodes dialog box. For details, see "Impacted Query Nodes Dialog Box"
below.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node or the relationship. For
details, see "Qualifier Tab" on page 84.

Note: This tab appears only in Enrichment Manager and Impact Analysis
Manager.

Selected
Identities

Displays the element instances that are used to define what should be included in
the TQL query results. For details, see "Identity Tab" on page 85.

Impacted Query Nodes Dialog Box
This dialog box enables you to define which query node in the TQL query is the trigger Impact
Analysis query node and which query nodes are impacted by the changes that occurred in the
system.

To access Right-click the query node or relationship that functions as a trigger and select
Define Impacted. The Impacted Query Nodes dialog box opens to display the
query nodes in the TQL query.

Important
information

Before creating the TQL query, youmust know which query node in the query is
the trigger Impact Analysis query node and which are impacted by the changes
beforehand. The definition is performed here.

Relevant
tasks

"How to Define an Impact Rule –Workflow" on page 430

See also l "Impact Analysis Manager Overview" on page 430

l "Impact Analysis Manager User Interface" on page 433
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User interface elements are described below :

UI Element
(A-Z) Description

Impacted
Query
Nodes
pane

Contains a list of the Impact Analysis query nodes in the Impact rule. Select the
query nodes to be impacted by the trigger query node. Click Next to view details
for the selected query node.

Impact Rules Definition Dialog Box
This dialog box enables you to set conditions for defining impacted query nodes, define the scope of
the trigger conditions, and define the severity of the impact.

To access In the Impact Analysis Manager, click Add in the Details page of the Impacted
Query Nodes dialog box.

Important
information

l In the Conditions area, set conditions for defining impacted query nodes. When
this condition is met, the simulated change in the system is triggered.

For example, you can define an Impact Analysis condition that states that the
operational state of the query node is other than Normal. When the operational
state of the query node instance changes and is no longer Normal, the
condition is met and the simulated changes in the system are triggered.

l In the Scope area, define how many instances of the trigger query node should
fulfill the conditions for triggering the changes in the system.

You can apply the trigger conditions to a single instance of a trigger query
node, to a certain percentage of the trigger instances, or to all of them.

For example, you can define that impact is calculated when at least 10% of the
system’s nodes are down.

l In the Severity area, define the severity of the Impact Analysis impact.

Relevant
tasks

"How to Define an Impact Rule –Workflow" on page 430.

See also l "Impact Analysis Manager Overview" on page 430

l "Impact Analysis Manager User Interface" on page 433

User interface elements are described below :
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UI Element
(A-Z) Description

All All instances should fulfill the conditions.

Any One instance or more should fulfill the conditions.

Description A description of the Impact rule you are defining.

Fixed
severity

Define a fixed severity level for every system change generated. Then, select the
required severity level from the list.

Function Select Function (displayed when you selected theAll andRange options in the
Scope area) to define a severity level for the system changes, as a function of the
severity levels of all the trigger query node instances that are included in the
range. From the list, select eitherAverage orMax.

For example, if you select Average, the severity level of the system changes is
the average severity of all the trigger instances.

Operator Select the required operator. For a list of the operators you can use for defining an
attribute condition, see "Attribute Operator Definitions" on page 38.

Range A certain percentage of all instances should fulfill the conditions. For example, if
you enter a range of 50% to 100%, the changes are triggered when 50% ormore
of the instances meet the conditions.

Severity
relative to
trigger
severity (%)

Select Severity relative to trigger severity (%) (displayed when you selected
theAny option in theScope area) to define a severity level for each system
change that is relative (as a percentage) to the severity of the trigger event.

Enter the percentage in the box provided.

State Choose the required state. The states that appear in the list are the states that are
defined in the StateManager. For details, see "StateManager" in theHP
Universal CMDB Administration Guide.

Value
comparison

Select the required attribute.

New Impact Rule/Impact Rule Properties/Save As Impact
Rule Wizard

This wizard enables you to create or modify an Impact rule.

Modeling Guide
Chapter 10: Impact Analysis Manager

HP Universal CMDB (10.10) Page 443 of 534



To access l To create an Impact rule, right-click anywhere in the Impact Rules pane and

click New or click theNew button.

l Tomodify an Impact rule, right-click an Impact rule in the Impact Rules pane
and select Properties.

l To create a new Impact rule based on an existing query, right-click an Impact
rule in the Impact Rules pane and select Save As.

Important
information

l Any major changemade to the TQL query after creating an Impact rule causes
the system to delete the rule. These changes include deleting a root cause or
impacted query node or changing theMin andMax relationship definitions. For
details, see "Cardinality Tab" on page 76.

l Minor changes, such as adding a query node to the TQL query, do not cause
the deletion of the rule.

l The Impact Analysis TQL query that serves as the basis of the Impact rule, is
subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations" on page 93 . If the TQL query is not valid, it cannot be used for the
creation of an Impact rule.

Relevant
tasks

"How to Define an Impact Rule –Workflow" on page 430.

Wizard
Map

The "New Impact Rule/Impact Rule Properties/Save As Impact RuleWizard"
contains:

"Impact Rule General Attributes Page" below > "Impact Rule BaseQuery Page"
on the next page > "Impact Rule Groups Page" on page 446

See also l "Impact Analysis Manager Overview" on page 430

l "Impact Analysis Manager User Interface" on page 433

Impact Rule General Attributes Page

This wizard page enables you to enter a unique name and description for the Impact rule.
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Important
information

l The Impact Analysis TQL query that serves as the basis of the Impact rule, is
subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations" on page 93. If the TQL query is not valid, it cannot be used for the
creation of an Impact rule.

l For important information on the effects of making changes to the TQL query
after creating it, see "New Impact Rule/Impact Rule Properties/Save As
Impact RuleWizard" on page 443.

l By default, this wizard is set to display aWelcome page. You can choose not
to display theWelcome page by changing the user preferences. For details,
see "User Preferences Dialog Box" on page 92.

Wizard
map

The "New Impact Rule/Impact Rule Properties/Save As Impact RuleWizard" on
page 443 contains:

"Impact Rule General Attributes Page" > "Impact Rule BaseQuery Page" >
"Impact Rule Groups Page"

See also "IT UniverseManager" on page 180

User interface elements are described below:

UI Element
(A-Z) Description

Rule
Description

(Optional) Enter a description of the Impact rule.

Rule Name Enter a unique name for the Impact rule.

The rule name cannot contain any of the following characters: \ / : " < > |% ?. The
final character cannot be a blank space.

Note: If the Impact rule name is either empty, contains a name used by
another Impact rule, or uses invalid characters, theNext and Finish buttons
are disabled.

Impact Rule Base Query Page

This wizard page enables you to define the properties of the TQL query on which the Impact rule is
based. You can use an existing query or create a new query.
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Important
information

l The Impact Analysis TQL query that serves as the basis of the Impact rule is
subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations" on page 93. If the TQL query is not valid, it cannot be used for the
creation of an Impact rule.

l For important information on the effects of making changes to the TQL query
after creating it, see "New Impact Rule/Impact Rule Properties/Save As
Impact RuleWizard" on page 443.

Wizard
map

The "New Impact Rule/Impact Rule Properties/Save As Impact RuleWizard"
contains:

"Impact Rule General Attributes Page" > "Impact Rule Base Query Page" >
"Impact Rule Groups Page"

See also "IT UniverseManager" on page 180

User interface elements are described below :

UI Element (A-Z) Description

Base the Impact rule
on a new query

Select this check box if you want to base the Impact rule on a new TQL
query. The query results are based on the attributes defined for the new
TQL query.

Base the Impact rule
on an existing query

Select this check box if you want to base the Impact rule on an existing
TQL query. Select the required Impact Analysis TQL query from the
drop-down list.

Base Query
Description

(Optional) Enter a description of the TQL query.

Base Query Name Enter a unique name for the Impact Analysis TQL query.

If you selected theBase the Impact rule on an existing TQL option,
select the Impact Analysis TQL query on which you want to base the
rule.

Save a new query
based on the current
definition

Select to save a new TQL query based on your Impact rule definition.

Note: This field only appears in the Save As Impact Rule wizard.

Impact Rule Groups Page

This wizard page enables you to define where you can run Impact rules.
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Important
information

l The Impact Analysis TQL query that serves as the basis of the Impact rule, is
subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations" on page 93. If the TQL query is not valid, it cannot be used for the
creation of an Impact rule.

l For important information on the effects of making changes to the TQL query
after creating it, see "New Impact Rule/Impact Rule Properties/Save As
Impact RuleWizard" on page 443.

l By default, this wizard is set to display a Completion page after clickingNext
in this page. You can choose not to display the Completion page by changing
the user preferences. For details, see "User Preferences Dialog Box" on page
92.

Wizard
map

The "Impact Rule Groups Page" contains:

"Impact Rule General Attributes Page" > "Impact Rule BaseQuery Page" >
"Impact Rule Groups Page"

See also "IT UniverseManager" on page 180

User interface elements are described below :

UI Element (A-
Z) Description

<Impact Rule
bundles>

Displays the available bundles. Select the bundle(s) in which to include this
Impact Rule.

For new Impact rules, theUCMDB: Rule will run within UCMDB
application option is selected by default.
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Chapter 11: CI Type Manager
This chapter includes:

CI Types Overview 448

CI Type Attributes 449

CI Type Relationships 450

Deprecated CI Types 451

System TypeManager 451

How to Create a CI Type 452

How to Create a Relationship Type 453

How to Create a Calculated Relationship Type 454

How to Create List and Enumeration Definitions 455

How to Create an Enumeration Definition –Workflow 456

View Descriptions for CI Types and Relationships 457

CI TypeManager User Interface 458

Note to HP Software-as-a-Service customers: The data in CI TypeManager can be
viewed but not edited.

CI Types Overview
A configuration item (CI) can represent hardware, software, services, business processes, or any
component of your IT infrastructure. CIs with similar properties are grouped under a CI type (CIT).
Each CIT provides a template for creating a CI and its associated properties.

Every CI must belong to a CI type. The following are themain categories of CITs:

l Business Element. CITs that correspond to the logical elements of your business, such as
processes and organizational groups.

l IT Process Record. CITs that correspond to changes that occur in your IT infrastructure.

l Monitor. CITs that handle incomingmetrics collected from your business universe.

l Location. CITs that correspond to the location of devices and business organizations or people
supporting a function.

l Party. CITs that correspond to an active entity such as a person or organization.
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l CI Collection. A logical collection of CIs.

l Infrastructure Element. CITs that correspond to the physical elements (hardware and
software) installed in your business environment.

The CITs are arranged in a tree structure under these categories in the CI Types pane. You can
browse the CI Typemodel by expanding the tree in the CI Types pane. The CIT selected in the left
pane is displayed in the topology map along with all the potential valid relationships to other CITs.

You can also define new CITs tomatch your business needs. For details on defining new CITs, see
"Create Configuration Item Type/Relationship/Calculated RelationshipWizard" on page 466.

CI Type Attributes
Every CI type has attributes which define it, such as name, description, and default value. The
CITs grouped under other CITs in the CI Type tree inherit attributes from the higher-level CITs.

When you define a new CI type, you first select a Base Configuration Item Type from a list of
existing CITs. Your new CIT inherits the attributes of the existing CIT. You can then set the
attributes for the new CIT. You edit the attributes of an existing CIT by selecting a CIT from the tree
in the CI Types pane and selecting the Attributes tab of the topology map. For details on CIT
attributes, see "Attributes Page" on page 469.

This section includes the following topics:

l "CI Type IdentificationMethods" below

l "CI Type Naming" on the next page

CI Type Identification Methods
Every CI created is given an automatically generated global ID, which is used to distinguish
different instances of the sameCI type. UCMDB provides identificationmethods which enable you
to set conditions under which two CI instances are defined as identical, and are consequently
merged into a single instance. For example, theBy key attributesmethod involves defining CIs
with certain matching attributes to be identical. You can also select additional identification
methods as described in "Details Page" on page 467.

If you select theBy key attributes option, you can designate one or more of the CIT's attributes as
key attributes, which are used as identifiers of the CIT. When you define an instance of a CIT, the
CIT's key attributes aremandatory fields for CIs of that type. You can assign as many key
attributes as you want to a given CIT. If you do not assign a key attribute when defining a new CIT
or changing the identificationmethod of an existing CIT toBy key attributes, youmust select the
ABSTRACT_CLASS qualifier on the Qualifier page of the wizard.

You can change or remove the key attributes of an existing CIT if the key attribute values for all
instances of that CIT are unique. Similarly, you can change the identificationmethod toBy key
attributes only if the key attribute values for all instances of that CIT are unique. If the selected
changes result in multiple instances of a CIT with identical key attribute values, an error message
indicates that the action is not permitted, as the CIT instances would bemerged.
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If you select other identificationmethods, you cannot define key attributes for the CIT, but it retains
the key attributes of its parent CIT. These key attributes aremandatory fields for CIs of that type
and they cannot be removed. For those identificationmethods, there are no restrictions on the
qualifiers selected.

Identification is also relevant for CIs of sibling CI types, if at least one of the CI types inherits its
identificationmethod from the common ancestor CIT. For example, the CI types Router and
Switch Router are sibling CI types, descendants of the ancestor CIT Node. If at least one of them
has Inherited from parent as the identificationmethod, then CIs of the two types could bemerged
if the identification criteria aremet. In such a case, the CI type of themerged CI is that of the sibling
that was most recently updated. If one of the CIs had attributes that do not exist in the CI type of
themerged CI, they are filtered out of themerged CI.

CI Type Naming
Entity names in HP Universal CMDB for CMDB-based applications follow the conventions
described below:

l CIT attributes values. All primitive types are supported: long, double, float, string, and so on.

l CIT attributes values-type string. All special characters are supported. Themaximum length
is 4000 characters.

l CIT name. Only the following characters are permitted: a-z, A-Z, 0-9 and underscore (_). Note
also:

n The first character must not be a number.

n The name field is case sensitive, but you cannot use the same namewith different cases for
different CITs.

n Themaximum length is 200 characters.

l CIT attribute name. Only the following characters are permitted: a-z, A-Z, 0-9 and underscore
(_). Note also:

n The first character may be a number.

n The attribute name field is not case sensitive.

n Themaximum length is 200 characters.

l CIT attribute length. The total length of all the attribute values in one CIT cannot exceed 8K
bytes due to aMicrosoft SQL Server limitation. This limitation is relaxed under certain
circumstances. For details, see http://msdn.microsoft.com/en-us/library/ms186981.aspx.

CI Type Relationships
A relationship defines the link between two CIs. Relationships represent the dependencies and
connections between the entities in your IT environment. When you select relationships or
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calculated relationships in the drop-down box in the CI Types pane, the topology map displays all
the valid instances of CITs linked by the selected relationship. For details about calculated
relationships, see "Using Calculated Relationships" on page 98.

The same attributes defined for CITs are also defined for relationships. You can also assign key
attributes for relationships but it is not required. For details on defining new relationship types, see
"Create Configuration Item Type/Relationship/Calculated RelationshipWizard" on page 466.

Deprecated CI Types
CITs and relationships that are scheduled to be removed in a subsequent product version are
known as deprecated CITs. Such CITs appear in the user interface in strikethrough font. You can
hold the pointer over a deprecated CIT to display a tooltip with information about it, including which
CIT replaces it.

Note: The strikethrough font is only visible when a font size of 14 points or higher is selected
for the topology map.

Deprecated CITs appear in the CIT tree inModeling Studio, however it is not recommended to use
them in building new TQL queries and views. In place of a deprecated CIT, use the CIT indicated in
the tooltip as its replacement. Deprecated CITs do not appear in out-of-the-box queries and views.

CIT attributes which are scheduled to be removed are deprecated attributes. They also appear in
strikethrough font in the user interface.

The following image displays a TQL query containing a deprecated CIT:

System Type Manager
System TypeManager enables you to create a predefined list whose values define an attribute
type. For more details on System TypeManager, see "System TypeManager Dialog Box" on page
487.

You can create the following attribute types:
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l List. Enables you to create a predefined list of values, for example, Location.

l Enumeration. Enables you to create a predefined list of values, as well as assign each value a
color. Enumerations are designed to be used as severity value lists by states. For details, see
"StateManager" in the HP Universal CMDB Administration Guide.

Severity lists are used for:

l Retrieving Impact Analysis results in IT UniverseManager. For details, see "IT Universe
Manager" on page 180.

l Creating an Impact rule. For details, see "Impact Analysis Manager" on page 430.

You can use both List and Enumeration values for:

l Editing the attributes of a CIT. For details, see "How to Create a CI Type" below.

l Defining an attribute condition for a TQL query node or relationship. For details, see "Query
Node/Relationship Properties Dialog Box" on page 72.

How to Create a CI Type
This task describes the process you follow to create a CIT using the Create CI Type wizard.

This task includes the following steps:

l "Prerequisites" below

l "Define the CI Type" below

l "Set the CI Type Attributes" on the next page

l "Assign Qualifiers to the CI Type" on the next page

l "Assign an Icon to the CI Type" on the next page

l "Customize the CI TypeMenu" on the next page

l "Define the CI Type Default Label" on the next page

l "Define theMatching Rules" on the next page

1. Prerequisites
From the CI TypeManager, select CI Types from the list box in the CI Types pane. Then click

New to start the Create CI TypeWizard.

2. Define the CI Type
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Enter the name, description, and base configuration item type for the new CI type and select an
identificationmethod for it. For details, see "Details Page" on page 467.

3. Set the CI Type Attributes
Edit the attributes of the new CI type. For details, see "Attributes Page" on page 469.

Note: List and Enumeration definitions are created in the System TypeManager. If
required, you can create additional List and Enumeration definitions. For details, see "How
to Create List and Enumeration Definitions" on page 455.

4. Assign Qualifiers to the CI Type
Assign qualifiers to the definition of the new CI type. For details, see "Qualifiers Page" on page
472.

5. Assign an Icon to the CI Type
Select an icon to assign to the new CI type. For details, see "Icon Page" on page 475.

6. Customize the CI Type Menu
Select themenu items and commands to appear in the shortcut menu for the new CI type. For
details, see "AttachedMenu Page" on page 476.

7. Define the CI Type Default Label
Define the attributes to appear in the CI type label. For details, see "Default Label Page" on
page 479.

8. Define the Matching Rules
If necessary, define thematching rules for the new CI type. For details, see "Matching Rules
Page" on page 481.

Note: This step is only relevant for customers running HP Universal CMDB Configuration
Manager.

How to Create a Relationship Type
This task describes the process you follow to create a relationship type using the Create
Relationship wizard.

This task includes the following steps:

l "Prerequisites" on the next page

l "Define the Relationship" on the next page
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l "Set the Relationship Attributes" below

l "Assign Qualifiers to the Relationship" below

l "Customize the Relationship Menu" below

l "Define the Relationship Default Label" below

1. Prerequisites
From the CI TypeManager, select Relationships from the list box in the CI Types pane. Then

click New to start the Create RelationshipWizard.

2. Define the Relationship
Enter the name, description and base CI type for the new relationship. For details, see "Details
Page" on page 467.

3. Set the Relationship Attributes
Edit the attributes of the new relationship. For details, see "Attributes Page" on page 469.

Note: List and Enumeration definitions are created in the System TypeManager. If
required, you can create additional List and Enumeration definitions. For details, see "How
to Create List and Enumeration Definitions" on the next page.

4. Assign Qualifiers to the Relationship
Assign qualifiers to the definition of the new relationship. For details, see "Qualifiers Page" on
page 472.

5. Customize the Relationship Menu
Select themenu items and commands to appear in the shortcut menu for the new relationship.
For details, see "AttachedMenu Page" on page 476.

6. Define the Relationship Default Label
Define the attributes to appear in the relationship label. For details, see "Default Label Page" on
page 479.

How to Create a Calculated Relationship Type
This task describes the process you follow to create a calculated relationship type using the Create
Calculated Relationship wizard.

This task includes the following steps:
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l "Prerequisites" below

l "Define the Calculated Relationship" below

l "Assign Qualifiers to the Relationship" below

l "Add Required Triplets" below

1. Prerequisites
From the CI TypeManager, select Calculated Relationships from the list box in the CI Types

pane. Then click New to start the Create Calculated RelationshipWizard.

2. Define the Calculated Relationship
Enter the name, description and base CI type for the new calculated relationship. For details,
see "Details Page" on page 467.

3. Assign Qualifiers to the Relationship
Assign qualifiers to the definition of the new relationship. For details, see "Qualifiers Page" on
page 472.

4. Add Required Triplets
Add the required triplets. For details, see "Triplets Page" on page 474.

How to Create List and Enumeration Definitions
This section describes the tasks for creating List and Enumeration definitions.

This task includes the following steps:

l "Create a List Definition" below

l "Create an Enumeration Definition" below

1. Create a List Definition
You can create a List definition of predefined values. For example, a List definition called
Locationmight contain:

n New York

n Boston

n Baltimore

For details, see "Create/Update List/Enumeration Definition Dialog Box" on page 482.

2. Create an Enumeration Definition

Modeling Guide
Chapter 11: CI TypeManager

HP Universal CMDB (10.10) Page 455 of 534



You can create anEnumeration definition, which enables you to assign a color for each value
on the list. For details, see "Create/Update List/Enumeration Definition Dialog Box" on page
482. For an example of an Enumeration definition, see "How to Create an Enumeration
Definition –Workflow" below.

How to Create an Enumeration Definition – Workflow
The following steps describe how to create an Enumeration definition.

Note: To retrieve the required results, youmust follow each step in this task.

To create an Enumeration definition:

1. SelectManagers > Modeling > CI Type Manager.

2. From theMainMenu, select CI Types > System Type Manager to open the System Type
Manager dialog box.

3. Click theAdd button to open the Create List Definition dialog box.

Note: Alternatively, you can select Managers > Administration > State Manager and
then click theNew Enumeration button to open the Create Enumeration Definition dialog
box.

4. Select Enumeration.

5. In theName box, enter the required name.

6. (Optional) In theDisplay Name box, enter the required display name.

This example describes how to create the following severity list:

Key Value Severity Represented

0 Green Normal

1 Orange Major

2 Red Critical

7. Click theAdd button to create a new row.

8. In theValue box, enter Normal, in theKey box, enter 0, and in theColor section, select
Green.
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9. Click theAdd button to create another row.

10. In theValue box, enter Major, in theKey box, enter 1, and in theColor section, select
Orange.

11. Click theAdd button to create another row.

12. In theValue box, enter Critical, in theKey box, enter 2, and in theColor section, select
Red.

The following image shows the Enumeration Definition section after the changes:

13. Click OK to save your changes.

View Descriptions for CI Types and Relationships
You can view a complete list of available CI types in tree format in the left pane of CI Type
Manager. You can search incrementally for a specific CI type as described in "CI TypeManager
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Page" on page 462. To see a description for a particular CI type, select it from the tree and hold the
pointer over the icon which corresponds to it in the Topology Map. A tooltip containing a description
of the CI type is displayed.

For relationships, select Relationships in the left pane and search incrementally by the first letter
of the relationship. Select the relationship you want and hold the pointer over its icon in the
Topology Map to display a tooltip containing a description of the relationship.

For detailed information on CI types and relationships, you can generate the UCMDB CI Types and
Relationships Information PDF. For details, see "Export Selected CITs to PDF Dialog Box" on
page 486. Alternatively, you can access the UCMDB Class Model Reference by clicking theView

UCMDB Class Model button in the CI Types pane toolbar.

CI Type Manager User Interface
This section includes (in alphabetical order):

Add/Edit Attribute Dialog Box 458

Add/Remove Relationship Dialog Box 461

CI TypeManager Page 462

Create Configuration Item Type/Relationship/Calculated RelationshipWizard 466

Create/Update List/Enumeration Definition Dialog Box 482

Export Selected CITs to Excel Dialog Box 484

Export Selected CITs to PDF Dialog Box 486

System TypeManager Dialog Box 487

Add/Edit Attribute Dialog Box
This dialog box enables you to define a new attribute to add to a CIT or to edit an existing attribute of
a CIT.

To access In the CI TypeManager, select the Attributes tab, then click theAdd button,
or select an attribute and click theEdit button or double-click the attribute.

Important
information

In Edit mode, fields that cannot be changed are disabled. For CI types with
instances, some fields cannot be edited. For details, see "Attributes Page" on
page 469.

Relevant
tasks

l "How to Create a CI Type" on page 452

l "How to Create a Relationship Type" on page 453

See also l "CI Types Overview" on page 448

l "CI Type Attributes" on page 449
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Details Tab
User interface elements are described below:

UI Element
(A-Z) Description

Attribute
Name

Enter a unique name for the new attribute. Only the following characters are
permitted: a-z, A-Z, 0-9 and underscore (_). Note also:

l The first character may be a number.

l The attribute name field is not case sensitive.

l Themaximum length is 200 characters.

Attribute
Type

Select one of the following options:

l Primitive. Choose from one of the following field types: boolean, bytes, date
number, double number, float number, integer, list of integers, list
of strings, long number, string, xml.

l Enumeration/List. Contains a list of Enumerations and Lists defined in the
System TypeManager. For details, see "System TypeManager" on page 451.

This option enables you to define an attribute with a predefined value. For
example, a location attributemight be defined by a location list containing the
following values: Singapore, Paris, New York.

Default
Value

Enter or select a default value for the attribute. The options for theDefault Value
field vary depending on the attribute type you selected.

Note: If you select thePrimitive attribute types list of integers or list
of strings, you can enter multiple values.

Description Enter a description for the new attribute. The description can be up to 2,048
characters long.

Note: This field is optional.

Display
Name

Enter a name for the new attribute to identify it in HP Universal CMDB.

Note: This field is optional.

Scope Select the scope of the new attribute (the class model to which it belongs).

Value Size Enter a value for themaximum physical size of the new attribute. (Enabled for
bytes and string only).
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Advanced Tab
User interface elements are described below:

UI Element
(A-Z) Description

Asset Data Select to display the attribute value in the Asset Report.

Comparable Select to enable this attribute to be used for comparing compound CIs.

Discovery
Auto Trim

When selected, results sent from the Probe are trimmed. That is, leading and
trailing spaces and tabs are trimmed, so that there are no white spaces at the
beginning or at the end of the result.

Discovery
Auto
Truncate

If selected, when attributes of type STRING exceed the size limit, Discovery
truncates the value. For details, see "Server-Side Data Normalization" in theHP
Universal CMDB Data Flow Management Guide.

Editable Select to enable future editing of the attribute. Only attributes that aremarked as
Editable (or ones that have values) are displayed in the Properties tab in IT
UniverseManager.

Index Select to accelerate the attribute retrieval performance. This option is
recommended for attributes that are used frequently in search conditions. For
example, IP address is usually an index attribute of a node.

Lower Case When this option is selected, the attribute value appears in lower case.

Managed This designation is only relevant for users of HP Universal CMDB Configuration
Manager.

Note:

l When this qualifier is selected for a given attribute, the attribute appears
as a visible column in the CI Instances dialog box. For details, see "CI
Instances Dialog Box" on page 64.

l Managed is not relevant for attributes of the type list of integers or list of
strings.

Not Tracked
for History

Select to exclude this attribute from History storage.

Password When this option is selected, the attribute value appears as asterisks (a hidden
value).

Required Select to define this attribute as a required one, if its value is required for the
creation of the CIT.

Static Select to define this attribute as static.
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UI Element
(A-Z) Description

Unique When this option is selected, different instances of this CI typemust have unique
values.

Upper Case When this option is selected, the attribute value appears in upper case.

Use Update
Value
Policy

For details on this qualifier, see "The Use Update Value Policy Qualifier" on page
23. 

Visible Select to display this attribute in the Properties tab in IT UniverseManager.

UCMDB Browser Qualifiers
User interface elements are described below:

UI Element
(A-Z) Description

CMS Browser
Editable

Select to enable this attribute to be editable in the UCMDB Browser.

CMS Browser
Searchable

Select to enable this attribute to be searchable in the UCMDB Browser.

CMS Browser
Visible

Select to enable this attribute to be viewed in the UCMDB Browser.

TheVisible in preview mode field determines whether the attribute is
displayed in preview mode of the UCMDB Browser.

TheProperties group assignment field determines the group in the properties
widget where the attribute is displayed.

Hide in
Modeling

WhenCMS Browser Visible is selected, select Hide in Modeling to prevent
the attribute from appearing in the Lightweight Modeling component of the
UCMDB Browser.

Hide in
Export
Search
Results

Select to enable this attribute to be excluded from exported search results in the
UCMDB Browser.

Add/Remove Relationship Dialog Box
This dialog box enables you to add or remove default or new relationships between CITs, which
define their physical or logical connections.

To access In the CI TypeManager, right-click a CIT or two CITs and select Add/Remove
Relationship.
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Important
information

When adding a relationship between two CITs, select the two CITs to be linked by
holding theCTRL key and clicking the CIT names. Then right-click one of them
and select Add/Remove Relationship.

See also l "CI Types Overview" on page 448

l "CI Type Relationships" on page 450

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

<query node1 to query
node2>

Select the relationships to add in the direction of the first query node
to the second.

<query node2 to query
node1>

Select the relationships to add in the direction of the second query
node to the first.

Relationship Name A list of the possible relationships.

CI Type Manager Page
This page enables you to view the information in the CI Typemodel, which contains the definitions
of all configuration item types (CITs) defined in the system and the relationships that define the
connections between them. Each CIT has its own attributes, as well as the attributes inherited from
its parent CIT.

To access Select CI Type Manager from the NavigationMenu or selectManagers >
Modeling > CI Type Manager.

Important
information

CI TypeManager consists of the following panes:

l CI Types. Displays a hierarchical list of CI Types and relationships. The
number appearing next to the CIT indicates the number of instances of that
CIT which exist in the CMDB.

l Topology Map. Displays a topology map of the CITs and relationships in the
system.

Relevant
tasks

l "How to Create a CI Type" on page 452

l "How to Create a Relationship Type" on page 453

l "How to Create a Calculated Relationship Type" on page 454
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See also l "CI Types Overview" on page 448

l "CI Type Attributes" on page 449

l "CI Type Relationships" on page 450

l "Deprecated CI Types" on page 451

l "View Descriptions for CI Types and Relationships" on page 457

l "CI TypeManager User Interface" on page 458

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

New. Opens the Create Configuration Item TypeWizard which enables
you to define a new CI type. For details, see "Create Configuration Item
Type/Relationship/Calculated RelationshipWizard" on page 466.

Delete. Deletes the selected CI type or relationship. This option is only
available for CI types that have no children and no instances.

Note:When you delete a CI type or relationship, all resources
dependent on that CI type or relationship are also deleted. When you
click Delete, the Confirm Delete dialog box displays links for each
type of dependent resource. Click the links to display the dependent
resources. The dependent resources can include queries, views,
reports, Enrichments, or Impact rules.

Refresh. Refreshes the data content of the hierarchical tree structure that
may have beenmodified by other users.

Save. Saves the changes made to a CI type.

Import From XML. Enables you to import CITs from an external file.

Export To XML. Enables you to export a CIT as an XML file. Use this
option tomove CITs from one server to another.

Export Class Model. Enables you to export a CIT. Choose the export
format. The available options are:

l PDF. The table data is exported in PDF format.

l XLS. The table data is formatted as an .xls (Excel) file that can be
displayed in a spreadsheet.
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UI Element (A-Z) Description

View UCMDB Class Model. Opens the Class Model Reference, which
contains information on all packages, CI types, and relationships in the
class model.

<CI
Type/Relationship
Box>

Select one of the following options:

l CI Types. Display the CI types in the CIT model.

l Relationships. Display the relationships in the CIT model.

l Calculated Relationships. Display the calculated relationships in the
CIT model.
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UI Element (A-Z) Description

<Editing Pane> The following tabs are available:

l Dependencies. Displays the CI Typemodel in a topology map,
including the CITs and the relationships between them. The name of
the selected CI type or relationship appears in the border at the top of
the pane. When you point to a CIT, a tooltip displays the display name
of the CIT and its description.

l Details. Enables you to edit the basic information about the CI type
selected in the left pane. For details, see "Details Page" on page 467.

l Attributes. Enables you to edit the attributes of the selected CIT. For
details, see "Attributes Page" on page 469.

l Qualifiers. Enables you to assign qualifiers to the selected CIT. For
details, see "Qualifiers Page" on page 472.

l Triplets. Enables you to create a calculated relationship. For details,
see "Triplets Page" on page 474. This tab appears only for calculated
relationships.

l Icon. Enables you to assign an icon to the selected CIT. For details,
see "Icon Page" on page 475. This tab does not appear for
relationships.

l Attached Menu. Enables you to customize the shortcut menu of a CI
by addingmenu items and commands (for example, ping, run a
program, open a URL). The customizedmenu is displayed when you
right-click a CI instance in IT UniverseManager. For details, see
"AttachedMenu Page" on page 476.

l Default Label. Enables you to define attributes that appear in the CIT
label. You can includemore than one attribute by using the function
buttons. For details, see "Default Label Page" on page 479.

l Matching Rules. Enables you to definematching rules for use in HP
Universal CMDB ConfigurationManager. For details, consult the
ConfigurationManager documentation. This tab does not appear for
relationships and only appears when UCMDB is running with
ConfigurationManager.

<Main Menu> For details, see "MainMenu" on page 163.

<Toolbar> For details, see "Toolbar Options" on page 167.
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UI Element (A-Z) Description

CI Types Pane A hierarchical tree structure of the CI Typemodel containing the
inheritance relationships among CITs, and displaying the number of
instances of each CIT in the CMDB. All CITs included in the CI Type
model are classified as either a CIT or a relationship. You can drill down
and view the relationships and neighbors of the selected CIT in the
topology map. You can search in the list of CITs or relationships using the
Incremental Search by entering the first letter of the CIT or relationship
repeatedly until you reach the required selection. You can also search for a
CIT or relationship by entering its full name.

Shortcut Menu
CI TypeManager includes the following options available by right-clicking a CI type in the CI Types
pane or the Dependencies map:

UI Element
(A-Z) Description

Add/Remove
Relationship

Opens the Add/Remove Relationship dialog box, which enables you to add or
remove relationships from CITs. For details, see "Add/Remove Relationship
Dialog Box" on page 461.

Delete
Selected
Item

Deletes the selected CI type. This option is only available for CI types that have
no children and no instances.

Note:When you delete a CI type or relationship, all resources dependent on
that CI type or relationship are also deleted. When you select Delete
Selected Item, the Confirm Delete dialog box displays links for each type
of dependent resource. Click the links to display the dependent resources.
The dependent resources can include queries, views, reports, Enrichments,
or Impact rules.

Export To
XML

Enables you to export a CIT as an XML file. Use this option tomove CITs from
one server to another.

New Opens the Create Configuration Item TypeWizard which enables you to define a
new CI type. For details, see "Create Configuration Item
Type/Relationship/Calculated RelationshipWizard" below.

Show CIT
Instances

Opens the Show All Instances dialog box, which displays all instances of the
selected CIT. For details, see "CI Instances Dialog Box" on page 64.

Create Configuration Item Type/Relationship/Calculated
Relationship Wizard

This wizard enables you to define a new configuration item type or relationship.
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To
access

Click a CI type or relationship in the topology map or CI Types pane of the CI Type

Manager and select New or click theNew button in the CI types pane.

Relevant
tasks

l "How to Create a CI Type" on page 452

l "How to Create a Relationship Type" on page 453

l "How to Create a Calculated Relationship Type" on page 454

Wizard
map

The "Create Configuration Item Type/Relationship/Calculated RelationshipWizard"
contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "Icon
Page" > "AttachedMenu Page" > "Default Label Page" > "Matching Rules Page"

See also l "CI Types Overview" on page 448

l "CI Type Attributes" on page 449

l "CI Type Relationships" on page 450

The Create Configuration Item Type wizard includes the following pages:

l "Details Page" below

l "Attributes Page" on page 469

l "Qualifiers Page" on page 472

l "Triplets Page" on page 474

l "Icon Page" on page 475

l "AttachedMenu Page" on page 476

l "Default Label Page" on page 479

l "Matching Rules Page" on page 481

Details Page

This wizard page enables you to enter basic information about the new CI type you are defining.

Important
information

For general information about the Create Configuration Item TypeWizard, see
"Create Configuration Item Type/Relationship/Calculated RelationshipWizard"
on the previous page.

Wizard
map

The "Create Configuration Item Type/Relationship/Calculated Relationship
Wizard" contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "Icon
Page" > "AttachedMenu Page" > "Default Label Page" > "Matching Rules Page"
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User interface elements are described below:

UI Element
(A-Z) Description

Base CI
Type

Select a base CIT for the CIT you are creating. The new CIT inherits the base
CIT's attributes.

Note: This field only appears in the Create CI TypeWizard. It is not
relevant when editing an existing CIT in the Details tab of CI TypeManager.

Created By The user who created the new CIT.

Note: This field is optional.

Description A description for the new CIT. The description can be up to 2,048 characters
long.

Note: This field is optional.

Display
Name

The name of the CIT as it appears in the HP Universal CMDB interface.

Note: This field is optional.

Identification Every new CI defined has an identification based on its CMDB ID and global_id
properties. You can set an additional identificationmethod for instances of the
selected CIT. The following options are available:

l By key attributes. Select attributes from the Available Attributes pane and
move them to the Selected Attributes pane. These attributes are defined as
the CIT's key attributes. CIT instances with matching values for all of the key
attributes aremerged into a single instance.

l By identification rule. Click theEdit button to define an XML identification
rule. For an example of an XML identification rule, see How to Create an
Identification Rule Document in theHP Universal CMDB Data Flow
Management Guide.

l Inherited from parent. The CIT uses the same identificationmethod as its
parent CIT.

l No identification. No additional identificationmethod.

Note: For relationships, only theBy key attributes option is available.
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UI Element
(A-Z) Description

Name The unique name of the new CIT. Only the following characters are permitted: a-
z, A-Z, 0-9 and underscore (_). Note also:

l The first character must not be a number.

l The name field is case sensitive, but you cannot use the same namewith
different cases for different CITs.

l Themaximum length is 200 characters.

Scope Select the scope of the new CIT (the class model to which it belongs).

Attributes Page

This wizard page enables you to edit the attributes of the CI type.

Important
information

For each attribute, there are columns which display its name, display name, type,
description and default value. There are also columns for each attribute qualifier. A
check mark indicates that the qualifier is selected.

Click theEdit button to edit attribute details and qualifiers. For CI types with
instances, some qualifiers cannot bemodified, as displayed in theQualifier can
be modified when there are CIT instances column. If a qualifier is modified for
a selected attribute for a CI type with instances, the attribute of each CI instance
is changed accordingly (for example, if theVisible attribute is selected, the
CI instances become visible in IT UniverseManager).

Wizard
map

The "Create Configuration Item Type/Relationship/Calculated Relationship
Wizard" contains:

"Details Page" > "Attributes Page" >"Qualifiers Page" > "Triplets Page" > "Icon
Page"> "AttachedMenu Page" > "Default Label Page" > "Matching Rules Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

Qualifier can be
modified when there
are CIT instances

Add. Enables you to define a new attribute. For details,
see "Add/Edit Attribute Dialog Box" on page 458.

N/A
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UI Element
(A-Z) Description

Qualifier can be
modified when there
are CIT instances

Edit. Opens the Edit Attribute dialog box. For details,
see "Add/Edit Attribute Dialog Box" on page 458.

Note: If youmodify an attribute belonging to a
CIT's parent, the text turns light blue. If youmodify
an attribute belonging to the CIT itself, the text
remains dark blue.

N/A

Delete. Deletes the selected attribute. This option is
only active for newly defined attributes.

N/A

Reset. Resets the attribute settings after editing a pre-
existing attribute.

N/A

Select Columns. Enables you to select the columns to
appear using the Select Columns dialog box. For
details, see "Select Columns Dialog Box" on page 530.

N/A

<Attributes> Displays all attributes associated with the new CIT.
Attributes appearing in black are ones that the new CIT
inherits from the base CIT. Attributes appearing in dark
blue are ones that are private to this CIT and its
descendants. Attributes appearing in light blue are
inherited ones that have beenmodified for the new CIT.

N/A

Asset Data Indicates whether the attribute value is displayed in the
Asset Report. For details see "Asset Report" on page
346.

Note:When this qualifier is selected for a given
attribute, the attribute appears as a visible column
in the CI Instances dialog box. For details, see "CI
Instances Dialog Box" on page 64.

Yes

CMS
Browser
Editable

Indicates whether this attribute is editable in the
UCMDB Browser.

Yes

CMS
Browser
Searchable

Indicates whether this attribute is searchable in the
UCMDB Browser.

Yes

CMS
Browser
Visible

Indicates whether this attribute is visible in the UCMDB
Browser.

Yes
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UI Element
(A-Z) Description

Qualifier can be
modified when there
are CIT instances

Comparable Indicates whether this attribute is to be used for
comparing compound CIs. For details, see "Compare
CIs Report" on page 361. The changes in the value of
such an attribute are saved in the History.

Note:When this qualifier is selected for a given
attribute, the attribute appears as a visible column
in the CI Instances dialog box. For details, see "CI
Instances Dialog Box" on page 64.

Yes

Default
Value

The default value for the attribute. This value appears
when the new CIT is defined and there is no runtime
value for the attribute.

N/A

Description A description of the attribute. N/A

Discovery
Auto Trim

Indicates whether the results sent from the Probe are
trimmed.

Yes

Discovery
Auto
Truncate

Indicates whether the auto-truncate feature for
attributes of type STRING is enabled.

Yes

Display
Name

The attribute name that appears in the HP Universal
CMDB interface.

N/A

Editable Indicates whether the attribute can be edited.

Only attributes that aremarked as Editable (or ones
that have values) are displayed in the Properties tab in
IT UniverseManager.

Yes

Index Indicates whether the attribute has been defined as an
index attribute, which enables you to accelerate the
attribute retrieval performance.

This option is recommended for attributes that are used
frequently in search conditions. For example, IP
address is usually an index attribute of a node.

Yes

Key Indicates whether the attribute is defined as a key
attribute.

Note: This column is only relevant whenBy key
attributes is selected as the identificationmethod.

Yes
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UI Element
(A-Z) Description

Qualifier can be
modified when there
are CIT instances

Lower Case Indicates whether to keep the attribute value in lower
case.

Yes

Managed This designation is only relevant for users of HP
Universal CMDB ConfigurationManager.

Note:When this qualifier is selected for a given
attribute, the attribute appears as a visible column
in the CI Instances dialog box. For details, see "CI
Instances Dialog Box" on page 64.

Yes

Name The actual name of the attribute (compare to Display
Name). The namemust be in English.

N/A

Not Tracked
for History

When this qualifier is selected for a given attribute, the
attribute is not monitored by History.

Yes

Required Indicates whether this attribute is defined as a required
one, whose value is required for the creation of the CIT.

Only if the attribute in
the instances is not
empty

Static Indicates whether this attribute is defined as static. No

Type The type of the attribute. N/A

UDM Scope Indicates whether the attribute is included in the UDM
class model.

No

Unique Indicates whether this attribute is defined as unique, for
which different instances of this CI typemust have
unique values.

No

Upper Case Indicates whether to keep the attribute value in upper
case.

Yes

Visible Indicates whether this attribute is displayed in the
Properties tab in IT UniverseManager.

Yes

Qualifiers Page

This wizard page enables you to assign qualifiers to a CI type definition.
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Important
information

Qualifiers enable you to define added attribute definitions to the CIT. In the
Qualifiers list, select the required qualifiers using theAdd buttons tomove your
selections to theConfiguration Item Type Qualifiers list. You canmake
multiple selections by holding theCTRL key.

Wizard
map

The "Create Configuration Item Type/Relationship/Calculated Relationship
Wizard" contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "Icon
Page"> "AttachedMenu Page" > "Default Label Page" > "Matching Rules Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-
Z) Description

Moves all qualifiers to theConfiguration Item Type Qualifiers list.

Adds the selected qualifier to theConfiguration Item Type Qualifiers list.
Select multiple qualifiers by holding theCTRL key.

Removes the selected qualifier from theConfiguration Item Type
Qualifiers list.

Removes all qualifiers from theConfiguration Item Type Qualifiers list.

To define a new, custom qualifier, enter the qualifier name in the text box and
click Insert. The qualifier appears in theConfiguration Item Type
Qualifiers list.

<Configuration
Item Type
Qualifiers>

The list of qualifiers that define attributes of the new CIT. For example, you
can use a qualifier to define a CIT as abstract, whichmeans that you cannot
create instances from it.

<Qualifiers> The list of available qualifier options.

ABSTRACT_
CLASS

You cannot create instances of this CIT.

BLE_LINK_
CLASS

Relevant for HP Business ServiceManagement only.

CONTAINER This qualifier is assigned to relationships that signify a containment
relationship, such as Membership, Composition, Containment.

HANDLER Relevant for HP Business ServiceManagement only.

HIDDEN_
CLASS

Instances of this CIT do not appear anywhere in the application.

MAJOR_APP CI types that are assigned this qualifier appear in the Application Breakdown
custom report. For details, see "Application BreakdownReport" on page 342.
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UI Element (A-
Z) Description

MODELING_
ENABLED

Enables a CIT to act as amodel in theModeling Studio. For details, see
"Business CI Models" on page 247.

Note: This qualifier can only be selected for CI types that are
descendants of the CI typeConfiguration Item.

NETWORK_
DEVICES

A qualifier common to all the CI types that represent a network device. It can
be used for TQL queries related to network devices and serves as a
replacement for CI types in a query.

PM_SUSPECT Relevant for HP Business ServiceManagement only.

READ_ONLY_
CLASS

This CIT cannot be edited.

RECURSIVE_
DELETE

Relevant for relationships. When the CI at one end of a relationship is
deleted, the system checks the CI at the other end of the relationship. If it is
not related to any other CIs, it is also deleted.

Note: This qualifier appears only in the qualifier list in Modeling Studio.

STRONG_
CONTAINMENT

Relevant for relationships. Indicates that the root_container attribute of end2
is assigned the ID of end1.

Triplets Page

This wizard page enables you to create a calculated relationship. Each row on the Triplets page
represents one of the allowed steps in the path leading from the source CI to the target CI in the
topology map.

Note: This step of the wizard is only relevant for calculated relationships.

Important
information

l This page is displayed if you select Calculated Relationships in the drop-
down box in the CI Types pane.

l For details about calculated relationships, see "Using Calculated
Relationships" on page 98.

l For general information about the Create Configuration Item TypeWizard, see
"Create Configuration Item Type/Relationship/Calculated Relationship
Wizard" on page 466.
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Wizard
map

The "Create Configuration Item Type/Relationship/Calculated Relationship
Wizard" contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "Icon
Page"> "AttachedMenu Page" > "Default Label Page" > "Matching Rules Page"

See also "Using Calculated Relationships" on page 98

User interface elements are described below:

UI Element
(A-Z) Description

Add. Enables you to define the allowed steps in a path in the topology graph
leading from the source CI to the target CI in the calculated relationship. Opens
the Add Triplet dialog box. For details, see "Add Triplet Dialog Box" on page 61.

Edit. Enables you to edit the triplet. Opens the Edit Triplet dialog box. For
details, see "Add Triplet Dialog Box" on page 61.

Delete. Deletes a selected triplet.

Relationship The required relationship connecting the two query nodes.

Relationship
Direction

The source and target of a relationship.

l The direction is from source to target.

l The direction is from target to source.

Source The required source query node.

Target The required target query node.

Icon Page

This wizard page enables you to select an icon to assign to the new CI Type.

Note: This step of the wizard is not relevant for relationships.

Important
information

Each CIT is displayed with a default icon. However, you can attach different icons
to the sameCIT when certain conditions apply. For example, you can associate
different icons with the sameCIT when one of its attribute values changes.

Wizard
map

The "Create Configuration Item Type/Relationship/Calculated Relationship
Wizard" contains:

"Details Page" > "Attributes Page" > "Qualifiers Page"> "Triplets Page" > "Icon
Page" >"AttachedMenu Page" >"Default Label Page" > "Matching Rules Page"
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User interface elements are described below:

UI Element (A-Z) Description

Add Icon Function. Adds a row.

Note: Only active if Change the Configuration Item Type
icon according to its attribute value is selected.

Remove Icon Function. Removes the selected row.

Note: Only active if Change the Configuration Item Type
icon according to its attribute value is selected.

Attributes Select an attribute to determine the icon assigned to the CIT.

Change the
Configuration Item
Type icon according to
its attribute value

Enables you to assign an icon for each attribute value. For example,
you could define two values for the City attribute: if City=London,
one icon is displayed. If City=Beijing, another icon is displayed.

Note: If you change the icon of a CIT that appears in an existing
view, the CIT's icon is not updated in the view.

Configuration Item
Type Main Icon

Select the group to which the CIT belongs.

Icon Select an icon to associate with the value you entered in the Value
column.

Value Enter a value corresponding to the attribute you selected. You can
add a new line for each value you enter.

Attached Menu Page

This wizard page enables you to customize the shortcut menu of a CI by addingmenu items and
commands (for example, ping, run a program, open a URL). The customizedmenu is displayed
when you right-click a CI instance in IT UniverseManager.

Important
information

If a CIT does not have amethod defined specifically for it, the CIT inherits all the
menus from its parent CIT or the nearest ancestor that does have amethod
defined for it.

If you create or modify amenu, the change occurs only in the specific CIT that is
being edited.
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Wizard
map

The "Create Configuration Item Type/Relationship/Calculated Relationship
Wizard" contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "Icon
Page" > "Attached Menu Page" > "Default Label Page" > "Matching Rules
Page"

User interface elements are described below:

UI Element
(A-Z) Description

Select amenu item from the tree and click the button. A new entry appears under
the selected item.

Click to remove amenu item.

Click tomove a selectedmenu item up in themenu.

Click tomove a selectedmenu item down in themenu.

<Tree> Hierarchical tree containing the default menu items.

Caution: It is not recommended to edit the definitions of the default menu
items.

Command To connect to a specific location on theWorldWideWeb, select URL, and enter
the exact Internet address, for example, http://www.hp.com/go/software.
(Available only if you select the URL command type option.)

Note: If you use a variable in the Command field, use the format command
name %1 and define the CIT attributes as described in "Parameters" on the
next page. The parameter values replace %1 according to their order in the
list. For example, %1 is replaced by the first parameter in the list, %2 is
replaced by the second parameter in the list, and so on.

Description Enter a description for themethod. (This is for internal use only and does not
appear in themenu.)

Existing
Method

Select to choose a command from a list of definedmethods inherited from the IT
Universe CIT and all its ancestors.

Icon Select the icon to appear next to themenu option in the shortcut menu.

Note: This field is optional.
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UI Element
(A-Z) Description

Menu Item
Name

Enter a name for the new menu item as it should appear in themenu.

Method Enables you to add a command to themenu.

Note: To create amethod and not override the existingmethod, it is
recommended to create a new menu item and place the new method there.

Method
Name

Enter a name for the command.

New Method Select to add an action (for example, ping) to themenu item.

Parameters To add attributes to the command or URL, click theAdd Parameter button and
select the attribute from the list.

To delete an existing entry, select it and click theRemove Parameter button.

Note: Parameters are not relevant when Inner Process is selected.

Require
user
confirmation

Select the check box for users to confirm access to amenu item before the item
is displayed.

Separator To place a separator between twomenu items:

Click OK to place a separator underneath the selectedmenu option.

Shortcut Press any key combination to create a shortcut for themenu item, for example,
CTRL+h.

Note: This field is optional.

Sub-Menu Select to create a sub-menu under the selectedmenu option.
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UI Element
(A-Z) Description

Type Choose a command type:

l URL. Opens a web page to the specified URL. Enter the URL of aWeb page
for the command to open in the URL box.

l Inner Process. Triggers an internal HP Universal CMDB action. Select an
action from the drop-down list of actions.

l Execute. Triggers an executable action. Enter an executable command in the
Executable box.

Note: In theExecutable box, enter only the name of the executable file
(for example, notepad.exe). Do not enter a path to the executable file. A
path cannot execute a program.

Default Label Page

This wizard page enables you to define attributes that appear in the CI type label. You can include
more than one attribute by using the function buttons.

Important
information

You build a label by selecting attributes in the CI Type Attributes pane and adding
them to the Format pane, using the operators in the Format pane to connect them.

The label appears as the title under a CI of the new CI Type. The label definition
can be customized to include different attribute values. For example, if the
function label of the node CIT is composed of hostname and network, the
displayed label is: server1 10.0.65.0.

Labels can also be created using regular expressions.

Wizard
map

The "Create Configuration Item Type/Relationship/Calculated Relationship
Wizard" contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "Icon
Page" > "AttachedMenu Page" > "Default Label Page" > "Matching Rules
Page" on page 481

User interface elements are described below:

UI
Element
(A-Z) Description

Add selected attribute. Adds the selected attribute to the Format pane.
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UI
Element
(A-Z) Description

Parentheses. Adds parentheses to the formatted text (use in conjunction with the
other functions).

And. Places anAND operator between two attributes in the formatted text. For
example, network_netaddr&network_domain displays the network address and
the domain of a query node.

Or. Places anOR operator between two attributes in the formatted text.

Regular Expression. Adds a regular expression (using regular expression syntax)
to the label definition. The structure of the entry is (v1, v2, v3), where v1 represents
the selected attribute, v2 represents the regular expression itself (which divides the
value into groups), and v3 represents the number of the selected group.

For example, if the selected attribute is a name, consisting of a first name, a space,
and a surname, the regular expression would be (name, (\S*)(\s*)(\S*), 3),
which indicates that the surname can be used for the name attribute in the default
label.

For examples of how to use regular expression syntax, see "Regular Expression
Examples" on page 533.

Undo. Reverses the last change youmade.

Redo. Repeats the last action you took.

Clear. Clears the Format pane.

Restore Default. Restores the default settings.

CI Type
Attributes

Displays the available options of attributes to be included in the CIT label.

CI Type
Label
Definition
Format

Displays the attributes that you select to appear in the CIT label.

For example, to label a node by its host name and operating system, choose the
host_hostname and host_os attributes. The CIT label is host1 UNIX.

You can define conditions using AND and OR combinations.

Note: To delete an attribute from the Format pane, highlight it and press the
Delete key.
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Matching Rules Page

This wizard page enables you to definematching rules for comparable attributes for use in HP
Universal CMDB ConfigurationManager.

Important
information

This page is only relevant when ConfigurationManager is installed. For details on
matching rules, refer to the ConfigurationManager documentation.

Note: You can activate theMatching Rules pagemanually by setting the
Enable Configuration Manager Matching Rules setting to true in the
Infrastructure Settings Manager.

Wizard
map

The "Create Configuration Item Type/Relationship/Calculated Relationship
Wizard" contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "Icon
Page" > "AttachedMenu Page" > "Default Label Page" > "Matching Rules
Page"

User interface elements are described below:

UI Element
(A-Z) Description

Moves the selected comparable attributes to theMatching Rule Priorities pane
or the RequiredMatching Attributes pane. Select multiple attributes by holding
theCTRL key.

Removes the selected attribute from theMatching Rule Priorities pane or the
RequiredMatching Attributes pane.

Moves all attributes to theMatching Rule Priorities pane or the Required
Matching Attributes pane.

Removes all attributes from theMatching Rule Priorities pane or the Required
Matching Attributes pane.

Sets the order of thematching rules using the up and down buttons.

Comparable
Attributes

A list of all the attributes of the selected CI type with the comparable qualifier
selected.

Matching
Rule
Priorities

The attributes selected are used by ConfigurationManager, according to the
priority defined, to determine if thematching rule is satisfied.
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UI Element
(A-Z) Description

Required
Matching
Attributes

The values of the selected attributes of component CIs must match to satisfy
the ConfigurationManager matching rule, when comparing between composite
CIs.

Wildcards cannot be used when specifying a requiredmatching attribute. If an
exact match is not found, component CIs are not compared.

Create/Update List/Enumeration Definition Dialog Box
This dialog box enables you to define a new List or Enumeration definition. The List or Enumeration
definition you have created appears in the System TypeManager dialog box, where you can edit it if
required (for details, see "System TypeManager Dialog Box" on page 487).

To access Click theAdd button in the System TypeManager dialog box.

Important
information

You can access the Create/Update Enumeration Definition dialog box from the
StateManager as well. For details, see "StateManager" in theHP Universal
CMDB Administration Guide.

Relevant
tasks

l "How to Create List and Enumeration Definitions" on page 455

l "How to Create an Enumeration Definition –Workflow" on page 456

See also l "System TypeManager" on page 451

l "System TypeManager Dialog Box" on page 487

User interface elements are described below:

UI Element
(A-Z) Description

Display
Name

Enter the name you want to appear in the list of System Type Definitions. If you
leave this field empty, the entry in the Name field is used.

Enumeration Enables you to create a predefined list of values, as well as assign each value a
color. For details, see "Enumeration Definition Area" on the next page.

List Enables you to create a predefined list of values. For details, see "List Definition
Area" below.

Name Enter a unique name for the definition.

List Definition Area
This area enables you to create a predefined list of values.
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To access Select List in the Create List/Enumeration Definition dialog box.

Important
information

For example, a Location attributemight be defined by a location list
containing the following values:

l New York

l Boston

l Baltimore

The following elements are included (unlabeled elements are shown in angle brackets):

UI
Element
(A-Z) Description

Add. Adds a List definition. Double-click inside the row and either select a date from
the calendar that appears (if you chose the typeDate) or type the required value.

Remove. Deletes the selected List definition.

Sort. Sorts the list in alphabetical order.

Type Choose one of following field types:

l Date

l Double

l Integer

l Long

l String

Enumeration Definition Area
This area enables you to create a list from a predefined list of values (similar to List), with
capabilities such as assigning a color for every value.

To access Select Enumeration in the Create List/Enumeration Definition dialog box.
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Important
information

Enumerations are designed to be used as severity value lists by states. You can
use Enumerations for lists that require key values.

Note:

l If an existing enumeration definition is designated as a default value for a
CIT attribute, you cannot change its value.

l If you change the value of an existing enumeration definition, all
CI instances of that CIT that include attributes with the selected value, are
reset to the default value for that attribute.

See also "How to Create an Enumeration Definition –Workflow" on page 456

User interface elements are described below:

UI
Element
(A-Z) Description

Add. Adds an Enumeration definition.

Remove. Deletes the selected Enumeration definition.

Color Select a color that indicates the severity level.

Note: Gray is only enabled when you create an Enumeration of the type Admin.

Key Type a number to create an enumeration that describes a severity list for a category.

Assign key values according to the following rules:

l The list of key values must always begin with zero (0). (Zero represents the
Normal state.) Otherwise, it does not appear in the StateManager (for details, see
"StateManager" in theHP Universal CMDB Administration Guide).

l The list must always be numbered consecutively.

For an example of an Enumeration definition, see "How to Create an Enumeration
Definition –Workflow" on page 456.

Value Type a value, either a string or a number, for example, Red or my value. The value
appears in the tooltip for the CI in IT UniverseManager.

Export Selected CITs to Excel Dialog Box
This dialog box enables you export selected CI types to an Excel report.
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To access In the CI TypeManager, click theExport Class Model button and select
Export Selected CITs to Excel.

Important
information

You can select a CIT and a relationship to serve as the root CI type and root
relationship for the report. If you do not select a CIT or relationship, the default
values are used. The root CIT and root relationship are independent of each other.

The report displays the root CIT and all its descendant CITs. The report contains
the following pages:

l CIT Hierarchy. Displays the CITs under the root CIT in tree format with links
to their attributes.

l Relationship Hierarchy. Displays the relationships under the root relationship
in tree format with links to their attributes.

l CIT Attributes. Displays the name, type, description and display level for the
CIT attributes of each CIT under the root CIT.

l Relationship Attributes. Displays the name, type, description and display
level for the relationship attributes of each relationship under the root
relationship.

l Valid Relationships. Displays all the valid relationships for each CIT under
the root CIT.

l Enumerations. Displays all the enumeration definitions from the System Type
Manager. (Not dependent on the root CIT or root relationship.)

l Lists. Displays all the list definitions from the System TypeManager. (Not
dependent on the root CIT or root relationship.)

You can select the pages you want to display in the report.

See also l "CI Types Overview" on page 448

l "View Descriptions for CI Types and Relationships" on page 457

l "Universal DataModel (UDM)Overview" on page 522

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

Root
CI Type

Click the ellipsis button to select a CIT to serve as the root CI type. If you do
not select a CIT, the default root CI type used . To change the default value, edit
theObject root setting in Infrastructure Settings Manager.
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UI Element
(A-Z) Description

Root
Relationship

Click the ellipsis button to select a relationship to serve as the root
relationship. If you do not select a relationship, the default root relationship used.
To change the default value, edit the Link root setting in Infrastructure Settings
Manager.

Select pages
to display

Select the pages to display in the report (select the check boxes for all the
required pages). The following options are available:

l CIT Worksheets. Includes the CIT Hierarchy and the CIT Attributes
worksheets.

l Relationship Worksheets. Includes the Relationship Hierarchy and
Relationship Attributes worksheets.

l Valid Relationships Worksheet. Includes the Valid Relationships
worksheet.

l Type Definition Worksheets. Includes the Enumerations and Lists
worksheets.

Export Selected CITs to PDF Dialog Box
This dialog box enables you export selected CI types to a PDF report.

To access In the CI TypeManager, click theExport Class Model button and select
Export Selected CITs to PDF.

Important
information

The output of this dialog box is the UCMDB CI Types and Relationships
Information PDF, describing the Universal DataModel.

See also l "CI Types Overview" on page 448

l "View Descriptions for CI Types and Relationships" on page 457

l "Universal DataModel (UDM)Overview" on page 522

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A-Z) Description

All Data Select to display all the information on the selected CITs.

Changes
Only

Select to display only the changes in the selected CITs from the previous data
model.
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UI Element
(A-Z) Description

CITs Click the ellipsis button to select CITs to export.

Filter
attributes by
qualifiers

Select to filter the attributes in the report by qualifiers. Enter the required
qualifiers in the box. The report displays only the attributes with the selected
qualifiers.

Relationships Click the ellipsis button to select relationships to export.

Show
Properties

Select the scope of the selected CITs and relationships:

l UDM. Includes CITs and relationships from the UDM.

l CMS. Includes only CITs and relationships used in the CMS

Show
Qualifiers

Select to include qualifier information in the exported report.

Show
Relationships

Select to include relationship information in the exported report.

Show Valid
Links

Select to include valid link information in the exported report. The valid link
section displays all the valid relationships for the selected CITs.

System Type Manager Dialog Box
This dialog box enables you to display the attribute types you defined in the Create
List/Enumeration Definition dialog box.

To access From the CI TypeManager, select CI Types > System Type Manager.

Relevant tasks l "How to Create List and Enumeration Definitions" on page 455

l "How to Create an Enumeration Definition –Workflow" on page 456

See also l "CI Types Overview" on page 448

l "System TypeManager" on page 451

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element
(A-Z) Description

Add. Enables you to create a predefined list whose values define an attribute
type. You can create a definition for the following attribute types:

l List definition.

l Enumeration definition.

For a description of these attribute types, see "Create/Update
List/Enumeration Definition Dialog Box" on page 482.

Edit. Enables you to edit an existing definition. For details, see "Create/Update
List/Enumeration Definition Dialog Box" on page 482.

Delete. Deletes an existing definition. Select the system type definition you
want to delete and click theDelete button.

<System Type
Definitions>

The list of Enumeration and List definitions created in the System Type
Manager.
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Chapter 12: Enrichment Manager
This chapter includes:

Enrichment Manager – Overview 489

How to Define an Enrichment Rule – Scenario 491

How to Add Enrichment Query Nodes and Relationships to an Enrichment TQLQuery 495

How to Define a Tenant Association Rule 496

Enrichment Manager User Interface 497

Enrichment Manager – Overview
Enrichment rules can be used for several purposes:

l Adding new CIs and relationships to the CMDB.

l Deleting specific CI instances from the CMDB.

l Updating the attribute values of specific CI instances in the CMDB.

Enrichment query nodes and relationships differ from other query nodes and relationships in that
they are conceptual deductions that represent real relationships and CIs that cannot be discovered
automatically by the discovery process.

Enrichment query nodes and relationships are created as part of a TQL query, whose other TQL
query nodes are regular ones, meaning TQL query nodes that already exist in the CMDB. For more
information about TQL queries, see "Topology Query Language" on page 15.

The following example displays a regular query node of typeNode linked to aWebsphere AS
Enrichment query node by an Enrichment Composition relationship.
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By placing an Enrichment query node within a TQL query context, the query receives data from its
attributes, and uses it to insert new information into the CMDB.

When you create Enrichment rules, the following results can occur:

l The CMDB is enlarged. Add Enrichment query nodes and relationships that are currently not
included in the CMDB.

The following Enrichment rule example displays a regularWindows query node (that already
exists in the CMDB) connected to a Log FileEnrichment query node by an Enrichment
Composition relationship.
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This Enrichment rule states that for everyWindowsCI instance that is found in the CMDB, a new
Log FileCI instance is created, and linked to theWindowsCI with aComposition relationship.

l Specific CI instances are deleted from the CMDB. For an example, see "How to Define an
Enrichment Rule – Scenario" below.

l The values of CI attributes are updated. Use an Enrichment rule to update the attributes of a
CI that already exists in the CMDB.

The following Enrichment rule example illustrates that a regularWindows query node (that
already exists in the CMDB) has been updated with an Enrichment rule.

This Enrichment rule states that everyWindowsCI found in the CMDB is updated with the
attribute value defined in the Enrichment rule.

How to Define an Enrichment Rule – Scenario
This task describes how to create the following Enrichment rule:

An IP AddressCI is connected to two identical NodeCIs: oneNodeCI is identified by its IP
address and the other is identified by its lowest MAC address. For every such instance, delete the
NodeCI that is identified by its IP address from the CMDB.

Note: To reach the required result, youmust implement each one of the following steps.

This task includes the following steps:

l "Create an Enrichment TQLQuery" below

l "Define the Query Node of Type Node that Is Identified by its Lowest MAC Address" on page
493

l "Define the Query Node of Type Node that is Identified by its IP Address" on page 494

l "Define the Enrichment Rule" on page 494

1. Create an Enrichment TQL Query
To create an Enrichment TQL query, you need to define an Enrichment rule and then add the
regular TQL query nodes and relationships that define the query.

Note: You can add Enrichment query nodes and relationships only after at least one
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regular query node has been added to the query.

SelectManagers >Modeling > Enrichment Manager. For details about how to create an
Enrichment TQL query, see "New Enrichment Rule/Enrichment Rule Properties/Save As
Enrichment RuleWizard" on page 506. For details about how to add query nodes and
relationships to a query, see "How to AddQuery Nodes and Relationships to a TQLQuery" on
page 25.

You can add query nodes of a federated CI type to the Enrichment TQL query, but if the actions
defined in the Enrichment rule affect those query nodes, their source is automatically set to
UCMDB when you save the rule. You cannot update or delete a federated query node or a
relationship to or from a federated query node.

Example of an Enrichment TQL Query:

A new Enrichment TQL query called doubleHosts1 (located under theNetwork folder) is
created in Enrichment Manager.

The doubleHosts1 Enrichment rule is displayed in the Enrichment Rules pane.
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In this Enrichment TQL query, an IP Address query node is linked to two query nodes of
typeNode by aContainment relationship. The query results must comply with the
direction of the arrows.

Note: A TQL query is subject to certain validation restrictions. For details, see
"Troubleshooting and Limitations" on page 93.

2. Define the Query Node of Type Node that Is Identified by its Lowest
MAC Address
At the top of the Enrichment Manager page, select Querymode. In the editing pane, right-click
the required query node of typeNode, select Query Node Properties to open theQuery Node
Properties dialog box. Then define an attribute condition in the Attribute tab. For details on how
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to define an attribute condition, see "Query Node/Relationship Properties Dialog Box" on page
72.

Example of an Attribute Condition Definition that Identifies the Node by its Lowest
MAC Address:

In the Attribute tab, this attribute condition definition identifies the required Node by its
lowest MAC address.

n Attribute name—Node is Complete

n Operator—Equal

n Value—True

3. Define the Query Node of Type Node that is Identified by its IP Address
At the top of the Enrichment Manager page, select Querymode. In the editing pane, right-click
the required query node of typeNode, and select Query Node Properties to open theQuery
Node Properties dialog box. Then define two attribute conditions in the Attribute tab. For details
on how to define an attribute condition, see "Query Node/Relationship Properties Dialog Box"
on page 72.

Example of an Attribute Condition that Enables a Node to Be Identified by its IP
Address:

This attribute condition is the first attribute condition you need to define in the Attribute tab
to enable the query node of type node to be identified by its IP Address.

Attribute name—Node is Complete

Operator—Equal

Value—False

This is the second attribute condition you need to define in the Attribute tab to enable the
query node of type node to be identified by its IP address.

Attribute name—Node is Complete

Operator— Is null

Value—Value cannot be changed

4. Define the Enrichment Rule
Define the Enrichment rule that deletes all instances of the query node of typeNode that are
identified by their IP addresses. From the toolbar, select Enrichmentmode. In the Enrichment
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Rules pane, select the doubleHosts1 Enrichment rule. Then right-click the query node of type
Node that is identified by its IP address and select Delete Relationship/Query Node Item.

Example of a Query Node of Type Node Containing a Removed Indicator:

The query node of typeNode now has a removed indicator to denote that all node
instances that have identical attribute and cardinality settings are removed from the
CMDB. The Enrichment query now looks like this.

How to Add Enrichment Query Nodes and
Relationships to an Enrichment TQL Query

This section describes how to add Enrichment query nodes and relationships to an Enrichment TQL
query in Enrichment Manager.

To add Enrichment query nodes and relationships to a TQL query:

1. From the tree in the Enrichment Rules pane, select the Enrichment rule to which you want to
add Enrichment query nodes and relationships or create a new one. For details, see "New
Enrichment Rule/Enrichment Rule Properties/Save As Enrichment RuleWizard" on page 506.

2. From theQuery/Enrichment drop-down at the top of the page, select Enrichment Mode.

3. From the tree displayed in the CI Type Selector, click and drag the query nodes you want to
function as an Enrichment query node on to the editing pane. These are the TQL query nodes

that are included in the query. Added Enrichment query nodes are displayed by an added
indicator.
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Note: You can addmore than one Enrichment query node to a rule.

4. Link the Enrichment query node to an existing TQL query node or query nodes, to provide the
Enrichment query node with the needed context for its operation.

The following are the Enrichment rule validations:

n Youmust link the new Enrichment query node to at least one of the existing TQL query
nodes in the rule.

n Enrichment query nodes can only be linked to one another with an Enrichment relationship.

n If the new Enrichment query nodemust be contained (according to its CIT definition) in
another query node, youmust use theComposition relationship to connect this
Enrichment query node to an existing TQL query node.

n You cannot link an Enrichment query node to a TQL query node that is hidden.

5. To add a relationship between two query nodes, do one of the following:

n Select the required query nodes by holding theCTRL key and clicking the TQL query nodes,
right-click and select Add Relationship.

n Click theCreate Relationship button and draw a line between the required query
nodes.

Added Enrichment relationships are displayed by an added indicator.

The Add Relationship dialog box opens. For details, see "Add/Edit Relationship Dialog Box"
on page 52.

6. Click OK. The selected query nodes are linked by the relationship you have selected.

How to Define a Tenant Association Rule
The following task describes how to define a Tenant Association rule.

Note: This task is only relevant whenmulti-tenancy is enabled.

1. Run the New Tenant Association Rule Wizard

In Enrichment Manager, click the small arrow next to theNew Enrichment Rule button
and select New Tenant Association Rule. Enter the general attributes and base query
information on the wizard pages. For details, see "New Tenant Association Rule/Tenant
Association Rule Properties/Save As Tenant Association RuleWizard" on page 510.
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Note: Make sure to select theRule is Active check box on the Rule General Attributes
page of the wizard to activate the rule.

2. Build the Rule Query
If you are basing your Tenant Association rule on a new query, build the query by dragging the
required CITs onto the canvas and inserting the required relationships.

3. Update the Owner Tenant of a Selected Query Node
Right-click the query node to be updated by the Tenant Association rule and select Update
Owner Tenant. The Update Owner Tenant dialog box opens. Select themethod by which to
update the owner tenant (By value orBy attribute) and select the required parameters for that
option. Click OK. For details, see "Update Owner Tenant Dialog Box" on page 519.

Note: You can update the owner tenant of more than one query node in the rule.

4. Update the Consumer Tenants of a Selected Query Node
Right-click the query node to be updated by the Tenant Association rule and select Update
Consumer Tenants. The Update Consumer Tenants dialog box opens. Select themethod by
which to update the consumer tenants (By value orBy attribute) and select the required
parameters for that option. Click OK. For details, see "Update Consumer Tenants Dialog Box"
on page 518.

Note:

n You can update the consumer tenants of more than one query node in the rule.

n You can update both the owner tenant and the consumer tenants of the same query
node in a single Tenant Association rule.

5. Save the Rule

Click Save to save the Tenant Association rule. The rule runs according to the frequency
defined by its priority.

Enrichment Manager User Interface
This section includes (in alphabetical order):

Enrichment Manager Page 498

New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment RuleWizard 506

New Tenant Association Rule/Tenant Association Rule Properties/Save As Tenant
Association RuleWizard 510
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Query Node/Relationship Definition Dialog Box 514

Query Node Definition - Advanced Attribute Dialog Box 516

Update Consumer Tenants Dialog Box 518

Update Owner Tenant Dialog Box 519

Enrichment Manager Page
This page enables you to define Enrichment rules. These rules, which are based on a specific TQL
query, can be used for several purposes, including:

l Adding new CIs and relationships to the CMDB.

l Deleting specific CI instances from the CMDB.

l Updating the attribute values of specific CI instances in the CMDB.

To access Select Enrichment Manager from the NavigationMenu or selectManagers >
Modeling > Enrichment Manager.

Important
information

Enrichment Manager has twomodes in which you can work. Always check the
Enrichment/Query mode list in the toolbar to verify the currently selectedmode.

Relevant
tasks

"How to Define an Enrichment Rule – Scenario" on page 491

"How to Define a Tenant Association Rule" on page 496

See also l "Enrichment Manager – Overview" on page 489

l "Enrichment Manager User Interface" on the previous page

Enrichment Rules Pane
This area displays a hierarchical tree structure of predefined folders and Enrichment rules. Each
Enrichment rule is associated with a TQL query.

Important
information

You can create your own Enrichment rule, or work with the out-of-the-box (factory)
Enrichment rules provided with your HP Universal CMDB installation.

The default folders are provided for the out-of-the-box queries. You canmodify
these folders, or add additional folders according to your organization's
requirements.

You can drag and drop Enrichment rules or folders tomove them from one folder to
another.

User interface elements are described below:
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UI Element
(A-Z) Description

New Folder. Creates a new folder.

New. Creates an Enrichment rule. Opens the New Enrichment Rule wizard.

Note: In amulti-tenancy environment, click the small arrow to the right of
the button to display the options. New Enrichment Rule opens the New
Enrichment Rule wizard. New Tenant Association Rule opens the New
Tenant Association Rule wizard.

Delete. Deletes the selected folder or Enrichment rule.

Refresh. Refreshes the data content of the hierarchical tree structure that may
have beenmodified by other users.

Save. Saves the Enrichment rule to the CMDB. (Enabled only when an
Enrichment rule is created or when changes aremade to an existing one.)

Properties. Opens the New Enrichment Rule/Properties wizard. Enables you to
change the description and the activation state of the Enrichment rule.

Preview. Generates a preview of the results of the selected Enrichment rule.

Note: This button is not available whenmulti-tenancy is enabled.

Represents a folder.

Represents an Enrichment rule.

Represents a Tenant Association rule.

Note: This icon is only relevant whenmulti-tenancy is enabled.

<Enrichment
Rule tree>

Displays the existing Enrichment rules in tree format.

Note: Only Enrichment rules appear in the tree. TQL queries of type
Enrichment (created in theModeling Studio) do not appear in the tree.

The following elements are available by right-clicking a folder or Enrichment rule:

UI Element
(A-Z) Description

Delete Deletes the selected folder or Enrichment rule.
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UI Element
(A-Z) Description

Export To
XML

Displays a standard Save As dialog box, enabling you to save the Enrichment
rule as an XML script. This option can be used tomove an Enrichment rule from
one workstation to another, provided the related TQL query is also relocated.

Import
From XML

Imports XML files that contain saved Enrichment queries to the Enrichment
Manager.

New
Enrichment
Rule

Creates an Enrichment rule. Opens the New Enrichment Rule wizard.

New Folder Creates a new folder.

New Tenant
Association
Rule

Creates a Tenant Association rule. Opens the New Tenant Association Rule
wizard.

Preview Generates a preview of the results of the selected Enrichment rule.

Properties Opens the New Enrichment Rule/Properties wizard. Enables you to change the
description and the activation state of the rule.

Rename
Folder

Renames the folder.

Save (Enabled only when a new Enrichment query is created or when changes are
made to an existing one.) Saves the Enrichment rule to the CMDB.

Save As Displays the Save As Enrichment Rule wizard, enabling you to define a new
name and description for a query. This option can be used for creating a new
Enrichment rule based on an existing one.

Editing Pane
This area enables you to create and define Enrichment query nodes and relationships.
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Important
information

l When you select a folder in the Enrichment Rules pane, the editing pane is
empty.

l When you select an Enrichment rule in the Enrichment Rules pane, the editing
pane displays the selected rule, which consists of TQL query nodes that are
defined in the TQL query and the relationships between them, and the
Enrichment query nodes and relationships that are created and added to the
rule.

l The Enrichment Manager has twomodes in which you can work: Enrichment
mode andQuerymode.

Themode in which you are working determines the options that appear in the
shortcut menu. For details, see the editing pane description below.

l You can calculate the number of instances that were created as a result of an
Enrichment rule and remove the instances created from an Enrichment rule
from the CMDB. For details, see "Additions Count" on page 167 and "Remove
Enrichment Results" on page 173.

Relevant
tasks

"How to Define an Enrichment Rule – Scenario" on page 491

See also For details on how to create a TQL query, see "How to AddQuery Nodes and
Relationships to a TQLQuery" on page 25.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A-Z) Description

Indicates an added Enrichment query node or relationship.

Indicates a query node or relationship that has been deleted from the
CMDB.

Indicates an updated query node or relationship.

Query and
Enrichment mode

The Enrichment Manager has twomodes in which you can work:
Enrichmentmode andQuerymode.

Working in:

l Query mode enables you to define regular (non-Enrichment)
relationships and query nodes and add them to the TQL query you
defined.

l Enrichment mode enables you to define Enrichment relationships
and query nodes and add them to the TQL query you defined.

<Main Menu> For details, see "MainMenu" on page 163.
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UI Element (A-Z) Description

<Query Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between two query nodes.

<Shortcut menu>
options

For details, see "Shortcut MenuOptions" on page 33.

<Toolbar> For details, see "Toolbar Options" on page 167.

<Tooltips> Hold the cursor over a query node or relationship to view its tooltip.

The tooltips contain the following information:

l Element name. The name of the query node.

l CI Type. The CIT of the query node as defined in the CI Type
Manager. For details, see "CI TypeManager" on page 448.

l Definitions of the selected query nodes and relationships. The
attribute conditions, as described in "Query Node/Relationship
Properties Dialog Box" on page 72.

CI Type Selector
This area displays a hierarchical tree structure of the CI Types found in the CMDB.

Important
information

The CI Type Selector is part of Enrichment Manager, Impact Analysis Manager,
and Trigger TQL Editor.

To create or modify a TQL query, click and drag query nodes to the Editing pane
and define the relationship between them. Your changes are saved to the CMDB.
For details, see "How to AddQuery Nodes and Relationships to a TQLQuery" on
page 25.

Note: The number of instances of each CIT in the CMDB is displayed to the
right of each CIT.

Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "How to Create a Pattern View" on page 255

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Elements (A-Z) Description

Add CI Type to Map.Moves the selected CI type to the Editing pane.

Refresh. Refreshes the CI type tree.

Search. Searches for the CI type entered.

Expand All. Expands all subtrees within the CI type tree.

Collapse All. Collapses the subtrees within the CI type tree.

<Search window> Enter the name or part of a name of a CI type for which to search.

Shortcut Menu Options

The CI Type Selector includes the following elements (listed alphabetically) available by right-
clicking a CI Type:

Menu Item Description

Add CI Type
to Map

Select to add the selected CI type to the Editing pane.

Go to CI
Type
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT
Instances

Opens the CIT Instances window, which displays all instances of the selected
CIT. For details, see "CI Instances Dialog Box" on page 64.

Advanced Pane
This area displays the properties, conditions, and cardinality for the selected query node and
relationship.

Important
information

The Advanced pane appears in the lower part of the window in the following
managers and user interfaces: Modeling Studio, Impact Analysis Manager,
Enrichment Manager, the Input Query Editor and Trigger Query Editor in DFM.

A small green indicator appears next to the tabs that contain data.
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Relevant
tasks

l "How to Define an Impact Rule –Workflow" on page 430

l "How to Define an Enrichment Rule – Scenario" on page 491

l "How to Define a TQLQuery" on page 23

l "How to Create a Pattern View" on page 255

l "How to Create a Template" on page 256

l "How to Create a Perspective" on page 257

User interface elements are described below:

UI
Elements
(A-Z)

Description

If the window is not wide enough to display all the tabs, use the left and right
arrows tomove to the required tab.

Click Show List to display a list of the available tabs for the current module. You
can select a tab from the list.

Attributes Displays the attribute conditions defined for the query node or the relationship. For
details, see "Attribute Tab" on page 74.

Cardinality Cardinality defines how many query nodes you expect to have at the other end of
a relationship. For example, in a relationship between a node and an IP Address, if
the cardinality is 1:3, the TQL query retrieves only those nodes that are connected
to between one and three IP Addresses. For details, see "Cardinality Tab" on
page 76.

Data
Sources

Displays the data sources set for the selected query node.

Note: This tab appears only in theModeling Studio.
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UI
Elements
(A-Z)

Description

Details Displays the following information:

l CI Type/Element Type. The CIT of the selected query node/relationship.

l Element Name. The name of the query node or relationship. This appears only
in theModeling Studio.

l Show in query results. A green check indicates that the selected query
node/relationship is visible in the topology map. A redmark indicates that it is
not visible. In theModeling Studio, this is indicated by the word Yes or No.

l Include subtypes. A green check indicates that both the selected CI and its
children are displayed in the topology map. A redmark indicates that only the
selected CI appears. This item does not appear in theModeling Studio.

Edit Click Edit to open the relevant dialog box for the selected tab.

Element
Layout

Displays the attributes selection for the selected query node or relationship. It lists
the attributes selected to be included in the query results (whenSpecific
Attributes is selected as the attributes condition). It also lists the excluded
attributes and any selected qualifiers for attributes. For details, see "Element
Layout Tab" on page 82.

Note: This tab appears only in theModeling Studio.

Element
Type

Displays the subtype conditions defined for the query node or relationship. For
details, see "Element Type Tab" on page 80.

Note: This tab appears only in theModeling Studio.

Enrichment
Rules

Displays the Enrichment rule defined for the selected query node or relationship. If
the Enrichment rule is used to update the attributes of a CI, click Edit to open the
Query Node/Relationship Definition dialog box and edit the rule if required. For
details, see "Query Node/Relationship Definition Dialog Box" on page 514.

Note: This tab appears only in Enrichment Manager.
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UI
Elements
(A-Z)

Description

Impacted
Query
Nodes

Indicates which query node is impacted by the changes that occur in the selected
trigger query node. If required, you can click Edit to open andmodify the Impacted
Query Nodes dialog box. For details, see "Impacted Query Nodes Dialog Box" on
page 441.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node or the relationship. For
details, see "Qualifier Tab" on page 84.

Note: This tab appears only in Enrichment Manager and Impact Analysis
Manager.

Selected
Identities

Displays the element instances that are used to define what should be included in
the TQL query results. For details, see "Identity Tab" on page 85.

New Enrichment Rule/Enrichment Rule Properties/Save
As Enrichment Rule Wizard

This wizard enables you to create or modify an Enrichment rule.

To access l To create a new Enrichment rule, right-click anywhere in the Enrichment Rules
pane and click New Enrichment Rule or click theNew Enrichment Rule

button.

l Tomodify an existing Enrichment rule, right-click an Enrichment rule in the
Enrichment Rules pane and select Properties.

l To create a new Enrichment rule based on an existing query, right-click an
Enrichment rule in the Enrichment Rules pane and select Save As.
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Important
information

l When creating a new Enrichment rule, bear in mind that the application does
not allow you tomake any changes in the TQL query that are necessary for the
rule. These changes include the following:

n Deleting, from the Enrichment TQL query, the query nodes or relationships
connected to the Enrichment query node, causing a query node to become
unattached to any relationship.

n You cannot change the cardinality definition to 0 (not required) of a query
node or relationship that is used in an Enrichment rule. For details on
relationship cardinality, see "Query Node/Relationship Properties Dialog
Box" on page 72.

l An Enrichment TQL query that serves as the basis for Enrichment rules, is
subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations" on page 93. If the TQL query is not valid, you cannot save it.

Relevant
tasks

"How to Define an Enrichment Rule – Scenario" on page 491

Wizard
map

The "New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment
RuleWizard" contains:

"Rule General Attributes Page" > "Rule BaseQuery Page"

See also l "Enrichment Manager – Overview" on page 489

l "Enrichment Manager User Interface" on page 497

l "Topology Query Language" on page 15

Rule General Attributes Page

This wizard page enables you to enter a unique name and description for the Enrichment rule.

Important
information

l An Enrichment TQL query that serves as the basis for Enrichment rules is
subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations" on page 93. If the TQL query is not valid, you cannot save it.

l For important information on the effects of making changes to the TQL query
after creating it, see "New Enrichment Rule/Enrichment Rule Properties/Save
As Enrichment RuleWizard" on the previous page.

l By default, this wizard is set to display aWelcome page. You can choose not
to display this page by changing the user preferences. For details, see "User
Preferences Dialog Box" on page 92.
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Wizard
map

The "New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment
RuleWizard" contains:

"Rule General Attributes Page" > "Rule BaseQuery Page"

See also "Topology Query Language" on page 15

User interface elements are described below:

UI Element
(A-Z) Description

Rule
Description

(Optional) Enter a description of the rule.

Rule is
Active

(Optional) Select this option to activate the rule in the system as soon as it is
saved.

Default:Not selected.

Note:

l If an active Enrichment rule is deactivated (by clearing theRule is Active
check box), all changes that occur in the CMDB relating to the rule are
deleted from the system. When you deactivate an Enrichment rule, a red
X appears next to the Enrichment rule in the Enrichment Rules pane.

l To reactivate the rule, right-click the rule in the Enrichment Rules pane
and select Properties. In the General Attributes page, select Rule is
Active.

Rule Name Enter a unique name for the Enrichment rule. The rule name cannot contain any of
the following characters: \ / : " < > |% ?. The final character cannot be a blank
space.

Note: If the rule name is either empty, contains a name used by another
Enrichment rule, or uses invalid characters, theNext and Finish buttons are
disabled.
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UI Element
(A-Z) Description

Update
Last
Access
Time

When this option is selected, the Enrichment rule updates the Last Access Time
property of the CIs it affects. When the check box is cleared, the Enrichment rule
does not update the attribute and therefore does not perform touch on those CIs.
This ensures that the Enrichment rule does not affect the aging of the relevant
CIs.

Note:

l For out-of-the-box Enrichment rules, this option is selected by default.

l For new CIs created by the Enrichment rule, the Last Access Time
property is updated even when the check box is cleared.

Rule Base Query Page

This wizard page enables you to define the properties of the TQL query on which the Enrichment
rule is based.

Important
information

l An Enrichment TQL query that serves as the basis for Enrichment rules, is
subject to certain validation restrictions. For details, "Troubleshooting and
Limitations" on page 93. If the TQL query is not valid, you cannot save it.

l For important information on the effects of making changes to the TQL query
after creating it, see "New Enrichment Rule/Enrichment Rule Properties/Save
As Enrichment RuleWizard" on page 506.

l By default, this wizard is set to display a Completion page after clickingNext
in this page. You can choose not to display the Completion page by changing
the user preferences. For details, see "User Preferences Dialog Box" on page
92.

Wizard
map

The "New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment
RuleWizard" contains:

"Rule General Attributes Page" > "Rule Base Query Page"

See also "Topology Query Language" on page 15

User interface elements are described below:

UI Element (A-Z) Description

Base the
Enrichment rule
on a new query

Select this check box if you want to base the Enrichment rule on a new TQL
query. The TQL results are based on the attributes defined for the new TQL
query.
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UI Element (A-Z) Description

Base the
Enrichment rule
on an existing
query

Select this check box if you want to base the Enrichment rule on an existing
TQL query. Select the required Enrichment TQL query from the drop-down
list.

Base Query
Description

(Optional) Enter a description of the TQL query.

Base Query
Name

Enter a unique name for the Enrichment TQL query.

If you selected theBase the Enrichment rule on an existing TQL option,
select the Enrichment TQL query on which you want to base the rule.

Base Query
Priority

Select a priority level for the new TQL query (Low, Medium, High, or
Express). This setting determines how often the query is rerun
automatically by the system to include updated information from the CMDB.

Save a new
query based on
the current
definition

Select to save a new TQL query based on your Enrichment rule definition.

Note: This field only appears in the Save As Enrichment Rule wizard.

New Tenant Association Rule/Tenant Association Rule
Properties/Save As Tenant Association Rule Wizard

This wizard enables you to create or modify a Tenant Association rule.

To access l To create a new Tenant Association rule, right-click anywhere in the
Enrichment Rules pane and click New Tenant Association Rule or click the

down arrow next to theNew button and select New Tenant Association
Rule.

l Tomodify an existing Tenant Association rule, right-click a Tenant Association
rule in the Enrichment Rules pane and select Properties.

l To create a new Tenant Association rule based on an existing query, right-click
a Tenant Association rule in the Enrichment Rules pane and select Save As.
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Important
information

denotes an active Tenant Association rule.

denotes an inactive Tenant Association rule.

Note:

l This wizard is only available whenmulti-tenancy is enabled.

l A TQL query that serves as the basis for Tenant Association rules is
subject to certain validation restrictions. For details, see "Troubleshooting
and Limitations" on page 93. If the TQL query is not valid, you cannot save
it.

Relevant
tasks

l "How to Define a Tenant Association Rule" on page 496

l "Multi-Tenancy Workflow" on page 1

Wizard
map

The "New Tenant Association Rule/Tenant Association Rule Properties/Save As
Tenant Association RuleWizard" contains:

"Rule General Attributes Page" > "Rule BaseQuery Page"

See also l "Topology Query Language" on page 15

l "Multi-Tenancy Overview" on page 1

l "Tenant Association Rules" on page 1

Rule General Attributes Page

This wizard page enables you to enter a unique name and description for the Tenant Association
rule.

Important
information

l An Enrichment TQL query that serves as the basis for Enrichment rules is
subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations" on page 93. If the TQL query is not valid, you cannot save it.

l For important information on the effects of making changes to the TQL query
after creating it, see "New Enrichment Rule/Enrichment Rule Properties/Save
As Enrichment RuleWizard" on page 506.

l By default, this wizard is set to display aWelcome page. You can choose not
to display this page by changing the user preferences. For details, see "User
Preferences Dialog Box" on page 92.
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Wizard
map

The "New Tenant Association Rule/Tenant Association Rule Properties/Save As
Tenant Association RuleWizard" contains:

"Rule General Attributes Page" > "Rule BaseQuery Page"

See also "Topology Query Language" on page 15

User interface elements are described below:

UI Element
(A-Z) Description

Rule
Description

(Optional) Enter a description of the rule.

Rule is
Active

(Optional) Select this option to activate the rule in the system as soon as it is
saved.

Default:Not selected.

Note:

l If an active Tenant Association rule is deactivated (by clearing theRule is
Active check box), all changes that occur in the CMDB relating to the rule
are deleted from the system. When you deactivate a Tenant Association
rule, a red X appears next to the rule in the Enrichment Rules pane.

l To reactivate the rule, right-click the rule in the Enrichment Rules pane
and select Properties. In the General Attributes page, select Rule is
Active.

Rule Name Enter a unique name for the Tenant Association rule. The rule name cannot
contain any of the following characters: \ / : " < > |% ?. The final character cannot
be a blank space.

Note: If the rule name is either empty, contains a name used by another
Tenant Association rule, or uses invalid characters, theNext and Finish
buttons are disabled.
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UI Element
(A-Z) Description

Update
Last
Access
Time

When this option is selected, the Tenant Association rule updates the Last
Access Time property of the CIs it affects. When the check box is cleared, the
Tenant Association rule does not update the attribute and therefore does not
perform touch on those CIs. This ensures that the Tenant Association rule does
not affect the aging of the relevant CIs.

Note:

l For out-of-the-box Tenant Association rules, this option is selected by
default.

l For new CIs created by the Tenant Association rule, the Last Access
Time property is updated even when the check box is cleared.

Rule Base Query Page

This wizard page enables you to define the properties of the TQL query on which the Tenant
Association rule is based.

Important
information

l An Enrichment TQL query that serves as the basis for Enrichment rules, is
subject to certain validation restrictions. For details, "Troubleshooting and
Limitations" on page 93. If the TQL query is not valid, you cannot save it.

l For important information on the effects of making changes to the TQL query
after creating it, see "New Enrichment Rule/Enrichment Rule Properties/Save
As Enrichment RuleWizard" on page 506.

l By default, this wizard is set to display a Completion page after clickingNext
in this page. You can choose not to display the Completion page by changing
the user preferences. For details, see "User Preferences Dialog Box" on page
92.

Wizard
map

The "New Tenant Association Rule/Tenant Association Rule Properties/Save As
Tenant Association RuleWizard" contains:

"Rule General Attributes Page" > "Rule Base Query Page"

See also "Topology Query Language" on page 15

User interface elements are described below:
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UI Element (A-Z) Description

Base the Tenant
Association rule
on a new query

Select this check box if you want to base the Tenant Association rule on a
new TQL query. The TQL results are based on the attributes defined for
the new TQL query.

Base the Tenant
Association rule
on an existing
query

Select this check box if you want to base the Tenant Association rule on
an existing TQL query. Select the required TQL query from the drop-down
list.

Base Query
Description

(Optional) Enter a description of the TQL query.

Base Query Name Enter a unique name for the TQL query.

If you selected theBase the Tenant Association rule on an existing
TQL option, select the TQL query on which you want to base the rule.

Base Query
Priority

Select a priority level for the new TQL query (Low, Medium, High, or
Express). This setting determines how often the query is rerun
automatically by the system to include updated information from the
CMDB.

Save a new query
based on the
current definition

Select to save a new TQL query based on your Tenant Association rule
definition.

Note: This field only appears in the Save As Tenant Association Rule
wizard.

Query Node/Relationship Definition Dialog Box
This dialog box displays the attributes of the selected query node/relationship. The key attributes
and the required attributes of the selected query node appear in bold.

To access Right-click a query node or relationship when in Enrichment mode (select
Enrichment from theQuery/Enrichment drop-down at the top of the Enrichment
Manager page) and select Update Relationship/Query Node.

Modeling Guide
Chapter 12: Enrichment Manager

HP Universal CMDB (10.10) Page 514 of 534



Important
information

Use an Enrichment rule to update the value of CI attributes in the CMDB, or to add
data to attributes that currently do not have values. You can use this option, for
example, for simultaneously adding a note to all CI instances.

Youmust fill in the value of the key attributes and the required attributes of the
Enrichment query node. Themethod you use to define these values determines
the number of instances created.

If you enter a dynamic value, you can create numerous instances. For example,
entering the dynamic value of a host_key for the CIT Node or an IP address
attribute for the CIT IpAddress.

Relevant
tasks

"How to Define an Enrichment Rule – Scenario" on page 491

See also l "Enrichment Manager – Overview" on page 489

l "Enrichment Manager User Interface" on page 497

Attributes Area
User interface elements are described below :

UI
Element
(A-Z) Description

Name The attribute name.

Type The field type of the selected attribute.

Value The value as defined in one of the following:

l TheValue box in theSet Attributes area.

l The combination of the values in theBy Attribute boxes in theSet Attributes
area.

l TheValue column if you selectedSimple in the Type column in the Query Node
Definition - Advanced Attribute dialog box.

l The combination of the values in theValue column and the column to the right of
theValue column if you selectedBy Attribute in the Type column in the Query
Node Definition - Advanced Attribute dialog box.

Set Attributes Area
User interface elements are described below :
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UI Element
(A-Z) Description

Advanced Define an attribute value using the Query Node Definition - Advanced Attribute
dialog box.

. Advanced. Opens the Advanced Attribute dialog box.

Clear. Clears theValue column in theAttributes area.

Note: This element is only active when an attribute of the field type string is
selected.

By
Attribute

Define an attribute using attributes from other query nodes in the TQL query.

l In the box to the left, select the required query node.

l In the box to the right, select the query node’s required attribute.

Apply. Adds the selected attribute definition to theValue column in the
Attributes area.

Clear. Clears theValue column in theAttributes area.

RegExp
Group

(Appears only when you select an attribute of the field type string.) Enter the
group number only if you are adding a regular expression using regular expression
syntax. This is the part of the regular expression pattern to focus on when creating
the attribute. A set of parentheses ( ) constitutes a group.

Regular
Expression

(Appears only when you select an attribute of the field type string.) Add a regular
expression using regular expression syntax. Enter the regular expression pattern.

For examples of how to use regular expression syntax, see "Regular Expression
Examples" on page 533.

Value (in
the Set
Attributes
area)

Define a constant value. Enter the required value in theValue box or select a
value from theValue list.

Apply. Adds the value definition to theValue column in theAttributes area.

Clear. Clears theValue column in theAttributes area.

Query Node Definition - Advanced Attribute Dialog Box
This dialog box enables you to define query node and relationship attributes of the typeString using
simple or complex expressions. You can also create complex expressions using regular expression
format.
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To
access

Select an attribute of the type string in the Query Node Definition dialog box. Select
Advanced and then click theAdvanced button.

Relevant
tasks

"How to Define an Enrichment Rule – Scenario" on page 491

See also l "Enrichment Manager – Overview" on page 489

l "Enrichment Manager User Interface" on page 497

User interface elements are described below :

UI Element
(A-Z) Description

Add. Enables you to define an attribute value using simple or complex
expressions. Creates a new entry in the Type column. Click the new entry and
select eitherSimple orBy Attribute. For details, see the description for the
Type column below.

Delete. Deletes the selected attribute value.

Up.Moves a selected row up.

Down.Moves a selected row down.

Advanced
Value

(This list is only available if you select By Attribute in the Type column.) Click
the entry inside the box and select the required attribute.

Concatenate Use all the attribute values listed in this dialog box.

RegExp
Group

(This list is available only if you select By Attribute in the Type column.) Click
inside theRegExp Group column, click the button, and enter the group
number in the Value for RegExpGroup dialog box that opens. This is the part of
the regular expression pattern to focus on when creating the attribute. A set of
parentheses ( ) constitutes a group.

Regular
Expression

(This list is only available if you select By Attribute in the Type column.) Click
inside theRegular Expression column, click the button, and enter the
regular expression pattern in the Value for Regular Expression dialog box that
opens.

For examples of how to use regular expression syntax, see "Regular Expression
Examples" on page 533.
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UI Element
(A-Z) Description

Type Click the entry inside the Type column and select one of the following options:

l Simple. Define a constant value using a simple expression.

l By Attribute. Define an attribute using attributes from other query nodes in
the TQL.

Default is: Simple

Use first
attribute
with value

Use the first attribute value listed in this dialog box that is not empty.

Value l If you select Simple in the Type column, click inside theValue column, click
the button, and enter the required value in the Value for Simple dialog
box.

Note: If you define an attribute value using only one Simple expression,
theValue column cannot be empty.

l If you select By Attribute in the Type column, click inside theValue column
and select the required value from the list.

Update Consumer Tenants Dialog Box
This dialog box enables you to define a rule for updating the consumer tenants of a CI.

To access In Enrichment Manager, select Enrichment Mode. Right-click the required query
node in the Tenant Association rule and select Update Consumer Tenants.

Important
information

This dialog box is only available whenmulti-tenancy is enabled.

Relevant
tasks

"How to Define a Tenant Association Rule" on page 496

See also l "Multi-Tenancy Overview" on page 1

l "Tenant Association Rules" on page 1

User interface elements are described below:

UI Element (A-Z) Description

Append selected
value to original

When this option is selected, the consumer tenants selected are appended
to the original consumer tenants of the updated query node.
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UI Element (A-Z) Description

Get attribute
value from

Select the tenancy attribute of the selected query nodes to apply to the
updated query node. The options are:

l Owner Tenant attribute. Applies the owner tenants of the selected
query nodes as the consumer tenants of the updated query node.

l Consumer Tenants attribute. Applies the consumer tenants of the
selected query nodes as the consumer tenants of the updated query
node.

Note: This element is only relevant whenBy Attribute is selected.

Override original
value

When this option is selected, the consumer tenants selected replace the
original consumer tenants of the updated query node.

Select nodes Move the selected query nodes from the Available Nodes pane to the
Selected Nodes pane using the arrow buttons.

Note: This element is only relevant whenBy Attribute is selected.

Select tenant Move the selected tenants from the Available Tenants pane to the Selected
Tenants Pane using the arrow buttons.

Note: This element is only relevant whenBy Value is selected.

Update
consumer
tenants

Select amethod for updating the consumer tenants. The available options
are:

l By Value. Select tenants directly from the available tenants.

l By Attribute. Select other query nodes in the rule. The updated query
node is assigned the consumer tenants of the selected query nodes.

Update Owner Tenant Dialog Box
This dialog box enables you to define a rule for updating the owner tenant of a CI.

To access In Enrichment Manager, select Enrichment Mode. Right-click the required query
node in the Tenant Association rule and select Update Owner Tenant.

Important
information

This dialog box is only available whenmulti-tenancy is enabled.
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Relevant
tasks

"How to Define a Tenant Association Rule" on page 496

See also l "Multi-Tenancy Overview" on page 1

l "Tenant Association Rules" on page 1

User interface elements are described below:

UI Element
(A-Z) Description

Select tenant Select a tenant from the drop-down list.

Note: This element is only relevant whenBy Value is selected.

Select owner
tenant from

Select a query node from the drop-down list.

Note: This element is only relevant whenBy Attribute is selected.

Update owner
tenant

Select amethod for updating the owner tenant. The available options are:

l By Value. Select a tenant directly from a drop-down list.

l By Attribute. Select another query node in the rule. The updated query
node is assigned the owner tenant of the selected query node.
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Chapter 13: UCMDB Data Model Introduction
This chapter includes:

Universal DataModel (UDM)Overview 522

Universal Data Model (UDM) Overview
The Universal Datamodel (UDM), provides the informationmodel that enables HP Software
products to integrate using a common language. The UDM provides the vocabulary in the form of
CI types and the relationships between them, and their attributes. This vocabulary and the artifacts
derived from it are used to enable integrations in an enterprise environment, to enable faster design
and deployment, and to facilitate ease of maintenance and integration evolution. The UDM is
applied tomany management products and solutions, including HP Universal CMDB and its
integrations.

You can generate the UCMDB CI Types and Relationships Information PDF, which provides
information on specific CI Types and Relationships in the UDM. For details, see "Export Selected
CITs to PDF Dialog Box" on page 486. You can also find a UDM Powerpoint document on the HP
Live Network or access the UCMDB Class Model Reference by selectingHelp > UCMDB Class
Model.
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Chapter 14: Exporting the UCMDB Data Model
to a UML Tool

This chapter includes:

Export to UML Tool – Overview 523

How to Export the Class Model 523

How to Convert XML of a Selected Part of the Class Model 524

Export to UML Tool User Interface 525

Tool Plug-in Input 527

Note: Currently, Altova UModel versions 2008 and 2009 are supported.

Export to UML Tool – Overview
The Export to UML tool enables you to export selected sections of the UCMDB class model to a
format compatible with UML tools, and to view themodel as a UML diagram.

The input for the tool is the UCMDB class model XML file retrieved by the JMX service
UCMDB:service=Class Model Services/
exportClassModelToXml().

Note: To access the JMX console, enter the following address in your browser:
http://<server_name>:8080/jmx-console, where <server_name> is the name of themachine
on which HP Universal CMDB is installed.

How to Export the Class Model
This task describes how to use the Export Class Model to UML tool wizard.

This task includes the following steps:

l "Prerequisites" below

l "Run the UML Tool" on the next page

l "View the Exported File in Altova" on the next page

1. Prerequisites
Set up the tool by extracting the following zip file to any location:

<Volume>:\hp\UCMDB\UCMDBServer\tools\ExportClassModel.zip
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2. Run the UML Tool
You use the Export Class Model to UMLwizard to choose the CIT and its attributes to be
exported to the UML tool.

For details on working with the Export to UMLwizard, see "Export Class Model to UML
Wizard" on the next page.

3. View the Exported File in Altova
a. In Altova, select File > Import From XMI File.

b. Select the XMI file. The class model entry appears in theModel Tree pane.

c. Right-click the entry and select Show in new diagram > Content. Click OK.

How to Convert XML of a Selected Part of the Class
Model

This task describes how to use the custom plug-in to convert the XML of a selected part of the
class model to the UML tool format.

The plug-in can be either a Java class or an XSLT text file. If you use a Java class, it must
implement the ITransformToUML(ExportToUML.jar) interface; the transformToUML()method
receives an XML string as a parameter and returns a byte array that is written to the output file.

For details on the custom plug-in input, see "Tool Plug-in Input" on page 527.

This task includes the following steps:

l "Activate the Plug-in Using a Java Class" below

l "Activate the Plug-in Using an XSLT Text File" below

Activate the Plug-in Using a Java Class
Add the display name and fully-qualified class name to the config.xml file in the ExportToUML
directory, as follows:

        <ConverterToUML>
            <Name><display name></Name>
            <Class><fully qualified class name></Class>
        </ConverterToUML>

Continue with the procedure for exporting the class model. For details, see "How to Export the
Class Model" on the previous page.

Activate the Plug-in Using an XSLT Text File
In this case, XSLT from the specified file is applied to the class model XML and is written to the
output file.
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Add the display name and full path of the XSLT file to the config.xml file in the ExportToUML
directory, as follows:

        <ConverterToUML>
            <Name><display name></Name>
            <XsltFile><Full_path_of_the_XSLT_file></XsltFile>
        </ConverterToUML>

Continue with the procedure for exporting the class model. For details, see "How to Export the
Class Model" on page 523.

Export to UML Tool User Interface
This section includes:

Export Class Model to UMLWizard 525

Export Class Model to UML Wizard
This wizard enables you to choose the CIT and its attributes to be exported to the UML tool.

To access Browse to the location where you extracted the tool. Right-click
ExportClassModel.jar in the ExportClassModel directory. Select Open With >
Java 2 Platform SE binary.

Important
information

By default the tool opens theClassModel.xml file in the ExportClassModel
directory. You open other files through the File > Open Class Model File menu.

Relevant
tasks

"How to Export the Class Model" on page 523

Wizard
map

The Export Class Model to UMLwizard contains:

"Export Class Model to UML Wizard" above > "Select Valid Links" on the next
page > "Export Selected Items" on the next page

See also l "Export to UML Tool – Overview" on page 523

l "Tool Plug-in Input" on page 527

User interface elements are described below:

UI Element (A-Z) Description

File Displays a list of XML files. Open the file that contains the class model.
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UI Element (A-Z) Description

Select Attributes
Pane

Select the attributes to be displayed in the UML tool.

The attributes of the selected CIT are displayed in this pane. The attributes
are colored as follows:

l Attributes inherited from the parent CIT are black.

l Attributes specific to this CIT are dark blue.

Select CI Types
Pane

The CITs displayed here are retrieved from the ClassModel.xml file.

Select the CIT and its sub nodes to be exported to the UML tool.

Use the buttons to select or clear all subindex.

Select Valid Links

This wizard page enables you to select links that can be used between two CITs.

Important
information

General information about the wizard is available in "Export Class Model to
UMLWizard" on the previous page.

Wizard map The Export Class Model to UMLwizard contains:

"Select Valid Links" > "Export Selected Items"

User interface elements are described below:

UI Element
(A-Z) Description

Removes the filter from the list of CITs.

Filter by Enables you to filter the list of valid links. You can filter the list of CITs and you can
sort the list by CIT or relationship.

Export Selected Items

This wizard page enables you to export the selected CITs and their attributes to the UML tool.

Important
information

General information about the wizard is available in "Export Class Model to
UMLWizard" on the previous page.

Wizard map The Export Class Model to UMLwizard contains:

"Select Valid Links" > "Export Selected Items"

User interface elements are described below:

Modeling Guide
Chapter 14: Exporting the UCMDB DataModel to a UML Tool

HP Universal CMDB (10.10) Page 526 of 534



UI Element
(A-Z) Description

Export Click to browse to the UML file, in XMI format, to which you want to add the
UCMDB CITs and their attributes.

If there are no valid links for a pair of CITs, a no valid linksmessage is displayed
in the Select Valid Links page.

Tool Plug-in Input
The input for the plug-in is an XML string (selected classes/attributes/valid links) in the following
form:

    <?xml version="1.0" encoding="ISO-8859-1"?>
    <Class-Model>

    <Class class-name="hostresource" display-name="Host Resource" visibility
="public">

<Attribute name="isvirtual" display-name="Is Virtual" visibility="pu
blic"/>

    <Attribute name="city" display-name="City" visibility="public"/>
    </Class>
    <Class class-name="host_node" display-name="Computer" visibility="publi

c">
    <Derived-From class-name="host"/>

    </Class>
    <Class class-name="vax" display-name="VAX" visibility="public">

    <Attribute name="root_actualdeletionperiod" display-name="Actual Del
etion Period" visibility="public"/>

    <Attribute name="data_allow_auto_discovery" display-name="Allow CI U
pdate" visibility="public"/>

    <Derived-From class-name="host_node"/>
    </Class>
    <Class class-name="host" display-name="Host" visibility="public">

    <Attribute name="host_iscomplete" display-name="Host Is Complete" vi
sibility="public"/>

    <Attribute name="host_isroute" display-name="Host Is Route" visibili
ty="public"/>

    <Attribute name="host_hostname" display-name="Host Name" visibility=
"public"/>

    <Attribute name="host_os" display-name="Host Operating System" visib
ility="public"/>

    </Class>
    <Class class-name="unix" display-name="Unix" visibility="public">

    <Derived-From class-name="host_node"/>
    </Class>
    <Valid-Link ID="host_member_host" display-name="Member" visibility="publ

ic">
    <End1 class-name="host"/>
    <End2 class-name="host"/>
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    </Valid-Link>
    <Valid-Link ID="host_container_f_hostresource" display-name="Container l

ink" visibility="public">
    <End1 class-name="host"/>
    <End2 class-name="hostresource"/>

    </Valid-Link>
    </Class-Model>
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Chapter 15: Working with Tables
This chapter includes:

Columns User Interface 530

Columns User Interface
This section includes (in alphabetical order):

Select Columns Dialog Box 530

Sort ColumnContent Dialog Box 531

Select Columns Dialog Box
This dialog box enables you to choose the information you are interested in displaying. You can hide
a column or display a hidden column.

To access
Click theSelect Columns button. This button appears above every table in
a report.

Important
Information

The order of the columns in the list in the Visible Columns pane determines the
order of the columns displayed in the table. To change the order of table columns,
move them to the required position using the up and down arrow buttons or by
dragging a column to a new location.

The following elements are included:

UI Element
(A-Z) Description

Displays a column. Moves the selected column from theAvailable Columns
pane to theVisible Columns pane.

Hides a selected column. Moves the selected column from theVisible
Columns pane to theAvailable Columns pane.

Displays all hidden columns. Moves all the columns from theAvailable
Columns pane to theVisible Columns pane.

Hides all columns. Moves all the columns from theVisible Columns pane to the
Available Columns pane.

Moves a selected column up in the list in theVisible Columns pane.

Moves a selected column down in the list in theVisible Columns pane.
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UI Element
(A-Z) Description

Available
Columns

The columns in this pane do not appear in the table.

Visible
Columns

The columns in this pane are visible in the table.

Sort Column Content Dialog Box
This dialog box enables you to set or change the sort order for the entries displayed in a table.

To access Click the Sort Column Content button.

Important
Information

l To sort a table by one column:

Move the column name from theAvailable Columns to theSorted Columns
list. Select the name and decide whether to sort in ascending (upward triangle)
or descending (downward triangle) order by clicking the relevant button.

l To sort a table by more than one column:

Move the column names from theAvailable Columns to theSorted
Columns list. For each column, decide whether to sort in ascending or
descending order.

l To change the order in which columns are sorted:

In theSorted Columns list, select an entry, and click the Up or Down arrow to
change the order. (Entries higher in the list are sorted before entries lower in the
list.) A number is displayed in the table's column headers.

Note: Only columns that are displayed can be sorted. For details on how to
define which columns are displayed in the table and in which order, see
"Select Columns Dialog Box" on the previous page.

The following elements are included:

UI
Element 
(A–Z) Description

Moves the selected column from theAvailable Columns pane to theSorted
Columns pane. You can double-click the selection to perform the same procedure.

Moves the selected column from theSorted Columns pane to theAvailable
Columns pane.
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UI
Element 
(A–Z) Description

Moves all the columns from theAvailable Columns pane to theSorted Columns
pane.

Moves all the columns from theSorted Columns pane to theAvailable Columns
pane.

Moves the selected column up or down in the list to increase or decrease its priority
in establishing the sort order.

Enables you to sort the column content in ascending or descending order.

In theSorted Columns pane, select a column name and click the ascending or
descending button.

Available
Columns

The columns whose content is not sorted.

Note: You can select multiple columns.

Sorted
Columns

The columns whose content is sorted in either ascending or descending order.
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Chapter 16: Regular Expression Examples
This chapter includes:

Examples of Regular Expressions 533

Examples of Regular Expressions

l Enter a regular expression to define an IP address (aa.yy.zz.mm):

To: In the First Field Enter: In the Second Field Enter:

Create label by aa (.*)([.].*[.].*[.].*) 1

Create label by yy (.*[.])(.*)([.].*[.].*) 2

Create label by zz (.*[.].*[.])(.*)([.].*) 2

Create label by mm (.*[.].*[.].*[.])(.*) 2

l Enter a regular expression to create the label by the first or last letters of the selected attribute:

To: In the First Field Enter: In the Second Field Enter:

Create label by the first letter (.)(.*) 1

Create label by the last letter (.*)(.) 2

Create label by the first two letters (..)(.*) 1

Create label by the last two letters (.*)(..) 2
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We appreciate your feedback!
If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:

Feedback on Modeling Guide (Universal CMDB 10.10)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client,
and send your feedback to SW-Doc@hp.com.
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